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PREFACE

This Preface provides supporting information for the Oracle Financial Services Analytical Applications
Profitability Pack Installation Guide and includes the following topics:

e Summary

* Audience

* Documentation Accessibility
* Related Documents

+ Conventions

Summary

You can find the latest copy of this document in OHC library which includes all the recent additions/revisions (if
any) done till date.

Before you begin the installation, ensure that you have an access to the Oracle Support Portal with the required
login credentials to quickly notify us of any issues at any stage. You can obtain the login credentials by contacting
Oracle Support.

Audience

The Oracle Financial Services Analytical Applications (OFSAA) profitability pack Installation and Configuration
Guide is intended for Administrators, Business User, Strategists, and Data Analyst, who are responsible for
installing and maintaining the application pack components.

The document assumes you have experience in installing Enterprise components. Basic knowledge about the
OFSAA PROFITABILITY pack components, OFSAA Architecture, UNIX commands, Database concepts and
Web Server/ Web Application Server is recommended.

Following are the expected preparations from the administrator before starting the actual installation:

* Awareness of the OFSAA Tier Architecture. For more information, see the Application Tiers section.

» Decision on the appropriate OFSAA Deployment Option. For more information, see the Recommended
Deployment Options section.
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Related Documents

This section identifies additional documents related to OFSAA Infrastructure. You can access Oracle
documentation online from Oracle Help Center (OHC).

* Oracle Financial Services Funds Transfer Pricing Management User Guide

» Oracle Financial Services Profitability Management User Guide

* Oracle Financial Services Enterprise Financial Performance Analytics User Guide
» Oracle Financial Services Institutional Performance Analytics User Guide

* Oracle Financial Services Retail Performance Analytics User Guide

Conventions

The following text conventions are used in this guide:

Convention Meaning

boldface Boldface type indicates graphical user interface elements
associated with an action, or terms defined in text or the
glossary.

italic Italic type indicates book titles, emphasis, folder paths, or

placeholder variables for which you supply particular values.

monospace monospace indicates commands within a paragraph, URLs,
code in examples, text that appears on the screen, or text that
you enter.

Filenames filenames indicate the file names within a pragraph.

Hyperlink Hyperlinks indicate the cross-references, external document

links, and external website links.

Abbreviations
AIX Advanced Interactive eXecutive
BDP Big Data Processing
DBA Database Administrator
DDL Data Definition Language
DEFQ Data Entry Forms and Queries
DML Data Manipulation Language
EAR Enterprise Archive
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Abbreviation Meaning

EJB Enterprise JavaBean

ERM Enterprise Resource Management

FTP File Transfer Protocol

GUI Graphical User Interface

HDFS Hadoop Distributed File System

HTTPS Hypertext Transfer Protocol Secure

J2c J2EE Connector

J2EE Java 2 Enterprise Edition

JDBC Java Database Connectivity

JDK Java Development Kit

JNDI Java Naming and Directory Interface

JRE Java Runtime Environment

JVM Java Virtual Machine

LDAP Lightweight Directory Access Protocol

LHS Left Hand Side

MFA Multi-Factor Authentication

MOS My Oracle Support

OFSAAI Oracle Financial Services Analytical
Application Infrastructure

OHC Oracle Help Center

OLAP On-Line Analytical Processing

OLH Oracle Loader for Hadoop

ORAAH Oracle R Advanced Analytics for
Hadoop

oS Operating System

RAM Random Access Memory

RDBMS Relational Database Management
System

SFTP Secure File Transfer Protocol

SID System Identifier
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Abbreviation Meaning

SSL Secure Sockets Layer

TDE Transparent Data Encryption
TNS Transparent Network Substrate
URL Uniform Resource Locator

VM Virtual Machine

WAR Web Archive

XML Extensible Markup Language
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CHAPTER 1 — ABOUT OFSAA AND OFSAA APPLICATION PACKS

This chapter includes the following topics:

» About Oracle Financial Services Analytical Applications (OFSAA)

* About Oracle Financial Services Analytical Applications (OFSAA) Pack

* About Oracle Financial Services Profitability Management Applications Pack

» About Oracle Financial Services Analytical Applications Infrastructure (OFS AAl)

About Oracle Financial Services Analytical Applications (OFSAA)

In today's turbulent markets, financial institutions require a better understanding of their risk-return, while
strengthening competitive advantage and enhancing long-term customer value. Oracle Financial Services
Analytical Applications (OFSAA) enable financial institutions to measure and meet risk adjusted performance
objectives, cultivate a risk management culture through transparency, lower the costs of compliance and
regulation, and improve insight into customer behavior.

OFSAA uses industry-leading analytical methods, shared data model and applications architecture to enable
integrated risk management, performance management, customer insight, and compliance management.
OFSAA actively incorporates risk into decision making, enables to achieve a consistent view of performance,
promote a transparent risk management culture, and provide pervasive intelligence.

Oracle Financial Services Analytical Applications delivers a comprehensive, integrated suite of financial
services analytical applications for both banking and insurance domain.

About Oracle Financial Services Analytical Applications (OFSAA)
Pack

OFSAA applications are packaged, and released as Application Packs starting from 8.0 release. An Application
Pack is a group of OFSAA products packaged together in a single installer and addresses specific functional
area via its products that are grouped together. Packaging applications in a group ensures simplified installation,
maintenance, development and integration in an integrated deployment.
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About OFSAA and OFSAA Application Packs

The following figure depicts the various application packs that are available across the OFSAA Banking and
Insurance domains:

/ Insurance Market Risk ™
- Insurance Market Risk Analytics
Insurance Operational Risk Standard
Edition/Enterprise Edition
Insurance Operational Risk
Insurance Operational Risk Analytics
Insurance Model Risk Management
Insurance Enterprise Risk Management
Insurance Governance and Compliance
Management
Insurance Solvency Il Management
Insurance Operational Risk Economic

\L Capital /
—| INSURANCE

/~ Advanced Analytical
Application

Infrastructure

Data Management Pack
Data Foundation Pack
Risk Regulatory

Solution Pack

\.__ Connectors J/

“orm |

Behavior Detection
Pack

. - Compliance Regulatory
BANKING Compllance Reporting Solution Pack
- Governance Risk and

Compliance Pack

. _/

Pricing Management
Pack
- Performance - Customer Analytics
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About OFSAA and OFSAA Application Packs

About Oracle Financial Services Profitability Management
Applications Pack

OFS Profitability 8.0.6.0.0 Pack includes the following applications:

Oracle Financial Services Analytical Applications Infrastructure: Oracle Financial Services Analytical
Applications Infrastructure (OFS AAl) powers the Oracle Financial Services Analytical Applications family
of products to perform the processing, categorizing, selection and manipulation of data and information
needed to analyze, understand and report on specific performance, risk, compliance and customer insight
issues by providing a strong foundation for the entire family of Oracle Financial Services Analytical
Applications across the domains of Risk, Performance, Compliance and Customer Insight.

Oracle Financial Services Funds Transfer Pricing Management: It enables the bank to apply various
transfer pricing methods on products to calculate funds transfer price. It calculates transfer price across all
product types varying in terms of characteristics like fixed rate or floating rate instruments, bullet or
amortizing or fixed tenor or perpetual instruments. In addition it also supports the calculation of transfer price
at account level or ledger level including migration of charge or credit to ledger if required.

Oracle Financial Services Profitability Management: It helps Banks and Financial services institutions
manage and monitor interest rate risk, liquidity risk, foreign currency risk and earnings risk. The application
models every loan, deposit, investment portfolio individually to help institutions better understand the risks
they have assumed and their sensitivity to economic conditions.

Oracle Financial Services Enterprise Financial Performance Analytics: It is based upon a dedicated
reporting mart built on the new Financial Services Data Model. OF SEFPA leverages several components of
OBIEE technology including Dashboards and Answers. It includes various Dashboards and Reports for the
user to carry out various Profitability Management based analytics.

Oracle Financial Services Institutional Performance Analytics: It provides strategic insights on -
Profitability of the business and the underlying customers, Product holdings and Relationship depth across
the organization, Behavioral and Engagement trends of it's target segments - exposures, commitments, line
utilization, assets/liabilities, deposits, withdrawals, Fees, Income, recent transactions and so on, Efficiency
of investments (like marketing, partner development), Efficiency of the sales force in terms of ongoing
customer revenue generation, cross-sell and up-sell, product usage and pipeline.

Oracle Financial Services Retail Performance Analytics: It focuses on Summary performance of the
LOBs and overall profitability, Portfolio mix, LOB specific profitability reports to be analyzed against key
dimensions like customer segments, product family, region, branch, risk scores and so on, Product holdings
and Relationship depth across the LOBs, Customer Trends across performance drivers like Sales,
Balances, Deposits, Product subscriptions (revenue services), Credit scores and delinquency bands,
losses, and so on, Wallet Share analysis and customer lifetime value, Efficiency of investments (like
marketing, branch, channel and so on) over time.

About Oracle Financial Services Analytical Applications
Infrastructure (OFS AAl)

Oracle Financial Services Analytical Applications Infrastructure (OFS AAI) powers the Oracle Financial Services
Analytical Applications family of products to perform the processing, categorizing, selection and manipulation of
data and information needed to analyze, understand and report on specific performance, risk, compliance and
customer insight issues by providing a strong foundation for the entire family of Oracle Financial Services
Analytical Applications across the domains of Risk, Performance, Compliance and Customer Insight.

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0



About OFSAA and OFSAA Application Packs

Components of OFSAAI

The OFSAA Infrastructure is comprised of a set of frameworks that operates on and with the Oracle Financial
Services Analytical Applications Data Model and form the array of components within the Infrastructure.

The OFSAA Infrastructure components/ frameworks are installed in two layers; primarily the Metadata server
and Infrastructure services run on one layer, and the Ul and presentation logic runs on the other. The Ul and
presentation layer is deployed on any of the supported J2EE Servers.

The following figure depicts the various frameworks and capabilities that make up the OFSAA Infrastructure:
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OFSAA Infrastructure High Availability

The current release of the OFSAA Infrastructure supports only "Single Instance" installation for the Infrastructure
components. However, the High Availability (HA) for the Database Server and/ or the Web Application Server
clustering and deployment are supported in this release.

This release supports Active-Passive model of implementation for OFSAAI components. For more information,
see Configuration for High Availability- Best Practices Guide.
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About OFSAA and OFSAA Application Packs

About Data Security Configuration

Data Security refers to the protection of data against unauthorized access and data theft. OFSAA ensures Data
Security with the following features:

*  Multi-Factor Authentication

»  Transparent Data Encryption (TDE)
+ Data Redaction

+ Key Management

« HTTPS

* Logging

For more details on the features in the previous list, see the relevant topics in this guide and the Data Security
and Data Privacy section in the OFSAAI Administration Guide.
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Understanding OFS Profitability Application Pack Installations

CHAPTER 2 — UNDERSTANDING OFS PROFITABILITY

APPLICATION PACK INSTALLATIONS

This chapter includes the following topics:

Installation Overview

This release of the OFS Profitability Application Pack bundles the upgrade patch set along with the base

Installation Overview

Verifying the System Environment
Understanding Installation Modes

Hardware and Software Requirements

installer. Users/ Administrators who wish to install a new OFS Profitability Application Pack 8.0.6.0.0 instance

or upgrade an existing OFS Profitability Application Pack 8.0.x instance to 8.0.6.0.0 should download this
installer. The following figure shows the order of procedures you will need to follow to install a new OFS

Profitability Pack 8.0.6.0.0 instance. For upgrading a current OFS Profitability Application Pack 8.0.x instance
to 8.0.6.0.0 release, see Upgrading the OFS PFT Application Pack.

This section gives an overview of the OFS Profitability Applications Pack Installation. The following figure shows
the order of procedures you need to follow:

Installation Workflow

Start

Verify System Environment

4

Obtain the Software

1

y

Configure and Exacute the Schema Creator Utility

l

Install Portability Pack

!

Cenfigure Portability Pack

!

Verify Installation

v
Done |
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Understanding OFS Profitability Application Pack Installations

The following table describes the tasks and their descriptions:

Tasks Details and Documentation

Verify Systems Environment To verify that your system meets the minimum necessary requirements for
installing and hosting the OFS Profitability Application Pack, see Verifying
the System Environment.

Obtain the software To access and download the OFS Profitability Application Pack, see
Obtaining the Software.

Configure and Execute the Schema Creator |For instructions on creating the database schemas, see Configuring and
Utility Executing the Schema Creator Utility.

Install OFS Profitability Application Pack For instructions on Installing OFS Profitability Application Pack, see
Installing the OFS Profitability Applications Pack.

Configure OFS Profitability Setup See Post-Installation Configuration.
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Understanding OFS Profitability Application Pack Installations

Deployment Topology

The following figure depicts the typical deployment topology implemented for OFSAA Applications:
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Hardware and Software Requirements

This section describes the various Operating Systems, Database, Web Server, and Web Application Server

versions, and other variant details on which this release of the Oracle Financial Services Profitability Application

Pack has been qualified.

OFS Profitability Application Pack installation can be performed on both Virtual and Physical servers.
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Understanding OFS Profitability Application Pack Installations

Configurations Supported for Java 7

The following table shows the minimum hardware and software requirements for installing OFS Profitability
Application Pack (for Java 7):

Requirement

Operating System

Sub-Category Value

Oracle Linux/Red Hat Enterprise Linux |m  Red Hat Enterprise Linux or Oracle Linux Server
(x86-64) release 6 update 6 to latest update version

m  Red Hat Enterprise Linux or Oracle Linux Server
release 7 update 1 to latest update version

Oracle Solaris (SPARC)/ Solaris x86 m  Oracle Solaris v5.10 Update 11 and above - 64 bit

m  Oracle Solaris v5.11 update 3 and above - 64 bit

IBM AIX (PowerPC) m  AIX6.1(TL 09 and above) - 64 bit

m  AIX7.1(TL 03 and above) - 64 bit

Shell KORN Shell (KSH)
Note:
m Ifthe OSis IBM AIX 6.1 and the file size limit for the AIX user on the target server is too small,

configure the size parameter setting for "Large File Support". Follow these steps:

Change the file size limit for the user that initiates the transfer on the AIX system. To change
the file size limit for a particular user, add or edit the fsize attribute for the user in the /etc/
security/limits file on the AIX system. Change the file size limit to unlimited (fsize = -1) or to a
size equal to the size of the file being transferred. This may require an restart of the AIX server
to pick up the new configuration. For more information, see IBM Support.

If the operating system is RHEL, install the package Isb_release using one of the following
commands by logging in as root user:

O vyum install redhat-lsb-core

O yum install redhat-1sb

To install this release on Oracle Solaris OS, refer to the following list for version specific
information:

O Solaris 11 - Upgrade to Oracle Solaris 11.3 with SRUO9 or higher. See https://
docs.oracle.com/cd/E60778_01/html/E60743/gouaw.html#scrolltoc to upgrade to SRU09
if you have a lower SRU version. Additionally, install the required runtime libraries. For
more information, see Installing Only the Runtime Libraries on Oracle Solaris 11.

O Solaris 10 - Install the required OS patches. For more information, see Installing the

Required Oracle Solaris 10 Patches. Additionally, install the required runtime libraries. For
more information, see Installing Only the Runtime Libraries on Oracle Solaris 10.

Note: In an OFSAA instance where multiple OFSAA application packs have been installed/
deployed, it is mandatory to upgrade all OFSAA application packs to 8.0.4.0.0 release. You should
start the upgrade of OFS AAAIl<<your pack name>>pack, only after confirming that all of the
application packs in your OFSAA instance are available for upgrade to 8.0.4.0.0 version. For
information on availability of the required OFSAA Application Packs, see 2246606.1.
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Understanding OFS Profitability Application Pack Installations

Requirement Sub-Category
Java Runtime Oracle Linux / Red Hat Enterprise Linux |{m  Oracle Java Runtime Environment (JRE) 1.7.x - 64
Environment bit

IBM AIX IBM AIX Runtime, Java Technology JRE 1.7.x - 64 bit
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Understanding OFS Profitability Application Pack Installations

Requirement

Oracle Database
Server and Client

Sub-Category Value

Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.3.0 +) - 64 bit RAC/ Non-
RAC with partitioning option

Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.4.0 +) - 64 bit RAC/Non-RAC
with partitioning option, Advanced Security Option**

Oracle Database Server Enterprise Edition 12c Release 1 (12.1.0.1.0 +) - 64 bit RAC/ Non-
RAC with partitioning option, Advanced Security Option**

Oracle Database Server Enterprise Edition 12C Release 2 (12.2.0.1.0 +) - 64 bit RAC/Non-
RAC with partitioning option, Advanced Security Option**

Note: ** See the "Additional Notes" section in the 806 Tech Matrix for details.

Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit

Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit

Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin driver)
Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle thin driver)
Oracle R Distribution (ORD) version 3.2.0/3.3.0 (Optional)

Oracle R Enterprise (Server) version 1.5 with ORD 3.2.0 and version 1.5.1 with ORD 3.3.0
(Optional).

Note: Ensure that the following patches are applied:

O For Oracle DB Server 12.1.0.1 and 12.1.0.2, download the patches 27010930 and
22205607 from My Oracle Support and apply them.

O For Oracle DB Server 11.2.0.4, download the patch 22205607 from My Oracle Support
and apply.

In Oracle release 12.2, the default value for the SQLNET . ALLOWED LOGON VERSION SERVER
parameteris "12", i.e. Exclusive Mode. It is recommended to set this parameter as described below.
This will relax the SQLNET . ALLOWED LOGON VERSION SERVER setting in the sqlnet.ora file to a
more permissive setting.

Set the following parameters as below:
SQLNET.ALLOWED LOGON VERSION CLIENT = 8
SQLNET.ALLOWED LOGON_ VERSION SERVER = 8

ORAAH Technical Description

No | Oracle R Oracle R OpenSource R or | Oracle Database
Enterprise Advanced Oracle R Enterprise
Analytics for Distribution Edition
Hadoop
1 1.51 271 3.3.0 11.2.0.4,
12.1.0.1,
12.1.0.2,
12.2.0.1
2 1.5.0 2.5.1, 3.2.0 11.2.0.4,
2.6.0, 12.1.0.1,
2.7.0 12.1.0.2
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Requirement

OLAP

Sub-Category

Oracle Hyperion Essbase

Value

m V 11.1.2.1+ (Server and Client) with Oracle 11g
Database

m V 11.1.2.3+ (Server and Client) with Oracle 12c
Database

Note: Oracle Hyperion Essbase is requi

red only if you are using the OLAP feature of OFSAAI.

Web Server/ Web
Application Server

Oracle Linux/Red Hat Enterprise Linux
/ 1BM AIX Oracle Solaris

Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 2.2.x/
IBM HTTP Server

m  Oracle Weblogic Server 12.1.3+ with jersey 2.25
m  Oracle Weblogic Server 12.2.x - (64 bit)

m  IBM WebSphere Application Server 8.5.5.9+ (Full
Profile) with IBM Java Runtime - (64 bit)

m  Apache Tomcat version 8.0.47 - (64 bit)

Note: OFS Inline Processing Engine does not support
Tomcat Web Application Server.

Note: OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle

JRockit is not supported.

Desktop
Requirements

Operating System

Windows 7/8/10

Browser m  Chrome 57.x
m  FireFox 52.x
Office Tools m  MS Office 2007/ 2010/ 2013/ 2016

m  Adobe Acrobat Reader 10 and 11

Screen Resolution

1024*768 or 1280*1024

Other Software Directory Services OFSAAIl is qualified on both OPEN LDAP 2.2.29+ and
Oracle Internet Directory v 11.1.1.3.0. However, it can be
integrated with other directory services software such as
MS Active Directory.

Note: Configuration of Directory services software for OFSAAI installation is optional. For more
information on configuration, see LDAP Configuration section in OFSAAI Administration Guide.
Open LDAP needs to be installed on MS Windows Server machine only.

AAIl One-off patches Download the following one-off patches for the given bug

numbers from http://support.oracle.com:

m 27938294
= 28079607
m 28033582
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Requirement

PFT Application

Sub-Category

One-off patches

Value

Download the following one-off patches for the given bug
numbers from http://support.oracle.com:

= 28053291
= 28170580
= 28399997

FTP Application

One-off patches

Download the following one-off patches for the given bug
numbers from http://support.oracle.com:

= 28053724
= 28197858
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Configurations Supported for Java 8

The following table shows the minimum hardware and software requirements for installing OFS PFT Application
Pack (for Java 8):

Requirement Sub-Category Value

Operating System Oracle Linux/Red Hat Enterprise Linux |m  Red Hat Enterprise Linux or Oracle Linux Server
(x86-64) release 6 update 6 to latest update version

m  Red Hat Enterprise Linux or Oracle Linux Server
release 7 update 1 to latest update version

Oracle Solaris (SPARC)/ Solaris x86 m  Oracle Solaris v5.10 Update 11 and above - 64 bit
m  Oracle Solaris v5.11 update 3 and above - 64 bit

IBM AIX (PowerPC) m  AIX6.1(TL 09 and above) - 64 bit
m  AIX7.1(TL 03 and above) - 64 bit

Shell KORN Shell (KSH)

Note:

m Ifthe OSis IBM AIX 6.1 and the file size limit for the AIX user on the target server is too small,
configure the size parameter setting for "Large File Support". Follow these steps:
Change the file size limit for the user that initiates the transfer on the AIX system. To change
the file size limit for a particular user, add or edit the fsize attribute for the user in the /etc/
security/limits file on the AIX system. Change the file size limit to unlimited (fsize = -1) or to a
size equal to the size of the file being transferred. This may require an restart of the AIX server
to pick up the new configuration. For more information, see IBM Support.

m  If the operating system is RHEL, install the package Isb_release using one of the following
commands by logging in as root user:

O vyum install redhat-lsb-core
O yum install redhat-1sb

m  To install this release on Oracle Solaris OS, refer to the following list for version specific
information:

O Solaris 11 - Upgrade to Oracle Solaris 11.3 with SRUO9 or higher. See https://
docs.oracle.com/cd/E60778_01/html/E60743/gouaw.html#scrolltoc to upgrade to SRU09
if you have a lower SRU version. Additionally, install the required runtime libraries. For
more information, see Installing Only the Runtime Libraries on Oracle Solaris 11.

O Solaris 10 - Install the required OS patches. For more information, see Installing the
Required Oracle Solaris 10 Patches. Additionally, install the required runtime libraries. For
more information, see Installing Only the Runtime Libraries on Oracle Solaris 10.

Note: In an OFSAA instance where multiple OFSAA application packs have been installed/
deployed, it is mandatory to upgrade all OFSAA application packs to 8.0.4.0.0 release. You should
start the upgrade of OFS AAAIl<<your pack name>>pack, only after confirming that all of the
application packs in your OFSAA instance are available for upgrade to 8.0.4.0.0 version. For
information on availability of the required OFSAA Application Packs, see 2246606.1.
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Requirement

Java Runtime
Environment

Sub-Category Value

Oracle Linux / Red Hat Enterprise m  Oracle Java Runtime Environment (JRE) 1.7.x - 64

Linux//IBM AIX bit

Oracle Solaris m  Oracle Java Runtime Environment (JRE) 1.8.x - 64
bit

IBM AIX IBM AIX Runtime, Java Technology JRE 1.8.x - 64 bit

Oracle Database
Server and Client

Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.3.0 +) - 64 bit RAC/ Non-
RAC with partitioning option

Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.4.0 +) - 64 bit RAC/Non-RAC
with partitioning option, Advanced Security Option**

Oracle Database Server Enterprise Edition 12c Release 1 (12.1.0.1.0 +) - 64 bit RAC/ Non-
RAC with partitioning option, Advanced Security Option**

Note: See the "Additional Notes" section in the 806 Tech Matrix for details.

m  Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit

m  Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit

m  Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin driver)

m  Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle thin driver)

m  Oracle R Distribution (ORD) version 3.2.0/3.3.0 (Optional)

m  Oracle R Enterprise (Server) version 1.5 with ORD 3.2.0 and version 1.5.1 with ORD 3.3.0
(Optional).

Note:

Ensure that the following patches are applied:

Oracle Server 12¢, v12.1.0.1 - 17082699

Oracle Server 12¢, v12.1.0.2 - 19392604, 19649591

For Oracle DB Server 12.1.0.1 and 12.1.0.2, download the patches 27010930 and 22205607
from My Oracle Support and apply them.

For Oracle DB Server 11.2.0.4, download the patch 22205607 from My Oracle Support and
apply.

Also for latest information, see http://support.oracle.com, 12.1.0.2 Bundle Patches for Engineered
Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1).

ORAAH Technical Description

No.

Oracle Database
Enterprise Edition

Oracle R Advanced
Analytics for Hadoop

Oracle R Enterprise Open Source R or

Oracle R Distribution

1.5.1 2.7.1 3.3.0 11.2.0.4,
12.1.0.1,
12.1.0.2,
12.2.0.1,

12.1.0.2
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Requirement Sub-Category

OLAP Oracle Hyperion Essbase

Value

m V 11.1.2.1+ (Server and Client) with Oracle 11g
Database

m V 11.1.2.3+ (Server and Client) with Oracle 12c
Database

Note: Oracle Hyperion Essbase is requi

red only if you are using the OLAP feature of OFSAAI.

Web Server/ Web Oracle Linux/Red Hat Enterprise Linux

Application Server /1BM AIX
Oracle Solaris

Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 2.2.x/
IBM HTTP Server

m  Oracle Weblogic Server 12.1.3+ with jersey 2.25
m  Oracle Weblogic Server 12.2.x - (64 bit)

m  IBM WebSphere Application Server 8.5.5.9+ (Full
Profile) with IBM Java Runtime - (64 bit)

m  Apache Tomcat version 8.0.47- (64 bit)

Note: OFS Inline Processing Engine does not support
Tomcat Web Application Server.

Note:

is not supported.

OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle JRockit

For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download and install patch
18729264 from http://support.oracle.com.

Desktop Operating System

MS Windows 7/8/10

Requirements

Browser m  Chrome 57.x
m  FireFox 52.x
Office Tools m  MS Office 2007/ 2010/ 2013/ 2016

m  Adobe Acrobat Reader 10 and 11

Screen Resolution

1024*768 or 1280*1024

Other Software Directory Services OFSAAIl is qualified on both OPEN LDAP 2.2.29+ and
Oracle Internet Directory v 11.1.1.3.0. However, it can be
integrated with other directory services software like MS
Active Directory.

Note: Configuration of Directory services software for OFSAAI installation is optional. For more
information on configuration, see LDAP Configuration section in OFSAAI Administration Guide.
Open LDAP needs to be installed on MS Windows Server machine only.

AAI One-off patches Download the following one-off patches for the given bug

numbers from http://support.oracle.com:

= 27938294
= 28079607
= 28033582
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Requirement Sub-Category Value

PFT Pack One-off patches Download the following one-off patches for the given bug
numbers from http://support.oracle.com:

= 28053291
= 28170580
= 28399997

FTP One-off patches Download the following one-off patches for the given bug
numbers from http://support.oracle.com:

= 28053724
= 28197858

Note: To upgrade an existing OFSAA 8.0.x Java 7 instance to Java 8, see Upgrading an Existing OFSAA 8.0.x
Java 7 Instance to Java 8.
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Recommended Software Combinations

OFS PFT Application Pack recommends the following software combinations for deployment:

Operating System

Oracle Linux 5.3 up to 5.10/
6.0 and above

Database

Oracle Database

Web Application Server

Oracle WebLogic Server/
Apache Tomcat Server

Web Server

Oracle HTTP Server/
Apache HTTP Server

Oracle Solaris 5.10/ 5.11

Oracle Database

Oracle WebLogic Server/
Apache Tomcat Server

Oracle HTTP Server/
Apache HTTP Server

IBM AIX 6.1

Oracle Database

IBM WebSphere Application
Server/ Apache Tomcat
Server

IBM HTTP Server/ Apache
HTTP Server

Verifying the System Environment

To verify if your system environment meets the minimum requirements for the installation, a Pre-Install Check
utility (Environment Check) is available within the Install Kit archive file. This utility can also be obtained
separately by contacting Oracle Support.

Though the system environment verification is an integral and automated part of the installation of this software
product, Oracle strongly recommends running this utility prior to beginning the installation as part of your
organization's "Installation Readiness Verification Process".

Note: For more details on download and usage of this utility, see Oracle Financial Services Analytical
Applications Infrastructure Environment Check Ultility Guide given in the Related Documents section.
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Understanding Installation Modes

The following modes of installation are available for the OFS Profitability Application Pack.

GUI Mode

This mode launches the product installation in a Graphical User Interface (GUI) Mode. You need to enter the
required information on various panels within the Ul in a user interaction format at various stages.

See GUI Mode Installation for details on configuration required for GUI Mode installation.

SILENT Mode

This mode mandates updating the installation configuration files with required details and performs installation
in a "SILENT" non user interactive format.

See Silent Mode Installation for details on configuration required for SILENT Mode installation.
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CHAPTER 3 — PREPARING FOR INSTALLATION

This chapter provides necessary information to review before installing the OFS Profitability Pack v8.0.6.0.0.
This chapter includes the following topics:

* Installer and Installation Prerequisites
+ Obtaining the Software
+  Common Installation Tasks
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Installer and Installation Prerequisites

The following table mentions the list of prerequisites required before beginning the installation for OFS
Profitability Application Pack. The Installer/ Environment Check utility notifies you if any requirements are not

met.
Requirement Sub-Category
Environment Settings Java Settings

Expected Value

PATH in .profile to be set to include the Java Runtime Environment
absolute path. The path should include Java version (Java 7 or
Java 8) based on the configuration.

Note: Ensure the absolute path to JRE/bin is set at the beginning
of PATH variable.

For example, PATH=/usr/javaljre1.6/bin:$ORACLE_HOME/
bin:$PATH

Ensure no SYMBOLIC links to JAVA installation is being set in the
PATH variable.

Oracle Database
Settings

Oracle Database Server

m TNS_ADMIN must be set in .profile file pointing to appropriate
tnsnames.ora file.

m  Enable Transparent Data Encryption (TDE) and/ or Data
Redaction**

Note: For more information, see TDE, Data Redaction and the
Corresponding Settings in OFSAA..

OFSAA Processing Server

m  ORACLE_HOME must be set in .profile file pointing to
appropriate Oracle Client installation.

m  PATH in .profile must be set to include appropriate
$ORACLE_HOME/bin path.

m  Ensure that an entry (with SID/ SERVICE NAME) is added in
the tnsnames.ora file.

Oracle Essbase Settings

ARBORPATH, ESSBASEPATH, HYPERION_HOME to be set in
the .profile pointing to an appropriate Oracle Essbase Client
installation.

Note: These settings are required only if you want to use Oracle
Hyperion Essbase OLAP features.
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Requirement

OS/ File System Settings

Sub-Category

File Descriptor Settings

Expected Value

Greater than 15000

Note: The value specified here is the minimum value to be set for
the Installation process to go forward. For other modules, this value
may depend on the available resources and the number of
processes executed in parallel.

Total Number of Process
Settings

Greater than 4096

Note: The value specified here is the minimum value to be set for
the Installation process to go forward. For other modules, this value
may depend on the available resources and the number of
processes executed in parallel.

Port Settings

Default port numbers to be enabled on the system are 6500, 6501,
6505, 6507, 6509, 6510, 6666, 9999, and 10101.

.profile permissions

User to have 755 permission on the .profile file.

Installation Directory

A directory where the product files will be installed/ copied.
Assign 755 permission on this directory.
This directory needs to be set as FIC_HOME.

Temporary Directory

Default temporary directory where installation files are stored for a

short period of time to support faster installation.

m  Forinstallation on UNIX OS, you UNIX administrator must give
you the required read-write permissions for the /tmp directory
and disable the NOEXEC option.

m  Configure adequate space on the /tmp directory. It is
recommended that you allocate more than 10 GB of space.

Note: If NOEXEC is enabled, the extraction of files by the installer
in to /tmp directory is prevented and the binaries will not execute in
the directory, which will fail the installation.

Staging Area/ Metadata
Repository

A directory to hold the application Metadata artifacts and
additionally act as staging area for flat files.

The directory should exist on the same system as the OFSAA
Installation. This directory can be configured on different mount or
under a different user profile.

Assign 775 permission on this directory.

Note: This directory is also referred to as FTPSHARE folder.

Download Directory

A directory where the product installer files will be downloaded/
copied.
Set 755 permission on this directory.

OS Locale

cation Pack mstanagon ana Go

m  Linux: en_US.utf8

m  AIX: EN_US.UTF-8

m  Solaris: en_US.UTF-8

To check the locale installed, execute the following command:

locale -a | grep -i 'en US.utf'

-0.U.6.UU Z0
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Requirement Sub-Category Expected Value
Database Settings Database Instance NLS_CHARACTERSET to be AL32UTF8
Settings NLS_LENGTH_SEMANTICS to be BYTE

OPEN CURSORS limit to be greater than 1000

Web Application Server |WebSphere/ WebLogic/ |Web Application Server should be installed and profile /Jdomain
Tomcat created.

You will be prompted to enter the WebSphere Profile path or
WebLogic Domain path or Tomcat Deployment path during
OFSAAl installation.

Note: See Configuring Web Server for WebSphere Profile
Creation and WeblLogic Domain Creation.

Web Server Apache HTTP Server/ This is an optional requirement.
Oracle HTTP Server/ HTTP Server Installation to be present.
IBM HTTP Server You will be required to enter the Web Server IP/ Hostname and Port

details during installation.
Note: See Configuring Web Server for Web Server

configuration.
Others Oracle R/ Oracle R This is an optional requirement.
Enterprise For more details, see Configuration for Oracle R Distribution

and Oracle R Enterprise (ORE).

Following step is applicable only if existing OFSAA setup version is 8.0.5.x.x and Configuration and Atomic
Schema(s) were restored from exported dumps of other environment:

Login to Configuration Schema and execute the following SQL statements:

alter table AAI AOM APP COMP ATTR MAPPING drop constraint AOM APP COMP_ATTR PK drop index

/

alter table AAI AOM APP COMP ATTR MAPPING add constraint AOM APP_COMP ATTR PK primary key
(APP_COMP_ATTR MAP ID)

/

Note: Ensure that the tablespace(s) used for the database user(s) is set to AUTOEXTEND ON.

Obtaining the Software
This release of OFS Profitability Application Pack v8.0.6.0.0 is available for download in My Oracle Support

(https://support.oracle.com) as Patch 27893249. You need to have a valid Oracle account in order to download
the software.
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Common Installation Tasks

The following are the common pre-installation activities that you need to carry out before installing the OFS
Profitability Application Pack.

This section includes the following topics:

»  Configuration for GUI Mode Installation

+ ldentifying the Installation, Download and Metadata Repository Directories
* Downloading and Copying the OFS Profitability Applications Pack Installer
»  Copying and Extracting the Software

+  Setting up the Web Server/ Web Application Server

+ Installation of Oracle R Distribution

Configuration for GUI Mode Installation

To install OFS Profitability Application Pack in GUI mode, you need to ensure the below software and
configurations are available:

» Install and configure any PC X Server software such as Open Text Exceed (formerly Hummingbird Exceed)
on the user desktop system from which the installation is triggered.

»  Configure DISPLAY variable.

* Ensure to set the DISPLAY variable on the system on which the OFSAA will be installed, to point to the user
desktop system where the PC X Server software has been installed.

Syntax:
export DISPLAY=hostname:n.nl

where hostname is the IP Address/ Host Name of the user desktop system and n is the sequence number
(usually 0).

For example, 10.11.12.13:0.0 Or myhostname:0.0

Identifying the Installation, Download and Metadata Repository
Directories

For installing any OFSAA Application Pack, the below folders/ directories required to be created.

* OFSAA Download Directory (Optional): Create a download directory and copy the OFSAA Application
Pack Installer File (Archive). This is the directory where the downloaded installer/ patches can be copied.

* OFSAAInstallation Directory (Mandatory): Create an installation directory. This is the directory where the
installer installs or copies the product files. FIC_HOME variable to be set in the .profile file to point to the
OFSAA Installation Directory.

+ OFSAA Staging/ Metadata Repository Directory (Mandatory): Create a Staging/ Metadata Repository
Directory. This is the directory where you should copy data loading files, save data extracts and so on.
Additionally, this folder also maintains the OFSAA Metadata artifacts. This is commonly referred as
"FTPSHARE". This directory must be created on the same host as the OFSAA Installation Directory
mentioned in the previous point in this list.
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Note: Ensure that the user permission is set to 755 on the Installation and Download Directory and the user

permission is set to 777 on the Staging Directory.

Downloading and Copying the OFS Profitability Applications Pack
Installer

To download and copy the OFS Profitability Applications Pack Installer, follow these steps:

This release of OFS Profitability Application Pack v8.0.6.0.0 is available for download in MOS as Patch
27893249. You need to have a valid Oracle account in order to download the software.

Copy the downloaded installer archive to the Download Directory (in Binary Mode) on the setup identified
for OFSAA installation.

Download the mandatory installer one-off patch 28398331 from http://support.oracle.com.

Copying and Extracting the Software

Once you obtain the installer, copy the installer (in BINARY mode) to the system on which the OFSAA
Infrastructure components will be installed.

Note: You must be logged in to the UNIX operating system as a non-root user.

Download the unzip utility (OS specific) unzip_<os>.Z and copy it in Binary mode to the directory that is
included in your PATH variable. If you already have the unzip utility to extract the contents of the downloaded
archive, skip to the next step.

Uncompress the unzip installer file using the command:

uncompress unzip <os>.7Z

Note: If you notice an error message "uncompress: not found [No such file or directory]", contact your
UNIX administrator.

Give EXECUTE permission to the file using the command:

chmod 751 unzip <os>

For example, chmod 751 unzip sparc

Extract the contents of the OFS PFT Application Pack 8.0.6.0.0 installer archive to Download Directory
using the following command:

unzip OFS PFT 8.0.6.0.0 <0S>.zip

Extract and apply the patch 28398331. Refer to the readme. txt file packaged with the patch for details on
how to apply the patch.
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Note: Do not rename the Application Pack installer folder name on extraction from the archive.

5. Give below permission to the installer folder. Navigate to the Download Directory and execute the
command:

chmod -R 750 OFS_PFT PACK
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Setting up the Web Server/ Web Application Server

For more information to set up the environment based on your selected Web Server/ Web Application Server,
see Configuring Web Server and Configuring Web Application Server.

Installation of Oracle R Distribution

This is an optional step and required only if you intend to use Oracle R scripting in the Oracle Financial Services
Enterprise Modeling Application or if the OFSAA Application that you have licensed uses this feature. For
information on applications that use this feature, see the Tech Matrix.

The following is the instruction to install ORD and ORE:

Install Oracle R Distribution and Oracle R Enterprise (Server Components) on the Oracle Database server. See
Oracle® R Enterprise Installation and Administration Guide for Windows, Linux, Solaris and AlX - Release 1.5
at Oracle R Enterprise Documentation Library and Release 1.5.1 at Oracle R Enterprise Documentation Library.

No. Oracle R Enterprise Oracle R Advanced Open source R or Oracle Oracle Database
Analytics for Hadoop R Distribution Enterprise Edition
1 1.5.1 2.7.1 3.3.0 11.2.0.4,
12.1.0.1,
12.1.0.2,
12.2.0.1
2 1.5.0 2.5.1, 3.2.0 11.2.0.4,
2.6.0, 12.1.0.1,
2.7.0 12.1.0.2

Note: If you use ORE 1.5 or ORE 1.5.1, for Oracle Financial Services Enterprise Modeling, you must set the
session time zone in 'R_HOME/etc/Rprofile.site'file on the database server, where R_HOME is the
home directory of the R instance on which ORE server packages are installed. Alternatively, you can set
session time zone in scripts registered within OFS EM by using the 'Sys.env(TZ=<time zone>)' R
function.
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CHAPTER 4 — INSTALLING OFS PROFITABILITY APPLICATION
PACK

This chapter describes the steps to be followed to install the OFS Profitability pack.
This chapter includes the following topics:

* About Schema Creator Utility
o Configuring Schema Creator Utility for RDBMS Installation
o Execution Modes in Schema Creator Utility
o Selecting Execution Options in Schema Creator Utility
»  Configuring and Executing the Schema Creator Utility
o Prerequisites
o Configuring the Schema Creator Utility
o Executing the Schema Creator Utility
» Installing the OFS Profitability Applications Pack
o GUI Mode Installation
o Silent Mode Installation
o \Verifying the Log File

About Schema Creator Utility

Creating database users/ schemas (RDBMS/ HIVE) is one of the primary steps in the complete OFSAA
installation process. The Schema Creator utility facilitates you to quickly get started with the OFSAA 8.0
installation by allowing easier and faster creation of database User(s)/ Schema(s) (RDBMS/ HIVE), assigning
the necessary GRANT(s), creating the required entities in the schemas, and so on.

The schema creator utility should be configured and executed mandatorily every time prior to installation of any
OFSAA Application Pack.

This section includes the following topics:

»  Configuring Schema Creator Utility for RDBMS Installation
* Execution Modes in Schema Creator Utility

»  Selecting Execution Options in Schema Creator Utility

Configuring Schema Creator Utility for RDBMS Installation

OFS PFT Application Pack specific schema details need to be filled in the ors prT scHEMA 1N.xml file before
executing the Schema Creator Utility. For more information on the xml file, see Configuring
OFS_PFT_SCHEMA_IN.xml.

The following are the types of schemas that can be configured in the OFSAA:
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» CONFIG - This schema holds the entities and other objects required for OFSAA setup configuration
information.

Note: There can be only one CONFIG schema per OFSAA instance.

« ATOMIC - This schema holds the data model entities. One ATOMIC schema is attached to one Information
Domain.

Note: For some application packs, there can be multiple ATOMIC schemas per OFSAA Instance, but the
Profitability Pack supports only one atomic schema per OFSAA instance.

« SANDBOX - Denotes the schema that contains the data for all Sandbox executions. One SANDBOX
schema is attached to one Sandbox Information Domain.

Note: This Schema type is not applicable for OFS Profitability Application Pack. There can be multiple
SANDBOX schemas per OFSAA Instance and a Sandbox Information Domain can have only one
SANDBOX schema.

+ ADDON - Denotes any additional schema used by the OFSAA Applications.

Note: This Schema type is not applicable for OFS Profitability Application Pack.

Execution Modes in Schema Creator Utility

The Schema Configuration Utility supports the following modes of execution:

* Online Mode: In the Online mode, the utility connects to the database and executes the DDLs for Users,
Objects and Grants. If you have the SYSDBA privileges you can execute the Schema Creator Utility in
Online mode and thereby create the Users, Objects and Grants during the execution process.

To execute the utility in Online mode, you need to connect as "<User> AS SYSDBA".

+ Offline Mode: In the Offline mode, the utility generates SQL script with all the required DDLs for Users,
Objects and Grants. This script needs to be executed by the DBA on the appropriate database identified for
OFSAA usage. If you do not have the SYSDBA privileges, you can execute the Schema Creator Utility in

Offline mode and generate the script file that contains the Schemas, Objects and Grants, information.
Subsequently, a SYSDBA user can execute the script file manually.

To execute the utility in Offline mode:

1. Connect as any user with below grants (alternatively, you can also connect as a user with SYSDBA
privileges):
SELECT ON DBA ROLES
SELECT ON DBA USERS
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SELECT ON DBA DIRECTORIES
SELECT ON DBA TABLESPACES
CREATE SESSION
For more details, see Executing the Schema Creator Utility in Offline Mode.
If there are any errors during the script execution, reconfigure the ors prT scueMa 1n.xML file and execute

the utility. This generates the scripts with corrected information. For more information, see Configuring
OFS_PFT_SCHEMA_IN.xml.

Note: Do not modify the ors prT scueMA ouT.xML file generated after the execution of this utility.

Selecting Execution Options in Schema Creator Utility

Depending on the option you choose to run the OFSAA Application Pack Installer, you need to choose the
schema creator utility execution option. To run the OFSAA Application Pack installer in SILENT mode, it is
mandatory to execute the schema creator utility with -s option.

Note: If the schema creator utility is executed without the option -s, it is mandatory to run the OFSAA

Application Pack Installer in GUI mode.

Configuring and Executing the Schema Creator Utility

This section includes the following topics:

Prerequisites
Configuring the Schema Creator Utility
Executing the Schema Creator Utility

Prerequisites

The following prerequisites must be ensured before configuring the Schema Creator Utility:
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You must have the Oracle User ID/Password with SYSDBA privileges.
You must have the JDBC Connection URL for RAC/Non RAC database.
The HOSTNAME/IP of the server on which OFSAA is getting installed.

For enabling Transparent Data Encryption (TDE) in your OFSAA instance during installation, perform the
steps explained in TDE, Data Redaction and the Corresponding Settings in OFSAA.

It is recommended to set the pGa AGGREGATE LIMIT database-parameter value sufficiently, when Oracle
12c is installed

You must add a TNS entry before the installation.
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Note: The TNS Entry for an atomic schema should be without any special character, i.e '_". If the atomic

schema name is like 'DEV_ATOM', the TNS name should be like 'DEVATOM'.

Configuring the Schema Creator Utility

To configure the Schema Creator Utility, follow these steps:

1.

o v b

Log in to the system as non-root user.

Navigate to the following path: 0Fs PFT PACK/schema creator/conf.

Edit the ors prT scuHEMA IN.xml file in a text editor.

Configure the elements as described in the Configuring OFS_PFT_SCHEMA_IN.xml.

Save the ors prT scHEMA IN.xml file.

Note: On successful execution of the utility, the entered password in the ors prT scHEMA IN.xml file is

nullified.

Executing the Schema Creator Utility

This section includes the following topics:

Executing the Schema Creator Utility in Online Mode

Executing the Schema Creator Utility in Offline Mode

Executing the Schema Creator Utility with -s option

Executing the Schema Creator Utility for Subsequent Application Pack
Verifying the Log File
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Executing the Schema Creator Utility in Online Mode

In Online Mode, the Schema Creator Utility will create all the Schemas, Schema Objects, Tablespaces, Grants,
and Roles in the database during the execution process.

1.
2,
3.

To execute the Schema Creator Utility in Online Mode, follow these steps:
Log in to the system as non-root user.

Navigate to the following folder path: 0Fs PFT PACK/schema creator/bin/.
Execute the following command:

./osc.sh

The following message is displayed: You have chosen ONLINE mode. Triggering the utility in ONLINE mode
will execute the DDLs directly on the Database. Do you wish to proceed? (Y/y or N/n).

B ol iR sradin dore - P TTW

Enter Y/y to proceed.
Enter the DB Username with SYSDBA Privileges.
For example: SYS as SYSDBA.

Enter the User Password.

8.

The console runs the initial validation checks and then displays the following message:

You have chosen to install this Application Pack on <Name of the Atomic Schema > ATOMIC schema. Do
you want to proceed? (Y/N).
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You have chosen to install this Application Pack on <Name of the Infodom>. Do you want to proceed? (Y/N).

1 found
on found
le

9. Enter Y/y to start the schema creation.

Or

Enter N/n if you want to quit executing the schema creation.

Note: On successful execution of schema creator utility, the console displays the following status

message:

Schema Creator executed successfully. Please proceed with the installation.

See log file in 0Fs _PFT PACK/schema creator/logs folder for execution status. If there are any errors,

contact Oracle Support.

Executing the Schema Creator Utility in Offline Mode

In Offline Mode, the Schema Creator Utility will create an output in SQL file format. This script has to be executed
manually by logging as database user with SYSDBA privileges. The SQL file will contain the scripts for creation
of Schemas, Schema Objects, Tablespaces, Grants, and Roles.

Prerequisites:

« Database user with below privileges:

Q

Q
o
Qo

SELECT
SELECT
SELECT
SELECT

ON
ON
ON
ON

DBA_ROLES
DBA_USERS
DBA_DIRECTORIES
DBA_TABLESPACES
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O CREATE SESSION

Note: Explicit Grants to the user are required. Grants assigned through Roles are not supported.

To execute the schema creator utility in the offline mode, follow these steps:

Log in to the system as non-root user.
Navigate to the following path: OFS_PFT_PACK/schema_creator/bin
Execute the osc.sh file using the following command:
./osc.sh -o
4. The following message is displayed:

You have chosen OFFLINE mode. Triggering the utility in OFFLINE mode will generate the script. Do you
wish to proceed? (Y/y or N/n).

Enter Y/y to proceed.
Enter the DB Username with SELECT privileges.
Enter the User Password.

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0 38



Installing OFS Profitability Application Pack

8. The console runs the initial validation checks and displays the following message:

You have chosen to install this Application Pack on <Name of the Atomic Schema > ATOMIC schema. Do
you want to proceed? (Y/N).

You have chosen to install this Application Pack on <Name of the Infodom>. Do you want to proceed? (Y/N).

9. Enter Y/y to start the script generation.
Or

Enter N/n if you want to quit the script generation.

on Temp Tabli
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10.
1.
12,

Note: On successful execution of schema creator utility, the console displays the following status
message:

Schema Creator executed successfully. Please execute scratch/ofsaaapp/OFS_PFT_PACK/
schema_creator/sysdba_output_scripts.sql before proceeding with the installation.

Navigate to the directory: OFS_PFT_PACK/schema_creator.

Login to SQLPLUS with a user having SYSDBA Privileges.

Execute the sysdba_output_scripts.sql file using the following command:
SQL>@sysdba_ output scripts.sql

Alternatively, you can copy the sysdba_output_scripts.sql file and SQLScripts folder to a remote server and
execute sysdba_output_scripts.sql file, after providing appropriate execute permissions.

Note: Seethelog sysdba output scripts.log file for execution status. If there are any errors, contact
Oracle Support. This log would be empty if there are no errors in the execution.

Executing the Schema Creator Utility with -s option

If you want to run the OFSAA Application Pack Installer in SILENT mode, it is mandatory to execute the schema
creator utility with -s option.

To execute the utility with -s option, follow these steps:

1.
2,

Edit the file 0rs_prT PACK/schema creator/conf/OFS_PFT_SCHEMA TN.xml in text editor.
Execute the utility with -s option.

For Example: . /osc.sh -s

Note: If the utility is executed without the -s option, it is mandatory to launch the OFSAA Application Pack
Installer in GUI mode.

To execute the utility in OFFLINE mode with SILENT option, enter following command:

/osc.sh -o -s
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Executing the Schema Creator Utility for Subsequent Application Pack

While executing the schema creator utility for subsequent Application Pack, you can choose to install the pack
either on the same Information Domain/Atomic Schema or on a new Information Domain/Atomic Schema. You
can execute the Schema Creator Utility either in Online or Offline Mode.

Note: OFS PFT Application Pack can be installed on any Information Domain/ Atomic schema where any OFS
Application Packs are installed other than OFS Behavior Detection Application Pack or OFS Compliance
Regulatory Reporting Application Pack.

To execute the schema creator utility while installing OFS PFT Application Pack over an existing Application
Pack, follow these steps:

1. Repeat the steps 1 to 9 from the Executing the Schema Creator Utility section.

Note: Ensure to use the same config schema user name as the previous Application Pack.

2. The utility identifies the Application Packs that are already installed on the current OFSAA setup and
displays the following on console:

o Atomic schema of the Existing Application Pack
o Information Domain Name of the Existing Pack, and the

o List of Installed Application Packs Execute the ./osc.sh file.

3. Select the Atomic User, on which you want to install the Application Pack.

On successful execution or schema creator utility, the following message is displayed: Schemas Creation
Completed.

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0 41



Installing OFS Profitability Application Pack

See the log file in 0Fs PFT PACK/schema_creator/logs folder for execution status.

See the log sysdba output scripts.log file for execution status, if executed in offline mode. This log
would be empty if there are no errors in the execution.

If there are any errors, contact Oracle Support.
Verifying the Log File

If schema creation is successful, the console would display an appropriate message.

@ ofss222582.in.oracle.com - PuTTY EI@
N le MAI N

of

m

If the schema creation runs into errors, see the log files:

<<OFSPFT Installer folder>>/<<OFS_PFT PACK>>/schema creator/logs/and
<<OFS PFT>> 0SC <timestamp>.log for further details.

You may contact Oracle support anytime for assistance.
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Installing the OFS Profitability Applications Pack

Follow the instructions in this section to install the OFS Profitability Applications Pack depending on the mode
of installation.

This section includes the following topics:
*  GUI Mode Installation
« Silent Mode Installation

»  Verifying the Log File

GUI Mode Installation

GUI mode of installation is supported only on RDBMS database server. For HDFS support of installation, see
section Silent Mode Installation.

Ensure that you have followed the steps as mentioned in the Configuration for GUI Mode Installation section
prior to proceeding with the next steps.

1. Log in to the system as non-root user.

2. Identify a directory for installation and set the same in the user .profile file as below:
ORACLE HOME=<oracle installed dir>
Export FIC HOME

3. Execute the user .profile.
Navigate to path: orFs pPFT Pack.

Edit the oFs PFT PACK/schema creator/conf/OFS PFT SCHEMA IN.xml file to set the appropriate
attribute values.

Note: See Configuring OFS_PFT_SCHEMA_IN.xml file for details on configuring this XML file.

6. Execute the schema creator utility.

Note: This step is mandatory and should be executed before every OFSAA Application Pack installation.
See Executing the Schema Creator Utility for more details.

Navigate to the path: ors PFT PACK/bin.
To install OFS PFT Application Pack on:
o For Java 6 and 7: Proceed with step 9.

o For Java 8: Edit the Verlnfo.txt file to modify the value for property JAVA_VERSION to 1.8. Save the
changes and proceed with step 9.

9. Execute ./setup.sh GUI in the console.
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Refer to the console for any errors during Pre-install checks.

10. The general License Agreement is displayed.

Weslcome 1o the OFSAR Applcation Pack installation
5 program will guide you Srough he installation of OF SAA Applicaton Pack

resenad

0 and 2 prol
ehibit, perfor

ded undir a i
#, COPY. reproduce, Fansia
5 S0MWaE, UNIESs raauEed by law fo

enginsering, dissssambly, or decomnpilation

The information contsined herein is subject 13 change withoul notice and is nol warranted 53 be error-free. I you find amy erroes, pléase repce Sem b ws inwaiting

RIMIMENt of anyona licensing il on baha of the LS. Govemmeant, tha following

¥ihis sofbware or ralabed documentation is delivensd to the LS

o, indegrated softwa ,
n Regulation and agency-specfc supplemental regulaions. As such, use,
stallad on the hardwars, andior documsentation, shall be subjectin license tem:

programs, including ary operat
aril o the applicable Federal Acq
o, Intagrated sodware, any oo
ovarnment

diviloped for geners |
nal injury. i you use thi o all apgropriate fail

: in dangerous applicatio

ORACLE
FIVANCIL SERVCES

1 oo tha Taeme o

) 180 RO amcapt Hha tarm

InstallAnywhere

display sy part, in

£ 19 apgacable

et parbes. Oratle Comearation and S5 sMliates are notn
any loss, costs, of damage:

11. Select | accept the terms if the License Agreement option.
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12. Click Next to display the The Application Pack details.

[ packinstal =0
Financial Services
k) Proinstall Selup Apgiication Pack 10 OF5_PFT_PACK ORACLE"
o Appiication Pack Hame ; Financisl Sorvicos Profitability Appiications Pack T FRANCIAL SERWICES
ANALYTICAL APPLICATIONS

Appibcation Pack Version:  S05.00

Prastiuctune

¥ Financial Services Funds Transfer Pricing
] Financial Senvices Institutinal Performance Anabics

¥ Financial Senvices Retail Performance Analtics

=) - Anahic:

-

ORACLE
Tl R ——

T Pt A gty a1 A 2500 ANAEIN I dons nod nead 40 ba elesied waplicitly, This product is e baes inastresiuee and gt italied autsmatically

Mot

3. Praduct Babesprics Modaliag Cotis Finptamag s prsdurtn) har degendest lizsran

[ gevous | [ mem |

13. Select the product to enable for which you have already obtained license.
14. Click Next to display the License Agreement page.

s i o Pack s
[ OF S04 APPLICATION PACK LICENSE AGREEMENT

Oracle Analyical OF SA%) application packs are groups of OF3AA products phckaged Rogether it @ single installer. Each appdication
specile funcional domains.

Every appacation pack atso inciudes the - pplic. P! which afe Y #pplicator
1. Oricle Financial Seracas Analdcal Appic ations Infrasinschine

2. Orale Financial Serdcas Enterprise Modeing

3. Oratle Finantial Services In-ire Processing Enging

4. Oracie Financial Servces Big Data Processing

Financial Services Profitability Applica

OFSAA 18 ddvess

Oracle Financial Seraces Anahtical Appkcations: Infrastnacture {OF 5 AR is e for all OF AR and is therefore automatically installed and enabied by e application pack instaler

The wetaller abweays installs derprice Modeling, Irrling g Enging and Orscle
but erisbles tham onhy if Sny applicabion That requines their fanctionaity is enabled

Processing Engine and Oracle Finandial Services Big Data Processing aee indmdually Iikensable appliabon opons

ORACLE
FIVNCIL SERVCES

) 1 gooagt the 1arms o1 e Lomnee Agreaman
() 14 WO mccapt Sha tarma af Tha Lanas Agreamant

Any OF SAA application That ks enabled must be licensed for use Oracle Financial Senvices Analyiical Applicabons Infrastructure, Dracle Financial Senices Enterprise Modeling, Oracle Financial Senvices in-line

Application products once enabled cannot be disabled. Application products nol enabled on installation, may ke be enabled Using T “Manage OFSAA Product License(s)” featune of the platiorm.

Big applicstien options

[ previous | [ pest

15. Select | accept the terms if the License Agreement option.
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16. Click Next.

=0 = |
X i b
G Frainatall Setup
" ﬂpgmlw Pack 1D
FS_PFT_PACK
ﬂ?dmbﬂ Paok Home
nanadl Senicas Proftadity Apphcatons Pack
Application Pack Version
.0.6.0.0
Below proclucts are selected 1o be enabled:
Financial Servicas Analylical Applications: Inkastruciure
Financial Senvicas Proflabikty Managamant
Financial Senvicas Funds Transler Pricing
Financisl Senvcas Instiutional Pedornance Analytics
Financial Sanicas: Aatal Padormance Analytics
Finangal Senvices Enterprise Financal Peromance Analysics
ORACLE
FINANCIAL SERVICES
[powoss ][t ]
17. Click Next to display the Manage Information Domain page.
A ® Information Demain Name ] Application Name ] Infermation Demain Description I Type DB Schema
3 Freinstall Setup Em_pn
%) st OFSPFTINFO anagement PRODUCTION Sparca0Bsm
Trarsder OFS_PFT
Fricing PRODUCTION spaniiEatm
‘OF8_PFT
Feriamance Anabfics PRODUCTION sparcaisatm
OFS_PFT
paalyis PRODUCTION SPArCAGaT
ansia OFS_PFT
Parformance Anshfice PRODUCTION SRarcA0Esm
ORACLE
FINANCIAL SERVICES
[gomwe |[ mea |

18. Edit the Information Domain Name if it is a new Information domain and you wish to change the name of
the information domain name.
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The Information Domain Name is not editable in case of subsequent Application Pack installation on the
same Information Domain.

Permissible length is 10 characters and only alphanumeric characters allowed. No special characters
allowed.

19. Click Next to display the following window.

il Freinstall Selup
k5 st

ORACLE

e o take a moment
FINANCIAL SERVICES

Coppight © 1983, 2007, Oracke andie ks smlistes. Al rights reservesl

ORACLE
FIVANCIAL SERVCES
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20. Click Next to display the User Installation Directory window.

o

e Ussis Installation Disectory
i Frainatall Seup

TseratthipREstPFT_HOME

ORACLE
FIVANCIAL ERWCES

Cancel Help et

21. Enter the installation directory path. This is the directory you have set in the user .profile file in step 2.
22. Click Next to display the OFSAA Infrastructure Server Details window.

o

Enter requested infarmation

¥ Freinstall Setup

) ke 1 e JOBC_URL I5 of RAC type then DB Seever IPTHostname feid name shouwld be MA,

OFSAAl Server 1P | Host rme
10.184.154 208

Distabeasee Server 5 { Hostname :
10.184.1 47136

ORACLE
FIVNCIL SERVCES

Cancel Help Prévious. Bt

23. Enter the IP address or hostname of the OFSAAI server and Database server.
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24. Click Next to display the Web Application Server window.

e Chioose the Wb Appliction Serr hpe
Freinstall Setup

Tomcat
WebSphere
& Weblogic

ORACLE
FIVNCIAL ERVCES

Cances Heip Erenvious Rt

25. Select the appropriate Web Application server type. The options are Tomcat, WebSphere, and WebLogic.
26. Click Next. Based on the selection, corresponding screens are displayed.
For Tomcat: The Absolute Tomcat Path window is displayed.
m  Enter the Tomcat installation path (till /webapps) where OFSAAI will be deployed.
For WebSphere: The WebSphere Setup Details window is displayed.

m  Enter the installation path (up to the host name directory) of the WebSphere. The format is
WebSphere path <WebSphere profile directory>/installedApps/ <NodeCellName>.
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For WebLogic: The Weblogic Home window is displayed.

[Entur wiabiogic ome
Foe Ex Momaiweblogicieatwedlogic 10.3.50

Prelnstall Setup

TscratchiorackeMiddipwareiCracls_Home

ORACLE
FIVANCILSERVCES

Cancel Help Privious Pt

m  Enter the WebLogic home directory path.
= Enter the path of the Weblogic domain home directory.
27. Click Next to display the OLAP Details window.

.No'.\e
1= Enabied =Désabled

g Freinstall Setup
. Hwalug i5 1 Ben ARBORPATH, HYPERIGN_HOME & ESSBASEPATH variakies should be setin profile bafoes installation

CONFIGURE DFSAA OLAP FEATURE :
o

ORACLE
FIVNCIAL SERWCES

Cancel Help Prévious Best
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Enter 1 if you want to configure OFSAAI OLAP feature. By default, value 0 is displayed.
28. Click Next to display the Web Server Details window.

[Hecte - content name will be usid in your Apgilcation LRL
hitp et SenweP e <Senat port=I<contestnam e=Aoge o
Example- hitp:110.80.50 306 90&mysppiogin jsp

¥ Frelnstall Selup

L] ENABLE HTTPE

WEB SERVER PORT
F200

WED SERVER I
il 0djx

Conte name fof deployment
ofss

WEB LOCAL PATH
IscratchipfiastMpshare

ORACLE
FIVANCIL SERVES

Gancel Help

Previous st

Select the Enable HTTPS check box to configure HTTPS.

o Enter Web Server (HTTP Server) Port, Web App Server (HTTP Server) IP address, context name for

deployment and the local path to any folder on the Web Application Server (Tomcat/ Websphere/
Weblogic).
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29. Click Next to display the Database Details window.

[rore
Specity the Dalabase user name whath is the uses cfeatad e conhuraton dalabase schema. For exampls configuser

Spacityhe Dalabase driver path a5 <ORACLE_HOME/dbciib whore <ORACLE_HOME> should be raplaced with ORACLE _HOME valup
The ARSOLUTE DRIVER PATH retess 1o the JDBC driver fies path

Freinstall Setup

ORACLE SID [ SERVICE_NAME :

EPM1ZCRY

JOEC LRL:

|dbe oraciathin @10 184 1457 1381521 EPM1 JCR2
CONFIG SCHEMA LISER 1D ©

SparcB0Stont

Orachs Configuration Schima Password

ABSOLUTE DRIVER PATH :
fscratehioraciedoracieiproducy’ 2.1 Qiclient_ 1 Aaociib
Brastors Detaul Chgose
FINANCIAL SERVICES
Gaocet | [ pen Prevous ™

30. Enter Oracle SID/Service Name, JDBC URL, Configuration Schema User ID and Password, and Absolute
Driver Path.

Note: Absolute Driver Path can be the path where Oracle DB client is installed or JDBC driver is installed.
For example, /scratch/oracle/app/oracle/product/11.2.0/client 1/jdbc/1ib
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31. Click Next to display the Ports Configuration window.

Enter requined information
bt Ports miset hirve unigue value

il Freinstall Setup
-

Javva Pont
AT

Mastive Port
[Lis]

Agent Post
4673
I Sorver Port
46T4

ICC Native Port
475

ORACLE
FIVNCIL SERVCES

Canced Help Erevious. et

Enter Java Port, Native Port, Agent Port, ICC Server Port, and ICC Native Port. You can proceed with the

default port values configured.

32. Click Next to display the Ports Configuration window.

Exitér rquésted infarnation
oot Porte muset e unigue value

i Freinstall Selup
.

OLAP Pait
200

Message Server Port
£390

Router Port
s

AM Port
5282

ORACLE
FIVANCIAL SERWCES

Cancel Heip Previous. Bend
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Enter OLAP Port, Message Server Port, Router Port, and AM Port.

33. Click Next and then select the File Transfer protocol.

Note: Ensure the system on which the OFSAA Infrastructure is being installed, has either FTP/ SFTP
enabled.

Enter the port to be used for file transfer.

N CHOOSE FALE TRANSFER PROTOCOL :
& EFTP FTP

¥ Freinstall Setup

FILE TRANSFER PORT :
1

ORACLE
FIVNCIAL ERWCES

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0

54



Installing OFS Profitability Application Pack

34. Click Next to display the OFSAAI FTP/SFTP Details window.

FIPSHARE PATH
Iscratchipfestfoshare

b Freinstall Setup
Eostoen Detautt Chgose

FIP /SFTP USER ID
st

Please enter infrastructure FTRSFIP password:

ORACLE
FIVNCIAL ERVCES

35. Enter the path of the ftpshare directory and the User Id and password for OFSAAI Server.

Note: The transfer of data (files) between the OFSAAI Server and the Web Application Server happens

over FTP/ SFTP. Ensure the necessary host configurations are made for a successful handshake.
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36. Click Next to display the Pre-Installation Summary window.

bed
Ul

Preinstall Setup
" Product Name:
OFSAAInkasnscure

Werson
6.0.6.00

Installation Folder
FfacratehiphasUPFT_HOME

Required Space
890 MagaBytas

Awnilable Space
16705 MagaBytas

Selected Locale
an_USUTF-B

Warnings
Nena

ORACLE
FIVNCIL SERVCES

Cantel Brévious Install

37. Click Next to display the Pre Installation Summary window.
38. Click Install to display the Installing OFSAA Infrastructure window.

) Freinstall Setup
EH nistallabon

e

Installation is in progress...
This process may take several minutes. Ploase Wail.

ORACLE
FIVNCIL SERVCES

I— | oo oo

Cantel
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Anytime during the installation you can click Cancel to stop the installation. Once completed, the Installation

Summary screen is displayed.

INSTALLATION SUMMARY
Preinstall Setup i
Ingstallaton 0
leptall Conpleia $DEBUG STATEMENTS: 543
#INF ORMATIONS-—: 65
FAARNING G e 0

#FATAL ERRORE— 0

[
Please se0 the installation log under fscratchiplestMuOFS_FFT_PACKIOFS_AMN0gEIOF BAMBI2018_05_07_11_23_53 g and s T. E _Instaillog for
Click on Mt to consinue,

ORACLE
FIVNCIL SERVCES

The Summary screen displays the number of Fatal Errors, Errors, Debug Statements, Information, and

Warnings along with the location of log files.

39. Click Next to display the Installation Complete window.

e Congratulations! Oracle Financial Sarvices Anahtical Applications Infrastnucture has Been suscesshaly installed
b Freinstall Setup

) irictallaton
B Iitall Complite

Click on=Dome” 1o exit #e inslaller. Please @0 nol chose e console. Postinstall scihvites will be perfomed in consade.

ORACLE
FIVNCIAL SERVCES

Bremous Doree
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Note: If the installation is successful with some warnings, you can navigate to the installation log for more

details and address them.

40. Click Done. The following message is displayed:
Please wait, pack_install is being configured for your system. This may take a moment.

41. After the pack installation is complete, the Solution Setup - Introduction window will be displayed.

This wser intertece wil guide you Bough the sohution setup Before procesding with the installation, you must engurs the following:

« That Oracle Financial Sences Analyiical Applcations Infrastucture (OF SAN) must be installed and confgured on The maching.
- The FiC:aerver s running and all oiher OF SAA sarvers Sre shul drwn por o star of the solution installation

- Please ensurs thi OFSAM vwersion is B0 A0

Note: AL any poind Ifyou wish & , YOU ITiay 3855 B0 Previous scraens by clcking on the Pravicus bution

ORACLE
FIVANCIAL ERHCES

InstallArwhere

Gancel Help

Hest
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42. Click Next to display the Log mode window. Select the Log Mode.

Pre-Setup Information
welect the L

Pre-iretall Configueation

L
Hyou select Dibug mode, S passwords will be printed in F bog Sie. The 1og fle will b

specified in e logdj

* Detug
General

ORACLE
FIVNCIL SERVES

InstaltArywhere

| Cantel Help

Prenious et

43. Click Next to display the Segment creation window. Enter the log paths.

Pre-Setup Information

domain

Profitability Applications Segment
OFSPFT

Appication Server fipshane log path.
TscratchupfinstfosharedOFSPFTINF Ologs

Dtatase Senves pshare log path
TserabchipfesiMpsharelQF SPFTINF flogis

ORACLE
FIVANCIAL SERVES

Cancel Help

Privious Mt
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44. Click Next to display the Pre-Infodom Creation Summary window.

S

Pre-infodom Creation Summary

st 1 ,,
Infer mation Domain Name
OFSPFTINFO
Infodom Desoription
Inlarration Dommain for OFS_PFT
Application Schema User
sparcB0Gam
Application Schema JOBC Usl
pibeodathin:@ 10.164.157.138: 1521:EPM12CA2

Infeclom Sohema Database Namre:
sparcBOGatm

Infecom Maintenance Application Server Log Path
facrateh/phesifpsharaCFSPFTINFO0gs

Infocdom Maintenance Dotabase Server Log Path
facrtehiphastpeharafOFSPFTINFO g s

ORACLE
FIVNCIAL ERVCES

InstallArywhere

Cancel el

Previous Bt

T

45. Click Next to display the Infodom creation window.

Note: Permissible length for information domain is maximum 10 characters and only alphanumeric

characters allowed. No special characters allowed.
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46. After creation of infodom, the Tablespace specification window will be displayed.

..... Plase specify the Tabespace name (nfodoem database)
Name | OFSA4_DATA

ORACLE
FIVNCIL SERVES

InstaltArywhere

| Cantel Help Prenious it

Pre-Setup Information

47. Click Next to display the Model Upload window.

Do yous wraed 1o perTonm Moded upload 77
= Yes

' No | hawe already done i

ORACLE
FIVANCIAL SERVES

CancH Help l Prindous ] Bisst

Pre-Setup Information
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48. Select Yes and click Next to display the Model Type window.

® Released Data Model
Customized Data Model

ORACLE
FIVANCIAL ERWCES

InstallArywhere

Cantel Help Prenious. et

Pre-Setup Information

49. Select Released Data Model and click Next. Model will get copied into ftpshare.
50. After Model is copied to ftpshare, the Model Review window will be displayed.

Pre-Model Upload Summary

Pee-Irstall Configuration
Infor mation domain Name
OFSPFTINFOG

Data Moded xml path
facratchiphestit'OFS_PFT_PAGKIOFS_PFT/Databodel

Drata Moded xmil file
OFS_PFT_Datasmodal xmi
ERwin xml Path
SPFTINFO,
FINANCIAL SERVICES
InstallArmwhere
cancer | [ b | Previous peat
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Note: If Heap Memory Warning is displayed, then click on Back, and update your .profile entry with
required heap memory size.

Open a new session in Putty.

Shutdown Reveleus server using $FIC_HOME/ficapp/common/FICServer/bin/ reveleusshutdown.sh.
Update the X_ARGS_APP entry in .profile following example.

Example:

X ARGS APP="-Xms2g -Xmx18g -XX:+UseAdaptiveSizePolicy -XX:MaxPermSize=1024M -
XX:+UseParallelO0ldGC -XX:+DisableExplicitGC"

o Run .profile.
o Start Reveleus using $FIC_HOME/ficapp/common/FICServer/bin/ reveleusstartup.sh.
o Proceed for model Upload by clicking on Next.

Pack-on-pack installation for Profitability pack, execute config/insert/indexes.sql as a post data model
upload step.

The data model is getting uploaded.

51. Click Next to display Oracle Business Intelligence Configuration screen.

Pre-Setup Information

Or ache Busiress inteBigence Configur ation

Orache BI Host IP
whDazin.orstle com

Pee-irstall Configuration

Pl
Tan

ORACLE
FIVANCILSERVCES

InstallArywhere

Cance: Help Erévious et

The Pre-Setup Information screen requests for setup information.

The following panel seeks input from the user on whether to create new ETL application/source pair or use
an existing one.

Choose a desired option.
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52. Click Next to continue.

Pre Setup Information
..... D yoia et 1 et & new ETL Source of use this xisting one?
® Niw Source
Exising source
FINANCIAL SERVICES
Installaniwhere
Cantel Help. Bremous Bt

53. Select New Application source and click Next. Staging details will be displayed:

Pre-Setup Information

| ETL STAGNG Source Details
Hame STAGING
Description | STAGING
ETL PROCESSING Soinca Delails
Name PROCESSING

Descripion | FROCESSING

ORACLE
FIVANCLLSERVCES

InstallArmwhere
Cancel MHelp Erivious Bt
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54. After Creation, click Next to display the Installation Details Review window.

Pre-Installation Summary

Pre-Imetall Configurstion
Pre-Irstall Summarny P

LATFORM
Oracle Financial Servicas Analytcal Applications Infrastruchue
FLATFORM YERSION
6.006.000
PRODUCT NAME
Oracla Finanaal Sanices Proftabilty Managamant Pack

FRODUCT VERSION
6.0.6.0.0

INFGDOM NAME ENTERED
OFSPFTINFO

OFSAAI USER ID ENTERED
SYSADMN

CONFIG SCHEMA USER
sparcBiGeonl

JAVA BIN
facratchidk] 7.0_S1irabin/sparced

Disk Space Infor mation (for Installation Tar get):
Raquirad: 1.167,862.130 byles
Awalabla: 16,024 335,360 byles

ORACLE
FIVNCIAL ERVCES

InstallArywhere

Canced Help

Previous | | Jnstal

55. Click Install. A Pop window will ask for the confirmation.

Pre-Installation Summary

@ Fre-inctall Configuration

P

i Pro-install Summary

LATFORM
Oracle Financial Services Analybcal Applicaions Infrastruciue

FLATFORM YERSION
606,000

PRODUCT NAME
Oracla Financial Sanices Prodtabilty Managamant Pack

PRODUCT VERSION
£.0.6.0.0

INFGDOM HAME ENTERED
OFSPFTINFO

OFSAAI USER ID ENTERED
BYSADMN

CONFIG SCHEMA USER
sparcBiGeont

JAVA BIN
faaratehidkl 7.0_S1irabin/sparcvd
Disk Space Infor mation (for Installation Tar getl

Raquirad: 1,167,662.130 byt
Avaiabla: 16,024,355 360 bylas

ORACLE
FIVNCIAL SERVCES

InstallArywhere

Help

56. Click Yes to begin the installation. The installation progress will be in the Installation Progress window.
57. After Installation completion, Installation Completion window will be displayed.
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58. Click Done. The Panel will go back to Main App Pack Installation window and the Installation Summary
window will be displayed.

- . INSTALLATION SUMMARY:
@ Freinstsl Senup
- #FATAL ERRORE-—: 0
+ FERRORE-—mi
R bertall Conmglain #DEBUG STATEMENTS: 138
HNFORMATIONS-——: 0

Flease 568 the installation log under JscrabchipfesttiyOrS_PFT_PACKoge®ack_Install lng
Click on Mext 0 confinue,

ORACLE
FIVNCIL SERVES

59. Click Next to display the Installation Complete window.
e ’ Congratulabons! Financial Services Proftabiliy Fack has been successidly installed
) Freinstall Setup
g Click on “Dome” 1o exit ™e installer. Please do not close ®e console. Post install activites will be performed in console
= stall Complete
FINANCIAL SERVICES
: &mnn) ] "_an-e ]

60. Click Done.
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Note: The installation process continues on the console. Do not close the console until the installation
process is complete.

Post Install Health checks are displayed:

= xterm - X

CTRL characters removal started ...

CTRL characters removal over ...

Windows executable files removal started ...
Wlindows executable files removal over ..

ile are nou in /scratch/ofsasapp ...

.profile excouted
“profile executed

executing "ant"

Buildfile: /scratoh/ofsasapp/PFT_HOME/Ficusbibuild.xml
Truing to everride old definition of datatupe resources

existiesty
[echo] Checking for file /scratch/ofsaaapp/PFT_HIME/f icush/PFT_HOME ,uar existenss

createvar:
[echo] Creating /scratchy/ofsaaapp/PFT_HOME/F icueb/PFT_HOME. war freshly..
[war] Building wari /soratch/ofsaaapp/PFT_HOME/Ficweb/PFT_HOME,uar

BUILD SUCCESSFUL
Total time: 1 ninute 54 seconds

OFSAR App Laver Services start-up check started...
Starting startofsaai,sh service,,,

OFSHA Service - OK

Starting icc service...

ICC service - OK

Shutting doun icc service...

Shutting doun OFSAA servics,,,

OFSAAL App Lausr Services check Status: SUCCESSFUL,
OFSAAL I Layer Services check started...

Calling agentshutdown.sh to check and kill, if any of the server is rumning...
OLAP Data Server service is not running,

Stop HESSAGE Server service with Proces 10 3 8087
Stop A service with Proces 1D ; 3043

Stop ROUTER service with Proces 1D : 9047

(Starting ROUTER Service

ROUTER service started in background made,

Starting AH Serwics

A service started in background mode,

Starting HESSAGE SERVER Service

HESSAGE SERVER service started in background mode.
Starting OLAP DATA SERVER Service

OLAP TATA SERVER service started in background mode,
OLAP Data Server service is not running.

5top ROUTER service with Proces ID ¢ 27793
OFSAAT TB Layer File Services check Status: SUCCESSFUL,

Installation completed...

/scratchyafsasapp/Meu_KIT/OFS_PFT_PACK/binsl

61. Install the following mandatory one-off patches. Refer to the Readme available with the patch for further
instructions on installing the patch.

o 27938294
o 28079607
o 28033582

62. If your PFT Pack installation is on an environment where another application pack is already installed, then
apply the following mandatory one-off patches for PFT and FTP applications:

o PFT: 28053291, 28399997
o FTP: 28053724

Refer to the Readme available with the patches for further instructions on installing the patches.

63. Release 8.0.6.0.0 of OFS PFT application pack is not fully backward compatible with earlier versions of
OFSAA applications. You can either upgrade all of your applications from existing 8.0.x versions to 8.0.6.0.0
version or choose to upgrade only selective application packs to v8.0.6.0.0. In the case of the latter, you
must also apply the following compatibility patches for the required application packs, so that the remaining
application-packs can continue to be at their pre-8.0.6.0.0 versions:

o Compatibility patch for OFS PFT: 28170580
o Compatibility patch for OFS FTP: 28197858
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64.

65.

66.
67.

68.

69.

You can download these patches from the Patches & Updates tab of https://support.oracle.com portal. For
more information about the application of these patches, refer to the Readme files.

Go to $FIC WEB HOME/webroot/WEB-INF/web.xml file. Find the servlet entry for PETConfigRESTService
and replace the servlet entry with the following:
<servlet>
<servlet-name>PFTConfigRESTService</servlet-name>
<servlet-class>org.glassfish.jersey.servlet.ServletContainer</servlet-class>
<init-param>
<param-name>jersey.config.server.provider.packages</param-name>
<param-value>com.ofs.fsapps.pft</param-value>
</init-param>
<init-param>

<param-name>jersey.config.server.provider.classnames</param-name>

<param-value>com.ofs.fsapps.pft.action.PFTConfigController,com.ofs.fsapps.pft.
action.clsActAllocationID,com.ofs.fsapps.pft.action.ClsActAllocModel,
com.ofs.fsapps.pft.action.ClsActRuleSelection,com.ofs.fsapps.pft.action.ClsAct
RuleSelectionService,com.ofs.fsapps.pft.action.clsActLookuplID,
com.ofs.fsapps.pft.action.ClsActTablelId, com.ofs.fsapps.pft.action.ClsActHierar
chyBrowser,com.ofs.fsapps.pft.action.clsActAllocationHist,
com.ofs.fsapps.pft.action.clsActAllocationIDService</param-value>
</init-param>
</servlet>

Install the following mandatory one-off patch for the application mentioned:

o FTP application: 28465810 (Profitability Management Application Pack Maintenance Level Release
8.0.6.1.0)

o Verify and apply any recent fixes for respective applications.
Perform steps mentioned in the Post-Installation Configuration section.

For enabling Transparent Data Encryption (TDE), see TDE, Data Redaction and the Corresponding Settings
in OFSAA.

For enabling Data Redaction, see Data Redaction section under Data Security and Data Privacy chapter in
OFS Analytical Applications Infrastructure Administration Guide 8.0.6.0.0.

For information on Data Protection Implementation, see Data Protection Implementation in OFSAA.
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Silent Mode Installation

Note: For Schema Creator Utility steps, see Executing the Schema Creator Utility.

Log in to the system as non-root user.
2. Identify a directory for installation and set the same in the user .profile file as below:
FIC HOME=< OFSAA Installation Directory > export FIC HOME
3. Execute the user .profile.
Pre-Installation XML/ File Populations:
Before Proceeding to SILENT Installer, we need to populate following files with pre-defined values.

O OFSAAI InstallConfig.xml (Location: 0Fs PFT PACK/OFS AAI/conf). For more information, see
Configuring OFSAAI_InstallConfig.xml File section.

Note: If value for HTTPS ENABLE is set to 1, ensure you have a valid certificate available from a trusted
CA and the same is configured on your web application server.

O SILENT.props File. (Location: 0Fs PFT PACK/OFS PFT/conf)

Note: The file name will be STLENT. template in the installer and it has to be renamed as
SILENT.props.

Do not install the new applications in the same segment if the pre-installed applications use run

management.
Property Name Description of Property Permissible Values Comments
UPLOAD_MODEL whether you want to perform |0 = No Mandatory
Model Upload 1=ves
MODEL_TYPE Released data model or 0 = released # Mandatory only in the case
Customized data model 1 = customized of uploading the data model
DATAMODEL the path for the customized | Not Applicable # Mandatory only in the case
data model of uploading the customized
data model
# Option selected for
MODEL_TYPE=1
DM_DIRECTORY the file name for the Not Applicable # Mandatory only in the case
customized data model of uploading the customized
data model
# Option selected for
MODEL_TYPE=1
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Configuring Application Pack XML Files

OFS_PFT_PACK.xml

The ors prT pPaCK.xml file holds details on the various products that are packaged together in Profitability
Application Pack.

This section details the various tags/ parameters available in the file and the values that need to be updated.
Prior to installing the Profitability Application Pack in SILENT mode, it is mandatory to update this file.

Note: If you are installing in the GUI mode, then this file need not be updated.

Installation

1. Navigate to the following folder path: oFs prFT Pack/bin/.
2. Execute the setup. sh file using the following command:
./setup.sh SILENT

3. The installer will proceed with Pre-Installation Checks.

2P o45522068 3 ored Jecom - PuTTY
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4. Enter the OFSAA Processing Tier FTP/SFTP password value, when prompted at the command prompt.
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6. First AAIl will be Installed.

£ 5230683 in.oracke.com » PuTTY

7. After AAl is installed, the PFT Pack installation begins.
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Note: Data Model Upload may take several hours to get complete. You can check the Logs in
OFS_PFT PACK/OFS PFT/logs.
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8. Do not close the console until the installation is complete.

] Creating
] Building

check

.out!

. oug!

!

atus:
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e old definition of dataty

.ont!

L out !

DEERT
DEET

i BFND

9. Install the following mandatory one-off patches. Refer to the Readme available with the patch for further
instructions on installing the patch.

o 27938294
o 28079607
o 28033582

10. If your PFT Pack installation is on an environment where another application pack is already installed, then

apply the following mandatory one-off patches for PFT and FTP applications:
o PFT: 28053291, 28399997

o FTP: 28053724
Refer to the Readme available with the patches for further instructions on installing the patches.
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1.

12,

13.
14.

15.

16.

Release 8.0.6.0.0 of OFS PFT application pack is not fully backward compatible with earlier versions of
OFSAA applications. You can either upgrade all of your applications from existing 8.0.x versions to 8.0.6.0.0
version or choose to upgrade only selective application packs to v8.0.6.0.0. In the case of the latter, you
must also apply the following compatibility patches for the required application packs, so that the remaining
application-packs can continue to be at their pre-8.0.6.0.0 versions:

o Compatibility patch for OFS PFT: 28170580
o Compatibility patch for OFS FTP: 28197858

You can download these patches from the Patches & Updates tab of https://support.oracle.com portal. For
more information about the application of these patches, refer to the Readme files.

After installing the above patches the following mandatory one-off patch for the application mentioned:

o FTP application: 28465810 (Profitability Management Application Pack Maintenance Level Release
8.0.6.1.0)

o Verify and apply any recent fixes for respective applications.
Perform the steps mentioned in Post-Installation Configuration section.

For enabling Transparent Data Encryption (TDE), see TDE, Data Redaction and the Corresponding Settings
in OFSAA.

For enabling Data Redaction, see Data Redaction section under Data Security and Data Privacy chapter in
OFS Analytical Applications Infrastructure Administration Guide 8.0.6.0.0.

For information on Data Protection Implementation, see Data Protection Implementation in OFSAA.
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Verifying the Log File

See the following logs files for more information:

*+ Seetheors prT installation.log located at oFs pPFT PACK/OFS PFT/logs folder for OFS Profitability

Application Pack installation log file.

* Seethe pack Install.log located at oFs prT PACK/logs/ folder for OFS Profitability Application Pack

installation log file.

+ See the log file(s) located at ors pFT PACK/OFS AAI/logs/ folder for Infrastructure installation log.

+ Seethe oFsaAInfrastucture Install.log located at sFrc nowmE folder for Infrastructure installation log.

Changes in .profile file for Solaris Operating System

For Solaris operating system, do the following changes in .profile file present in user's home directory.

1. For Solaris Sparc and X86 systems, append the path $FIC_DB_HOME/lib/libC++11/ to
LD_LIBRARY_PATH variable in .profile file.

For example:
LD LIBRARY PATH=$LD LIBRARY PATH:$FIC DB HOME/lib/libC++11

2. For Solaris Sparc, add the Oracle Developer Studio 12.5 installed path in the beginning of
LD_LIBRARY_PATH variable in .profile file.

For example:

LD LIBRARY PATH=/opt/SunProd/studiol2u5/developerstudiol2.5/1lib/compilers/CCgcc/lib/
sparcv9: $LD_LIBRARY_PATH
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CHAPTER 5 - UPGRADING THE OFS PFT APPLICATION PACK

This chapter provides necessary information to upgrade the Profitability Application Pack.

Note: If you are currently on Release 8.0.0.x.x or 8.0.1.x.x of the OFS PFT, then you need to first upgrade to

Release 8.0.2.x.x before upgrading to 8.0.6.0.0.

This chapter includes the following topics:

Upgrading the OFS PFT Application Pack

Upgrading the OFS PFT Application Pack

Refer to the following instructions to download, extract, install, and configure this release.

1.

Download the OFS PFT Application Pack v8.0.6.0.0 archive file and copy it to your OFSAA server in Binary
mode.

Note: The archive files are different for every operating system like AlX, Solaris, and RHEL/Oracle Linux.

Log in to the OFSAA Server with user credentials that was used to install OFS PFT.

Shut down all the OFSAAI Services. For more information, see the Start/Stop Infrastructure Services section
in Start/Stop OFSAA Infrastructure Services.

Execute the following command:
chmod -R 750 $FIC HOME

If you have Unzip utility, skip to the next step. Download the Unzip utility (OS specific) and copy it in Binary
mode to the directory that is included in your PATH variable, typically $SHOME path or directory in which you
have copied the 8.0.6.0.0 installer.

o Uncompress the unzip installer file using the command:

uncompress unzip <os>.Z

Note: If you notice an error message "uncompress: not found [No such file or directory]" when the
package is not installed, contact your UNIX administrator.

o Give EXECUTE permission to the file using the command:
chmod 751 OFS PFT 80600 <O0S>.zip

Extract the contents of the OFS PFT Application Pack 8.0.6.0.0 in Download Directory installer archive file
using the following command:

unzip <os> <name of the file to be unzipped>

Give EXECUTE permission to the archive file. Navigate to the path orFs PFT 80600 <0s>.zip and execute
the command:

chmod -R 750 OFS_PFT PACK
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8. Rename the sTLENT. template file (Location: 0oFs PFT PACK/0FS PFT/conf) in the installer as

SILENT.props. Configure silent.Props file only for the following parameters:

Property Name Description of Property Permissible values

UPLOAD_MODEL whether you want to perform |0: No
Model Upload 1: Yes

Comments

Mandatory

Select "1" to perform the
Model Upload.

Select "0" to skip Model
Upload.

MODEL_TYPE Released data model or 0 = released
Customized data model 1 = customized

# Mandatory only in the case
of uploading the data model

If UPLOAD_MODEL option
is selected as "1", then you
can choose to upload
Released Model (0) or
customized Model (1).

DATAMODEL the path for the customized |Not Applicable
data model

# Mandatory only in the case
of uploading the customized
data model

# Option selected for
MODEL_TYPE=1

DM_DIRECTORY the file name for the Not Applicable
customized data model

# Mandatory only in the case
of uploading the customized
data model

# Option selected for
MODEL_TYPE=1

9. Execute setup.sh file using the following command from the ors prT/bin directory:

./setup.sh SILENT

Verify if the release is applied successfully by checking the log files generated in the installation folder as

mentioned below:

O OFS PFT PACK/OFS AAAI PACK/logs/OFSAAIUpdate.log for Infrastructure installation log file.

O OFS _PFT PACK/OFS PFT /logs/OFS PFT installation.log for OFS Profitability Application Pack

installation log file.
You can ignore the following errors in the log files:
ORA-00001
ORA-00955
ORA-02260
ORA-01430
Error Message->DMT.DUPLICATE_RECORD_FOUND
Error Message->COMMONOBJECT.SAVE_FAILED
If there are any other errors, contact Oracle Support.

©c 0O 0 O O ©
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10.

1.

12,

13.

14.

15.

16.

17.

Install the following mandatory one-off patches. Refer to the Readme available with the patch for further
instructions on installing the patch.

o 27938294

o 28079607

o 28033582

Release 8.0.6.0.0 of OFS PFT application pack is not fully backward compatible with earlier versions of

OFSAA applications. You can either upgrade all of your applications from existing 8.0.x versions t0 8.0.6.0.0
version or choose to upgrade only selective application packs to v8.0.6.0.0. In the case of the latter, you
must also apply the following compatibility patches for the required application packs, so that the remaining
application-packs can continue to be at their pre-8.0.6.0.0 versions:

o Compatibility patch for OFS PFT: 28170580
o Compatibility patch for OFS FTP: 28197858

You can download these patches from the Patches & Updates tab of https://support.oracle.com portal. For
more information about the application of these patches, refer to the Readme files.

For more information on securing your OFSAA Infrastructure, see to the Oracle Financial Services
Analytical Applications Infrastructure Security Guide.

Restart all the OFSAAI services. For more information, see the Start/Stop Infrastructure Services section in
Start/Stop OFSAA Infrastructure Services.

Generate the application EAR/WAR file and redeploy the application onto your configured web application
server. For more information on generating and deploying EAR / WAR file, see Creating EAR/WAR File and
Deploying EAR/WAR File sections.

After successful installation, follow these steps:

o Log in to the web application server and clear the application cache. Navigate to the following path
depending on the configured web application server and delete the files.

Tomcat:
<Tomcat installation folder>/work/Catalina/localhost/<Application name>/org/apache/jsp
Weblogic:

<Weblogic installation location>/domains/<Domain name>/servers/<Server name>/tmp/_WL_user/
<Application name>/<auto generated folder>/jsp_servlet

In case of WebLogic version 12.2.x.x, delete the folder named ".WL_internal" present in the path
<WebLogic installation location>/user_projects/domains/< Domain name >/applications/
<context_name>.ear/META-INF/", if it exists.

Websphere:

<Websphere installation directory>/AppServer/profiles/<Profile name>/temp/<Node name>/server1/
<Application name>/<.war file name>

Add umask 0027 in the .profile of the UNIX account which manages the WEB server to ensure restricted
access permissions.

If OFS Enterprise Modeling is licensed and enabled in your OFSAA instance, uninstall OFSAAIRunner
package and reinstall the latest available OFSAAIRunner package. For more details, see Configuration for
Oracle R Distribution and Oracle R Enterprise (ORE).
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18. For enabling Transparent Data Encryption (TDE), see TDE, Data Redaction and the Corresponding Settings
in OFSAA.

19. For enabling Data Redaction, see Data Redaction section under Data Security and Data Privacy chapter in
OFS Analytical Applications Infrastructure Administration Guide 8.0.6.0.0.

20. For information on Data Protection Implementation, see Data Protection Implementation in OFSAA.

Note: If any grants are missing for any applications, then manually execute the files present in location
SFIC HOME/app conf files/grants With respect to the individual application.

Removing OId Struts Libraries

After you upgrade the PFT Pack, the Struts libraries need to be checked and the older version of the files should
be removed mandatorily. Use the following procedure to remove the old Struts libraries:

Navigate to the path sF1c wEB HOME/webroot/WEB-INF/1ib and perform the following checks:

1. Ifboth struts2-core-2.3.32.jar and struts2-core-2. 3. 34. jar exist, then delete the file struts2-
core-2.3.32.7ar file.

2. If both xwork-core-2.3.32.5ar and xwork-core-2.3.34.jar exist, then delete the file xwork-core-
2.3.32.5ar file.

3. Ifboth ogn1-3.0.19.9ar and ogn1-3.0.21.jar exist, then delete the file ogn1-3.0.19.5ar file.

Improving Performance of EFPA Application

The OFS EFPA Application Essbase cube does not save with three dimensions. To resolve this, perform the
following steps:

1. Take a backup of file excludeURLList .cfg which will be present in beployedrocation/conf folder.
For example:

/weblogic/user projects/domains/ofsaadomain/applications/ofsaa.ear/ofsaa.war/conft/

2. OpenexcludeURLList.cfg, there will be an entry [SQLIA]./FormsFrameworkController. Change this entry
to [ALL]./FormsFrameworkController.

Ensure that you do not add any additional blank space or extra lines.

Restart the Weblogic server and test the cube creation scenario.

Changes in .profile file for Solaris Operating System

For Solaris operating system, do the following changes in .profile file present in user's home directory.

1. For Solaris Sparc and X86 systems, append the path $FIC_DB_HOME/lib/libC++11/ to
LD_LIBRARY_PATH variable in .profile file.

For example:

LD LIBRARY PATH=SLD LIBRARY PATH:$FIC DB HOME/lib/libC++11
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2. For Solaris Sparc, add the Oracle Developer Studio 12.5 installed path in the beginning of
LD_LIBRARY_PATH variable in .profile file.

For example:

LD LIBRARY PATH=/opt/SunProd/studiol2u5/developerstudiol2.5/1lib/compilers/CCgcc/lib/
sparcv9: $LD7LIBRARY7PATH
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DMT Migration

DMT migration utility is available as part of the OFSAAI 8.0.6.0.0 upgrade to migrate the DMT metadata (PLC/
Data Source/Data Mapping/Data File Mapping) to be persisted in tables instead of XML. To identify when to
migrate, what/how to migrate, and how to handle migration issues, see OFSAA DMT Metadata Migration Guide.

For upgrade installer, below changes are to be done in T2T Fs1 D cusTOMER.xml before migrating the T2T xml
to table entries if the T2T is customized by customer.

Line Number in the XML file Parameter Recommended Value

116 <COLUMN ID=""> <COLUMN ID="AS_OF_DATE">

129 <COLUMN ID=""> <COLUMN ID="CUSTOMER_ID">

142 <COLUMN ID=""> <COLUMN ID="IDENTITY_CODE">
155 <COLUMN ID=""> <COLUMN ID="ISO_CURRENCY_CD">

Note: Above line number references are as per the out of the box XML of 12T Fs1 D cusSTOMER.xm1 file.

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0 83


https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAA%20DMT%20Metadata%20Migration%20Guide%208.0.6.0.0.pdf

Post-Installation Configuration

CHAPTER 6 — POST-INSTALLATION CONFIGURATION

After successfully installing the Oracle Financial Services Advanced Analytical Applications Infrastructure
Application Pack, follow the post installation steps mentioned below.

This chapter includes the following topics:

Grants for Model Executions

User Creation, Roles and Permissions

Excel Upload Mapping and Template

Configure Resource Reference

Start/Stop OFSAA Infrastructure Services

Add TNS entries in TNSNAMES.ORA file
Configuring Web Server

Configuring Work Manager in Web Application Servers
Disabling Data Types in Web Logic

Creating and Deploying EAR/WAR File

Accessing the OFSAA Application

OFSAA Landing Page

User Group Mapping

Create and Deploy the Application Pack Web Archive
Patching Your OFS Profitability Pack Installation

Note: Ensure that to clear the application cache prior to the deployment of Application Pack Web Archive. This
is applicable to all Web Servers (WebSphere, WebLogic, Tomcat). For more information, See Clearing

Application Cache section.

Grants for Model Executions

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0

Grants- Connect; Data Redaction; RQADMIN; RQROLE; CREATE ANY MINING MODEL; CREATE
MINING MODEL; SELECT ANY MINING Model; OLAP USER

Grant the following roles:
Login as SYSDBA and execute the following queries:

grant execute on DBMS REDACT to <SANDBOX SCHEMA>

/

Create role OFS_SEC DATA

/

grant OFS SEC DATA to <SANDBOX SCHEMA>
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/

create role OFS NOSEC DATA

/

grant EXEMPT REDACTION POLICY to OFS NOSEC DATA

/

grant OFS NOSEC DATA to <SANDBOX SCHEMA>

/

alter user <SANDBOX SCHEMA> default role none

/

After granting roles present in point number 5, alter user <SANDBOX SCHEMA> default role rgadmin;

User Creation, Roles and Permissions

After successful installation of the Oracle Financial Services Advanced Analytical Applications Infrastructure
Application Pack, perform the following post installation steps:

1.

2.
3.
4

Create RCA user from sysadmin.

Authorize the user from sysauth.

Assign the user to RCA-related user groups.
Authorize the user group mapping to RCA.

Excel Upload Mapping and Template

o w0 bd =

Copy the ExcelUpload directory present in $FTCHOME/CIRCA/ExcelUpload.

Change the name of directory named as infodom in ExcelUpload to respective infodom name.
Copy the ExcelUpload directory to ftpshare/sSTAGE directory.

Create sTAGE directory in <TOMCAT HOME>.

Copy the ExcelUpload directory to sTaGe directory in <TOMCAT HOME>.

Configure Resource Reference

Configure the resource reference in the Web Application Server configured for OFSAA Applications. See
Configuring Resource Reference in Web Application Servers for details on configuring the resource reference
in WebSphere, WebLogic, and Tomcat Application Servers.
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Start/Stop OFSAA Infrastructure Services

Start the OFSAA Infrastructure Services prior to deployment or accessing the OFSAA Applications.

This chapter details on how to start and stop OFSAA Infrastructure services. This section includes the following
sub-sections:

« Starting Infrastructure Services

«  Starting Web Application Servers

Starting Infrastructure Services

Once the installation of Infrastructure has been completed successfully and the post-installation steps are
completed, the servers must be started. Log on to each machine and run the .profile file. All servers mentioned
must be started from the same shell encoding. The servers mentioned below are dependent on each other. It is
mandatory to maintain the order in which the servers are started. Allow each of the servers to initialize
completely before starting the next server.

1. On the machine in which Infrastructure Application components have been installed, navigate to
$FIC_APP HOME/common/FICServer/bin and execute the following command to start the Infrastructure
Server.

./startofsaai.sh

Note: You can also start the Infrastructure Server by executing the command "nohup ./ startofsaai.sh &".
Starting the process using "nohup" and "&" will return the command prompt without having to wait till the
process completes. However, this command cannot be used when you are starting the server for the first
time or starting after changing user password in the configuration database schema.You can also start the
Infrastructure Server by executing the command "nohup ./ startofsaai.sh &". Starting the process using
"nohup" and "&" will return the command prompt without having to wait till the process completes. However,
this command cannot be used when you are starting the server after changing user password in the
Configuration database schema.

2. Start ICC server:

o On the machine in which Infrastructure default Application components have been installed, navigate
to $FIC HOME/ficapp/icc/bin folder.

o Execute the command:

./iccserver.sh

Note: Only Infrastructure Default Application Server would hold ICC component.

3. Stopping Infrastructure Services:

o On the machine on which Infrastructure Database components have been installed, navigate to
$FICc DB HOME/bin folder and execute the command to start "Agent server™:

./agentstartup.sh
Or
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o Start Back-end services using the command:

nohup ./agentstartup.sh &

Note: This agent internally starts the Router, Message Server, OLAP data server and AM services.

Starting Web Application Servers

Start the Web Application Server depending on the type from the following table.

Start up Option Description

Starting WebSphere profile On the machine in which Web sphere is installed, navigate to
[Webshpere_Install_Directory] /AppServer/<profiles>/<profile name>/bin and
execute the command:

./startServer.sh serverl

Starting WebLogic Domain On the machine in which WebLogic is installed navigate to <WebLogic Installation
directory>/user_projects/domains/<domain name>/bin and execute the command:
startWebLogic.sh -d64

Note: If WebLogic is already running, access the WebLogic Admin Console. Stop and
start the application <context name>.ear.

Starting Tomcat Application On the machine in which Tomcat is installed, navigate to <Tomcat_Install_ Directory>/
bin and execute the command:

./catalina.sh run

Stopping Infrastructure Services

To stop Infrastructure services:

1. On the machine in which Infrastructure Application components have been installed, navigate to
SFIC APP HOME/common/FICServer/bin folder and execute the command:

./stopofsaai.sh

2. To stop ICC server, on the machine in which Infrastructure default Application components have been
installed, navigate to $F1c HOME/ficapp/icc/bin folder and execute the command:

./iccservershutdown.sh

Only Infrastructure Default Application Server would hold ICC component.

3. To stop Back-end server, on the machine in which Infrastructure database components have been installed,
navigate to $rFrc DB HOME/bin folder and execute the command:

./agentshutdown. sh
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Add TNS entries in TNSNAMES.ORA file

Add TNS entries in the tnsnames. ora file, for every schema created for the Application Pack:
To find the tnsname for the entries, follow these steps:

1. Login to the application using System Administrator privileges.

2. Navigate to System Configuration & Identity Management tab.

3. Click Administration and Configuration >> System Configuration >> Database Details.
4. Expand the drop-down list for Name to get the list of TNS entry names.

Alternatively, you can connect to the CONFIG schema and execute the below query:

select dbname from db master where dbname !='CONFIG'

Configuring Web Server

This section includes the following topics:

+  Configuring Web Server
»  Configuring Web Application Server

Configuring Web Server

This step assumes an installation of a Web Server exists as per the prerequisites.

Refer the product specific Installation Guide/ Configuration Guide to install/ configure the Web Server. If an
installation already exists, skip and proceed to the next step.

Note: Make a note of the IP Address/ Host-name and Port of the web server. This information is required during
the installation process.

See Oracle Financial Services Analytical Applications Infrastructure Security Guide for additional
information on securely configuring your Web Server.

Ensure to enable sticky session/ affinity session configuration on the web server. See the respective
product specific Configuration Guide for more details. Additionally, you also need to enable the sticky
session/ affinity session configuration at Load Balancer level if you have configured a Load Balancer in
front of the web server(s).

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0 88


http://docs.oracle.com/cd/E61555_01/books/OFSAAI_Security_Guide.pdf

Post-Installation Configuration

Configuring Web Application Server

This step assumes an installation of a web application server exists as per the prerequisites. To configure the
Web Application Server for OFSAA Deployment refer the sections below.

This section includes the following topics:

»  Configuring WebSphere Application Server for Application Deployment
+  Configuring WebLogic for Application Deployment
»  Configuring Apache Tomcat Server for Application Deployment

Note: Make a note of the IP Address/ Host-name and Port of the web application server. This information is
required during the installation process (required if Web Server is not configured).

Add umask 0027 in the .profile of the UNIX account which manages the WEB server to ensure restricted
access permissions.

See Oracle Financial Services Analytical Applications Infrastructure Security Guide for additional
information on securely configuring your Web Server.

Configuring WebSphere Application Server for Application Deployment

You can deploy multiple OFSAA applications on different profiles of a WebSphere application server. To create
multiple WebSphere "Profiles" in a stand-alone server, use the command line option as explained below. A
profile is the set of files that define the runtime environment. At least one profile must exist to run WebSphere
Application Server.

This section includes the following topics:

+ Creating a New Profile in WebSphere

* Managing IBM WebSphere SDK Java Technology Edition Versions

» Managing Applications in WebSphere

»  Configuring WebSphere Application Server to Use a Load Balancer or Proxy Server
* Deleting WebSphere Profiles

»  Configuring WebSphere Shared Library to Support Jersey 2x and Jackson 2.9x Libraries
*  WebSphere HTTPS Configuration

*  WebSphere Memory Settings

»  Configuring WebSphere for REST Services Authorization

»  Configuring Application Security in WebSphere

Creating a New Profile in WebSphere

The Profile is created in WebSphere through command line using the manageprofiles.sh which resides in
<WebSphere Install directory>/AppServer/bin folder.

The command to create a profile without admin security through command line is as follows:
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"manageprofiles.sh -create -profileName <profile> -profilePath <profile path> -
templatePath <template path> -nodeName <node name> -cellName <cell name> -hostName
<host_name>"

Example:

Susr/home>./manageprofiles.sh -create -profileName mockaix -profilePath/websphere/
webs64/Appserver/profiles/mockaix -templatePath/websphere/webs64/Appserver/

profileTemplates/default -nodeName ipa020dorNode04 - cellName ipa020dorNode04Cell -

hostName ipa020dor

The command to create a profile with admin security through command line is as follows:

"manageprofiles.sh -create -profileName <profile> -profilePath <profile path> -
templatePath <template path> -nodeName <node name> -cellName <cell name> -hostName

<host_name> -enableAdminSecurity true -adminUserName <Admin User Name> -adminPassword <

Admin User Password> -samplespassword <sample User Password>"

Example:

Susr/home>./manageprofiles.sh -create -profileName mockaix -profilePath/websphere/
webs64/RAppserver/profiles/mockaix -templatePath/websphere/webs64/Appserver/
profileTemplates/default -nodeName ipa020dorNode04 -cellName ipa020dorNodeO4Cell -

hostName ipa020dor -enableAdminSecurity true -adminUserName ofsaai -adminPassword ofsaai

-samplespassword ofsaai"

Note: While using the manageprofiles.sh command to create a New Profile in WebSphere, you can also use
"-validatePorts" to validate if the specified ports are not reserved or in use. Additionally, you can specify

new ports with "-startingPort <base port>" which specifies the starting port number to generate and

assign all ports for the profile. For more information on using these ports, see WebSphere
manageprofiles command.

Managing IBM WebSphere SDK Java Technology Edition Versions

By default, WebSphere Application Server V8.5.5.X uses the Java 6.0 SDK. You must upgrade to Java 7.X SDK

or JAVA 8.X SDK.
Prerequisites: Install the IBM WebSphere SDK Java Technology Edition Versions 1.7.X_64 or 1.8.X_64.
Perform the following steps to upgrade to Java 7.X SDK or JAVA 8.X SDK:

1. Enter the WebSphere URL in the format http://HOST_NAME:PORT_NUMBER/ibm/console (use https if

SSL is enabled.). For example, http://192.168.1.0:9000/ibm/console.
Login with your administrator user ID and password.
From the LHS menu, click Servers to expand and view the menu.

Click Server Types to expand the menu further and then click WebSphere Enterprise Application
Servers to view the Application servers window.

5. On Application servers window, click the required Application Server link. For example, server1 in the
following illustration:
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Application servers

Application servers > serverl

Runtirne Configuration

General Propertias

Container Settings

Name

sarvarl |

Node name

whftOagnioda0l |

Run in develapment mode
¥ paraliel start

Start components as needed

Arcess to internal sarver classes

Allat A

Server-specific Application Settings

Classloader policy
Multiple ¥

Class loading mode

Classes loaded with parent class loader first

Appty | [ OK | [ Reset | [ Cancel |

Usa this page to configure an application server. An application server is a sarver that provides services required to run enterprise applications.

Zgssion management

EIP Container Settings

Web Container Settings

B B ®

Portlet Container Settings

EJB Containar Sattings

B B

Container Services

B Business Process Ssarvices

Applications

Installed spplications

Server messaging

Meszaging engines
Messaging engine inbound transports
WebSphere MQ link inbound transports

SIB service

Server Infrastructure

@ Java and Process Management
B Administration

Java SDK3

6. Click Java SDKs link from Server Infrastructure to view the list of Java SDKs.

Application servers ?
Application servers > serverl > Java SDKs
This page lists the softvare developmaent kits (SDks) that are installed on the server. Thesa SDKs are available to the servers.
& Braferencas
Make Default
2o
T T
Select Name & | Version & Locakion | Bits | Default O
You can administer the following resources:
| : - : .
1.5_54 1.6 ${WAS_INSTALL_ROOT}/java i &4 i false
1.7_54 1.7 | ${WAS_INSTALL_ROOT}/java_1.7_64 | 64 =
o | 1864 1.8 ${WAS_INSTALL_ROOT}/java_1.8_64 | &4 true
Total 2
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7. Select either 1.7_64 or 1.8_64 based on the JVM version with which you plan to install OFSAA or have

installed with.

Click Make Default button and save to master repository.

Restart the WebSphere Application Server to apply the changes to the IBM application profile.

Managing Applications in WebSphere

To manage the installed applications in WebSphere, do the following:

1. Open the administrator console using the following URL:

http://<ipaddress>:<Administrative Console Port>/ibm/console

Example: http://10.111.222.333:9003/ibm/console (hitps if SSL is enabled)

Note: Administrative Console Port value is available in serverindex.xml file within

Directory>/config/cells/<Node Cell>/nodes/<Node Name> directory.

<WebSphere Profile

The Integrated Solutions Console Login window is displayed.

Integrated Solutions Console

Log in to the console.
Uiar ID:
uggsTa

Fassvord

=25 1N

B

N

2. Log on with the User ID provided with the admin rights.

3. From the LHS menu, expand the Applications > Application Type> WebSphere Enterprise

Applications.
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The Enterprise Applications screen is displayed.

Emterprive Applications
Viw thig cags & manags installed agelcatgne. A l--;:i apglicaticn can e degleved ot mMultigle serveds
B Freferances

: i 1
Seart || Svag || Dasall || Unisanall et Redleut Updata Famzva File Expart || Exper DOL ExgaruFila |

BDE

Selact Mama 2 application Status £_

You can sdminister the following resouroas:

0 | Gsfatsccicaten +
O | bases .
[ | muse >
[] |u=asa >
Total &

4. This Enterprise Applications screen helps you to:
o Install new application
o Un-install existing applications

o Start or Stop the installed applications

Configuring WebSphere Application Server to Use a Load Balancer or Proxy Server

The configuration prevents the process server from redirecting to an internal port
when using a load balancer or proxy server.
The following steps describe the configuration:
1. Enter the WebSphere URL in the format
http://HOST_NAME:PORT_NUMBER/ibm/console (use https if SSL is enabled.).
For example, http://192.168.1.0:9000/ibm/console.
Login with your administrator user ID and password.
From the LHS menu, click Servers to expand and view the menu.
Click Server Types to expand the menu further and then click WebSphere

Enterprise Application Servers to view the Application servers window.
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5. On Application servers window, click the required Application Server link. For example, server1 in the
following illustration:

Application servers T -

Application servers > serverl = Web container > Custom properties

Use this page to specify an arbitrary name and value pair. The value that is specfied for the name and value pair is a sbing that can set
internal system configuration properties.

% Preferences

New... || Delete
=i w il
Select Mame 2 Value 2 Descnption 2

¥ou can administer the following resources:

com.ibm.ws.webcontainerextractHostHeaderPort true bl
trusthostheaderport true (S |
Total 2

Click Web Container Settings > Custom Properties.

Add the following properties:

o Name: trusthostheaderport
Value: true

o Name: com.ibm.ws.webcontainer.extractHostHeaderPort
Value: true

8. Restart the WebSphere Application Server to apply the changes.
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Deleting WebSphere Profiles

To delete a WebSphere profile, do the following:
1. Select the check box adjacent to the required application and click Stop.
Stop the WebSphere profile to be deleted.
Navigate to WebSphere directory:
<WebSphere_Installation_Directory>/AppServer/bin/
4. Execute the command:
manageprofiles.sh -delete -profileName <profile name>
5. Delete profile folder.
Example: <WebSphere_Installation_Directory>/AppServer/profiles/<profile_name>
6. Execute the command:

manageprofiles.sh -validateAndUpdateRegistry

Configuring WebSphere Shared Library to Support Jersey 2x and Jackson 2.9x
Libraries

Perform the following configuration to set WebSphere shared library to support jersey 2x and Jackson 2.9x
libraries.

1. Click Environment from the menu on the left to expand and view the list. Click Shared Libraries to open

the Shared Libraries window.

+ Guided Ativices
3 Sarven

| Applcatons

+ Sarvices

Ganaral Properties

4 Rascurces
1) Sacurity
=| Environmant
* Nama

[JERSEY2%

Dascription

Providing Jersey 2.x shared library |

# Classpath

) Syszem sdminigerarea sarateh/1BM WebSohere dRnSanoes’ profiles/ AALRNS SharesiLlR/

+ Uier and Groups

F Menicring and Turimg

1 Troubleshomting Matios Likrary Path
3 Sarvios imnegrasae

+ LoDl

Class Loading

# Use an isclated class loader for this shared library

[ Apoy ][ OK || Reset | [ Cancel |

T S = | _
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2. Enter details as shown in the following:

a. Name: Enter a unique identifiable name.

b. Description: Enter a valid description.

c. Classpath: Enter the absolute path where the JARs related to Jersey 2.x and Jackson 2.9x are copied.
These jars are available in the <OFSAA_HOME>/utility/externallib/WEB-INF/lib directory after creation

of the EAR file.

3. Select Use an isolated class loader for this library.
Click OK to save to master configuration.

Select the application or module and map the shared libraries. Click OK. In the following illustration, ofsa is

selected.

Enterprise Applications

Shared Library Mapping for Modules

scope.

Reference shared libraries ]

Select Application
Ld cofsa
Select Module

L OFSAAL Web Application

OK || Cancel

Enterprise Applications > ofsa > Shared library references

URI

META-INF/application.xml

URI

ofsa.vwar, WEB-INF/web.xml

Specify shared libraries that the application or individual modules reference. These libraries must be defined in the configuration at the appropriate

Shared Libraries

Shared Libraries

6. From the Shared Library Mapping window, move the required shared libraries from Available to Selected.
In the following illustration, JERSEY2x is selected.

Enterprise Applications

Map libraries to the application or module listed

OFSAAI Web Application

Map shared libraries to an entire application or to one or more madules.

Enterprise Applications > ofsa > Shared library references > Shared Library Mapping

Available:

Mew. ..
OK Cancel

Salect the library in the Available list. Move it to the Selected list by dicking >>.

o
Kl

Saelected:

JERSEY2x
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7. Click OK.
8. Similarly, select the next application or module and repeat the procedure from steps 5to 7.

Enterprise Applications ? =

Shared Library Mapping for Medulas

Specify shared libraries that the application or individual modules reference. These libraries must be defined in the ccn"igurc:lcr at the appropriate
SCODE.

Reference shared librarias

Select | Application URI Shared Libraries
ofsa META-INF/application.xml JERSEY2x
Salect| Module URI Shared Libraries
OFSAAL Web Application ofsa.wan WEB-INF/wab.xml JERSEY2x
OK | | Cancel

9. Disable the built-in JAX-RS via JVM property.
a. Go to WebSphere admin console in Servers > WebSphere Application Servers > yourServerName.

b. In Server Infrastructure section, go to Java and Process Management > Process definition > Java
Virtual Machine > Custom properties.

c. Add the following property:
com.ibm.websphere.jaxrs.server.DisableIBMJAXRSEngine=true

10. Restart the application.
WebSphere HTTPS Configuration

Following are the steps for configuring an HTTPS Transport on WebSphere:

Create a profile using the Profile Creation Wizard in WebSphere.

2. Note down the https port specified during this process and use the same as servlet port or web server port
during OFSAAI installation.

To enable https configuration on Infrastructure, assign value 1 to "HTTPS ENABLE" in
OFSAATI InstallConfig.xml for SILENT mode OFSAAI installation.

WebSphere Memory Settings

To configure the WebSphere Memory Settings:

1. Navigate to Websphere applications server > Application servers > server1 > Process definition > Java
Virtual Machine.

2. Change the memory setting for Java Heap:
o Initial heap size = 512
o Maximum heap size = 3072
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Configuring WebSphere for REST Services Authorization

Configure the following in WebSphere to enable REST API authorization by OFSAA:

1. Log on to WebSphere console with the User ID provided with the admin rights.
2. Expand Security menu in the LHS and click Global security > Web and SIP security > General settings.

0 ena Closs page
View: | A1 tasia v
. Global secyrity > Web security - General settings Fisld halp
For fiald halp information,

salect & fiald inbel or fat
marker whan the help cursor

Spacifies the settings for wb authentcation,

Camersl Bropaiies :
—_— s displayed.
= = Web authentication behavior Page help
(8] authanticate only whan the URI i protected L
REgE

¥ Use available authantication dats whan an unprotected URT is accessed

Authenticate whaen any UR1 is accessed

Dafault to basic authentication when certificate authentication for the HTTPS client fails

LApety || OK | | Resst || Cancel |

rization Grougs

¥ Managemant

(4] Users and Groups

(3 Mennsrag and Tusing
() Sarvica integratian
3 v

3. De-select the Use available authentication data when an unprotected URI is accessed check box.
4. Click OK.

| WebSphers. [% 7

Cless page

e e = | bl ettty 7 Q|

[ e Fisld help
e For fiald hal
&y Changes have been made to your bocal configuration, You cani Rrlimr].
B Sarvmny « Save directly to the master cenfiguration. markar whan
is desplayed.
I# Appbcatians » Baview changes before saving or discacding. e
# Servicas Page halp
(B Tha narver may reed to ba restarted for thass changas to take affact, Feefmy

Global security

Use this pans! to configure administration and the default appiication security policy. This security cenfiguration apples to the security policy for all administrative
functisng and i used a1 & default security policy for user applications. Securty domaing cam ba defined to cvarride and customize the security policies for uner

applicatigns,
Security Configuratien Wizand Securty Configuration Repeet |
Administrative security Authentication
B Gnable sdmisisirative securhy AT g AuAhantieation machanisms and axpiration
Admircgtratove groyus roles ® oTee
Adminitrative aythentication Karbarcs and LTPA
Earbaroy configuration
Application security SWAM (deprecated): No autharticated communication batvesn sarvers

L RO LR LR S )

@ Web and SiP security

Enabls applization sscurity

Java 2 security @ RMUTIOP se
Use Java I secunty to restrct applicaton sccess to local rescurces B Java Authentication and Authorizaton Service
+
Enaible Javn Authantication SP1 {JASDI)
Broviders
User account repository 1na rualm-nunlifind (mar namas

5. Click Save to save the changes to master configuration.
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Configuring Application Security in WebSphere

This is a mandatory security procedure for WebSphere to restrict the unauthorized access of configuration files
in directories. For detailed information, see the Oracle Financial Services Analytical Applications Infrastructure
Security Guide.

Configuring WebLogic for Application Deployment

You can deploy multiple Infrastructure applications on different domains of a stand-alone WebLogic application
server. To create multiple WebLogic "Domains" in a stand-alone server you can use the Domain Creation
wizard. A domain is the set of files that define the runtime environment. At least one domain must exist to run
WebLogic Application Server.

Note: For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download and install patch
18729264 from My Oracle Support.

This section includes the following topics:

*  Creating Domain in WebLogic Server

* Delete Domain in WebLogic

*  WebLogic Memory Settings

*  Configuring WebLogic for REST Services Authorization

Creating Domain in WebLogic Server

To create a new domain using Configuration Wizard in WebLogic, do the following:

1. Navigate to the directory <WLS_HOME>/wlserver/common/bin and execute the command:

./config.sh
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The Configuration Type window of the Configuration Wizard is displayed.

Configuration Type ORACLE i j
FUSION MIDDLEWARE

. Oreate Dosmakn
Templates
Administrator Account

Domain Mode and |DE

Advanced Configuration
Configuration Summary

‘What do you want to do?

& Create a new domain

Update an existing dom zin

Domain Location: | Jracle fMiddieware fOracle_Homefuser_projects fdomains /base_dom ain Browse

Créate & nisw dom 2in
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2. Select Create a new domain option and click Next to display the Templates window.

[18)] Fusion Middieware Configuration Wizard - Page 2 of 8@ofs5220601

Templates

Create Domain

Temp lates
AdeminiZtrator ACCount
Domain Mode and JOK

Advanced Configuration

——f—C——i

CuMiguratien Summ!!

Configuration Progress

End Of Configurat|

Help

ORACLE

FUSION MIDDLEWARE 0‘

) Create Domain Uzing Product Templates:

Template Categories: All Templates

Avallable Templates

|+ Basic Weblogic Server Domain - 12.2.1.2.0 fwizerver] *

| | Weblogic Advanced Web Services for JAX-RPC Extension - 12.2.1.2.0 [oracle_common]
|| Weblogic &dvanced Web Services for JA-WS Extension - 12.2.1.2.0 [oracle_common]
| | Weblogic Coherence Cluster Extension = 12.2.1.2.0 [wiserver]
|| Weblogic JAX-WS SOAR/IMS Extension - 12.2.1.2.0 [oracle_comman]

Create Domain Using Custom Template:

< fack Mext > Cancel
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3. Select the Create Domain Using Product Templates option and click Next to display the Administrator
Account window.

3] Fusion Middleware Configuration Wizard - Page 3 of 8@0f:5220601

Administrator Account

Create Domain

TEMEH.ICS
w  Administrator Account

Domain Mode and DE
Advanced Configuration

¥ Configuration Summary

Configuration Progress

End Of Configuration MName

Password

Confirm Password

User name may not contain commas, tabs, or any of the following characters: <># &7{(}

Help | < Back ; Mext = Cancel
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4. Enterthe user name to be assigned to the administrator, the password and confirm the password. Click Next
to display Domain Mode and JDK window is displayed.

= = = e
3] Fusion Middleware Configuration Wizard - Page 4 of B@ofss220601
Domain Mode and JDK _ORACLE"
FUSION MIDDLEWARE
4. Create Domain ]
_p Domain Mode
TgrrlEIMH
T o) Developm ent
Administrator Account
T Unilize boot properties for usernam e and password, and poll for applications 10 deploy.
w Domain Mode and JDE
| Production
. Advanced Configuratios : SR
T anced Configuration Require the entry of 3 username and password, and do not poll for applications to deploy
¥ Configuration Summary
< Configuration Progress IOk
g ) Qracle HotSpot 1.8.0_45 fusrfjava/jdkl 8.0_45
End Of Configuration
Other JDK Location:

Help

< Back Lﬁ?_‘ Cancel

5. Select from the following options:
o Inthe Domain Mode section, select the required mode (Development or Production).

o Inthe JDK section, select the required option. If you select Other JDK Location, click Browse,
navigate to the JDK location, and select.
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Click Next to display the Advanced Configuration window.

Advanced Configuration

Create Domain
Templates

Administrator Account
Domain Mode and |DK
Advanced Configuratbon

AdminiZIrstion Server

——€—F——6—F—)

Configuration Summa
Configuration Progress

End Of Configuration

Help

| 3 Fusion Middleware Configuration Wizard -

ORACLE
FUSION MIDDLEWARE

« Administration Server
Modify Senings

Nodde Manager
Configure Node Manager

Topology
Add, Delete or Modify Settings for Managed Servers, Clusters, Virtual Targets and Coherence

< fack | Mext = ] Cancel
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6. Select Administration Server. A WebLogic Server domain must have an Administration Server. You can
also select Manages Servers, Clusters and Machines and RDBMS Security Store, if required. Click Next
to display the Administration Server window.

[ | Fusion Middieware Configuration Wizard - Page 6 of 3@ ofss220601

Administration Server

ey Create Domain

Ttnlplmt:

Adminizirator ACCount

Domain Mode and DK
. Advanced Configuration

w  Administration Server

o Conf.gurarlon Su.'nmae_'\f

Help

Server Name AdminServer
Listen Address Al Local Addresses

Listen Port 9091

Enable 5L

ZSL Listen Port

-
Port numbeér must be betweén L and 65535, and différent from S5L listen port and cohérence port

< Back ezt =

_ORACLE"
FUSION MIDDLEWARE

Cancel

7. Enter Administration Server details such as the Server Name, Listen address, Listen Port, Enable SSL
(for secure login using https, select this check box), and SSL listen port.

Click Next to display the Configuration Summary window.

Note: Make a note of the Listen Port or SSL Listen Port value (for example: 7007), since the same has to
be re-entered in the Servlet port field during Infrastructure installation.
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OoRACLE

Configuration Summary S

Create Domain ¢ View | Deployment = Hame Basic WebLogic Server Domain

—— | Description  Create a basic WebLogic Server domai
HEmplEieE (= base_domain {/scraich/806wls/Oracle/Middleware, , it Chrsaralog

Administrator Account B = server Lacation fsoratchfE06ws fOracle Middisware f

[ Adminierver
Domain Mode and JDK

dudvanced Cnrmnura.lmn
Administration Server
w Configuration Summary

Configuration Prograss

End Of Configuration

1] P 1

Select Create to accept the above options and start creating and configuring a new domain, To change the
above configuration before s1aring Domain Crestion, go Back 10 the relévant page by selecting its name in
the left pane, or by wzing the Back button.

8. Verify the configuration details of the WebLogic domain and click Create.
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The Configuration Progress window is displayed with the status indication of the domain creation process.

Configuration Progress

Create Domain 1

3] Fusion Middleware Configuration Wizard - Page 8 of 980f;5220601 ]

ORACLE
FUSION MIDDLEWARE

*

Templaies [

< Adminizirator Account Copy Unprocessed Artifacts
Security Processing
Artifacts Ceneration

String Substitution

Past Processing

o Domain Mode and |DK

Advanced Configuration

Talefefefe

Administration Server
Configuration Summary
Configuration Progress
End Of Configuration

€—i—

Help

9. Click Next when 100% of the activity is complete.

100%

Mext =
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The End of Configuration window is displayed

-
t] Fusion Middleware Configuration Wizard - Page 9 of 9@ofss220601

End Of Configuration ORACLE

FUSION MIDDLEWARE

+# Oracle Weblogic Server Configuration Succeeded
New Domain base_domain Creation Succeeded
Do ain Location

fsoratch (E06wls ) Oracle fMiddlsware fOracle Homefuser_projacisfdomains/base domain

ol

Admin Server URL
http: ffofss220601:909]1 fconsols

w End OFf Configuration

Help Einish

10. Click Finish. The domain server is created enabling the deployment of multiple Infrastructure applications

on a single WebLogic.

Note: Note down the HTTPS port specified during this process and use the same as servlet port or web

server port during OFSAAI Installation.

To enable https configuration on Infrastructure, assign value 1 to "HTTPS ENABLE" in

OFSAATI InstallConfig.xml for silent mode OFSAAI installation

Add a java option entry -DUseSunHttpHandler=true iN WLS HOME/bin/ "setDomainEnv.sh" file

(Required only if self signed certificate is used).
Delete Domain in WebLogic

1. Navigate to the following directory:

<WebLogic Installation directory>/user projects/domains/<domain name>/bin

Execute stopWebLogic.sh to stop the Weblogic domain.
Delete the Weblogic domain.
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WebLogic Memory Settings

To configure the WebLogic Memory Settings:

1. Change the memory setting for Java Heap to -xms512m -Xmx3072min setDomainEnv. sh file, which resides
in the folder <poMAIN HOME>/bin and in CommEnv. sh file which resides in the folder common/bin.

Edit this file for customizing memory settings and garbage collector settings depending on the available
hardware configuration.

Example 1:

if [ "${JAVA VENDOR}" = "Sun" ] ; then
WLS MEM ARGS 64BIT="-Xms512m -Xmx1024m"
export WLS MEM ARGS 64BIT

WLS MEM ARGS 32BIT="-Xms512m -Xmx1024m"
export WLS MEM ARGS 32BIT

else

WLS MEM ARGS 64BIT="-Xms512m -Xmx1024m"
export WLS MEM ARGS 64BIT

WLS MEM ARGS 32BIT="-Xms512m -Xmx1024m"
export WLS MEM ARGS 32BIT

+  Example 2:

JAVA VM=
MEM ARGS="-Xms256m -Xmx1024m"

Configuring WebLogic for REST Services Authorization

To enable REST API authorization by OFSAA in WebLogic, perform the following steps:

1. Open the config.xml file located in the domain where OFSAA is deployed, that is <domain home>/config/

config.xml
2. Add the following in the security-configuration tag:

<enforce-valid-basic-auth-credentials>false</enforce-valid-basic-auth-credentials>
Updating Atomic Schema Data Source in Web Logic

To Disable the Wrap Data Types for the Atomic schema data source in Weblogic 12.2, execute the following
steps:

In the Change Center of the Administration Console, click Lock & Edit.

In the Domain Structure tree, expand Services, then select Data Sources.

On the Summary of Data Sources page, click the data source name.

Select the Configuration: Connection Pool tab.

Scroll down and click Advanced to show the advanced connection pool options.
In Wrap Data Types, de-select the checkbox to disable wrapping.

Click Save.

To activate these changes, in the Change Center of the Administration Console, click Activate Changes.

© No g kv b=
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9. Redeploy the Data Source and restart all the services.

Configuring Apache Tomcat Server for Application Deployment

This section is applicable only when the Web Application Server type is Tomcat.

This section includes the following topics:

Tomcat User Administration

Configure Tomcat to use JAVA 64 bit Executables

Configure Servlet Port

SSL Port Configuration

Apache Tomcat Memory Settings

Configuring Tomcat for User Group Authorization, Data Mapping, and Disabling WADL for the Web Service
Uninstalling WAR Files in Tomcat

Configuration for Axis API

Additional Configurations for Tomcat

Tomcat User Administration

The Tomcat administration and manager application does not provide a default login. You are required to edit
"SCATALINA HOME/conf/tomcat-users.xml" as instructed below.

This file contains an XML tag <user> for each individual user, which will display the user name and password
used by admin to log on to Tomcat, and the role names to which the admin user is associated with. For example,
<user name="admin" password="admin" roles="standard-manager " />

1.

Add the manager role to any one of the existing user name/ password combination as shown in the example
above.

Use the same user-name/ password to which the manager role has been assigned to access the Tomcat
Application Manager.

If the Tomcat server is already running, it requires a re-start after the above configuration is done.

Configure Tomcat to use JAVA 64 bit Executables

1.

Navigate to the "$CATALINA_HOME/bin" folder.

Edit the setclasspath.sh as explained below:

Replace the following block of text:
# Set standard commands for invoking Java.
_RUNJAVA="$JRE_HOME"/bin/java
if [ "$0s400" != "true" ]; then
_RUNJDB="$JAVA HOME"/bin/jdb

With:
# Set standard commands for invoking Java.

_RUNJAVA="S$JAVA BIN"/java
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if [ "$0s400" != "true" ]; then

_RUNJDB="$JAVA BIN"/jdb
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4. If the Tomcat server is already running, it requires a re-start after the above configuration is done.

Note: In case tomcat is installed under different Unix profile, set JAVA_BIN environment variable in .profile
to include the Java Runtime Environment absolute path.

For example:

export JAVA BIN /usr/java6 64/jre/bin
export JAVA BIN = /usr/javaé_64/jre/bin//sparcv9 for Solaris Sparc.

Configure Servlet Port

The default servlet port configured for the Tomcat installation is 8080. Ignore this section if you need to use the
default port.

If you need to use a different port number, you must first configure the port in the "server.xml" in the "conf"
directory of Tomcat Installation directory. The following steps guide you through the configuration process:

1. Navigate to $cATALINA HOME/conf. Open server.xml and locate the tag:
"Define a non-SSL HTTP/1.1 Connector on port 8080 "

2. Against this tag, a parameter is specified 'Connector port = "8080" '. Edit this value to the new port number
that will be used during the installation process.

3. Save your changes in server.xml.

Note: Make a note of the servlet port configured. This information is required during the installation of
OFSAA Application Pack.

SSL Port Configuration

If you need to configure and access your OFSAA setup for HTTPS access, ensure that the following connect
tag under "Define a SSL HTTP/1/1 Connector on port 8443"in"<Tomcat installation folder>/conf/
server.xml" file is uncommented for SSL Configuration. (By default, it is commented).

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"
maxThreads="150" scheme="https" secure="true"

clientAuth="false" sslProtocol="TLS"

Note: Make a note of the servlet port configured. This information would be required during the installation
of OFSAA Application Pack. To enable https configuration on Infrastructure, assign value 1 to
"HTTPS ENABLE" in OFSAAI InstallConfig.xml for SILENT mode OFSAAI installation.

For more information related to SSL Configuration on Tomcat, see http://tomcat.apache.org/.
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Apache Tomcat Memory Settings

To configure the Apache Tomcat Memory Settings:

1.
2,

Locate the file catalina.sh which resides in the folder <cararina HOME>/bin.

Edit this file for customizing the memory settings and garbage collector settings depending on the available
hardware configuration.

Add the memory setting for Java Heap to -xms512m -Xmx1024m.
Example:

if [ -z "SLOGGING MANAGER" ]; then

JAVA OPTS="S$JAVA OPTS -Xms512m -Xmx1024m
-Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager"
else

JAVA OPTS="$JAVA OPTS -Xms512m -Xmx1024m $LOGGING MANAGER"

Fi

Configuring Tomcat for User Group Authorization, Data Mapping, and Disabling WADL
for the Web Service

Users with system authorization roles can access User Group Authorization. However, to make it available on
Tomcat web server, you have to perform the following configuration steps:

1.
2,

Navigate to the sF1C_WEB_HOME/webroot/WEB-INF/ folder and open web.xml file.
Enter the following in the web . xm1 file.
<init-param>
<param-name>mappedfile</param-name>
<param-value>false</param-value>
</init-param>
To disable the WADL for the Web Service, navigate to the following snippet in the web.xm1 file.
<servlet>
<servlet-name>CommonRESTServlet</servlet-name>
<servlet-class>org.glassfish.jersey.servlet.ServletContainer</servlet-class>
<init-param>
<param-name>javax.ws.rs.Application</param—-name>

<param-value>com.ofs.fsapps.commonapps.util.ApplicationResourceConfig</param-
value>

</init-param>

<load-on-startup>1</load-on-startup>

</servlet>

Add the following snippet before the <1oad-on-startup>1</load-on-startup> attribute.

<init-param>
<param-name>jersey.config.server.wadl.disableWadl</param-name>
<param-value>true</param-value>

</init-param>

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0 113



Post-Installation Configuration

5. Save and close the file.

Uninstalling WAR Files in Tomcat

To uninstall WAR files in tomcat, see Uninstalling WAR Files in Tomcat.

Configuration for Axis API

This step is optional and required only if the web application server used in Apache Tomcat. If you use any other

web application server, skip and proceed to next step.

Copy the jaxrpc.jar from the <0Fsaa Installation Directory>/axis-1_4/webapps/axis/WEB-INF/1ib
and place it in under <Tomcat Installation Directory>/1ib and restart the Tomcat Server.

Additional Configurations for Tomcat

To stop generating static content with one print statement per input line, you need to configure the web . xm1 file.
To configure web . xm1 file, perform the following steps:

1. Navigate to tomcat/conf folder.
2. Edit web.xml file as explained below:
Set the mapped file parameter to False in the servlet tag mentioned with

<servlet-name>jsp</servlet-name>.
<init-param>
<param-name>mappedfile</param-name>
<param-value>false</param-value>

</init-param>

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0 114



Post-Installation Configuration

Configuring Work Manager in Web Application Servers

Process Modelling framework requires creation of Work Manager and mapping it to OFSAA instance. This

configuration is required for WebSphere and WebLogic Web Application Server types.

This section covers the following topics:

«  Configuring Work Manager in WebSphere Application Server

«  Configuring Work Manager in WebLogic Application Server

Configuring Work Manager in WebSphere Application Server

This section is applicable only when the Web Application Server type is WebSphere.

This section covers the following topics:

*  Creating Work Manager

* Mapping Work Manager to OFSAA WebSphere Instance

Creating Work Manager

1. Open the WebSphere admin console in the browser window: http://<ipaddress>:<administrative console
port>/ibm/console. (https if SSL is enabled). The Login window is displayed.

I sottare

my jurigdect

==

WebSphere Integrated
Solutions Console

UseriD

admin

Password

||uuu|| -w-l

d WebSphere are trademarks or
zx Machines Corp., registered in

igns vwarldvide. Other product and service names might be
trademarics of [BM or other companies. A& cument lisk of IBM trademarks is
avallable on the Web at Cogpyright and trademark information.
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2. Login with the user id that has admin rights.

Aboul this Ibegrated Solitians Eomaale

Ertwgrated Sclutions Conmcle provides & commaon imatrative comsole for mulbple products. The table Integrated Solubons Conscle, §.3.3.0
Latn tha peoduct Buten that tan Ba sdminitbared tuough this inutslistion. Salact & produt puts b wew Buld Mumbaer gmi319.01 -~
i Jareary. mors information. Buts Cate 3

LICERSED MATERIALS FROPEATY OF 1838
5734-308, 5724-063, 3734- M0, 3734 09, 3433-wid3 [E) Copyright
* Banices Sulte Noms Versten Ertarastionsl Businass Muchioes Cors. 1994, 2012 b
WabEahens Arstoation Seroe 8330
® Resswrcen

Taed help
Work managers
For fiald halp isdprmanion, peleet
Spachies 8 warks mansger et containg & poo! of Threads that are boynd inso the Jeva(TH) Naming snd Cirestory Intertace (01}, & Tl Labal o gt maricer mhan
B X e Rl cursor is diplayed
Vage halp
Senza apscdion tha leval st which tha rescures dafieibion ia vinkla. For detaled ismation on what seops b M infemation Al this
ad how A morki, G249 Ehe iiode Seltadi hals, azs

| T e r—

otn pdminratics arrpeg
il & Freferences b

ER

#l J08C | T

S — -
Cru—— Lo e sk

s Saiuct Name T ICL name Soope Owscription £ Category =
: s Yous can administer the folicming rescurcen:
# Cake matancas : e
i Wiakianager
o
E Ty p— Totsl 1
¥ Sacurty
& Riroamant

* Syvam sdminisrates.
# Wnars sad Grewps

» Mpsteriag and Taning
= Troeblusbestiog

= Sanece mtagration

= weod

4. Select the required Scope from the drop-down list

For example, Node=whf0OaqnNode01, Server=server1.
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5. Click New in the Preferences section.

Biwch gy > Sew—

Bpmitan 4 sk —acapr S eiacs 8 et o Frands Pl e el oS e e TE ey aed Grmbery Dt S0

s ]

B Feamin
b S e o Swndy
13 rands
e
a Armns
* Toappy Py
s pery
A Grmbin
Etﬂ Sl L |

e s R D T B L e e et
P Pt . 5 ] & i

6. Enter the Name as 'wm' and JNDI name as 'wm/WorkManager ' in the respective fields.
7. Enter the Thread pool properties.
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8. Click Apply.
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* Guided Activiciar

+ Sarven

+ Applications

# Sarvices

= Rasources

" Sehatulers
= Object pasl managers

¥ Rasewrce Adapress
= Aaynchrestes beans

Thmar manspars

= Werk managers
# Cacha instancas
B Mgl
B un
# Rasswres Exviconment
(¥ Security
(& Envirsamant
+ Syatem sdminiztration
# Urers and Grovpn
# Maaitpring and Tuning
* Trovilaakaating
'+ Sarvice mtegration
* woor

= Messages

& Changes have been madae te your local configuration. You eant

= Suve dicectly to the master configuration,
= Eavigw changes bafore saving or discarding.
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9. Click Save.
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After creating work manager successfully, you have to map it to OFSAA instance.
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Mapping Work Manager to OFSAA WebSphere Instance

1. From the LHS menu, expand Applications > Application Types and select WebSphere enterprise
applications.

= ———
Websphers. [0

[ v L'aun [T |

. Wk
B Dubded Activichs Enterprive Apploations
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o) ey A kel [5t] [ 3200 || 1nstan || wninatst || updste | Rolloutupdste || Remove File || txport || txport£OL || txpon Fie
= Application Typas
. B0
Selsct Nama & Application Status €
o can administer the followng ressurces |
[ |Reiauithopication L
& | e£ssal +
[ |tecoamacsss: +*
O UAAEE +*
O |ewex +
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L

= Adyncheonca basss Tatal
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& mud

® UL

% Rasource Eavirgament
® Sacurty
* Envirenmunty
* SyErm agmaipanan
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* Trosblasheating
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* ubDl
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2. Click OFSAAI instance hyperlink.
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4. Click Browse corresponding to the Work Manager Resource Reference. The available resources are

displayed.
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5. Select the newly created Work Manager (‘wm') and click Apply.
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6. Select the Work Manager ('‘wm/WorkManager') and click OK.
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7. Click Save.
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Configuring Work Manager in WebLogic Application Server

This section is applicable only when the Web Application Server type is WebLogic.

1.

port>/console. (https if SSL is enabled). The Welcome window is displayed.

Open the WebLogic admin console in the browser window: http://<ipaddress>:<administrative console

ORACLE Wablogic Senvr admnasaton Gonis 13c

2. Login with the user id that has admin rights.

3. From the Domain Structure menu in the LHS, expand Environment and select Work Managers. The

Summary of Work Managers window is displayed.
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4. Click New to create a new work manager component.

Creste » Mew Work Hanager {omposent
st v Cancel

Select Work Manager Definition type
what type of Work Manager, Reguest Class or Constraent do you want 1o creste?

» Wark Manager
Response Tene Reguest Class
Fair Share Rogecst Clais
Context Request Clias

Maximism Threads Constraint

Minimmum Threads. Constramit
Caparity Consbraint
Pigal I afid® Cangel

5. Select Work Manager and click Next.

) Home LogOut Praferences [B] Record Helo Q,

Boamd - amamsmy of Weork B neger

Create & New Wark Manager Compsient
Bk Pt eyt cance

Waork Mansger Propertics
T Foliovery propactied vwill b uted to hantly your fre Wik Manasger.

What wanldl o ol b3 FamE piaar e Wk Marager?

" M wm/WorkManager|

Bk bt Findab wangel

=

6. Enter the Name as 'wm/WorkManager'.
7. Click Next.

£ el & Mo Wik Marages © meegeeseed
B &4 T v Canca

Sk | lerpllcryrrarssd Lasgerts

Anadlibds Largecy

Serrwery

 admaniorver

B st ¥ v Cancal

Tions oo Eaeget T Work Marages 50 arw of These Wabloge Toreer insanom of Chasers. Saboct S weme Saegety or shach wou will Seploy applcafions Bef spforeron T Veorh Sarager
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8. Select the required deployment target and click Finish.
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Disabling Data Types in Web Logic
By default, data type objects are wrapped with a WebLogic wrapper. You must disable wrapping which can
improve performance and allow Profitability Management applications to use native driver objects directly.

For detailed instruction to disable the Data Types in Web Logic, see Disable wrapping of data type objects.

Creating and Deploying EAR/WAR File

This section includes the following topics:

* Creating EAR/WAR File
+ Deploying EAR/WAR File

Creating EAR/WAR File

To create EAR/WAR File, follow these steps:

Navigate to the srrc weB HOME directory on the OFSAA Installed server.
Execute ./ant.sh to trigger the creation of EAR/ WAR file.

On completion of the EAR files creation, the "BUILD SUCCESSFUL" and "Time taken" message is
displayed and you will be returned to the prompt.

4. The EAR/ WAR file - <contextname>.ear/ .war - is created.
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Note: The <contextname> is the name given during installation.
This process overwrites any existing version of EAR file that exists in the path.
In case of OFSAA configured on Tomcat installation, <contextname>.war will be created.

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0 127



Post-Installation Configuration

Deploying EAR/WAR File

This section includes the following topics:

* Deploying EAR/WAR Files on WebSphere
* Deploying EAR / WAR File on WebLogic
* Deploying WAR Files on Tomcat

Note: Ensure to clear the application cache prior to the deployment of Application Pack Web Archive. This is
applicable to all Web Servers (WebSphere, WebLogic, and Tomcat). For more information, see Clearing
Application Cache section.

Deploying EAR/WAR Files on WebSphere

To deploy WebSphere EAR/WAR File, follow these steps:

1. Start WebSphere Profile by navigating to the path "/<websphere Installation Directory>/IBM/
WebSphere/AppServer/profiles/<Profile Name>/bin/" and execute the command:
./startServer.sh serverl

2. Open the WebSphere admin console in the browser window:

http://<ipaddress>:<administrative console port>/ibm/console. (https if SSL is enabled). The
Login window is displayed.

2N sotvare
WebSphere Integrated
Solutions Console
e
=] =
 Login

3. Enter the user credentials with admin privileges and click Log In.
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4. From the LHS menu, select Applications and click New Application to display the New Application

window.

Mew Application

New Application
This page provides links to create new applications of different types.
Install a New Application

Mew Enterprise Application

[inhl.v in | Appli n
@NVA g

5. Click New Enterprise Application to display the Preparing for the application installation window.

Preparing for the application installation

Specify the EAR, WAR, JAR, or SAR module to upload and install.

Path to the new application

' Local file system

® Remote file system

Full path

|."5cra tchf/oracle/was855/profiles/ TESTE0AAL/AATS(
Nextl Cancel l

-

6. Select Remote File System and click Browse. Select the EAR file generated for OFSAA to upload and

install. Click

Next.

Preparing for the application installation

How do you want to install the application?

9 Fast Path - Prompt anly when additional information is required.

Detailed - Show all installation eptions and parameters.

# Choose to generate default bindings and mappings

I Pravious I le Cancel
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7. Select the Fast Path option and click Next to display the Install New Application window.

Specify options for installing enterprise spplications and modules.
=¥  Step 1: Select Select installation opltions

installation options

Spacify the varicus oprions that are available for your application,

Ll Pracompila JavaSarvar Pages files

Step 3 Summary Directory to install application

¥ pistribute application
[7] use Binary Configuration

Ll Dreploy entarprise beans

Application nama
[aaran

2] Create MBeans for resources

[”] overrde class reloading settings for web and EJB modules

Raload interval in seconds

D Deploy Web services
Validare Input offwarn/fail
WA @ *

|:| Process ambaddad configuration

Fila Parmiccion

Allovs all files to be read but not written to
Allow executables to execute
Allow HTML and image files to be read by everyone

[FLdll=755%, F | ao=7 558, %\ aaT55#. % 5|=7 55

Application Build ID
[nknown

[ allow dispatching includes to remote resources

D Allow servicing includes from remote resources

Business |level application name
Create New BLA x

Asynchrancus Requast Dispatch Typs
Disablad -

E allow E28 reference targets to resclve automatically
[C] Daploy elisnt modulas
[=clated il

“alidate schema

Naat|| Cancal
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8. Enter the required information and click Next to display the Map Modules to Servers window.

Inatsll Mew Applicatson

Spacify aptians for installing snterprizss applications and medulas,

Step 1 Felect Map modules te sarvars

inatallation optisna

Epecify targets such as application servers or clusters of application servers where you want to install the madules that are

=  Skep 2: Map madules comtaingd in yous spplication, Modules can be installed on the same application server or disparied smang seversl application
b sdvier s sarvars. Alss, spacify tha Wab sercars as targets thar serva as reutars for raqeases w2 this applicaten, Tha plug-in

configwration file [plugin:cfg.=ml] for sach Web server iz generated, bazed on the applications that sre routed throwgh.

Stép 3 Summan
A i Clustars and sarvars:

| WebSphereicell=ofss231 17 01 NodelZ Cell.node=afss23117 01 Node2 server=server 1 apply

e |
Select Module  URI Server |
T OFSaAL AATEO, war WEB- WebSpheraicell=ofs5231 1701 Mede02 Call.node=ofss221 17 01 NodeD 2 server=sarverl
7 wa,
£ :p‘:ll:ldan INE/web.om]

Pravisus || Next| Cancal |

9. Select the Web Application and click Next to display the Map Resource References to Resources
window.

specify aptions for insealling esterprise applicatons and modubes.

‘Map resource references to resources

Each resource reference that & delved o your apglcabon must be magped bo a resounce.

sdules 5
=

—* Step 3 wapresosce Set Multiphe MO Names * ] Moddy Gaecurce Auttanticahnn Mathod. . | [ txtandsd Propertms .|
TR 10 M

Semp d: Map wirtusl

hosts to Wel modubes. E E

Stmp S Summary Selact Modua M-[I.Iﬂ | Rmsourta Aefarencs  Target Aascurca MO Nama  Legn confguration
RESOUFCE

. authanzation:
OFEALE Wk AATBO war, WEB. jdbeiOFSALMINID = N Eomtainer
Appicabon ot wab.eel Browie... Auihasticalion
i thad !

Resource
ShONE Ao

jeec/ FICMASTER Container
Auther b ation
i chaed

OFSAAL Web AAIBD war, WES-
Apchcation tHF s T TR

Respurce
authonzation:
[ciorscaratganra | Container
GFEAAL Web mlr:rwﬂ- HbefOFSCARADQINIG | Browse..,
? Authanbcaton

mathesd;

Pravious | Finish Cancal ]

10. Map each resource defined in the application to a resource JNDI name defined earlier.
11. Click Modify Resource Authentication Method and specify the authentication method created earlier.

You can specify "config" for FICMASTER resource or "atomic" for atomic resource as the authentication
method.
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12. Select the OFSAAI Web Application check box and click Next to display the Map Virtual hosts for Web
Modules window.

Install New Application

Step 1 Salect
installation options

Step 2 Map
modules to servers

Step 3 Map

resource referances
to resources

Step 4: Map virtual
hosts for Wab
modules

Step § Summary

Specify options for installing enterprise applications and modules.

Map virtual hosts for Web modules

them among several hosts.

E Apply Multiple Mappings

& B

Specify the virtual hest where you vant to install the Web modules that are contained
in your application. You can install Wab modules on the sama virtual host or disperse

Select Web module

[¥] | oFsasl web Application

| Previous ] Nexﬂ | Cancel |

Virtual host

?_de_!'_l_ul_t__']n_n VJ

13. Select the Web Application check box and click Next to display the Summary page.

Step 1 Select
installation options

Step 2 Map
modules to servers

Step 3 Map
resource referances
to resources

Step 4 Map virtual
hosts for Web
modules

Step 5: Summary

Spacify options for installing anterprise applications and modules.

Summary

Summary of installation sptions
il B
 Precompile JavaServer Pages fles

Dirgctory to install application

Distribute application
:llqo Rinary Canfiguratian
Deploy enterprise beans
_Apllif_m:ion name

Create MBeans for resources

Overrice class reloading settings for Wed and EJE
modules

Relzad interval in gecands

Deploy Web services

Validate Input off wam/fail

Frocess ambadded configuration

Filg Permizsion

Application Build ID

Allew dispatzhing includes to remete resources
Allgw servicing ingludes from remote resources
Business lewel application nama
Asynchronows Requast Dispatch Type

.Allnw EJB reference targets to resolve astomatically
Bagloy rliant madulas

-Cllem: deployment mode

-Vlldlll schema

c‘llJ'NI.dI,l'BlNu

| _previous | Finish || Cancel |

I Valuas

Mo

Yes

AATBOD

Yas

i Sudli=7 55l."Lu-?55'.'\.!'755'-‘\-!"?55:
| Umkngwn

Ne
I MNa

Disablad
C
| MNa
Isolated
. Mo

| Slick hers

14. Click Finish and deploy the Infrastructure Application on WebSphere.

15. On successful installation, a message is displayed. Click Save and save the master file configuration. The

details are displayed in the Master File Configuration window.

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0

132



Post-Installation Configuration

To start the application:

1. Expand Applications > Application Type > WebSphere enterprise applications to display the
Enterprise Applications window.

Enterprise Applications TE

Enterprise Applications
Use this page te manage insealled applications, A single spplication can be deployed ento multiple servers.

& Preferences

@ Stop || Install | Uninstall Updara Rallout Update Ramava Fila | Export Expart DOL Expart Fila
=Ll e
Select Name £ Application Status £

Wou can administer the following rescurces:

Aals0
sfayletpplicprion

ivtépp

%+ =

quary

Toral 4

2. Select the installed application and click Start.

Note: <profile name> is the profile name given while creating the WebSphere profile.
<cell name> is the cell name given during profile creation.
<contextname> is the context name given during installation.

Deploying EAR / WAR File on WebLogic

Following are the steps for deploying Infrastructure application that would be created during installation:

1. Navigate to the path <WebLogic Installation directory>/user_projects/domains/<domain name>/bin in the
machine in which WebLogic is installed.

2, Start WebLogic by executing the command:
./startWebLogic.sh -d64 file

3. Open the URL in the browser window: http://<ipaddress>:<admin server port>/console. (https if
SSL is enabled). The Sign in window of the WebLogic Server Administration Console is displayed.

Note: Ensure that you have started Infrastructure Server by executing "./reveleusstartup.sh" as mentioned
in Start Infrastructure section.

4. Log on to the WebLogic Server by entering the user credentials having privileges to deploy the EAR file.
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From the Domain Structure LHS menu, click Deployments to display the Summary of Deployments
window.

ORACLE Weblogic Server® Administration Console

Change Center @D Home Log Out Preferences [P Record Help 4 Welcomee, upg7273 | Commected to:

View changes and restarts T
+ - Smerwenary ol Deploymmenty

Confguraton edang s erabied. Future
changes wil automatcaly be actrvated a8 you Summary of Deployment
modfy, add or delete Sems i ths doman Y, —

Control  Mortorng

Domain Structure

= Errronient Thes page daplays 8 kst of Java EE apphcatons and stand-aione aopicaton modues that have been rstaled to the
Deployments doman. Instaled apphcatons and modiues can be started, stopped, updated (redeployed), or deleted Som the doman by
B-services frit selectng the a0pkiaton name and usng the Controll on T DAge
Secunity Reairs To ratal 8 new sophcaton o madule for deployment B trge’s n T doman, cick e [rstal button
= - Interoper ablity
= Daagrostcs
¥ Customize this table
Deployments
leted Showrg Lto 1of 1 Previous | Next
[ | mame & State | Health | Type o
How do 1. = - o PRy = Erveror ae i
ek I L ofsaa Aceve |0 | L 300
System Status 'J -
et . 1 ral : Showing 1to 1of 1 Previous | Next

Click Install to display the Install Application Assistant window.

Select the Exploded EAR directory after browsing to the directory where it is saved and click Next.

Explode EAR File

To explode EAR, follow the below steps:

1.

Create the "applications" folder under domain name. For example:
/Bea/user projects/domains/ <Domain _name>/applications.
Create <context name>.ear folder under "applications" folder.

Copy the <$sF1C WEB HOME/<context name>.ear fileto <WEBLOGIC INSTALL DIR>/Bea/user projects/
domains/<DOMAIN NAME>/applications/<context name>.ear

Explode the <context_name>.ear file by executing the command:
jar -xvf <context name>.ear

Delete the <context>.ear and <context>.war files (recently created) <wEBLOGIC INSTALL DIR>/Bea/
user projects/domains/<DOMAIN NAME>/applications/<context name>.ear

Create a directory <context name>.war under <WweBLOGIC INSTALL DIR>/Bea/user projects/
domains/<DOMAIN NAME>/applications/<context name>.ear

Copy <$FIC WEB HOME/<context name>.war file t0 <WEBLOGIC INSTALL DIR>/Bea/user projects/
domains/<DOMAIN NAME>/applications/<context name>.ear/<context name>.war

Explode the <context name>.war file by executing the following command to get the directory structure:

jar -xvf <context name>.war
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Install Application
To install the Application:
1. Open the Install Application Assistant.

Install Apphoation Assmtant

Fogent Cangsl

Locate deployment to install and prepare for deployment

et reoresenss. the sopkcaton root drectory, archrve S exsioded srdhee drettory, or popication module descrotor Shat you want to nstal
tory or fiie in the Path field,

Select e He
e appicaton

Pathe oradata w1035 OracleMiddlewane/user_projects/domains/upgl 27 Mapphcations
Recently Used Paths:

Current Location:

O L upg?ardear fnoen drectery)

Foot Cancel

Fou N aiso erier the path of

O Oty ible? i 28 08 Caplyed Dedve, IF i SBAnat Fndd your Ceigynl Sy, oioa s Sall) 80/0r 00 that wiur BOSICRTON SONTRNG THE Hegurid JEDIyEENT BRI

2. Click Next.

Install Apphication Assstant
Back | | e Cancel

Choose targeting style

Tarpets are the servers, dusters, and viual hosts on whech s degioyment wil run, There are Several ways you Can tarpet &n SppiCabON,
(3} Install this deployment as an application
The sopizaton &g 8 ComDonents will e trpeted 10 e S DCAtonE. This i the MOS! Dommdn Lage

) Instal this deployment as a hbrary

Blaci | Meet Cancel

Agghcaton lbranes ane degioyments Sat ane avlabie for other deployments to share. Libranes should be avadable on al of the trgets running ther referencng applcatons
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3. From the Choose targeting style section, select the Install this deployment as an application option and
click Next to display the Optional Settings window.

Install Apphcation Assstant

Bac | MNexi| | Fnsh | Cancel
Opticnal Seltings
s e ey e SATINGE O BC0EDY T e et
General
do You v

Security

AT SETURTTY FRO0E 25 WOU R 1 LE W this appkoation

= [H» Gnby: Use ondy rodes and paboes that are defmed in the deplayment descriptors.

Custom Roles: Use robes that are defined m the Administration Comsole; wse palicses that are defined in the deployment
descrptor.

Custosm Roles snd Polickes: Use only roles and policies that are defined in the Administration Consobe.

Advanced: Use a custom model that you have configured an the realm’s configuration page.

Sowrte stcessibility

o Pk e source Fles be made sicessbie?
5 Use the defaults defimed by the deployment’s targels
Recommended selecion
Copy thit apphcation oato every target for me
Dorg ages s, ok Sies ol B8 CoDe S tomanoaly 10 T RBES SETOEE 1 PN T BODGTALN o TG S

1 waill make the deployment accessible from the following locatsan

Lecalion: oradata2iw 1035/ 0racle Middliesaneuser_peopects/doman

o here ol tarpets wil sccess ths appbcaton’s Sies. Th s often a shared drectory. You must ensure the spplcabon Sies est in tha iocation snd that each tanget tan
e
Baci | e Fins Cance

Enter a Name for the deployment if required.

Under the Security section, select the DD only option to specify that only roles and policies that are defined
in the deployment descriptors should be used.

6. Select the I will make the deployment available from the following location option under the Source
accessibility section.
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7. Click Next to continue and display the Deployment Summary window.

Enstall Applcation Assitant
Biman Fras | | Cabdal

Review your chostes and ol Fanish
Choie Finash to complete the deplayment. This may take 2 fewr moments to complete
Addditional configuration

Tr orcler to work successflly, ths aoplicaton may reaurs additonal configuraben. Do you wand io neview Bis acpicatorts configuraton afier compietng ths assstand?

(&) Yes, take me to the deployment’s configuration screen.

1o, 1wl review the configusratian later.

Summary
e playment: oradatad 103 Or acke Sicdeware iuser_progects domars upg FIT apoicatons upg T T ear
Mame: eIt
Staging mode: Uise the defauills defined by the chosen tangets
Secunty Madel COOry: L only rous 50 SobOd T b D8 frd © Tk Cepioy et SeRirionl
Target Summary
Companents Targets
wog T2 7 e AdrerServer
TES Fraa Sheie
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8. Select the option Yes, take me to the deployment's configuration screen option and click Finish to

display the Settings for <Deployment Name> window.

Settings for upg 7273
Ovarview DepioysentPan  Corfiguraien  Secnty Tegeis  Contrel | Testng  Momibing | Pobes
Save
Bon, sLch a8 ity name, & wical path o the appkcation fles, the ssacal piyman plar, ane 5o on, The tabie at
EJBa) that are corviamed i o sevorse sopkcaton. Chik on the rame of the ke 5o e and updiate it configuration
Memme: upgIITI “ore [
Path: Mddevere, user_projects| domses upg TETL
Dephoymsent Plan: o (A spesSe: - & A & Mo
ik
Staging Mode: ot Epedfed o
Security Modek COOnly - -
1] Deployment Order: 100 =
yh—.
17| Deployment Principal
Name:
Mere Inflo..
Save
Modubes and Components
Showirg Lo lof 1 Previous | Mext
Name - Type
Ervierprse
gL Anphzanor
SHEXs
Sintel . =]
ochubes
97Tl Neh
a Agphcatior
— - 3]
£ WindLle
S Wb St
Hore &0 csole
Snowing 10 10F 1 Previous | Mext

9. Review the general configuration details of the deployment. You can also update the configuration of the

deployment in this window. In the Overview tab you can view the complete deployment configuration.

10. Click Save to update the changes, if any.

11. From the LHS menu, click Deployments to display the Summary of Deployments window.

Summary of Deployments

Control | Monitorrg

and-sione sopkcation moduies: that have been rstaled to T
TGt BOCHIEDOM PSS B L5 T OO T o0 S D0

Thes page cisplays & st of Java B8 applcats
fredapioved), or deigted from the domen b

Tomsial o new sppicabon or module: for depioyment to tangets m this doman, cick the: Instal buston.

¥ Customize this table
Deployments

nast | upome || Come e v

doman. Instalies anpicatons snd moduies can be starh

Showng 180 10F 1 Previous | st

Servong ol requests

|
£ | Hame & Serviorg orly pimmairaton reguests iy

Health Type

Deployment Drder

=] H R oaTITI Artve

| ¥ o Enberprse Apolcao 100

inscall | Updese  Deiete | Siani~ | Swepw

Showrg 100 10f 1 Previous | hext
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12. Select the newly deployed Infrastructure application and click Start > Servicing all requests. Ensure that

the Infrastructure server is up and running.

Messages

oF Start resy
sammary of Deployments

Control | Moritonng

¥ Customine this table
Deployments

ang modues can be siaried, stocoed, Lodated

-
i
¥
:
§
F
i

13. The State of the deployed application is displayed as Active if started successfully.
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Deploying WAR Files on Tomcat

Before deploying the WAR files, ensure that the previously deployed applications of Infrastructure are
uninstalled. See Uninstalling Previously Deployed WAR Files in Tomcat for the procedure to uninstall the

previously deployed Infrastructure war files.

On the machine that hosts Tomcat, follow the below steps outlined to deploy Infrastructure application:

1. Copy the <context-name>.war from $FIC WEB HOME/<context-name.war>10 <Tomcat Installation
Directory>/webapps/ directory.

Home Documentation Configuration Examples Wiki Mailing Lists

Apache Tomcat/7.0.57

Find Help
™ Apache Software Foundation

http://www.apache.org/

Tomcai Sefup

Eirst ¥Web Apphcation

Managing Tomcat
For secunty, access to the mansger webapp is

restricted. Ussrs are dafined in

Release Notes
Changelog
Migration Guide
Security Notices

Recommended Reading

Security Considerations HOW-TO
Manager Application HOW-TO
Clustering/Session Replication HOW-TO

Developer Quick Start

Aeaims & ARA Examples

JIBC Data Sources

Documentation
Tomcat 7.0 Documentation
Tomeat 7.0 Configuration

SCATALINA HOME/conf/tomcat-users.xml Tomcat Wiki

Find additional impostant configuration
nfcemation in

FCATALINA_HOME/RUNNING. txt

Developers mary be imerested in

Tomcat 7.0 Bug Dulatass
Temeat 7.0 Jualess
Tomopt 70 SWN BEpaslory

Server Status
Manager App

Host Manager

Sarviel Specilicabions
Tomcal Versicns

Getting Help
FAQ and Mailing Lists

Thi follewnng mahng hsls ane avalable

IMpOrtant ARnCUNCEments., e leases, securty

vulnerabaty nolifications., {Low volume],
mcal-ysen

ser Bugpon and mcees

P LSBT

User support and descussion for Apache Taolos

| maiing kst ncisding £ easages

2. Click Manager App. The Connect to dialog box is displayed.
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3. Enterthe UserId and Password that has admin rights and click OK. (For user creation in tomcat, see Tomcat

User Administration. The Tomcat Web Application Manager window is displayed with the list of all the

applications deployed.

......

08 versam LIEREe

i

In the Deploy section, enter the Context Path provided during the installation as " /<context-name>".

5. Enter the path where the <context-name>.war file resides (by default "sFrc WEB HOME/<context-

name.war>") in the WAR or Directory URL field and click Deploy.

6. On successful application deployment, a confirmation message is displayed. Start the Tomcat server. For

more information, see Starting Infrastructure Services.

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0

141



Post-Installation Configuration

Accessing the OFSAA Application

This section gives details about the steps to be performed to access OFSAA Application.
To access the OFSAA application:

1. From a your desktop, open the browser and enter the URL in below format:
<scheme>://<IP address/ hostname>:<port>/<context-name>/login.jsp

For example: https://111.222.333.444:5555/0ofsaa/login.jsp

The OFSAA login window is displayed as below:

ORACLE Financial Services Analytical Applications

Language US-English

User ID

Password

Version 8.0.6.0.0

Copyright © 1993, 2018 Oracle and/or its affiliates. All rights
reserved.

2. With installation of every OFSAA Application Pack, there are two seeded user profiles configured in the
system:

o SYSADMN - System Administrator
o SYSAUTH - System Authorizer

Note: For SYSADMN and SYSAUTH, the default password is password0.

3. Login to the application using the "SYSADMN" User ID. (Note that, there is no "I" in the SYSADMN login
USER ID). Enter the password that was provided during installation. On the first login, you will be prompted
to change the password.
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OFSAA Landing Page

This section includes the following topics:

*  OFSAA Landing Page for Profitability Administrator
* Enabling a Product within an Application Pack

OFSAA Landing Page for Profitability Administrator

On successful authentication, the OFSAA Landing Page is displayed. This is a common landing page for all
users until a preferred application landing page is set by the user in his preferences.

= ORACLE Financial Services Analytical Applications @ 6 o Vs-English ¥ AUTOUSER

APPLICATIONS

Financial Services Asset Financial Services Asset Financial Services Financial Services Funds Financial Services

Liability Management Liability Management Enterprise Financial Transfer Pricing Institutional Performance

Application for Asset Liability Analytics Performance Analytics Application for Funds Transfer Pricing Analytics

Management Application for Asset Liability Application for Enterprise Financial Application for Institutional
Management Analytics Performance Analytics Performance Analytics

Financial Services Financial Services Retail
Profitability Management Performance Analytics
Application for Profitability Application for Retail Performance
Management Analytics

The landing page includes multiple tabs and each tab has specific links to OFSAA Infrastructure and/or
Application modules. The tabs and links are displayed based on the OFSAA Application accessed and the
access roles mapped to the logged in user.

Each tab contains LHS Menu and RHS Menu. The LHS Menu holds link(s) to modules in a tree structure. The
RHS Menu holds link(s) to modules in a navigational panel format.

The following tabs are available in the Landing Page:

* Applications tab
*  Object Administration tab
» System Configuration & Identity Management tab

Applications tab

This tab lists the various OFSAA Applications that are installed in the OFSAA setup. The Select Application
drop-down list displays the OFSAA Applications, based on the logged in user and mapped OFSAA Application
User Group(s). Links to related modules within Applications and Infrastructure are grouped appropriately to
maintain a unified experience.
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Object Administration tab

This tab lists the various OFSAA Information Domains created in the OFSAA setup. The Select Information
Domain drop-down list displays the OFSAA Information Domains based on the logged in user and mapped
OFSAA Application User Group(s). Links to modules that enable object traceability and migration of objects are
grouped in this tab.

System Configuration & Identity Management tab

This tab lists the OFSAA Infrastructure System Configuration and Identity Management modules. These
modules work across Applications/ Information Domains and hence there are no Application and Information
Domain drop-down lists in this tab. Links to modules that allow the maintenance of setup installation and identity
management tasks are grouped together in this tab.

Note: The navigation path differs from Application to Application. That is, based on the selected Application,
the navigation varies.

For more details on how to operate on each tab, see OFSAAI User Guide available in OHC.

Enabling a Product within an Application Pack

You can also enable a product/ application within an application pack post installation at any point of time.
To enable a product through the application Ul, follow these steps:

Login to the application as SYSADMN user or any user with System Administrator privileges.

2. Navigate to System Configurations & Identity Management tab, expand Administration and
Configuration and select System Configuration.

3. Click Manage OFSAA Product License(s) to display the Manage OFSAA Product License(s) window is
displayed.

MANAGE OFSAA APPLICATION PACHK LICENSE

INSTALLED APFLICATION PACKS
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4. Select an Application pack to view the products in it. The products are displayed in the Products in the
Application Pack grid.

PROMICTS IN THE APPLMCATHDN PACK

Select the check box to enable a product within the Application Pack which is not enabled during installation.

Click VIEW LICENSE AGREEMENT to view the license information. The License Agreement section is
displayed.

LICENSE REEWEM

ElABLE

7. Select the option | ACCEPT THE LICENSE AGREEMENT and click ENABLE. A pop-up message
confirmation is displayed showing that the product is enabled for the pack.

Note: To use the newly enabled product, you need to map your application users to the appropriate product
specific User_Group(s) and subsequently, authorize the actions by logging in as System Authorizer.

For more information, see Mapping/Unmapping Users section in the Oracle Financial Services
Analytical Applications Infrastructure User Guide 8.0. To identify the newly enabled product specific
UserGroups/ Application Pack specific User_Groups, see the respective Application Pack specific
Installation and Configuration Guide/ User Manual.
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User Group Mapping

Application specific User Group mappings:

Additionally, the following user groups are introduced for GDPR compliance:
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PFT:

o Profitability Application Administrator

o Profitability Application Analyst

o Profitability Application Auditor

FTP:

o Fund Transfer Pricing Application Administrator
o Fund Transfer Pricing Application Analyst
o Fund Transfer Pricing Application Auditor
IPA:

o |IPA Administrator

o IPABI Analyst

o |PA Data Analyst

RPA:

o RPA Administrator

o RPABI Analyst

o RPA Data Analyst

EFPA:

o EFPA Administrator

o EFPABI Analyst

o EFPA Data Analyst

Data Controller: This group has the privileges to maintain the Pl list and Redaction policies against them.

This group also has the privilege to ensure the Right to be Forgotten.

Data Security Group: This group has the privileges to see the PIl in un-redacted manner when the reports

are accessed through OBIEE.
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Create and Deploy the Application Pack Web Archive
On successful installation of the OFSAA Application Pack, the web archive file is automatically generated.
However, you need to deploy the generated web archive file on the Web Application Server.

For identifying the location of the generated web archive file and for generating and deploying the web archive
file at any time later, see Creating EAR/WAR File and Deploying EAR/WAR File sections.

Note: See the Oracle Financial Services Forms Manager User Guide for instructions on Creating and
Deploying the Forms Manager Web Archive.

Patching Your OFS Profitability Pack Installation

Oracle strongly recommends installing the latest available patch set so as to be up to date with the various
releases of the OFSAA Infrastructure product.

See http://support.oracle.com for more information on latest releases.
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CHAPTER 7 — RPD/ CATALOG DEPLOYMENT, D3 AND MAP VIEW
CONFIGURATION FOR OBIEE 11G

This chapter includes the following topics:

« Deploying Profitability Pack Dashboards and Analytics
* Deploying D3 on OBIEE 11g Server

*  Mapview Configuration

* HTML5 Compliance of OBIEE Reports in IE11

Deploying Profitability Pack Dashboards and Analytics

This section covers the following topics:

* Installing OBIEE Server

+ Installing OBIEE Windows Administration Client

« Deploying Profitability Pack Report Analytics

» Deploying EFPA/ IPA/ RPA Application Report Analytics

Installing OBIEE Server

To install Oracle Business Intelligence Enterprise Edition (OBIEE) server, see the Oracle Fusion Middle ware
Installation Guide for Oracle Business Intelligence11g Release 1 (11.1.1.9.5). After installing Oracle Business
Intelligence Enterprise Edition (OBIEE) server, get the Enterprise Manager URL, username, password, and
OBIEE installed directory from the System Administrator.

Note: From the OFS PFT Release 8.0.3.0.0 onwards, the OBIEE version 11.1.1.7.1 will not have support and
enhancements. All the existing reports work same as the previous versions, but the new developments
will not function in 11.1.1.7.1 version of OBIEE.

Installing OBIEE Windows Administration Client

To install OBIEE repository administration client for Windows machine, see the Oracle® Fusion Middle ware
Installation Guide for Oracle Business Intelligence11g Release 1 (11.1.1.9.0).
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Deploying Profitability Pack Report Analytics

To deploy Analytic Reports, follow these steps:

1. Stop Oracle Process Manager and Notification Server (OPMN) services by executing the following

command:

<OBIEE Installed Directory>/instances/instancel/bin./opmnctl stopall

2. Copy OFs PFT PACK.rpd from $FIC HOME/OFSPFTPACKBI/OBIEE/11.1.1.9.5/ of Web layer to the

Windows machine.

Note: Itis recommended to merge the rpd files by keeping ors prT PACK.rpd as the base, in order to

avoid merge errors.

In case of upgrade, the $r1c_nomME/orsprrrACKBI folder will have two folders namely, sF1c_HOME/
OFSPFTPACKBI/OBIEE and $FIC HOME/OFSPFTPACKBI/OBIEE11G. You can ignore the sF1c HOME/

OFSPFTPACKBI/OBIEEI11G folder.

3. To configure connection pool of repository, follow these steps:
a. Open the repository using OBIEE Windows administration client.

E D OF5_PFT_PACK.rpd 2/8/2017 216 PM
Recent Places

L

Desktop

=

Libraries

i_.‘!;g

Computer

@

Metwork

<

RPD File

File name: [oFs_PFT_PaCKpd

Files of type: IF{eposrtory Files {*rpd)
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Figure 1: OBIEE Windows Administration Client to Open Repository

-

[=] Oracle BI Ad
[ Fil: Tools Help

IR N IR BRIk

=~ efermEr

MName « I'I Date modified I'I Type

e > D OFS_PFT_PACK.rpd 2/8/2017 2:16 PM RPD File
Recent Places

|

Desktop

Files of type: | Repostory Files ("pd)

For Help, press F1

Figure 2: OBIEE Windows Administration Client to Select Repository from Windows Machine

b. Enter default repository password as Admin123.
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o
File

c. In the physical section, expand ‘Customer Insight Database’ folder.
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Figure 5: OBIEE Windows Administration Client to Open Connection Pool Window

| huml )

d. Double-click Customer Insight Connection Pool to open the Connection Pool Properties window.

e. Enter the following in Data Source Name text box of Connection Pool Properties window after modifying

<Database Server Host Name> and <Database Name>

(DESCRIPTION= (ADDRESS= (PROTOCOL=TCP) (HOST=<Database Server
HostName>) (PORT=1521)) (CONNECT_DATA=(SERVER=DEDICATED) (SERVICE_NAME=<Database

Name>) ) )

f. Enter atomic schema user in User name text box.

g. Enter atomic schema user password in Password text box.
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h. Click OK.
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+-[E Refemal Line of Business
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I Password: I

¥ Enable connection pooling
Timeout: |5
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Figure 6: OBIEE Windows Administration Client to modify Connection Pool variables

i. Double-click 'Customer Insight Connection Pool (Init Block)' to open the Connection Pool window.

j- Enter the following in Data Source Name text box of Connection Pool Properties window after modifying

<Database Server Host Name> and <Database Name>

(DESCRIPTION= (ADDRESS= (PROTOCOL=TCP) (HOST=<Database Server
HostName>) (PORT=1521)) (CONNECT_DATA=(SERVER=DEDICATED) (SERVICE_NAME=<Database

Name>) )

k. Enter atomic schema user in User name text box.

. Enter atomic schema password in Password text box.

m. Click OK.

4. To configure connection pool for EFPA, modify 'OFSEFPA Connection Pool' and 'OFSEFPA Init Block'
connection pool and set the property which is inside of 'EFPA' folder in the physical section.

Click File menu and then click Save.

Click Yes on the pop-up message Do you want to check global consistency?
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7. Click OK, on the pop-up message Consistency check didn't find any errors, warning or best practices
violations.

Note: Warnings on consistency check can be ignored.

List of Warning Messages:
Business Model Financial Reporting:

[39090] Logical column "Financial Reporting"."Dim - Reporting Period"."Month" has invalid Sort Order
column 'Month Sort'".

Business Model Management Reporting:

[39090] Logical column "Management Reporting"."Dim - Reporting Period"."Year" has invalid Sort Order
column 'Year Calendar'.

GLOBAL:

[39092] Presentation level "Retail Performance”.."Branch"."Branch Hierarchy"."Region" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Retail Performance”.."Time"."Time Hierarchy"."Year" is first under presentation
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Retail Performance".."Product”."Product Hierarchy"."Leve20Q" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Income Statement".."Reporting Period"."Time_Hierarchy Month"."Month" is
first under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Income Statement".."Reporting Period"."Time Hierarchy Year_Month"."Year" is
first under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Ratios".."Reporting Period"."Time_Hierarchy Month"."Month" is first
under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Reporting".."Reporting Period"."Time Hierarchy Month"."Month" is first
under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Reporting".."Reporting Period"."Time Hierarchy Year_Month"."Year" is
first under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet".."Reporting Period"."Time_Hierarchy _Month"."Month" is first
under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Reporting".."Reporting Period"."Time Hierarchy"."Year" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Institutional Performance”.."Time"."Time Hierarchy"."Year" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Ratios".."Reporting Period"."Time Hierarchy"."Year" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Income Statement".."Reporting Period"."Time Hierarchy"."Year" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.
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[39092] Presentation level "Balance Sheet".."Reporting Period"."Time Hierarchy"."Year" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Account"."Account"."Gen2,Account" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Period"."Period"."Gen2,Period" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Years"."Years"."Gen2,Years" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Scenario"."Scenario"."Gen2,Scenario" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning”.."Entity"."Entity"."Gen2,Entity" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Version"."Version"."Gen2,Version" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning”.."Strategy"."Strategy"."Gen2,Strategy" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Chart of Account"."Chart of Account"."Gen2,Chart of
Account" is first under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet
Planning".."AttributeValue"."AttributeValue"."Gen2,AttributeValue" is first under presentation hierarchy, but
logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Currency"."Currency"."Gen2,Currency" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.
[39092] Presentation level "Balance Sheet Planning”.."Intercompany Entity Flag"."Intercompany Entity

Flag"."Gen2,Intercompany Entity Flag" is first under presentation hierarchy, but logical level it is associated
with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."AssetClass"."AssetClass"."Gen2,AssetClass" is first
under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."COA type"."COA type"."Gen2,COA type" is first
under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet

Planning".."DelinquenciesExp"."DelinquenciesExp"."Gen2,DelinquenciesExp" is first under presentation
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Fee Classification"."Fee Classification"."Gen2,Fee

Classification" is first under presentation hierarchy, but logical level it is associated with is not grand total
level.

[39092] Presentation level "Balance Sheet Planning".."Intercompany COA Flag"."Intercompany COA

Flag"."Gen2,Intercompany COA Flag" is first under presentation hierarchy, but logical level it is associated
with is not grand total level.
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[39092] Presentation level "Balance Sheet Planning".."Sample COA"."Sample COA"."Gen2,Sample COA"
is first under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."curr_attrib"."curr_attrib"."Gen2,curr_attrib" is first
under presentation hierarchy, but logical level it is associated with is not grand total level

[39092] Presentation level "Institutional Performance”.."Segment"."Segment Hierarchy"."Type" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

Deploying EFPA/ IPA/ RPA Application Report Analytics

Use the following procedure to deploy the EFPA/ IPA/ RPA applications report analytics:

Note: Ensure that Oracle Business Intelligence 11.1.1.9.5 is available.

1. Deploy RPD and webcat file(s).
a. Login to OBIEE - Enterprise Manager URL (http://<ip address>:<port>/em).
m  Click on hyperlink 'coreapplication’ from 'Business Intelligence' tab on left hand side.

m  Under 'coreapplication’, select the tab 'Deployment' and in that select sub-tab 'Repository'.

=ﬂ' Advanced | Administration | Help + | Sign Out -

Catalog | Favorites ~ | Dashboards ~ | [ New ~ | B®Open ~ | Signed In Az weblogic ~
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= Click 'Lock and Edit Configuration' button located below title 'coreapplication’. Following screen is
displayed.

PUBEEE.._ .. . s o e
& nitpy/ sfwlFarn QO ~ & o 3t
File Edit View Favorites Tools Help x
35 I Sugg.. = ejALMm... @http... ejOrac... ejOrac... @ Prep... e:jGOP_ - ” ﬁ A > =3 Q%A v Page~ Safety~ Tools~ @v ”
ORACLE Enterprise Manager 11g Fusion Middieware Control Setup + Help~ Log Out

M 1t coreapplication ® Logged in as weblogic
v §§ Farm_bifoundation_domain @ Business Intelligence Instance -
[= [ Application Deployments

£5222549.in.oracle.com:7001/em/faces;

(& Business Intelligence Instan...

Page Refreshed Feb 8, 2017 4:06:11 PM IST [

L= [ WebLogic Domain Change Center: | 4 Lock and Edit Configuration ©)
W [ Busi i
@ ppl Overview Availability Capacity Management Di tics Security Deployment
[ [] Essbase Servers = » = =
b B Metadata Repositorics Presentation Repository Scheduler Marketing Mail
BI Server Repository Apply

~
This section shows the current installed RPD. You can use this section to configure a shared RPD location.

Default RPD OFS_PFT_PACK_BI0023

Share Repository

L

RPD Publishing Directory

Upload BI Server Repository

Use this section to upload a new RPD and its password to your BI Server domain. You may also use this section to re-enter the
password if a mistake was made on a previous upload.

Repository File Browse...

Repository Password

Confirm Password

H100% -

b. RPD Deployment: Select '‘Browse' button available under 'Upload BI Server Repository' section and
select OFS_PFT_PACK.rpd file from the local folder. Enter default Repository password Admin123.

c. Web catalog Deployment: Open the analytics OBIEE URL-(http://<ipaddress>:<port>/analytics) and
login with the credentials.

d. Click "Catalog" link available on the top right corner.
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e. Click "Shared Folders" and then "Un-Archive".

ORACLE BusinessIn

Cataios

User View ~ v @ ot IE'“ E i
‘= Folders [E=]Ga |

.......................................... 1

= Tasks
[E] shared Folders
[£3 Expand [&] Archive
s
3¢ Delete 2 Upload
. Copy == Properties
i@ Rename @ Permissions

ﬁ Create Shortout

f. Browse the path where "ors prT PACK.catalog"is copied in the local folder. Select the file and click
"Open". Then click "OK".

Unarchive @ x
Archive file OFS_PFT_PACK.catalog Browse. ..
Replace  Mone v
ACL  Inherit W
Ok Cancel
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g. Click "Dashboard" and click on any of the reports to ensure that all the reports are available.

Business Intelligence

To add content, cick Edit & here or in the toolbar.

Home

Catalog

iministration

Help +

Favorites + | Dashboards | I New + | BS Open ~ | Signed In As weblogic +

Most Recent(My Dashboard - page 1)
(@ My Dashboard
BSP
Forecast Reports
Financial Reporting
Finandial Reporting
Institutional Performance
Business Summary
Customer Central
Opporturities & Activities
Relationship Manager Insights
Management Reporting
Balance Sheet
Income Statement
Key Trends
Performance Measures
Retail Performance
Business Analysis
Customer Central
Product Summary
Relationship Manager Insights

Restart all services in OBIEE "Enterprise Manager".

If you are doing any changes online, then configure ODBC data source to connect to Oracle Bl Server as

follows:

a. Go To Control Panel > Administrative Tools > Data Sources (ODBC).

© o 0 T

f. Click 'Finish'.

4. If RPD deployment is done on Essbase, then modify ESSBASE connection pool and set the properties.

Select the 'System DSN' tab and click 'Add' Button.

Select a driver specific to (Oracle Bl Server 11g) and click 'Finish' Button.
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Deploying D3 on OBIEE 11g Server

This section provides detailed steps to install and configure D3, a visualization framework, which is used in few
reports of IPA and RPA.

To deploy the D3 on OBIEE 11g server, do the following:

1. Download d3.zip of version 3.5.17 and place it in your local folder.

2. Unzip the d3 folder and move this to analyticsRes in your entitlement server.

Note: To view the Customer Group Structure report, copy the hashMap.js file from $srFrc HOME/

OFSPFTPACKBI/OBIEE/ and place it in to the d3 folder under analyticsRes and restart the application from

the folder.

In case of upgrade, the $rFrc_HoME/OFspFTPACKBI folder will have two folders namely, $F1c_HOME/
OFSPFTPACKBI/OBIEE and $FIC HOME/OFSPFTPACKBI/OBIEE11G. You can ignore the sF1c HOME/

OFSPFTPACKBI/OBIEE11G folder.

) analyticsRes

|:Eg Download [

-EF - ) & G FindFiles | 5o
¥ =5 L Properties |5 [

/scratch/obieehome/instances/instancel /bifoundation/OracleBIPresentationServicesComponent/coreapplication_obipsl/analyticsRes

MName

.
. WEB-INF
Jid3,

Size Changed
23-04-2015 PM 02:22:51
23-04-2015 PM 02:22:51
13-07-2015 PM 02:31:54

Rights
PWHI-%---
PWKI-X---

MWK -XI-X

Owner
merajend
merajend

merajend

3. Copy the WEB_INF directory from analyticsRes into d3 folder.

-EE - &1 () & C& Find Files | 7y
& [m

/scratch/obieeshome/instances/instancel /bifoundation/OracleBIPresentationServicesComponent/coreapplication_obipsl/analyticsRes/d3

MName

. WEB-INF
| LICENSE
(2] d3.min.js
[B]dzs

Size Changed

13-07-2015 PM 02:31:54
13-07-2015 PM 02:38:56

2KB 07-02-2015 PM 12:28:18
148 KB 10-02-2015 AM 08:32:14
329KEB 10-02-2015 AM 08:32:08

Rights

PWT-X---
PWRT-XT-X
rW-r--r--
W-r--r--

PW-r--r--

Owner

merajend
merajend
merajend
merajend

merajend

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0

159



RPD/ Catalog Deployment, D3 and Map View Configuration for OBIEE 11g

4. Login to web logic server, go to Deployments in your domain structure, click the Lock & Edit button, and

then select Install.

Change Center
View changes and restarts

Mo pending changes exist. Click the Release
Configuration button to allow others to edit the
domain.

Lock & Edit

Release Corfiguration

Domain Structure

bifoundation_domain
Environment

» Install an Enterprise application
* Configure an Enterprise application
» Update (redeploy) an Enterprise application

* Start and stop a deployed Enterprise
application

» Monitor the modules of an Enterprise
application

» Deploy EJB modules
» Install a Web application

How do L. =]

Health of Running Servers

I Failed (0)

System Status =

ORACLE WeblLogic Server® Administration Console

@ Home Log Qut Preferences Record Help aQ

Home =Summary of Deployments
Summary of Deployments

Contrel = Monitoring

This page displays a list of Java EE applications and stand-alone application modules that have been installed to this domain. Installed appli

To install a new application or module for deployment to targets in this domain, dick the Install button.

[ Customize this table
Deployments

Install Update Delete Start ~ Stop ~

Name &

O

'ﬁadf.orade.businessedimr(l.D, 11.1.1.2.0)

iﬁadf.orade.domain(l.ﬂ,11. 1.1.2.0)

iﬁadf.orade.domain.u\'ebapp[l.ﬂ, 11.1.1.2.0)

nladminservice (11.1.1)

=.Ianalyﬁcs (11.1.1)

FRAPS (11.1.1)

E:'.Iasyncadminservice (11.11)

W bi.em

Ooo|o|o|o|o|a|oo

E:'.Ibiadminservices (11.1.1)

]

Iﬁ“lbiaclminser\rlet {11.1.1)

Install Update Delete Start ~ Stop ~

5. Once you click on Install button, it will take you to the screen shot below where you will paste the full path
to the d3 directory, check the check box next to d3 (open directory) and click Next.

Install Application Assistant

Back Ni| Finish ‘ Cancel

Path:
Recently Used Paths:

Current Location:

@ ® g3 (open directory)

Back MNext | Finish ‘ Cancel

Locate deployment to install and prepare for deployment
Select the file path that represents the application root directory, archive file, exploded archive directory, or application module descriptor that you want to install, You can also enter the path of the application directory or file in the Path field,
Note: Only valid file paths are displayed below. If you cannot find your deployment files, upload your file(s) and/for confirm that your application contains the required deployment descriptors.
/scratch/obieehomefinstances/instance1/bifoundation/CracleBIPresentationServicesComponent/coreapplication_obips1/analyticsRes/d3

(none)

ofss222590 [ scratch f obieehome f instances / instance 1 / bifoundation [ OradeBIPresentationServicesComponent [ coreapplication_obips1 / analyticsRes
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6. On the next screen, select Install this deployment as an application and click Next.

erver® Administration Console

@ Home Log Out Preferences Record Help | Q
H =Summary of Deployments
base Install Application Assistant
edit the

Back MNet | Firiish | Cancel
Choose targeting style
Targets are the servers, dusters, and virtual hosts on which this deployment will run. There are several ways you can target an application.

@ Install this deployment as an ion

The application and its compenents will be targeted to the same locations. This is the most commen usage.

_ Install this deployment as a library

Application libraries are deployments that are available for other deployments to share. Libraries should be available on all of the targets running their referendng applications.

Back MNext | Finish | Cancel

7. Onthe next screen, select | will make the deployment accessible from the following location and click

Finish.

rver® Administration Console

{81 Home Log Out Preferences Record Help Q
H -Summary of Deployments
se Install Application Assistant
Hit the

Back Next ‘ Finish ‘ Cancel

Optional Settings
‘fou can modify these settings or accept the defaults
General

What do you want to name this deployment?
Name: d3

Security

What security model do you want to use with this application?
@ DD Only: Use only roles and policies that are defined in the deployment descriptors.

Custom Roles: Use roles that are defined in the Administration Console; use policies that are defined in the deployment descriptor.

Custom Roles and Policies: Use only roles and policies that are defined in the Administration Console.

) Advanced: Use a custom model that you have configured on the realm's configuration page.

Source accessibility

How should the source files be made accessible?

_I Use the defaults defined by the deployment's targets

rver

ation Recommended selection.

") Copy this application onto every target for me
During deployment, the files will be copied automatically to the managed servers to which the application is targeted.

from the ing location

@ Iwill make the deploy
Location: [seratch/obieehome/instancesfinstance1/bifoundatior

Provide the location from where all targets will access this application's files. This is often a shared directory. You must ensure the application files exist in this location and that each target can reach the location.

Back Next ‘ Finish ‘ Cancel
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8. On this screen, click on Activate Changes.

L e — - Weﬁtuglc Server: Adminisiration Lonsole
Change Center {8 Home Log Qut Preferences Record Help | Q
View changes and restarts Home >Summary of Deployments
Messages
Pending changes exist. They must be activated
to take effect. 4 The deployment has been successfully installed.
& Activate Changes o You must also activate the pending changes to commit this, and other updates, to the active system.
Unda All Changes v of Deploy ts

Domain Structure

bifoundation_domain

Control | Monitoring

This page displays a list of Java EE applications and stand-alone application modules that have been installed to this domain, Installed applications and modules can be started, stop

Toinstall @ new application or module for deployment to targets in this domain, dick the Install button,

[ Customize this table
Deployments

Install Update Delete Start Stop

[C]| name & State

[ | padf.orade. businesseditor(1.0,11.1,1.2,0) Active
How do L.. =] -

] Iﬁadf.nrade.dnmaln(l.ﬂ, 11.1.1.2.0) Active
# Install an Enterprise application -

9. After activating the changes, the application will now be in a Prepared state, as in the screen shot below.
You will have to stop the application by checking the check box next to it and selecting Force Stop Now
from the Stop menu.

fy, add or

n
applcation

rise

rise

ic Server® Administration Console _

@ Home Log Qut Preferences

e | Q
Home =Summary of Deployments
Summary of Deployments

Control | Manitoring

This page displays a st of Java EE applications and stand-alone appiication moduies that have been installed to this domain, Installed applications and modules can b started, stopped, updated (redeployed), or deleted from the domain by first selecting the app

To install  new application or modle for deployment to targets in this domain, click the Tnstall button.

| Customize this table
Deployments

install | [ Updaie | [ Delete | || Stat~ | | Stopw

Vihen work completes
[7]| name & State Health Tvpe

Force Stop Now
=] Eblsear\:ﬁ (1.11) Stop, but continue servicing administration requests Active W oK Enterprise Application
[ | B gisecurity (11.1.1) Active d oK Enterprise Application
[ | B gbisecurityadmin (11.1.1) Active d oK Enterprise Application
[ | dpsbithirdparty(11.1.1) Active Library
] f@Cale (11.1.1) Active # oK Web Application
@ds Prepared & oK Web Application
] IEDMS Application (11.1.1.1.0) Active & oK Web Application
] peas (111.1) Active & oK Enterprise Application
B Active oK Enterprise Application
[ | wsemai Active Library

Install | [Update | [ Delete | || Statt~ | | Stop v
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10. You can start the application by checking the check box next to it and selecting Servicing all requests from
the Start menu.

er® Administration Console

@} Home Log Out Preferences

Help Q,

Home =Summary of Deployments
r Summary of Deployments

Contrel | Monitoring

This page displays a list of Java EE applications and stand-alone application modules that have been installed to this domain. Installed applications and modules can be started, stopped, updated (redeployed), or delete

To install a new application or module for deployment to targets in this domain, dick the Install button,

[ Customize this table
Deployments

Inetall Update Dielete Start ~ Stop ~

Servicing all requests
[C]| name ¢ State Health
Servicing only administration requests
[0 | B pRbisearch (11.1.1) Active & oK
[ | & pgbissaurity (11.1.1) Active & oK
(=) R bisecurityadmin {11.1.1) Active & oK
= a
(] [Elh\ﬂ'lir\:lparty'(l 1. 1.1} Active
(] @icac (1L1.1) Active & oK
on
ad3 Prepared ¥ 0K
0 72DM5 Application (11.1.1.1.0) Active & 0K

11. The application will now change to an Active state and ready to use.

Summary of Deployments

Control | Monitoring

This page displays a list of Java EE applications and stand-alone application modules that have been installed to this domain. Installed applications and modules can be started, stopped, updated (redeployed), or deleted from the domain by first selecting the ap;

To install a new application or module for deployment to targets in this domain, dick the Install button.

[» Customize this table
Deployments

Install Update Delete Start ~ Stop ~

[ | Name & State Health Type

|} Elhlsearm (1.1.1) Active & oK Enterprise Application
|} Tflhlsemr\ty {1.1.1) Active @ oK Enterprise Application
E = ‘T‘;hlsemmtyadmln (1.1.1) Active & oK Enterprise Application
= '}L_Ihwihlrdparty'[l 111 Active Library

|} @Cal( (1L1.1) Active & oK Web Application

0| & gda Active @ oK Web Application

171 | B =M annliation 1111110 Actiua o e [
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Mapview Configuration

This section provides information on prerequisites, creating the mapviewer NAVTEQ data source, configuration
edits and server starting which is required for viewing map based reports of IPA and RPA.

Note: This is just a sample configuration working on sample data provided by NAVTEQ.

This section covers the following topics:

*  Prerequisites
» Creating the Mapviewer NAVTEQ Data source
* Loading FSI_LOCATION_MAP_COORD for viewing NAVTEQ Maps

Prerequisites

NAVTEQ database dump can be imported only into an Oracle 11g database. If you have no other option than
using a 10g version, contact OBIEE/Mapviewer Product Management.

Creating the Mapviewer NAVTEQ Data source

Ensure that you have a connection to 11g Oracle database from the machine where your OBIEE platform is
installed.

Create a NAVTEQ schema within that database for holding the NAVTEQ spatial data.

To create NAVTEQ schema, perform the steps as explained in the following section.
Downloading the Mapviewer NAVTEQ Database Dump

To download the Mapviewer NAVTEQ Database Dump, follow these steps:
1. Access the NAVTEQ Data Bundle for OBIEE from the ‘OBIEE 11.1.1.3 - Sample Application’:
http://www.oracle.com/technetwork/middleware/bi-foundation/obieesamplesarchive-2026956.html

2. Download and unzip the samplerpp Navteqg dmp.zip file that contains an Oracle Database export file
named:

obiee navteq.dmp
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Creating NAVTEQ User

To create a NAVTEQ user, follow these steps:

Start a SQL*Plus session to the Oracle Database as a user with system or DBA privileges.
Run the following script:

create user obiee navteq identified by obiee navteq default tablespace users quota
unlimited on users;

grant "connect" to obiee navteq;
grant "resource" to obiee navteqg;

Once the script is executed, verify whether you can connect to the newly created user.

Note: The OBIEE_NAVTEQ user creation script defaults with the password obiee_navteq (same as user
name) within the script. It is recommended that you keep this value unchanged to simplify configuration.

Importing the database dmp file

4,

Import the Oracle Database export file - obiee_navteq.dmp into the obiee_navteq schema using the
following import command, from the command line (Command Prompt in Windows):

c:\> imp obiee navteg/obiee navteqg@connectString file=obiee navteq.dmp FULL=Y
ConnectString is the connection string to your Oracle Database 11g where the user obiee_navteq was
created in the step mentioned earlier. Wait for the import process to complete, once successfully completed,

login on your DB as obiee navteq/obiee navteg and validate that you can view the schema tables and
some data.

Inserting Extra Spatial Metadata

6.

Start a SQL*Plus session to the Oracle Database and connect as user obiee_navteq.

For example: c:\>sqlplus obiee navteg/obiee navteg@connectString

Run the following script:

INSERT INTO user sdo maps SELECT * FROM my maps;

INSERT INTO user sdo themes SELECT * FROM my themes;

INSERT INTO user sdo styles SELECT * FROM my styles;

INSERT INTO user sdo cached maps SELECT * FROM my tile cache;

Commit;

MapViewerConfig.xml Edits

1.

Open the Mapviewer console using the following URL:

http://<ip address>:<port>/mapviewer

Click Admin.

Login with the username/password that you provided while installing the product.
Click Configuration. This opens the mapViewerConfig.xml on your setup.
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5. Make the following updates to the xml file.

<security_config> (Optional)

In the <security_config> property of this file, make the following changes:

a.

Change the <proxy enabled hosts> property to the following: Substitute the hostname, IP address
and port to the correct values on your setup.

<proxy enabled hosts>
http://<ip address>:<port>/mapviewer
http://<ip address>:<port>/, http://<ip address>:<port>/
http://<ip address>:<port>/mapviewer
</proxy enabled hosts>
Substitute any entries with these tags with the following property entries:
<disable direct info request> true </disable direct info request>
<disable info request> true </disable info request>
<disable csf>true</disable csf>

<enforce security role> true </enforce security role>

Predefined Data Sources

1.

At the end of the file, in the section named Predefined Data Source, add the following data source entry.

2. Replace the IP address, SID, and port to the correct values of the database where the obiee _navteq
schema has been created in the above steps.

© N o o~

<map_data source name="OBIEE NAVTEQ SAMPLE"

jdbc _host="10.229.147.238" (use your db ip)

jdbc_sid="orcl" (use your db sid)

jdbc _port="1521" (use your db port)

jdbc _user="obiee navteqg"

jdbc password="!obiee navteq" (use your selected password if different from OOB)
jdbc_mode="thin"

number of mappers="3"

allow_jdbc theme based foi="false" />

Note: Ensure that all tags have been closed correctly and also the above data source is not within the
comments section (ensure that it is outside the comments section which is represented by <!-- .. -->).

Click Save and Restart button at the bottom of the file.
Once configuration.xml file is restarted, click Data Sources.

Verify whether you can view OBIEE NAVTEQ SAMPLE as an entry in data sources.

Select the radio button OBIEE NAVTEQ SAMPLE.

Login to Analytic screen > Administration.

Click Manage map Data.
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9. Click Import Layer and then choose OBIEE COUNTRY.

10. Choose Preview MAP as OBIEE WORLD MAP FAST.

11. Same for OBIEE STATE.

12. Select Background Maps.

13. Use import Background maps and chosen OBIEE WORLD MAP FAST.

14. Edit the same, add layer oBIEE CcOUNTRY and then oBIEE STATE. While choosing, chose the location
OBIEE WORLD MAP for higher Zoom value.

15. Select the zoom level for country 0 and for country 2...15.

16. Navigate back to Layers tab.

17. Edit oBIEE COUNTRY and OBIEE STATE by adding Bl Key Columns:
For Country:

a. Choose Institutional Performance>Geography>Country Description.

b. Choose Institutional Performance>Branch>Branch Country Description.
c. Choose Retail Performance>Geography>Country Description.

For State:

a. Choose Institutional Performance>Geography>State Description.
b. Choose Institutional Performance>Branch>Branch State Description.
c. Choose Retail Performance>Geography>State Description.
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Loading FSI_LOCATION_MAP_COORD for viewing NAVTEQ Maps

For NAVTEQ Maps to work, it requires the location data in our atomic schema to be in sync with the map
Metadata in NAVTEQ schema. This is achieved through a new table FSI_LOCATION_MAP_COORD, the load
process of which is described as follows.

Populate FsT_LoCATION MAP COORD based on DIM LoCATION data itself, but description and codes should
come from tables OBIEE COUNTRY, OBIEE STATE, OBIEE CITY (from the DB schema configured for Maps,
'OBIEE NAVTEQ', for example in this case) respectively for Country, State and City, and n_location skey should
be the corresponding n_location_skey from DIM LOCATION.

For Instance, let us consider the following data from DIM_LOCATION.

N_LOCATION_SKEY

1

V_LOCATION_CODE

HAW

V_COUNTRY_CODE

USA

V_COUNTRY_DESC

United States

V_STATE_CODE HI
V_STATE_DESC Hawaii
V_CITY_CODE CITi
V_CITY_DESC Honolulu
V_ZIP_CODE 96813

Now, to populate the following columns in FSI_LOCATION_MAP_COORD:

n_location_skey =

1

v_country_code = OBIEE_COUNTRY.ISO_COUNTRY_CODE USA

v_country_code_map = OBIEE_COUNTRY.ISO_COUNTRY_CODE USA

United States

v_country_desc = OBIEE_COUNTRY.NAME

v_state_code = OBIEE_STATE.ISO_CTRY_CD_STATE_ABBRV USA_HI
v_state_code_map = OBIEE_STATE.ISO_CTRY_CD_STATE_ABBRV |USA HI
v_state_desc = OBIEE_STATE.STATE_NAME HAWAII

v_city_code = OBIEE_CITY.CTRY_CD3_STATE_ABBRV_CITY

USA_HI_Honolulu

v_city_code_map = OBIEE_CITY.CTRY_CD3_STATE_ABBRV_CITY

USA_HI_Honolulu

v_city_desc = OBIEE_CITY.CITY_NAME

HONOLULU

v_zip_code =

96813
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HTMLS5 Compliance of OBIEE Reports in IE11

Perform the following steps in order to verify the HTML5 compliance of OBIEE reports in IE11:

Remove the compatibility settings for analytics.
2. Change the instanceconfig.xml file to make all the chart views to be shown in HTML5 by default.

You can find the instanceconfig.xml file in the following location:

OBIEE_HOME/instances/instance 1/config/OracleBlPresentationServicesComponent/
coreapplication_obips1

<Charts>
<DefaultWebImageType>html5</DefaultWebImageType>
</Charts>
3. Enable Mapviewer and D3 reports (to ensure that these reports show up as is).

Verify all the Bl reports by removing the default chart view setting (to ensure that these reports show up as
usual irrespective of HTMLS or flash web Image formats).

Details on OBIEE11.1.9.5

In a browser that does not support the html5 format, the image renders in the flash format instead (which is also
interactive).
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CHAPTER 8 — RPD/ CATALOG DEPLOYMENT, D3 AND MAP
CONFIGURATION FOR OBIEE12C

This chapter includes the following topics:

« Deploying Profitability Pack Dashboards and Analytics
» Deploying D3 on OBIEE 12c Server

*  Mapview Configuration for OBIEE 12C

Deploying Profitability Pack Dashboards and Analytics

This section covers the following tooics:

* Installing OBIEE Server

* Installing OBIEE Windows Administration Client

« Deploying Profitability Pack Report Analytics

« Deploying EFPA/ IPA/ RPA Application Report Analytics

Installing OBIEE Server

To install Oracle Business Intelligence Enterprise Edition (OBIEE) server, see the Oracle Fusion Middle ware
Installation Guide for Oracle Business Intelligence Release 12.2.1.3.0. After installing Oracle Business
Intelligence Enterprise Edition (OBIEE) server, get the Enterprise Manager URL, username, password, and
OBIEE installed directory from the System Administrator.

Note: From the OFS PFT Release 8.0.6.0.0 onwards, the OBIEE version 12.2.1.2.0 will not have support and
enhancements. All the existing reports work same as the previous versions, but the new developments
will not function in 12.2.1.2.0 version of OBIEE.

Once the OBIEE server is installed, it should be upgraded to the version as mentioned in the
Environment section.

Installing OBIEE Windows Administration Client

To install OBIEE repository administration client for Windows machine, see the Oracle® Fusion Middle ware
Installation Guide for Oracle Business Intelligence Release 12.2.1.3.0.
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Deploying Profitability Pack Report Analytics

To deploy Analytic Reports, follow these steps:

1. Copy oFs PFT PACK.rpd from $FIC HOME/OFSPFTPACKBI/OBIEE/12.2.1.3.0/ of Web layer to the
Windows machine.

Note: Itis recommended to merge the rpd files by keeping ors prT PaACK.rpd as the base, in order to
avoid merge errors.

In case of upgrade, the srrc HOME/OFsprTPACKBI folder will have two folders namely, sFIc HOME/
OFSPFTPACKBI/OBIEE and $FIC HOME/OFSPFTPACKBI/OBIEE12C. You can ignore the sF1c HOME/
OFSPFTPACKBI/OBIEE12C folder.

2. To configure connection pool of repository, follow these steps:

a. Open the repository using OBIEE Windows administration client.

E OF5_PFT_PACK.rpd 2/8/2017 216 PM RPD File
Recent Places

L

Desktop

=

Libraries

i_.‘!;:I

Computer

File name: [oFs_PFT_PaCKpd

Files of type: IF{eposrtory Files {*rpd)
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Figure 1: OBIEE Windows Administration Client to Open Repository

cle B Ad
[ File Tools Help

LeeseBa (a0 |3 Rad Va8 HEEH

- & > m
IVI Date modified I'I Type
2/8/2017 2:16 PM RPD File

Recent Places

|

Desktop

Network

| 2l
[ = [ o |
= Cancel |

Files of type: | Repostory Files {"rpd)

For Help, press F1

Figure 2: OBIEE Windows Administration Client to Select Repository from Windows Machine

b. Enter default repository password as Admin123.
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o
File

c. In the physical section, expand ‘Customer Insight Database’ folder.
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[ Organizational Unit

0 0 O oy O oy O e O o O B O B

[ Organizational Structure
. A aa .

5

M|

Business

General |Cor1r1edior1 Scripts | XML | Write Back I Miscellaneous I

Name: I stomer Insight Connection Pool Pemissions... |

Call interface:

=HEIEE

[Defaut (OCI 105/11g) |

Maximum connections: I 43:

™ Require fully qualfied table names

Data source name:

[+ Shared logon

I(.Nmoic Schemaz

I Password: I

[¥ Enable connection pooling

User name:

Timeout: |5
[~ Use multithreaded connections
[¥ Parameters supported

| Defautt |

I{minutes} ;I

Isolation level:

Description:

ool
ool (it Block)

Connection Pool "Customer Insight Database”." Customer Insight Connection Pool”

Figure 5: OBIEE Windows Administration Client to Open Connection Pool Window

d.

e.

<Database Server Host Name> and <Database Name>

(DESCRIPTION= (ADDRESS= (PROTOCOL=TCP) (HOST=<Database Server Host
Name>) (PORT=1521)) (CONNECT DATA= (SERVER=DEDICATED) (SERVICE NAME=<Database Name>)))

Enter atomic schema user in User name text box.

Enter atomic schema user password in Password text box.
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Double-click Customer Insight Connection Pool to open the Connection Pool Properties window.

Enter the following in Data Source Name text box of Connection Pool Properties window after modifying
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h. Click OK.

7 —_—
Connection Pool - Customer Insight Connection Pool-_ |
|

[ File  Edit Wiew Manage
Deew e@E | KEL|E |2 ]

Business Maf|

Tools  Diagram  Window  Help

Presentation

- Line of Business
- Reporting Line
(-5 Branch
- Geography
- Cumency
= Scenario
E
E
[+

=l

75 Run

- Product Family Holding

[ Dealer

----- @ — Customer Dimensions —
- Customer

o8 Customer Type

o8 Customer Vintage

- Customer Profile By Age On Book
o8 Industry

- Customer Parent Child Details

----- @ — Account Dimensions —
- Account
- Account Status
- Acquistion Charnel
- Attrition Reason
£
£
£
£

+-[EE Migration Reasons
+-E Source Channel

+-[E Refemal Line of Business
v Delinquency Band

..... & — Others —

- Prospect
- Segment
- Merchant Category

& Sales Stage

- Activity Type

- Opportunity

- Sales Representative

- Opportunity Win/Loss Reason
- Organizational Unit

- Organizational Structure

~ FFA aa .

M|

General |Connection Scripts I XML I Wite Back I Miscellaneous I = | = ) |
Name: I stomer Insight Connection Pool Pemissions... |
Callinterface: | Defaut (OC1 100/11g) |

Maximum connections: I 43:

[~ Redquire fully qualfied table names
|<.Nmoic Schema>

Data source name:

¥ Shared logon

I— Password: l—

¥ Enable connection pooling
Timeout: |5

[~ Use multithreaded connections

V¥ Parameters supported

| Defaut

User name:

=)

I{minutes}

Izolation level:

Description:

ool
‘ool (Init Block)

Connection Pool "Customer Insight Database”."Customer Insight Connection Pool”

Figure 6: OBIEE Windows Administration Client to modify Connection Pool variables

i. Double-click 'Customer Insight Connection Pool (Init Block)' to open the Connection Pool window.

j- Enter the following in Data Source Name text box of Connection Pool Properties window after modifying

<Database Server Host Name> and <Database Name>

DESCRIPTION= (ADDRESS= (PROTOCOL=TCP) (HOST=<Database Server Host
Name>) (PORT=1521)) (CONNECT DATA= (SERVER=DEDICATED) (SERVICE NAME=<Database Name>)))

k. Enter atomic schema user in User name text box.

. Enter atomic schema password in Password text box.

Click OK.

n. To configure connection pool for EFPA, modify 'OFSEFPA Connection Pool' and 'OFSEFPA Init Block'
connection pool and set the property which is inside of 'EFPA' folder in the physical section.

3. Click File menu and then click Save.

Click Yes on the pop-up message Do you want to check global consistency?
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5. Click OK, on the pop-up message Consistency check didn't find any errors, warning or best practices
violations.

Note: Warnings on consistency check can be ignored.

List of Warning Messages:
GLOBAL:

[39092] Presentation level "Retail Performance".."Branch"."Branch Hierarchy"."Region" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Retail Performance”.."Time"."Time Hierarchy"."Year" is first under presentation
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Retail Performance".."Product”."Product Hierarchy"."Leve20Q" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Income Statement”.."Reporting Period"."Time_Hierarchy_Month"."Month" is
first under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Income Statement".."Reporting Period"."Time Hierarchy Year_Month"."Year" is
first under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Ratios".."Reporting Period"."Time_Hierarchy Month"."Month" is first
under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Reporting".."Reporting Period"."Time Hierarchy Month"."Month" is first
under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Reporting".."Reporting Period"."Time Hierarchy Year_Month"."Year" is
first under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet".."Reporting Period"."Time_Hierarchy _Month"."Month" is first
under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Reporting".."Reporting Period"."Time Hierarchy"."Year" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Institutional Performance”.."Time"."Time Hierarchy"."Year" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Financial Ratios".."Reporting Period"."Time Hierarchy"."Year" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Income Statement".."Reporting Period"."Time Hierarchy"."Year" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet".."Reporting Period"."Time Hierarchy"."Year" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Account"."Account"."Gen2,Account" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Period"."Period"."Gen2,Period" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.
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[39092] Presentation level "Balance Sheet Planning".."Years"."Years"."Gen2,Years" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Scenario"."Scenario"."Gen2,Scenario" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning”.."Entity"."Entity"."Gen2,Entity" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning”.."Version"."Version"."Gen2,Version" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning”.."Strategy"."Strategy"."Gen2,Strategy" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Chart of Account"."Chart of Account"."Gen2,Chart of
Account" is first under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet
Planning".."AttributeValue"."AttributeValue"."Gen2,AttributeValue" is first under presentation hierarchy, but
logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Currency"."Currency"."Gen2,Currency" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Intercompany Entity Flag"."Intercompany Entity
Flag"."Gen2,Intercompany Entity Flag" is first under presentation hierarchy, but logical level it is associated
with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."AssetClass"."AssetClass"."Gen2,AssetClass" is first
under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning”.."COA type"."COA type"."Gen2,COA type" is first
under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet
Planning".."DelinquenciesExp"."DelinquenciesExp"."Gen2,DelinquenciesExp" is first under presentation
hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Fee Classification"."Fee Classification"."Gen2,Fee
Classification" is first under presentation hierarchy, but logical level it is associated with is not grand total
level.

[39092] Presentation level "Balance Sheet Planning".."Intercompany COA Flag"."Intercompany COA
Flag"."Gen2,Intercompany COA Flag" is first under presentation hierarchy, but logical level it is associated
with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."Sample COA"."Sample COA"."Gen2,Sample COA"
is first under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Balance Sheet Planning".."curr_attrib"."curr_attrib"."Gen2,curr_attrib" is first
under presentation hierarchy, but logical level it is associated with is not grand total level.

[39092] Presentation level "Institutional Performance".."Segment"."Segment Hierarchy"."Type" is first under
presentation hierarchy, but logical level it is associated with is not grand total level.

[39051] Application Role "BIAdministrator" is not defined in the Enterprise Manager.
[39051] Application Role "BlAuthor" is not defined in the Enterprise Manager.
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[39051] Application Role "Relationship Manager" is not defined in the Enterprise Manager.

[39051] Application Role "Sales Representative" is not defined in the Enterprise Manager.

[39051] Application Role "Business Analyst" is not defined in the Enterprise Manager.

Deploying EFPA/ IPA/ RPA Application Report Analytics

Use the following procedure to deploy the EFPA/ IPA/ RPA applications report analytics:

Note: Ensure that Oracle Business Intelligence 12.2.1.3.0 is available.

1. Deploy RPD and webcat file(s).

a.

Go to Oracle home and create a folder under below mentioned path and move the OFS_PFT_PACK.rpd
(with the Connection Pool details) from local to this newly created folder (for example: PFT_RPD)

SORACLE HOME/user projects/domains/bi

Go to the location of datamodel.sh . that is SORACLE HOME/ user projects/domains/bi/bitools/
bin/

Execute the following command:

./datamodel.sh uploadrpd -I rpdLocationPath -SI ssi -U username -P password

Replace rpdLocationpath with where you placed the rpd (for example: SORACLE HOME/
user projects/domains/bi/PFT RPD/OFS PFT PACK.rpd), username/ password with the analytics
username and password.

Web catalog Deployment:

m  CopyOoFs PFT PACK.catalogfrom $FIC HOME/OFSPFTPACKBI/OBIEE/12.2.1.3.0/and pastein
a local folder.

Open the analytics OBIEE URL-(http://<ipaddress>:<port>/analytics) and login with the credentials.

Click "Catalog" link available on the top right corner.
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f. Click "Shared Folders" and then "Un-Archive".

ORACLE Business In

Catalog
User View ~ i m _’EI“ __..
=l Folders [ERIG |

| =l Tasks

i@ Shared Folders

| [£3 Expand @ Archive

g

: 3¢ Delete EF Upload

! Copy @ Properties

| = Rename [ Permissions
&P Create Shortout

g. Browse the path where orFs prT PACK.catalog is copied in the local folder. Select the file and click
Open. Then click OK.

Unarchive @ X
Archive file OF5_PFT_PACK.catalog Browse...
Replace  Mone w
ACL  Inherit “
oK Cancel
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h. Click "Dashboard" and click on any of the reports to ensure that all the reports are available.

Business Intelligence

To add content, cick Edit & here or in the toolbar.

Home

Catalog

iministration

Help +

Favorites + | Dashboards | I New + | BS Open ~ | Signed In As weblogic +

Most Recent(My Dashboard - page 1)
(@ My Dashboard
BSP
Forecast Reports
Financial Reporting
Finandial Reporting
Institutional Performance
Business Summary
Customer Central
Opporturities & Activities
Relationship Manager Insights
Management Reporting
Balance Sheet
Income Statement
Key Trends
Performance Measures
Retail Performance
Business Analysis
Customer Central
Product Summary
Relationship Manager Insights

Restart all services in OBIEE "Enterprise Manager" This is optional.

If you are doing any changes online, then configure ODBC data source to connect to Oracle Bl Server as

follows:

a. Go To Control Panel > Administrative Tools > Data Sources (ODBC).

© o 0 T

f. Click 'Finish'.

4. If RPD deployment is done on Essbase, then modify ESSBASE connection pool and set the properties.

Select the 'System DSN' tab and click 'Add' Button.

Select a driver specific to (Oracle Bl Server 12c) and click 'Finish' Button.
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Enter 'Name' and 'Server' details (Specify the Host Name or IP Address of the Bl Server and click 'Next').

Enter Oracle Bl Server login id and password (Enter User Name and Password created at the time of
OBIEE installation). Click 'Next'.
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Post Installation Changes in instanceconfig.xml File

Do the following changes in the instanceconfig.xml file as post installation changes:
1. Backup and edit the instanceconfig.xml file located at:

SORACLE HOME/user projects/domains/bi/config/fmwconfig/biconfig/OBIPS

Tag to be changed Changes

<Views> <Views>
<Charts>

<DefaultWebImageType>flash</DefaultWebImageType>
</Charts>

</Views>

<Security> <Security>
<CheckUrlFreshness>false</CheckUrlFreshness>

<EnableSavingContentWithHTML>true</
EnableSavingContentWithHTML>

</Security>

2. Save and exit the file.

3. Restart the presentation server for the changes to take effect.
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Deploying D3 on OBIEE 12c Server

This section provides detailed steps to install and configure D3, a visualization framework, which is used in few
reports of IPA and RPA.

To deploy the D3 OBIEE 12c¢ server, do the following:

1.
2,

Download d3.zip of version 3.5.17 and place it in your local folder.
Create analyticsRes folder under below mentioned path:
SORACLE HOME /user projects/domains/

Unzip the d3 folder and move this to analyticsRes in your entitlement server.

analyticsRes - E [ ie=~ e=llval Gj E @ Find Files | F
£ (@
/scratchfobieel2c/Middleware/Oracle_Home/user_projects/domains/analyticsRes
MName . Size Changed Rights Owner
N . 26-05-2017 PM 6:14:41 PWTWXNA ofsaohie
d3 15-06-2017 PM 6:30:57 PWXT-XT-X nraira

Note: To view the Customer Group Structure report, copy the hashMap.js file from srF1c_HOME/
OFSPFTPACKBI/OBIEE/ and place it in to the d3 folder under analyticsRes and restart the application from
the folder.

In case of upgrade, the $rFrc_HoME/OFspFTPACKBI folder will have two folders namely, $F1c_HOME/
OFSPFTPACKBI/OBIEE and $FIC HOME/OFSPFTPACKBI/OBIEE12C. You can ignore the sF1c HOME/
OFSPFTPACKBI/OBIEE12C folder.

Create weB-1NF folder inside d3 folder and place a web . xm1 file with the content as given below:
<?xml version="1.0" encoding="UTF-8"?>
<web-app xmlns="http://java.sun.com/xml/ns/javaee"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalocation="http://java.sun.com/xml/ns/javaee/web-app 2 5.xsd"
version="2.5">
<mime-mapping>
<extension>xsd</extension>
<mime-type>text/xml</mime-type>
</mime-mapping>
<mime-mapping>
<extension>xml</extension>
<mime-type>text/xml</mime-type>

</mime-mapping>
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<mime-mapping>
<extension>js</extension>
<mime-type>text/javascript</mime-type>
</mime-mapping>
<mime-mapping>
<extension>css</extension>
<mime-type>text/css</mime-type>
</mime-mapping>
<mime-mapping>
<extension>png</extension>
<mime-type>image/png</mime-type>
</mime-mapping>
<mime-mapping>
<extension>swf</extension>
<mime-type>application/x-shockwave-flash</mime-type>

</mime-mapping>

</web-app>
| d3 -EE i B 5 @ & | B Find Files | T
B [
/scratch/obieel 2c/Middleware/Oracle_Home/user_projects/domains/analyticsRes/d3
e| | Mame M Size Changed Rights Owner
& .. 20-07-2017 PM 2:41:42 PWHTWHIWX ofsachie
) WEB-INF 15-05-2017 PM 4:48:41 PWHT-KT-X nmaira
|| LICENSE 2KB 17-02-2016 PM 4:33:26 rw-r--r-= nmaira
haShMEp.jS 4 KB 07-09-2015 PM 3:56:57 FW-r--r-- nmaira
B d3.mir1.js 149 KB 17-02-2016 PM 5:39:24 rw-r--r-- nmaira
B d3.js 331 KB 17-02-2016 PM 5:39:22 PW-r--r-- nmaira
E
E
E
| WEB-INF =N fa & G FindFiles | B
£ [
/scratch/obieel 2c/Middleware/Cracle Home/user_projects/domains/analyticsRes/d3/WEB-INF
e | | Mame ’ Size Changed Rights Owner
& - 15-06-2017 PM 6:30:57 PWXI=Xr=X nmaira
| web.xml 1KB 25-02-2016 PM 6:48:42 nW-r--r-- nmaira
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5. Login to web logic server, go to Deployments in your domain structure, and then select Install.

Change Center

View changes and restarts

No pending changes exist, Click the Release
Configuration butten to allow others to edit the
domain.

Lock & Edit

Releasze Configuration

Domain Structure
bi

B1-Domain Partitions
Environment

- Deployments
'Ser\.'ices

!
i--Security Realms

']nteroperability
'Diagncsﬁcs

T
i
L
h

How do I... =

» Install an enterprise application
s Configure an enterprise application

« Update (redeploy) an enterprise application

ORACLE WebLogic Server Administration Console 12¢

@ Home Log Qut Preferences Record Help

Home >Summary of Deployments

Summary of Deployments

Configuration | Control = Monitoring

This page displays the list of Java EE applications and standalone application modules installed to this dol
You can update (redeploy) or delete installed applications and modules frem the domain by selecting the

To install a new application or module for deployment to targets in this domain, click Install.

[ Customize this table

Deployments

Install | | Update Delete

Name &

= adf.orade businesseditor{1.0,12.2.1.1.0}

- 2df.orade.domain(1.0,12.2.1.1.0)

= adf.orade.domain.webapp(1.0,12.2.1.1.0)

L—f-_,ladminsewice (11.1.1)

|_=I:'.Ianalytic5

=

& asyncadminservice (11.1,1)

6. Once you click on Install button, it will take you to the screen shot below where you will paste the full path

to the d3 directory, check the check box next to d3 (open directory) and click Next.

ORACLE webLogic Server Administration Console 12¢

View changes and restarts

Configuration button to allow others to edit the
domain.

Lock & Edit

Release Configuration

Domain Structure
bi

F-Domain Partitions Path:
E-Environment

Current Location:

Ed-Interoperability
EB-Diagnastics

No pending changes exist. Click the Release Install Application Assistant

Recently Used Paths:

® B2 43 (open directory)

Py & Home Log Out Preferences [ Record Help Q

Hame >Summary of Deployments

Back | | Next ‘ Finish | Cancel

Locate deployment to install and prepare for deployment
Select the file path that represents the application root directory, archive file, exploded archive directery, or application module descriptor that you want to install. You can also enter the path of the appl]
Note: Only valid fils paths are displayed below. If you cannot find your deployment files, Uplozd your file(s) andfor confirm that your application contains the required deployment descriptors.
\scratch/obiee12c/Middleware/Oracle_Homeluser_projects/domains/analyticsRes/d3

[scratchfobiee12c/Middleware/Oracle_Home/user_projects/domains/analyticsRes

whf00blox.in.oracle.com [ scratch / obieei2c f Middleware | Oracde_Home [ user_projects / domains [ analyticsRes

Back | | Next ‘ Finish | Cancel
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7. On the next screen, select Install this deployment as an application and click Next.

ORACLE webLogic Server Administration Console 12¢

Change Center @ Home Log Out Preferences Record Help Q
el e et Home >Summary of Deployments =Summary of Services >Summary of Deployments
Mo pending changes exist, Click the Release Install Application Assistant
Configuration button to allow others to edit the
demain. Back | | Next ‘ Finish ‘ Cancel
Lock & Edit
Choose installation and scope
Release Configuration e P

Select if the deployment should be installed as an application or library. Also decide the scope of this deployment.
Domain Structure

The application and its components will be targeted to the same locations. This is the most common usage.
bi
B-Domain Partitions
Environment
Deployments

# Install this deployment as an application

Application libraries are deployments that are available for other deployments to share. Libraries should be available on all of the targets running their referencing applications.
Services

Install this deployment as a library
Interoperability
B-Diagnostics select a scope in which vou want to install the deploymant.

Scope: Global v

Back | | Mext ‘ Finish ‘ Cancel

8. On the next screen, click bi_cluster, and then select All servers in the cluster radio button.

ORACLE webLogic Server Administration Gonsole 12¢

Change Center {@ Home Log Out Preferences Record Help | @
View changes and restarts Home =Summary of Deployments =Summary of Services =Summary of Deployments
Mo pending changes exist. Click the Release Install Application Assistant
Configuration button to allow others to edit the
domain. Back| | Mext| || Finish ‘ Cancel
Lock & Edit
= Select deployment targets
Releaze Configuration

Select the servers and/or clusters to which you want to depley this application. [You can reconfigure deployment targ
Domain Structure

bi Available targets for d3 :
B1-Domain Partitions
Environment

[ a Servers
i--Deployments
Bt-services
1 _emc“e AdminServer
r~Security Realms
Interoperability
'Diagncstic:— Clusters
¥| bi_cluster
®! All servers in the cluster
Part of the cluster
bi_serverl
How do ... =] Virtual Hosts
» Start and stop 3 deployed enterprise bi_internal_virtualhost1
application
» Configure an enterprise application
o Create a deployment plan | Back | | Next | Finish ‘ _Cancel |

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0 184




RPD/ Catalog Deployment, D3 and Map Configuration for OBIEE12c

9. On the next screen, select | will make the deployment accessible from the following location and click

Change Center
View changes and restarts
Ne pending changes exist, Click the Relzase
Configuration button to allow cthers to edit the
domain.

Lock & Edit

Release Configuration

Domain Structure

t- Dom
++-Environment

: nents
+-Sarvices

-~ Security Realms
- Inkzroperability
I~ Diagnostics

in Partitions

-

Start and stop a deployed enterprise
application

Configure an enberprise application

Craake = deployment plan

Target an enterprize application to a server
instance

Test the madules in an enterprise application

How do L... (=]

Health of Running Servers as of 5:32 AM

Overloaded ()
| Warning {0}

I o« ()

System Status =

ORACLE WeblLogic Server Administration Gonsole 12c

@ Home Log Qut Preferences

Record Help Q

Home »Summary of Deploym =Summary of Services >Summary of Deployments

Install Application Assistant

Back | | Mexi

Finish | Cancel

Optional Settings

‘You can modify these settings or accept the defaults,

* Indicates required fields

General

What do you want to name this deployment?

*MName: dz

Security

What security model do you want te use with this application?

* DD Only: Use only roles and policies that are defined in the deployment descriptors.
Custom Roles: Use roles that are defined in the Administration Console; use policies that are defined in the deployment descriptor.
Custom Roles and Policies: Use only roles and policies that are defined in the Administration Console.

Advanced: Use a custom model that you have configured on the realm’s configuration page.

Source Accessil

ty

How should the source files be made accessible?
Use the defaults defined by the deployment’s targets
Recommended s=lection.
Copy this application onto every target for me
During deployment, the files will be copied automatically to the Managed Servers to which the application is targsted,

from the foll

= I will make the depl ac ibl

ing location

Location: /scratch/obies12c/Middleware/Oracle_Home/user_projects/do

10. On this screen, click Activate Changes.

Change Center
View changes and restarts

Pending changas exist, They must be activated
to take effect.

& Activate Changes

Undo &Ml Changes

QIRACLE WebLogic Server Administration Console 12¢

@ Home Log Out Preferences

Record Help Q

Home »Summary of Deployments »Summary of = =Summary of Deployments

Messages
«* The deployment has been successfully installed.
& You must also activate the pending changes to commit this, and other updates, to the active system.

y of Deploy 5

Domain Structure

++-Domain Partitions
- Environment

&t Diagnostics

How do I... =

Instzll an enterprise application

Configure an enterprise application

Update {redeploy]} an enterprise application

Manitor the modules of an enterprise

Configuration | Control | Maonitoring

This page displays the list of Java EE applications and standalone application medules installed to this domain.

You can update (redeploy) or delete installed applications and medules from the domain by selecting the checkbox next to the application name and then using the contralg

Toinstall 2 new application or medule for deployment to targets in this domain, click Install.

[ Customize this table

Daployments

|nstad | | Update | | Delete
MName # State
[ adf.aradle.businesseditor{1.0,12,.2.1.1.0) Active
i adf.orade.domain(1.0,12,.2.1.1.0) Acknre
W 2df.orace.domain.webapp(1.0,12.2.1.1.0) Brtive
# 2 adminsarvice (11.1.1) Active

Healt]

& oK
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11. After activating the changes, the application will now be in a Prepared state, as in the screen shot below.
Click on Control tab. The screen displays all the installed applications. You will have to stop the application
by checking the check box next to it and selecting Force Stop Now from the Stop menu.

ORACLE webLogic Server Administration Console 12¢

Change Center m’ Home Log Out Preferences

d Help aQ

Home >Summary of Deployments =Summary of Services »Summary of Deployments

View changes and restaris

Click the Lock & Edit button to madify, add or Summary of Deployments
delete items in this domain.
Configuration | Control = Monitoring

Lock & Edit

Release Configuration

This page displays the list of Java EE applications and standalone application medules installed to this domain.

Domain Structure
bi

Domain Partitions
Environment [ Customize this table

-Deployments

‘You can start and stop applications and modules from the domain by selecting the checkbox next to the application name and then using the controls on this page.

E3-Senvices Deployments
= Security Realms Start~ | | Stop |
Interoperability
: 4 When work completes
Diagnostics Nam State Health Type
Force stop now
bi{ Stop, but continue servicing administration requests Active ¥ 0K Enterprise Application
bidatasetsve Active « oK Enterprise Application
bimad {11.1.1) Active oK Enterprise Application
How do L... =] bipublisher (11.1.1) Active ¥ 0K Enterprise Application
» Configure an enterprise application bisearch Adee @ ok Esterprise spoliation
» Start applications and modules bitech-analysis-application Active & 0K Enterprise Application
= Stop applications and modules biwssoa (12.1.3) Active ¥ 0K Enterprise Application
» View the modules of an enterprise application
— — B . coherence-transaction-rar Active & 0K Resource Adapier
« Manitor the modules of an enterprise
application |+ & Prepared | % OK Web Application

12. You can start the application by checking the check box next to it and selecting Servicing all requests from

the Start menu.

ORACLE webLogic Server Administration Console 12¢

Change Center @ Home Log Out Preferences

ord Help Q

Home =Summary of Deployments =Summary of Services =Summary of Deployments

View changes and restarts

Click the Lock & Edit button to modify, add or Summary of Deployments
delete items in this domain.

Configuration | Control = Monitoring
Lock & Edit

Release Configuration

This page displays the list of Java EE applications and standalone application modules installed to this domain.
Domain Structure
bi

~Domain Partitions

You can start and stop applications and modules from the domain by selecting the checkbox next to the application name and then using the controls on this pf

: Emvironment b Customize this table
-Deployments
~Services Deployments
~Security Realms [ Start+ | | Stop v
~Interoperability
L e Servicing all requests
Diagnostics State Health
servicing only administration requests
H Elcunfen!zeruer -'.H‘!.ﬂ Active oK
bidatasetsve Active ¥ oK
bimad (11.1.1) Active oK
How do I... = bipublisher (11.1.1) Active & 0K
(] " Active 0K
» Configure an enterprise application bisearch
» Start applications and modules bitech-analysis-application Active & 0K
« Stop applications and modules Bivssoa (12.1.3) Active & oK
» View the modules of an enterprise application
i : . ceherence-transaction-rar Active ¥ 0K
» Monitor the modules of an enterprise
application * d3 Prepared |4 OK
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13. The application will now change to an Active state and ready to use.

OIRACLE webLogic Server Administration Console 12¢

Change Center @ Home Log Out Preferences

d Help ‘ Q

Home =Summary of Deployments =Summary of Servicss =Summary of Deployments

View changes and restarts

Click the Lock & Edit button to modify, add or Summary of Deployments
delate items in this domain.

Configuration | Control | Monitoring
Lock & Edit |

Release Configuration

This page displays the list of Java EE applications and standalone application modules installed to this domain.

Domain Structure
bi

You can start and stop applications and modules from the domain by selecting the checkbox next to the application name and then using the controls en this g

Domain Partitions
Environmant [ Customize this table

Deployments

R Deployments
Security Realms Startv | [Stop v
Interoperability
B Diagnostics Name & State | Health
bicontentserver (11.1.1) Active |9 0K
bidatasetsve Adive | ¥ 0K
Bl bimad (11.1.1) Acive | & OK
How do I... =] bipublisher (11.1.1) Active | % 0K
2 Active |9 OK
» Configure an enterprise application bisearch
 Start applications and modules bitech-analysis-application Active | % OK
» Stop applications and modules fiwssoa f53.9) Bk & oK
s View the modules of an enterprise application : :
: = : coherence-transaction-rar Active ¥ OK
» Monitor the modules of an enterprise
application =] 43 Active |9 oK
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Mapview Configuration for OBIEE 12C

This section provides information on prerequisites, creating the mapviewer mvdemo2 data source, configuration
edits and server starting.

Note: This is just a sample configuration working on sample data provided by mvdemo?2.

This section covers the following topics:

*  Prerequisites
» Creating the Mapviewer mvdemo2 Data source
* Loading FSI_LOCATION_MAP_COORD for viewing mvdemo2 Maps

Prerequisites

The mvdemo2 database dump can be imported only into an Oracle 12c¢ database. If you have no other option
than using a 11g version, contact OBIEE/Mapviewer Product Management.

Creating the Mapviewer mvdemo2 Data source

Ensure that you have a connection to 12c Oracle database from the machine where your OBIEE platform is
installed.

Create a mvdemo2 schema within that database for holding the mvdemo2 spatial data.

To create mvdemo2 schema, perform the steps as explained in the following section.
Downloading the Mapviewer mvdemo Database Dump

To download the Mapviewer mvdemo2 Database Dump, follow these steps:
1. Download MVDEMO Sample Data Set from the following location:
http://www.oracle.com/technetwork/middleware/mapviewer/downloads/index.html

2. Download and unzip the mvdemo_naturalearth.zip file that contains an Oracle Database export file named:

mvdemo naturalearth.dmp
Creating mvdemo2 User

To create a mvdemo2 user, follow these steps:
Start a SQL*Plus session to the Oracle Database as a user with system or DBA privileges.
2. Run the following script:

Create user mvdemo2 identified by mvdemo2 default tablespace users quota unlimited on

users;y;

grant "connect" to mvdemoZ2;

grant "resource" to mvdemo2;
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3.

Once the script is executed, verify whether you can connect to the newly created user.

Note: The mvdemo2 user creation script defaults with the password mvdemo2 (same as user name) within
the script. It is recommended that you keep this value unchanged to simplify configuration.

Importing the database dmp file:

4,

Import the Oracle Database export file - mvdemo_naturalearth.dmp into the mvdemo2 schema using the
following import command, from the command line (Command Prompt in Windows):

c:\> imp mvdemo2/mvdemo2@connectString file=mvdemo naturalearth.dmp FULL=Y

ConnectString is the connection string to your Oracle Database 12c where the user mvdemo2 was created
in the step mentioned earlier. Wait for the import process to complete, once successfully completed, login
on your DB as mvdemo2/mvdemo2 and validate that you can view the schema tables and some data.

Inserting Extra Spatial Metadata:

6.

Start a SQL*Plus session to the Oracle Database and connect as user mvdemo2.

For example: c:\>sqlplus mvdemo2/mvdemo2@connectString

Run the following script:

insert into user sdo_styles select * from styles;

insert into user sdo themes select * from themes;

insert into user sdo maps select * from basemaps;

insert into user sdo cached maps select * from tilelayers;

commit;

MapViewerConfig.xml Edits

o DN

Open the Mapviewer console using the following URL:
http://<ip address>:<port>/mapviewer
Click Admin.
Login with the username/password that you provided while installing the product.
Click Configuration. This opens the mapViewerConfig.xml on your setup.
In the section named Predefined Data Source, add the following data source entry:
Replace the IP address, SID, and port to the correct values of the database where the mvdemo2 schema
has been created in the above steps.
<map_data source name="mvdemo2"
jdbc _host="10.229.147.238" (use your db ip)
jdbc_sid="orcl" (use your db sid)
jdbc port="1521" (use your db port)
jdbc_user="mvdemo2"
jdbc_password="!mvdemo2" (use your selected password if different from OOB)
jdbc mode="thin"

number of mappers="3"
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o 9N

18.
19.
20.

allow jdbc theme based foi="false"
editable="false"
/>

Note: Ensure that all tags have been closed correctly and also the above data source is not within the
comments section (ensure that it is outside the comments section which is represented by <!-- .. -->).

Click Save and Restart button at the bottom of the file.

Once configuration.xml file is restarted, click Data Sources.
Verify whether you can view mvdemo2 as an entry in data sources.
Login to Analytic screen > Administration.

. Click Manage map Data.

. Click Import Layer and then choose World_Countries.
12.
13.
14.
15.
16.
17.

Choose Preview MAP as ORACLE_MAPS.

Same for World_States_Provinces.

Choose Preview MAP as ORACLE_MAPS.

Select Background Maps.

Use import Background maps and chosen ORACLE_MAPS.

Edit the same, add layer World_Countries and then World_States_Provinces. While choosing, chose the
location ORACLE_MAPS for higher Zoom value.

Select the zoom level for country 0 and for country 2...15.
Navigate back to Layers tab.

Edit World_Countries (select Name as the Layer Key) and World_States_Provinces (select State
Province Name as the Layer Key) by adding Bl Key Columns:

For Country:

a. Choose Institutional Performance > Geography > Country Description.

b. Choose Institutional Performance > Branch > Branch Country Description.
c. Choose Retail Performance > Geography > Country Description.

For State:

a. Choose Institutional Performance > Geography > State Description.

b. Choose Institutional Performance > Branch > Branch State Description.
c. Choose Retail Performance > Geography > State Description.

Loading FSI_LOCATION_MAP_COORD for viewing mvdemo2 Maps

For mvdemo2 Maps to work, it requires the location data in our atomic schema to be in sync with the map
Metadata in mvdemo2 schema. This is achieved through a new table FSI_LOCATION_MAP_COORD, the load
process of which is described as follows.
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Populate FST_LOCATION MAP COORD based on DIM LOCATION data itself, but description and codes should
come from tables OBIEE COUNTRY, OBIEE STATE, OBIEE CITY (from the DB schema configured for Maps,
'mvdemo?2’, for example in this case) respectively for Country, State and City, and n_location_skey should be
the corresponding n_location_skey from DIM LOCATION.

For Instance, let us consider the following data from DIM_LOCATION.

N_LOCATION_SKEY

1

V_LOCATION_CODE

HAW

V_COUNTRY_CODE

USA

V_COUNTRY_DESC

United States

V_STATE_CODE HI
V_STATE_DESC Hawaii
V_CITY_CODE CITI1
V_CITY_DESC Honolulu
V_ZIP_CODE 96813

Now, to populate the following columns in FSI_LOCATION_MAP_COORD:

n_location_skey = 1

v_country_code = OBIEE_COUNTRY.ISO_COUNTRY_CODE USA

v_country_code_map = OBIEE_COUNTRY.ISO_COUNTRY_CODE USA

v_country_desc = OBIEE_COUNTRY.NAME United States

v_state_code = OBIEE_STATE.ISO_CTRY_CD_STATE_ABBRV USA_HI

v_state_code_map = OBIEE_STATE.ISO_CTRY_CD_STATE_ABBRV |USA_HI

v_state_desc = OBIEE_STATE.STATE_NAME HAWAII

v_city_code = OBIEE_CITY.CTRY_CD3_STATE_ABBRV_CITY USA_HI_Honolulu

v_city_code_map = OBIEE_CITY.CTRY_CD3_STATE_ABBRV_CITY |USA_HI_Honolulu

v_city_desc = OBIEE_CITY.CITY_NAME HONOLULU

v_zip_code = 96813
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CHAPTER 9 — FAQS AND ERROR DICTIONARY

This chapter consists of resolution to the frequently asked questions and error codes noticed during OFSAAI
installation.

*  Frequently Asked Questions
+ Forms Framework FAQs
*  Error Dictionary

OFSAAl installer performs all the prerequisite validation check during installation. Any errors encountered in the
process is displayed with an appropriate Error Code. You can see the Error Dictionary to find the exact cause
and resolution to rectify the error.This chapter includes the following topics:

Frequently Asked Questions

You can refer to the Frequently Asked Questions which has been developed with the interest to help you resolve
some of the OFSAAI Installation and configuration issues. This intends to share the knowledge of problem
resolution to a few of the known issues. This is not an official support document and just attempts to share the
knowledge of problem resolution to a few of the known issues.

This section includes the following topics:

+ OFSAAI FAQs
* Application Pack 8.0.6.0.0 FAQs

OFSAAI FAQs

What are the different components that get installed during OFSAAI?
The different components of OFSAAI are illustrated in figure in the section Components of OFSAAI.

What are the different modes of OFSAAI installation?
OFSAAI can be installed in two modes, Silent Mode, and GUI mode.

Can the OFSAA Infrastructure components be installed on multi-tier?

No. OFSAA Infrastructure components (ficapp, ficweb, ficdb) cannot be installed on multi-tier. By default,
they will be installed on single-tier. However, OFSAA Infrastructure can be deployed within the n-Tier
architecture where the Database, Web Server and Web Application Server is installed on separate tiers.

Is JDK (Java Development Kit) required during installation of OFSAA? Can it be uninstalled after OFSAA
installation?

JDK is not required during installation of OFSAA and only a run time is needed for details. Refer to Hardware
and Software Requirements, Java Runtime Environment section.
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Is JRE required during installation of OFSAA? Can it be uninstalled after OFSAAI installation?
Only JRE (Java Runtime Environment) is required during installation of OFSAA and cannot be uninstalled
as the JRE is used by the OFSAA system to work.

How do | know what is the Operating system, web servers and other software versions that OFSAA supports?

Refer to OFSAA Technology Stack Matrices.

What are the different files required to install OFSAAI?
To install OFSAAI, the following files are required:

setup.sh.

envCheck.sh
preinstallcheck.sh
VerInfo.txt
OFSAAInfrastructure.bin
validatedXMLinputs.jar

log4j.xml

OFSAAI PostInstallConfig.xml
OFSAAI InstallConfig.xml
privileges config user.sql

o

Q

o

o

Q

o

O MyResources _en US.properties
Q

o

o

Q

O privileges atomic user.sql
o

XML Utility.jar

What should | do if | get the following error message during installation, "Execute Permission denied"?
Please check whether all the files provided for OFSAAI installation has execute permissions.
To give execute permissions, navigate to the path OFSAAI_80000 and execute the command:

chmod 755

"Graphical installers are not."

If error resembles "Graphical installers are not supported by the VM. The console mode will be used
instead..." then check whether any of the X-windows software has been installed.

Example: Hummingbird Exceed is started and configured to Graphical mode installation.

Note: Type 'xclock' from prompt and this should display clock in graphical mode.

"No Java virtual machine could be..."

If the error message reads "No Java virtual machine could be found from your PATH environment variable.
You must install a VM prior to running this program"”, then

o Check whether "java path" is set in PATH variable. See the Installer and Installation Prerequisites
section in this document.

o Check whether sufficient temporary space is available.
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o Ensure that the movement of OFSAAI Installer text files to the target system is done in the Text mode
so that setup.sh file does not contain control line feed characters (*M).

What should | do if | get the following error message during installation, "OracleDriver Files Not Found, Please
Choose the Right Path To Continue"?
Check whether the provided path for Oracle Driver files is correct and whether the user has permissions to

access the files.

What should I do if | get the following error message during installation, "User must have CREATE TABLE,
CREATE VIEW, CREATE TRIGGER, CREATE INDEX, CREATE SEQUENCE, CREATE PROCEDURE" even
though the oracle schema user created has the mentioned privileges?

OFSAAI installer validates the database details provided during installation, so ensure:

Whether the oracle schema user has the required set of privileges for successful installation.

Whether the oracle schema user has been created with quota privileges on tablespace to create
database objects.

o See the Installer and Installation Prerequisites section in this document.

Installation of OFSAAI was completed successfully! What next?
Post the successful completion of OFSAAI installation, one has to perform the Post Installation steps. See
Post-Installation Configuration.

What is to be done when OFSAAI Installation is unsuccessful?

OFSAAI installer generates log file OFSAAInfrastructure_Install.log in the Infrastructure Installation
Directory. There is also another log file created in the path configured in Log4j.xml. The logs of any of
these reported, Warnings/Non Fatal Errors/Fatal Errors/Exceptions should be brought to the notice of
the OFSAAI Customer Support. It is recommended not to proceed, until the reported problems are
adequately addressed.
How do | completely uninstall OFSAAI?
OFSAAI can be completely uninstalled by performing the steps provided in Uninstalling OFSAA
Infrastructure in the OFS AAAI Installation and Configuration Guide Release 8.0.6.0.0.
Can OFSAAI config and atomic schemas be on different databases?

OFSAAI requires both config and atomic schemas to be present on the same database instance.

How to grant privileges if a new information domain is created?

If you are creating a new information domain, provide a set of privileges (database permissions) to the new
Atomic schema.

o Log into the database as sys and connect as sysdba user.
o Execute the file privileges_config_user.sql available under $FIC_HOME directory
o Enter the database schema for which you want to grant privileges.
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When should | run the MLS utility?
See the Multiple Language Support (MLS) Utility section in OFSAAI Administration Guide available on OHC.

Does OFSAAI support Oracle Linux versions other than 5.5?

OFSAAI supports the Oracle Linux versions from 5.5 up to 5.10 and also from 6.0 and above.
What should I do if | get the following error message on the UNIX System terminal while executing ./setup.sh,
“Insert New Media. Please insert Disk1 or type its location"?

a. Login as root user on the Unix machine where OFSAAI is getting installed.

b. Navigate to the path /etc/security/.

c. Edit the file limits.conf to add/edit a row for the UNIX user installing OFSAA:
<Unix User> soft nofile 9216

d. After saving the changes, log in as UNIX user with which OFSAAI is getting installed and execute the
command:

ulimit -n

The command should return the value 9216.

How does one verify if the system environment is ready for OFSAAI installation?

To verify the system environment meets the minimum requirements for the installation, a Pre-Install Check
utility is available within the Install Kit archive file. This utility can also be obtained separately by contacting
Oracle Support.

See Verifying the System Environment section for additional information.

How do I know if the installation is completed successfully?

The OFSAA Infrastructure installation performs a post install health check automatically on successful
installation of the product. To rerun the post install verification at a later time, perform the following steps:

a. Navigate to the path $FIC_HOME (Product Installation Directory).
b. Execute the command:
./piverify.sh
What should one do if the installation in GUI mode is not invoked?
There are set of configuration steps required to be performed during the installation in GUI mode. Verify
whether the steps mentioned under Configuration for GUI Mode Installation section are done correctly.
What should one do if there are any exceptions or errors in installation and how to proceed?

a. Please backup the installation logs.
b. Share the backup logs with Oracle support.

What should I do if | get the following error message during OFSAAI installation on Solaris 11 system?
"Error: OFSAAI-1108
ORA-00604: error occurred at recursive SQL level 1

ORA-01882: timezone region not found"
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Or
"Time zone cannot be set as null or ‘localtime' "

This happens if the time zone is not set, that is NULL or it is set as 'localtime’. Set the environment variable
TZ to a valid time zone region in the .profile file. For example:

TZ=Asia/Calcutta
export TZ

What should | do if the installation process is abruptly terminated or aborted?

a. Ifthe installation is abruptly terminated, then the installation process will be incomplete. To recover from
this, follow the below steps:

b. Drop the DB objects in the config schema created by OFSAAI installation.

c. Open the .profile file and remove the entries made by the OFSAAI installation which are made between
the comment statements, #Beginning of entries by OFSAA Infrastructure installation and #End of
entries by OFSAA Infrastructure installation.

d. Delete the OFSAA install directory created by the OFSAAI installer.
e. Perform the OFSAAI installation again.

Does OFSAA support any other web server types, other than the ones stated in tech matrix and installation
guide?

No, all the supported softwares and versions are stated in the OFSAA Technology Stack Matrices.
What should one do if the database connection from connection pool throws an error
"java.sql. SQLRecoverableException: 10 Error: Connection reset"?

This happens while running several database intensive tasks in parallel. To correct this error, add the line
securerandom.source=file:/dev/./Jurandom in the java.security configuration file available in $JAVA_HOME/
jre/lib/security/ path.

Note: This needs to be configured on all the machines or VMs where the OFSAAI components are
installed.

If the issue is not resolved even with the above settings, check the MTU (Maximum Transmission Unit)
settings on the Linux box. For details on MTU settings and updating them, contact your system
Administrator.

What should | do when | get syntax errors/file not found error messages while invoking setup.sh file from my
install archive?
This could mostly happen:

o When installer was not unzipped correctly or corrupted during unzip.

o setup.sh file which resides within the install archive was not transferred in ASCII or text mode, which
could have corrupted the file.

To correct this, follow the steps:
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a. Copy the installer (in BINARY mode) to the system on which the OFSAA Infrastructure components will
be installed.

b. Unzip the installer using the command:
unzip <OFSAAI Installer>.zip

c. The corrupted setup.sh file would have introduced certain *M characters into the file. You can remove
AM characters from setup.sh file by following the below steps:

i. Login to the server where the installer is copied.
i. Navigate to the directory OFSAAI_80000.
iii. Open the setup.sh file in the vi editor using the command: vi setup.sh.

iv. Inside vi editor in Esc mode, type: %s/*M//g

Note: To enter M, hold the CTRL key then press V and M in succession.

v. Save the setup.sh file by typing: wq!

Does OFSAA support Oracle DB 11g Standard edition?

The OCI client and the jdbc driver does not change depending on whether it is a standard or enterprise
edition. So, OFSAAI will work with standard edition as well.

We do not recommend standard edition because it will not scale and does not support partition pack,
database security vault, or advanced analytics.

What should I do if | get the following error message while executing ./reveleusstartup.sh file on the UNIX
System terminal "./reveleusstartup.sh: /java: Execute permission denied"?

o Ensure JAVA_BIN environment variable path is set on the "UNIX user" terminal from where the
reveleusstartup.sh file is invoked.

o Ensure the .profile where the environment/ path settings are made has been executed successfully.

What happens when the OFSAAI Application Server does not proceed even after providing the system
password?

Ensure that, the System Password provided when prompted should match with the "Oracle Configuration
password" provided during installation. Also check whether the connection to the "configuration schema"
can be established through sqlplus.

Although the OFSAAI installation has completed successfully, when OFSAAI servers are started, and the
application URL is accessed, it gives an error message "the page cannot be found or displayed" or "Could not
retrieve list of languages from Server. Please contact the system administrator". What should one do?

Ensure OFSAAI servers have been started and are running successfully. On the server start up parameters
options, see the Starting Infrastructure Services section.

For more details on the issue, refer on to the Revappserver log in $F1C_APP  HOME/common/FICServer/
logs directory or the Web Server log files.

Is it necessary to provide the specified grants to the Oracle schema user before installation? If yes, can it be
revoked after completion of installation?
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The "Oracle schema" user requires the necessary grants specified before, during, and after the installation
process. Grants provided should never be revoked as the application makes use of these grants all the time.

Can we have distributed OFSAAI Application Server for load balancing?

OFSAAI Application server can be scaled out/distributed across different JVM's (machines) based on the
various services and Information Domains, in other words, Load balancing could be achieved with
distribution of services.

Why do we need Ftpshare? Why is it needed on all the layers? Can we have ftpshare on another machine other
than the machines where OFSAAI is installed?

Ftpshare is a Metadata Repository directory. All the Metadata related files used in Infrastructure are stored
in the ftpshare directory. The ftpshare contains folders for each Information Domain, with each Information
Domain folders holding Erwin, log, and scripts folder. The transfer of data among the Web, Application, and
Database servers in Infrastructure takes place through FTP/SFTP.

You need to configure FTP/SFTP and enable communication between the servers by providing App server's
FTP/SFTP credentials to the Web server and DB server users.

Yes, we can have ftpshare on another machine other than the machines where OFSAAI is installed.

Is it mandatory to provide the ftp/sftp password?
Yes, OFSAAI needs credentials of the user which has complete permissions on ftpshare directory, and
should be able to independently login to the UNIX server.

What are the permissions required for FTPSHARE and when should | give them?

It is recommended to provide permissions on FTPSHARE in case of installations done across different
machines or VMs (multi-tier installation).

In case of single tier installation, 770 permissions can be provided if the UNIX users of OFSAAI and web
server belong to the same UNIX group.

And on any new file that is created in the 'ftpshare’ folder of any installation layer should be granted specific/
explicit permission.

Port Change utility can be used to have the Port number modified, which are currently being used by the
Infrastructure application. For more information, refer Changing IP/ Hostname, Ports, Deployed Paths of the
OFSAA Instance section in OFS Analytical Applications Infrastructure Administration User Guide in OHC
Documentation Library.

Are there any in-built system administration users within OFSAAI Application?

The three in-built system administration users are provided to configure and setup OFSAAI.

o SYSADMN
o SYSAUTH
o GUEST

Does OFSAAI Application support both FTP and SFTP?
OFSAAI supports both FTP and SFTP configuration.

Is it necessary to enable the FTP/SFTP services to use the OFSAAI?
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Yes, enabling of FTP/SFTP services and its ports is a prerequisite step towards using the OFSAAI.

OFSAAI Configuration: Unable to save the server details?

o Ensure the input User ID, Password, and Share Name are correct.
o Ensure FTP/SFTP services are enabled.

o Have a test FTP/SFTP connection made and confirm if they are successful.
What should | do if | get the following message while creating Information Domain, "Please create a database
and then create the information domain"?

Information Domain is mapped to only one Database; and thus before the creation of Information Domain,
at least one database details would need to exist.

What should I do if | get the following message during startup of back-end engine message server,
"ConnectToDatabase: FatalError, could not connect to the DB server"?

Verify whether connection to the "configuration schema" can be established through sqlplus.
Verify "configuration schema" password is modified post installation.

Ensure oracle database alias name created for oracle instance and oracle service name are same.

o O O ©

On a mulii tier Installation mode, ensure TNSNAME and SID are the same in both the Application and
Database Layers.

What should I do if | get the following message during the startup of back-end engine message server, "Fatal
Error, failed to get user ID from LibSmsConnect"?
Ensure Reveleus.sec file exist under the $FIC_HOME/conf directory where the Database components are
installed.

Does OFSAAI Application support LDAP authentication?
OFSAAI supports LDAP configuration and authentication.

Does OFSAAI support multiple languages?
Yes, OFSAAI supports multiple languages.

Does OFSAAI provide any data back-up features?

OFSAAI does not have built-in back up facility. External Storage Infrastructure is recommended for back-up.

What kind of security features does the OFSAAI provides?
OFSAAI provides security at:

o Segment Level - Users can access only the segment they are mapped to.

o Application Level - Users can perform an operation only if mapped to appropriate role and functions.
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Does OFSAAI have the ability to enforce periodic password change?
OFSAAI provides configurable parameters to define number of days after which the user password would
expire and then the user is forced to change the password after expiration period.
What is the password policy followed in OFSAAI?
OFSAAI enforces a minimum password length with a combination of Upper and Lower case characters and
alpha-numeric strings.
Which version of Erwin Data Modeller does OFSAAI support?

The references to Data Modeler ERwin versions 70, 71, 72, 90, 92 and 96 are provided for the AAIl
framework to support these for backward compatibility. However, the data model-slices shipped with OFS
AAAI 8.0.6.0.0 application packs are compatible with Erwin versions 9.5, 9.6, and 9.7.

Does OFSAAI provide the mechanism to upload Business Data model?
OFSAAI provides two mechanisms for business data model upload:

o Easy to use GUI based Model upload mechanism to upload the Business Data Model through Unified
Metadata Manager --> Import Model.

o OFSAAI also provides a model upload utility "upload.sh" for uploading the business data model through
the command line parameter by executing this shell script file under the path <FIC_HOME>/ficapp/
common/FICServer/bin.

See the section Run Model Upload Utility of the Oracle Financial Services Analytical Applications
Infrastructure User Guide on OHC for details.

How do I apply incremental change to the existing model when the Business Data model undergoes a change?
Modified data model can be uploaded into the system and OFSAAI has the ability to compare the changes
within the data model with respect to the one already present in the system and enables propagation of
incremental changes in a consistent manner.

What are the different types of uploading a business data Model?

OFSAAI supports uploading of business data model from client desktop and also by picking up the data
model from the server location.

Can the OFSAAI "Configuration Schema" password be modified post installation?

The OFSAAI Configuration Schema password can be modified post installation. OFSAAI application stores
the password in the database and few configuration files, thus any changes to the Configuration Schema
password will require updating in those files. For more information, see OFSAA Infrastructure Config
Schema Password Modification.

Can the OFSAAI "Atomic Schema" password be modified?

The OFSAAI "Atomic Schema" password can be modified. OFSAAI application stores the atomic schema
password in the database and few configuration files, thus any change to the atomic schema password
would necessitate updating the password.

To change the Atomic Schema password, follow the steps:

o Login to OFSAA.
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o Navigate to System Configuration > Database Details window. Select the appropriate connection,
provide the modified password and save.

o Navigate to Unified Metadata Manager > Technical Metadata> Data Integrator > Define Sources
window. Update the appropriate Source details.

If you are using Apache Tomcat as Web server:

o Update the <Context> -> Resource tag details in server.xml file from the $CATALINA_HOME/conf
folder. (In case of Tomcat only Atomic <Resource> will exist).

o Login to the WebSphere Administration Console from the left side menu.
Navigate to Resources >JDBC >Data Sources. A list of data sources will be populated on the right side.

o Select the appropriate Data Source and edit the connection details. (In this case, both Config and
Atomic data sources need to be modified).

If you are using WebLogic as Web server:

Login to the WebLogic Administration Console from the left side menu.

Under Domain Structure list box, expand the appropriate Domain and navigate to Services > JDBC
>Data Sources. A list of data sources will be populated on the right side.

o Select the appropriate Data Source and edit the connection details. (In this case, both Config and
Atomic data sources need to be modified).

Restart the OFSAAI services

If the modified passwords are not updated, OFSAAI logs displays the message ORA-28000: the account is
locked.

Does the upload of Business Data model depend on Java Memory?

Business data model upload through OFSAAI depends on the Java memory settings on the client and
server machines. Java memory setting varies with the data model size and the available RAM. Contact
OFSAAI support for more details.

Why do the Business Metadata Management screens (Business Processors screen) in User Interface, takes
longer time to load than other screens?

The Log file in DynamicServices.xml which resides in $FIC_HOME/conf is continuously being updated/
refreshed to cache Metadata. This can be observed when you are starting reveleusstartup.sh and if any of
the log file (Ex: sMsservice.log)in DynamicServices.xml is being continuously refreshed for longer time.

By default, the Metadata Log file cache size is set to 1000. If the log is being updated beyond this limit,
retrospectively the preceding entries are overwritten. For example, the 1001th entry is overwritten by
deleting the first entry. This results in the application screen taking a longer time to load.

Increase the cache size limit in Dynamicservices.xml located at <FIC_HOME>/conf, depending on the
currently logged count for the specific Metadata.
o Generate the Log report by executing the below query in config schema.

select count(l), t.metadata name, m.dsn id

from metadata master m, metadata type master t

where m.metadata type = t.metadata type

group by t.metadata name, m.dsn_ id
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o The above query returns a list of codes with their respective Metadata count. You can see
"metadata_type master" table to identify the Metadata name.

o View the log report to identify the Metadata which is being updated/refreshed beyond the specified
cache size limit. Accordingly increase the cache size limit in Dynamicservices.xml depending on the
currently logged count for the specific Metadata.

For example, if the "MEASURE_CACHE_SIZE" is set to 1000 and total measure reported in log is 1022,
increase the limit to 2000 (approximately).

o Restart Reveleus/OFSAAI servers (Web and APP) and check the issue.

What should | do if | get OutOfMemoryError while deploying EAR file in WebSphere application server?

The Java memory needs to be increased in ejbdeploy.sh file which is present under <WebSphere Install
directory>/AppServer/deploytool/itp. For example,

$JAVA CMD \

-Xbootclasspath/a:$ejbd bootpath \

Xms256m -Xmx1024m \

What configurations should | ensure if my data model size is greater than 2GB?

In order to upload data model of size greater than 2GB in OFSAAI Unified Metadata Manager- Import Model,
you need to configure the required model size in struts.xml file available in the path $FIC_WEB_HOME/
webroot/WEB-INF/classes.

Note: The size requirements have to be always specified in bytes.

For example, if you need to configure for model size of 2.5GB, then you can approximately set the max size
to 3GB (3221225472 bytes) as indicated below, in order to avoid size constraints during model upload.

<constant name="struts.multipart.maxSize" value="3221225472"/>

After configuring struts.xml file, generate the application EAR/WAR file and redeploy the application onto
your configured web application server. For more information on generating and deploying EAR / WAR file,
see Creating EAR/WAR File and Deploying EAR/WAR File sections.

What should I do if my Hierarchy filter is not reflecting correctly after | make changes to the underlying
Hierarchy?

In some cases, the Hierarchy Filters do not save the edits correctly if the underlying Hierarchy has been
changed. This can occur in hierarchy maintenance, where you have moved a member to another hierarchy
branch, and that member was explicitly selected in the Filter and is now a child of a node which is already
selected in the Filter.

See the Support Note for the workaround.

How do you turn off unused information domains (infodoms) from cache?
Follow the below steps to turn off unused infodoms from cache:

o Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation.

o In the DynamicServices.xml file, identify the section for <Service code="20">.
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Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1).

o Repeat the same in the WEB layer too. Generate the application EAR/WAR file and redeploy the
application onto your configured web application server. For more information on generating and
deploying EAR / WAR file, see Configuring Web Application Servers.

o Restart the OFSAAI Services (APP and WEB). For more information, see Start/Stop OFSAA
Infrastructure Services.

Note: This setting will cache the Infodom Metadata only for the infodoms that get accessed upon user
login. Infodoms which do not get accessed, will not be cached.

Sample code is pasted below:

<SERVICE CODE="20"

CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD"

SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10">
<PARAMETERS>
<PARAMETER NAME="CACHE ON_ STARTUP" VALUE="0" />

<PARAMETER
<PARAMETER
<PARAMETER
<PARAMETER
<PARAMETER
<PARAMETER
<PARAMETER
<PARAMETER
<PARAMETER
<PARAMETER
<PARAMETER
<PARAMETER
<PARAMETER
<PARAMETER
<PARAMETER
<PARAMETER
</PARAMETERS>

</SERVICE>

NAME="BACKUP_XML" VALUE="1" />

NAME="MAX BACKUP XML" VALUE="2" />
NAME="PC_NONBI BI SWITCH" VALUE="2048" />
NAME="HIERARCHY NODE LIMIT" VALUE="2000" />
NAME="ALIAS CACHE SIZE" VALUE="1000" />
NAME="DATASET CACHE SIZE" VALUE="2000" />
NAME="MEASURE CACHE SIZE" VALUE="2000" />
NAME="HIERARCHY CACHE SIZE" VALUE="2000" />
NAME="DIMENSION CACHE SIZE" VALUE="2000" />
NAME="HIERARCHYATTRIBUTE CACHE SIZE" VALUE="1000" />
NAME="CUBE_CACHE_SIZE" VALUE="1000" />
NAME="RDM CACHE SIZE" VALUE="1000" />
NAME="BUSINESSPROCESSOR CACHE SIZE" VALUE="2000" />
NAME="DERIVEDENTITY CACHE SIZE" VALUE="1000" />
NAME="LOG_GET METADATA" VALUE="false" />

NAME="METADATA PARALLEL CACHING" VALUE="0" />

Can I install an Application Pack on an existing Atomic schema/ Information Domain created manually?

No, you cannot install an Application Pack on existing Atomic schema/Information Domain created
manually. Application Packs can be installed only on Atomic Schemas/Information Domain created using
schema creator utility and/ or the Application Pack installer.
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What should I do if I get the following exception while trying to view the model outputs in Model Outputs screen,
"Exception ->Local Path/STAGE/Output file name (No such file or directory)"?

Ensure you have created a folder "STAGE" under the path mentioned as "Local Path" in the web server
details screen. This folder needs to be created under the local path on every node, in case of web
application server clustering.

What should I do if | get the following exception during OFSAA services startup, "Exception in thread "main”
java.lang.UnsatisfiedLinkError: net (Not a directory)"?
Ensure the JRE referred in .profile is not a symbolic link. Correct the path reference to point to a physical
JRE installed.

What is the optimized memory settings required for "New" model upload?

The following table lists the optimized memory settings required for "New" model upload.

Upload Options Size of Data Model XML File X_ARGS_APP ENV Variable in
OFSAAI APP Layer
Pick from Server 106 MB “-Xms1024m -Xmx1024m
36 MB “-Xms2048m -Xmx2048m
815 MB “-Xms4096m -Xmx4096m
1243 MB “-Xms6144m -Xmx6144m
Model Upload Utility 106 MB “-Xms1024m -Xmx1024m"-
Xms2048m -Xmx2048m
336 MB “-Xms4096m -Xmx4096m
815 MB “-Xms4096m -Xmx4096m
1243 MB “-Xms6144m -Xmx6144m
Save New Erwin File In Server 106 MB “-Xms1024m -Xmx1024m
336 MB “-Xms2048m -Xmx2048m

“-Xms4096m -Xmx4096m

“-Xms6144m -Xmx6144m

What is the resolution if | get the error - ORA 01792 maximum number of columns in a table or view is 1000
during T2T execution?

You should apply the below patch set from Oracle. Applicable only for 12c.
https://support.oracle.com/epmos/faces/DocumentDisplay?id=1937782.1
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I did not enable OFS Inline Processing Engine Application license during the installation. However, | have
enabled it post installation, using the Manage OFSAA Product License(s) in the Admin Ul. Are there any other
additional configurations that | need to do?

Yes. Follow the instructions explained in the OFS Inline Processing Engine Configuration Guide available
on OHC.

I get an error when | try to build an Oracle OLAP cube. What should | do?
Execute the below grant on the appropriate ATOMIC schema

grant olap user to &database username

How do you turn off unused Information Domains (Infodoms) from caching?
Follow these steps to turn off unused infodoms from caching:

Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation.
In the Dynamicservices.xml file, identify the section for <Service code="20">.

Modify the value of parameter cacie_on sTarTUP to O (default is 1).

o 0O O ©

Repeat the same in the WEB layer too. Generate the application EAR/WAR file and redeploy the
application onto your configured web application server. For more information on generating and
deploying EAR / WAR file, see Creating EAR/WAR File and Deploying EAR/WAR File sections.

o Restart the OFSAAI Services (APP and WEB). For more information, see the Start/Stop OFSAA
Infrastructure Services section.

Note: This setting will cache the Infodom Metadata only for the infodoms that get accessed upon user
login. Infodoms which do not get accessed, will not be cached.

Sample code is pasted below:

<SERVICE CODE="20"
CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD"
SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10">
<PARAMETERS>
<PARAMETER NAME="CACHE ON_ STARTUP" VALUE="0" />
<PARAMETER NAME="BACKUP XML" VALUE="1" />

<PARAMETER NAME="MAX BACKUP_ XML" VALUE="2" />

<PARAMETER

<PARAMETER

<PARAMETER

<PARAMETER

<PARAMETER

<PARAMETER

<PARAMETER

<PARAMETER

<PARAMETER

NAME="PC_NONBI BI SWITCH" VALUE="2048" />
NAME="HIERARCHY NODE_LIMIT" VALUE="2000" />
NAME="ALIAS CACHE SIZE" VALUE="1000" />
NAME="DATASET CACHE SIZE" VALUE="2000" />
NAME="MEASURE_CACHE_SIZE" VALUE="2000" />
NAME="HIERARCHY CACHE SIZE" VALUE="2000" />
NAME="DIMENSION CACHE SIZE" VALUE="2000" />
NAME="HIERARCHYATTRIBUTE CACHE_SIZE" VALUE="1000" />

NAME="CUBE_CACHE SIZE" VALUE="1000" />
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<PARAMETER NAME="RDM CACHE SIZE" VALUE="1000" />

<PARAMETER NAME="BUSINESSPROCESSOR CACHE SIZE" VALUE="2000" />

<PARAMETER NAME="DERIVEDENTITY CACHE SIZE" VALUE="1000" />

<PARAMETER NAME="LOG GET METADATA" VALUE="false" />

<PARAMETER NAME="METADATA PARALLEL CACHING" VALUE="Q0" />
</PARAMETERS>

</SERVICE>

“While creating an Excel Mapping, after specifying the excel worksheet, the target table, and mapping each
column in the worksheet to a target table, I click SAVE and nothing happens. But when | click CANCEL, a
message pops up informing me that all changes will be discarded", what is to be done.

Check if the excel mapping creation is done using |.E 8 with JRE 1.4 plug in enabled on machine. If so,
upgrade the JRE plug in to 1.7+.
Can Multiple OFSAA Infrastructure instances share the same config schema?

No, only one OFSAA environment can be installed using one config schema.

Can Atomic schema be shared?
Yes, it can be shared between two OFSAA instances.
While setting a firewall, which ports should be opened for communication between the Web Server (Apache

HTTP Server/ Oracle HTTP Server/ IBM HTTP Server) and the Web Application Server (WebSphere/
WebLogic/ Tomcat) for OFSAAI to operate properly?

The OFSAA Servlet port which is same as Web server port should be open. Also the web application port
should be open.
Can | modify the NLS_ LENGTH_SEMANTICS to BYTE from CHAR for the Database where older versions of
OFSAA is Installed?
Yes, NLS_LENGTH_SEMANTICS can be modified to BYTE from CHAR if you are not intending to use multi
language support.
Can | install already installed application in a different infodom?

No, it is not possible to install the same application in two different infodoms.

How can I configure the OFSAA application for High Availability?
OFSAA can have active-passive high availability. For more details, see the Configuration for High
Availability- Best Practices Guide.

| want to configure OFSAA for High Availability that is WebLogic cluster on which OFSAA.ear is deployed and

cluster OFSAAI processes (such as Reveleus etc) are running. Is this a supported configuration?

High Availability is available for WebLogic cluster and DB level as active-active, but is not available on the
application side. OFSAA can have active-passive high availability. For more details, see Configuring
OFSAA in Clustered Environment Guide.
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During OFSAA installation should | provide web application server's IP /Hostname and port or web server's IP/
Hostname and port, if the Apache HTTP Server/ Oracle HTTP Server/ IBM HTTP Server are configured?

If the web server is configured, you should enter the Web Server IP Address/Hostname and Port details
during OFSAA installation. Here the Servlet port should be same as the Web Server port.

If Web Server is not configured, the Web Application Server's IP Address/ Hostname and Port is required
during the installation process. Here the Servlet port should be same as the Web application Server port.

Is "ReveleusAdminConsoleAgent” applicable for OFSAAI 8.0.6.0.0 and higher versions?

No, ReveleusAdminConsoleAgent is not applicable starting OFSAAI 7.3.3.0.0. There is a change in the way
agentservers are managed through AGENTSTARTUP.SH & AGENTSHUTDOWN.SH.

What should | do when the message server process does not open and | get the following error message,
"CIl18NProvider::Cl18NProvider, Error, unable to connect to the config database"?

This error is displayed due to the following reasons:

The Config Schema password is already expired.

If the config schema password is going to expire soon and the message like "ORA-28002: the password
will expire within 6 days" displays while connecting to config schema through sqlplus.

o The Config schema password is Modified.

To resolve the error, re-set the config schema password to the old password. Else, if the config schema
password is modified to something else then follow the below steps:

o Delete the $FIC_HOME/conf/Reveleus.SEC file.

o Shutdown the OFSAAI App service: cd $FIC_APP_HOME/common/FICServer/bin ./stopofsaai.sh
o Shutdown the OFSAAI App service: cd $FIC_APP_HOME/common/FICServer/bin ./stopofsaai.sh
o

Start the Infrastructure Server in foreground directly on the server or through XWindows software using
the command: ./startofsaai.sh

Enter System Password.

Enter the new Config schema password. The service starts and initializes if it is able to successfully
connect to the DB and generates the Reveleus.SEC file.

o Post successful startup of the service, if required, the Infrastructure server may be shut down and
restarted in the background using nohup mode.
What is the mechanism of Log File sizing and backup?

OFSAAI Log files created under sF1C_APP HOME/common/FICServer/logs & <OFSAAI DEPLOYED AREA>/
<CONTEXT.war>/logs is configurable in RevlL.og4jConfig.xml.

The default size of the log files (MaxFileSize) is set to max 5000kb & number of max backup log files
(MaxBackuplndex) retained is set to 5, both of which are configurable. Increasing these parameters to a
higher value should depend on the server HW configurations and may reduce the performance.

To configure the Logs file size on OFSAA Application server, follow these steps:

o Navigate to $FIC_HOME/conf where OFSAA is installed.
o Edit the following parameters in the file RevLog4jConfig.xml

<param name="file" : Enter the path where the Logs are to be generated.
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<param name="MaxFileSize" : Provide the required file size.

<param name="MaxBackupIndex" : Provide the required number of backup files to be
created.

Example:

<appender name="REVSERVERAPPENDER" class="org.apache.log4j.RollingFileAppender">

<param name="file" value="$FIC HOME/ficapp/common/FICServer/logs/RevAppserver.log"/
>

<param name="Append" value="true" />

<param name="MaxFileSize" value="5000kb" />

<param name="MaxBackupIndex" value="5" />

<layout class="org.apache.log4j.PatternLayout">

<param name="ConversionPattern" value="[REVELEUSLOG] %m%n"/>
</layout>

</appender>

To configure the Deployed area logs file, follow these steps:

o Navigate to <EAR/WAR Deploy area>/conf folder.
o Repeat step 2 from the above section.

Can we modify the Log file path?

Yes, Log file path is configurable, it can be configured in RevLog4jConfig.xml.default log file path (file) is set
by the installer. This can be configured to another path.

Can | point the environment with HTTP enabled to HTTPS after installation and vice versa?
Follow these steps:

o Create SSL related certificates and import to respective servers.

o Enable SSL on a desired Port (example 9443) on your existing and already deployed web application
servers.

o Replace the protocol as https and new ssl port (FIC_SERVLET_PORT) configured and in all the URLs
specified on below files:

SFIC HOME/ficapp/common/FICServer/conf/FICWeb.cfg and $FIC_ HOME/ficweb/webroot/
conf/FICWeb.cfg

SFIC_HOME/ficapp/icc/conf/WSMREService.properties

$FIC HOME/ficweb/webroot/conf/ModelExecution.properties

SFIC HOME/ficdb/conf/MDBPublishExecution.properties

SFIC HOME/ficdb/conf/ObjAppMap.properties

$FIC HOME/utility/Migration/conf/WSMigration.properties

SFIC HOME/utility/WSExecution/conf/WSExecution.properties

SFIC HOME/EXEWebService/WebSphere/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.wsdl

SFIC HOME/EXEWebService/Tomcat/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.wsdl

SFIC_HOME/EXEWebService/weblogic/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.wsdl
o Replace XML attribute/Node values as specified on below files:

SFIC _HOME/ficweb/webroot/WEB-INF/web.xml
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Q

FIC WEBSERVER PORT=9443
FIC WEBPROTOCOL=https

SFIC HOME/conf/LookUpServices.xml and $FIC HOME/ficweb/webroot/conf/
LookUpServices.xml

PORT="9443" PROTOCOL="https:"
Login to config schema and execute below SQL command to replace protocol and SSL port.

SQL> update configuration cn set cn.paramvalue='9443' where
cn.paramname='SERVLET_ENGINE_PORT';

SQL> update configuration cn set
cn.paramvalue=replace (cn.paramvalue, '"http:', 'https:') where
cn.paramname="'FormsManagerCacheReload';

SQL> update web server info ws set ws.servletport='9443"',ws.servletprotocol="https';

Create EAR/WAR file and Re-Deploy.

What should I do if the sliced data model upload takes a long time to complete?

If the Metadata cache size is set to a lower value than the actual count of each Metadata type (hierarchy,
dataset, dimension etc), then it gets into performance degrade issues. We have to increase the cache size
for each Metadata type according to the count in the environment.

Following are the parameters in DynamicServices.xml to be configured depends on the Metadata count in
your environment.

<PARAMETER NAME="HIERARCHY NODE LIMIT" VALUE="2000"/>
<PARAMETER NAME="ALIAS CACHE SIZE" VALUE="1000"/>

<PARAMETER NAME="DATASET CACHE SIZE" VALUE="2000"/>
<PARAMETER NAME="MEASURE CACHE SIZE" VALUE="3000"/>
<PARAMETER NAME="HIERARCHY CACHE SIZE" VALUE="2000"/>
<PARAMETER NAME="DIMENSION CACHE SIZE" VALUE="2000"/>
<PARAMETER NAME="CUBE CACHE SIZE" VALUE="1000"/>

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE SIZE" VALUE="2000"/>

<PARAMETER NAME="DERIVEDENTITY CACHE SIZE" VALUE="1000"/>

Metadata count can be derived based on the following queries:

select count(l) from metadata master where metadata version=0 --- for all metadata

select count (l) from metadata master where metadata version=0 and metadata type=1 -
-- for measure

select count(l) from metadata master where metadata version=0 and metadata type=2 -
-- for Dimension

select count (l) from metadata master where metadata version=0 and metadata type=3 -
-- for HCY

select count (l) from metadata master where metadata version=0 and metadata type=4 -
-— for DATASET

select count(l) from metadata master where metadata version=0 and metadata type=59 -
-- for BP's

select count(1l) from metadata master where metadata version=0 and metadata type=54 -
-- for Alias

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0 209



FAQs and Error Dictionary

select count (l) from metadata master where metadata version=0 and metadata type=5 -
-- for CUBES

select count(1l) from metadata master where metadata version=0 and metadata type=856
--- for Derived Entity

For LDAP authentication, which server connects with the LDAP server, the Application server (where ofsaai is
installed), or Web Application server (where EAR is deployed)?

For LDAP authentication, the Application server (ficapp) connects with the LDAP server.
The LDAP server in the setup listens on secure protocol Idaps (port 636). | have the root certificate of the LDAP
server for SSL, and would like to know where to offload this certificate?

You need to import the certificate into the JDK/JVM used by Reveleus server in ficapp layer.

How to relocate FTPSHARE folder?
You can run the portC. jar utility. For more details, refer Changing IP/ Host-name, Ports, Deployed Paths
of the OFSAA Instance section in the OFSAAI Admin Guide available on OHC.

What should | do when an entity containing many attributes (>100 columns) is selected as Source entity and the
Data Mapping (T2T definition) save operation takes longer than expected with the hourglass in the Ul
continuously rotating?

The workaround is:

Locate the web server deployed area webroot/conf/excludeURLList.cfg file.
o Modify the following entries:

[SQLIA]./datalntegrator/ to [ALL]./datalntegrator/

[SQLIA]./ETLExtractionServlet to [ALL]./ETLExtractionServlet

Save the changes and restart the web server.

Re-save the definition.

What are the configurations required for Connecting OFSAA to Oracle Database using Secure Database
Connection (TCPS)?

For details, see Configurations for Connecting OFSAA to Oracle Database using Secure Database
Connection (TCPS) in OFS AAI Administration Guide.

Application Pack 8.0.6.0.0 FAQs

What is an Application pack?

An Application Pack is suite of products. For more information, see About Oracle Financial Services
Analytical Applications (OFSAA) Pack.

Can | get a standalone installer for OFSAAI 8.0?

No. AAl is part of every application pack and installs automatically.

How does OFSAA 8.0 Application pack relate to OFSAA 7.x series?

8.0 is a new maijor release consolidating all products from OFSAA product suite.
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Can existing OFSAA 7.x customers upgrade to OFSAA 8.0 Application Pack?
There is no upgrade path available. However, we will have migration kit / path for every product to 8.0
application pack. Further details will be available with Oracle Support.

Does OFSAA 8.0 Application pack UPGRADE's automatically existing environments?

No. Refer Point 5. OFSAA 8.0 application pack has to be installed in an new environment and subsequently
migration path / migration kit needs to be run to migrate from 7.x to 8.0. Please note we will have migration
path only from the previously released version of OFSAA products.

Where can | download OFSAA 8.0 Application Pack?
You can download the OFSAAI 8.0 Application Pack from Oracle Software Delivery Cloud (OSDC).

What are the minimum system and software requirements for OFSAA 8.0 Application Pack?

See the installation guide section Hardware and Software Requirements section.

Is my environment compatible with OFSAA 8.0 Application Pack?

Environment Check utility performs the task. It is part of install and can also be run separately.

Does OFSAA 8.0 Application Pack is support all Operating systems?

LINUX, AIX, SOLARIS 10, 11. See the Technology Matrix for the technology matrix that OFSAA suite
products are/ will be qualified on.

How can I install OFSAA 8.0 Application Pack?

See the Oracle Financial Services Advanced Analytical Infrastructure Installation and Configuration Guide
published in OHC for the application pack installers.

Does this installation require any Third party Software?

Oracle Financial Services Advanced Analytical Infrastructure Installation And Configuration Guide
published in OHC lists the third party software that needs to be installed.

What languages are supported during OFSAA 8.0 Application Pack installation?
US English is the language supported.

What mode of installations OFSAA Application Pack supports? [i.e., Silent, GUI]
OFSAA Application Packs supports both, GUI and Silent Mode.

Does OFSAA 8.0 Application Pack support Multi tier Installations?

OFSAA 8.0 does single tier installation. For more information see the OFSAAI FAQs section.

Does this Application Pack validate all Prerequisites required for this installation i.e., Memory, Disk Space etc.?

Yes. The prerequisite checks are done by the respective application pack installer.
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What happens if it aborts during installation of any application with in Application pack?

You must restore the system and re-trigger the installation.

Does this Application pack 'Rolls Back' if any of application installation fails due to errors?

Rollback of installation is not supported.

Does the Application pack installs all applications bundled?

All application pack file system files are installed but there is an option to enable the licensed products.

How can I re-install any of the Application Pack?

You can re-trigger if there is a failure.

Does Application pack allow enabling / disabling any of the applications installed?
Yes. You cannot disable once the product is enabled in an environment.
| have installed one application in an Application pack and can | install any of new applications within the
Application pack later point of time?
No, installation of additional applications is not required. If you wish to add an application later, you can
enable the application at that time.
How many OFSAA Infrastructures can be installed in a single server?

There is no issue in installing separate OFSAAI installations, each with their own PFT/FTP installations and
separate associated database instances and separate Web Server installations on the same server as long
as adequate memory is allocated for each instance and as long as each OFSAAI installation is installed
using a separate UNIX user and profile. Care should be taken if running multiple OFSAAI installations on a
single server. Adequate memory will be required for each installation as several OFSAAI processes (model
upload, DEFQ services, etc) take significant amounts of memory. So it depends on your server memory.

Is it possible to Install OFSAA 8.0 Application pack on any one of the existing 'Infodom’ where another OFSAA
8.0 application is installed?
Yes. However, the Behavioral Detection Application Pack and Compliance Regulatory Reporting
Application Pack are the exceptions. They need to be installed in a different INFODOM.

Can | select an Infodom in Application pack during installation?

Yes. You can select or change the required infodom.

Can | install all Application Packs in a 'Single Infodom'?

Yes. But Behavioral Detection Application Pack and Compliance Regulatory Reporting Application Pack are
the exceptions. They need to be installed in a different INFODOM.
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Is it possible to install applications on different Infodom within the Application pack? (That is if you want to install
LRM & MR in two infodoms)

Applications within application pack have to be installed in the same information domain in the same
environment.

How many Infodoms can be created over a single OFSAA Infrastructure of 8.0.1.0.0?

You can install only one infodom during installation. But after installation, you can create multiple infodoms.

Does '‘Data Model’ bundled is Application pack Specific or Specific to individual application?

A merged data model for all applications within the application pack is bundled and uploaded.

Is it possible to install OFS Enterprise Modeling in later point of time?

OFS Enterprise Modeling is a separate product and can be enabled as an option later from any application
pack that bundles Enterprise Modeling.

Does Application pack create sandbox automatically for the required applications?

Yes, Sandbox creation is part of application install process.

Are upgrade Kits available for individual applications or the complete Application Pack?

Maintenance Level (ML) Release / Minor Release upgrades are available across all applications.

Can | upgrade AAl only?

Yes, you can upgrade AAI alone.

Can | upgrade one application within the Application Pack? (For example, | want to upgrade LRM in the Treasury
Application pack, but not MR.)

No. Not possible Upgrade is applied across packs.

Is it possible to uninstall any Application from the Application pack?

No, it is not possible to uninstall any Application from the Application Pack.

Can | uninstall entire Application Pack?

No, you cannot uninstall the Application Pack.

Is it possible to uninstall only application and retain AAl in the installed environment?

No, you cannot uninstall only the application and retain AAl in the installed environment.

Can | uninstall entire Application Pack?

No, you cannot uninstall the Application Pack.

Is it possible to uninstall only application and retain AAl in the installed environment?

No, you cannot uninstall only the application and retain AAl in the installed environment.

Does Application Pack contain all Language Packs supported?
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Language Packs need to be installed on 8.0 application packs.

Can | install an Application Pack over another Application Pack (that is same infodom or different infodom)?

Yes, you can install an Application Pack over another Application Pack in the same information domain or
different information domain. But Behavior Detection Application Pack and Compliance Regulatory
Reporting Application Pack, Asset Liability Management Application Pack and Profitability Application Pack
are the exceptions. They need to be installed in a different INFODOM.

Can | use an existing manually created schema as information domain for application pack installation?

No. Schemas required by OFSAA applications have to be created using Schema Creator Utility.

Does OFSAA 8.0 support on WebLogic 10.3.6 with Oracle 12c?

Yes, OFSAA 8.0 will support on WebLogic 10.3.6 with Oracle 12c. WebLogic 10.3.6 supports oracle 12c
with some additional configurations. See the link http://docs.oracle.com/cd/E28280_01/web.1111/e13737/
ds_12cdriver.ntm#JDBCAG55 for additional configurations.

What should | do if | get the following error message while running the schema creator utility, "HostName in input
xml is not matching with the local hostname"?
One possible reason could be the machine is configured for zonal partitioning. Ensure all the known IP
Addresses of the machine are present in the /etc/hosts file.
What are the Java versions supported in OFS PFT Application Pack version 8.0.6.0.0?
OFS PFT Application Pack supports 1.7.x and 1.8.x.

Is this release of the OFS PFT Application Pack version 8.0.6.0.0 supported on Java 8?

Yes. To install this release of the OFS PFT Application Pack version 8.0.6.0.0 on Java 8. For more
information, refer to specific notes mentioned in the sections Installer and Installation Prerequisites,
Configurations Supported for Java 8, Configuring the Schema Creator Utility, GUI Mode Installation, Silent
Mode Installation.

What should | do when | get "[ERRORY] - Error : APP Setup bin file failed." message during
OFS_Application_PACK installation?

This is a generic error message that appears during application installation failure. You should check the
installation log files for more information about what failed the installation.

However, if the message is displayed and the log files are not generated, it could be that it is a temp directory
issue. The resolution is that your UNIX administrator has to disable the NOEXEC option. The installers
extract the installation files into the /tmp directory, and if NOEXEC is enabled, execution of binaries will not
happen in the directory and the installation fails. Re-run the installer after the configuration is changed. For
detailed information, see the support note at

https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1.
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Forms Framework FAQs

What should | do when | have large volume of data to be exported?

It is recommended to use BIP reports or OBIEE reports if you have to export large volume of data.

How do I export the columns added to the grid by Field Chooser option?
Perform Grid Export operation to export the columns added to the grid by Field Chooser option.
'‘Expand All/ Collapse All' button is not visible in the Hierarchy Browser window. What should | do?

Expand All/ Collapse All button is enabled only if the number of hierarchy nodes is less than 50. If it is more
than that, it is considered as large hierarchy and the data will be fetched dynamically when you expand each
node.

Error Dictionary

This contents of this section has been created with the interest to help you resolve the installation issues if any.
There is a compilation of all the possible errors that might arise during the installation process with the possible
cause and the resolution to quickly fix the issue and proceed further with the installation.

This section includes the following topics:

* Accessing Error Dictionary
*  Error Code Dictionary

Accessing Error Dictionary

Instead of scrolling through the document to find the error code, you can use the pdf search functionality. In the
"Find" dialog available in any of the Adobe Acrobat version that you are using to view the pdf document, follow
the below instructions to quickly find the error resolution.

1.  With the Installation pdf open, press Ctrl+F or select Edit > Find.

2. The Find dialog is displayed as indicated.

3. Enter the error code that is displayed on screen during Infrastructure installation.
4. Press Enter. The search results are displayed and highlighted as indicated below.

View the details of the issues, its cause, and resolution specific to the error code. Repeat the step to find an
answer to any other errors that you notice during installation. If you are not able to resolve the issue even after
following the steps provided in resolution, you can contact support.oracle.com along with log files and
appropriate screen shots.
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Error Code Dictionary

Error Code Cause Resolution
OFSAAI-1001 Unix shell is not "korn" shell. Change the shell type to "korn". Use chsh UNIX
command to change SHELL type.
Shell type can also be changed by specifying
shell path for the Unix user in /etc/passwd file.
Note: chsh command is not available in Solaris
0OsS.
OFSAAI-1002 No proper arguments are Provide proper arguments. Invoke Setup.sh
available. using either SILENT or GUI mode.
Example: ./Setup.sh SILENT or ./Setup.sh GUI
OFSAAI-1004 File .profile is not present in Create .profile in $HOME, i.e. in the home
$HOME. directory of user.
OFSAAI-1005 File OFSAAInfrastructure.bin is Copy OFSAAInfrastructure.bin into installation
not present in current folder. kit directory.
OFSAAI-1006 File CustReg.DAT is not presentin |Copy CustReg.DAT into installation kit directory.
current folder.
OFSAAI-1007 File OFSAAI_InstallConfig.xml is |Copy OFSAAI_InstallConfig.xml into installation
not present in current folder. kit directory.
OFSAAI-1008 File validateXMLInputs.jar is not Copy validateXMLInputs.jar into installation kit
present in current folder. directory.
OFSAAI-1009 File log4j.xml is not present in Copy log4j.xml into installation kit directory.
current folder.
OFSAAI-1010 Unknown error occurred. Make sure to provide proper argument (SILENT
or GUI) to the Setup.sh file.
OFSAAI-1011 XML validation failed. Check InfrastructurePreValidations.Log for more
details.
OFSAAI-1012 Property file with locale name does |Copy MyResources_en_US.properties to the
not exist. setup kit directory and keep en_US in LOCALE
tag of OFSAAI_InstallConfig.xml.
OFSAAI-1013 File OFSAAI_InstallConfig.xml/ Copy OFSAAI_InstallConfig.xml/
OFSAAI_PostinstallConfig.xmlnot |OFSAAI_PostInstallConfig.xml to the setup kit
found. directory.
OFSAAI-1014 XML node value is blank. Make sure all node values except

SMTPSERVER, PROXYHOST, PROXYPORT,
PROXYUSERNAME, PROXYPASSWORD,
NONPROXYHOST, or RAC_URL are not blank.
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Error Code

OFSAAI-1015

Cause

XML is not well formed.

Resolution

Execute the command dos2unix
OFSAAI_lInstallConfig.xml to convert plain text
file from DOS/MAC format to UNIX format.

or

Make sure that OFSAAI_InstallConfig.xml is
valid.

OFSAAI-1016

User installation directory contain
blank spaces.

Provide an installation path that does not contain
spaces. Check the tag USER_INSTALL_DIR in
OFSAAI_InstallConfig.xml file. This path should
not contain any spaces.

OFSAAI-1017

User installation directory is
invalid.

Provide a valid installation path. Check if you are
able to create the directory mentioned in
USER_INSTALL_DIR tag value of
OFSAAI_lInstallConfig.xml file.
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APPENDIX A - INSTALLATION OF R AND ORACLE R
ENTERPRISE (ORE)

This is an optional step and required only if you intend to use Term Structure Parameter Estimation functionality
under Rate Management - Interest Rates, for computing term structure parameters. Both Funds Transfer
Pricing and Asset Liability Management applications require term structure parameters for all monte carlo
engine based calculations (OAS, VaR and EaR).

Following are the prerequisites:

* Install R and Oracle R Enterprise Server on the Oracle Database server. See
*  https://docs.oracle.com/cd/E57012_01/doc.141/e57007 .pdf
* ORE version supported - Oracle R Enterprise (Server) version 1.4.1

Dependencies

R code of the application requires dependent packages to be installed before the Reporting Line Forecast batch
is executed. Usage of the predictive model requires installation of packages - tseries, lattice, and R Oracle.
Verify that lattice and R Oracle are compatible with each other.

Package installation instructions can be found at:

http://cran.r-project.org/doc/manuals/r-release/R-admin.html#Installing-packages

Configuration for Oracle R Enterprise

Grant the roaDMIN role to atomic schema.

You can grant the rqadmin role in SQL*Plus by logging in to the database with DBA privileges and provide the
following privilege to Atomic Schema:

RQADMIN by executing the command:

GRANT RQADMIN TO < atomic schema>;

Configuration for Oracle R Distribution and Oracle R Enterprise
(ORE)

This is an optional step. Skip and proceed with the next steps if OFS Enterprise Modeling Application with R
scripting is not enabled during installation.

1. Install OFSAAIRunner Package. For more information, see Installing OFS AAAI Runner Package. If you
have already installed OFSAAIRunner package (as part of a previous installation), uninstall it (For more
information, see Uninstalling OFS AAAI Runner Package section), and reinstall the latest available
OFSAAIRunner package.

2. Login to the database with dba privileges and provide the following privilege to Configuration Schema:
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o RQADMIN by executing the command:
GRANT RQADMIN TO <configischema>;
3. Log in to the database with dba privileges and provide the following privileges to Atomic Schema:
o CREATE MINING MODEL privilege (to execute the Data Mining models) by executing the command:

GRANT CREATE MINING MODEL TO <atomic_schema>;

Installing OFS AAAI Runner Package

OFSAAIRunner is an R package built by the OFS Enterprise Modeling Application. It is a prerequisite for
executing models developed using R scripts. This package helps in:

* Initializing inputs

*  Mapping framework variables to R objects
»  Configuring possible outputs of the script
»  Storing results back to the Database

OFSAAIRunner package (0OFsaaTIRunner 1.0.0.tar.gz)is available under $F1c DB HOME/1ib.
Prerequisite

Oracle R & ORE should be installed on the Oracle Database server before installing OFSAAIRunner package.
Use the following procedure to install OFSAAIRunner package:

1. Login to the OFSAA Server. Navigate to the folder $rrc DB HOME/1ib.

Copy the file oFsaaTRunner 1.0.0.tar.gz in Binary mode to the Oracle Database Server.

Log in to the Oracle Database Server with the user using which Oracle Database Server installation is done.

Navigate to the directory where the file OFsAATRunner 1.0.0.tar.gz is copied.

o DN

Install the package by executing the command:

ORE CMD INSTALL OFSAAIRunner 1.0.0.tar.gz

Successful installation is indicated in the installation log as:
* DONE (OFSAAIRunner)

Making packages.html ... done

Note: The OFSAAIRunner package is installed in /usr/1ib64/R/1ibrary.

6. Navigate to the directory soraCLE HOME/R/1ibrary and check whether OFSAAIRunner package is listed
there by executing the command:

1s -1

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0 219



Installation of R and Oracle R Enterprise (ORE)

Uninstalling OFSAAIRunner Package

Use the following procedure to uninstall the OFSAAIRunner package:

1.

Log in to the Oracle Database Server with the same username, using which Oracle Database Server
installation is done.

Enter ORE in command prompt and execute the command:
#ORE

Enter the following command to save workspace image:
>remove.packages ("OFSAAIRunner")

Enter y when prompted to save the workspace image.

a()

Navigate to the directory SORACLE_HOME/R/library and verify the package is not listed there by executing
the command:

Save workspace image? [y/n/c]: y
1s -1

Configurations for ORE Execution

Follow this step:

1.

Add a TNS entry in tnsnames.ora file with tns name same as that of value set for ORACLE_SID in database
server.

Note: For RAC database, follow the aforementioned configuration in all machines.

Configuring Tomcat

To stop generating static content with one print statement per input line, you need to configure the web . xm1 file.

To configure web . xm1 file, perform the following steps:

Navigate to tomcat/conf directory.

Edit web . xm1 file as follows:

Set the mapped file parameter to False in the servlet tag mentioned with
<servlet-name>jsp</servlet-name>.

<init-param>

<param-name>mappedfile</param-name>
<param-value>false</param-value>

</init-param>
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APPENDIX A - FTP WEB SERVICE CONFIGURATION

The following installation activity describes how to setup FTP web services to support the Breakage Charge
Economic Loss calculation. The calculation logic is the same as the FTP Adjustment Rule Breakage Charge
calculation. This FTP Economic Loss Web Service is now independent of EXEWebService. Note, other FTP
web services are installed automatically and require no further setup.

Approach

The FTP Web services are designed as a wrapper which will call the FTP Engine for the calculation of Economic
Loss. The FTP Web Service is available in its own context and has a specific WSDL for that context.

Architecture

Web Service
Client

FTP Web Service

libbcservices.so

RDBMS cpp
library
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Prerequisites

*  For WebLogic and WebSphere, Data source should be present with JNDI name as jdbc/FTPWS.
* For Tomcat a separate context entry should be present in server.xml file.

Log4j configuration

log4j.properties file is already present inside WEB-INF/classed folder of the war file. Logs will be generated
inside $root_directory_of war/logs/webservice.log file.

Setup Environment Variable - ofsaaws.properties

ofsaaws.properties file is available in wEB-INF/classes folder. Specify the cpp_component Name. Place the
component libbcservices.so under /ficdb/1ib/1ibFSGBU. Add the library location to LD LIBRARY PATH.

If Web-services are deployed in an environment other than where OFSAA is deployed, then copy /ficdb/1ib/
1ibFSGBU to web-services environment and set in LIBRARY path.

o cpp_component= libbcservices.so(libbcservices.o) - for AIX
o cpp_component=bcservices - for Solaris

o cpp_component=bcservices - for Linux

Creating FTPWebServiceAXIS.war

1. Go to the server path in which the application is running.

For Example: $FIC HOME/FTPiebService

2. Run "ant.sh" in this folder. FTPiebserviceaxIs.war Will be created in the same folder.

Deploying FTPWebServiceAXIS.war

For Tomcat:

1. Copy the FTPiebserviceaxIs.war file to the webapps folder of apache tomcat directory.

2. Go to conf folder of apache tomcat and add a separate context entry in server.xml file with resource name
as jdbc/FTPWS.

Example:

<Context path="/FTPWebServiceAXIS" docBase="/<Tomcat webapps> /FTPWebServiceAXIS"
debug="0" reloadable="false" crossContext="true">

<Resource auth="Container"

name="jdbc/FTPWS"

type="javax.sqgl.DataSource
driverClassName="oracle.jdbc.driver.OracleDriver

username="username"

password="password" url="jdbc:oracle:thin:Q@db-ip:dp-port:dbname"
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maxActive="100"
maxIdle="30"
maxWait="10000"
removeAbandoned="true"
removeAbandonedTimeout="60"
logAbandoned="true"/>
</Context>

3. Restart the server.

For Weblogic and WebSphere:
Deploy FTPWebserviceAxIS.war from admin console.
Create data source for database connection with JNDI name as jdbc/FTPWS.
WSDL is present at following URL.

http://ipaddress:port/FTPWebServiceAXIS/services/OFSAAFTPService?wsdl
Additional Steps for Configuring the FTP Ad hoc Pricing Web Services

Ad hoc pricing web-services (getpricing) are deployed along with OFSAA FTP. Configuring these web services
require some minor configuration after installation, steps are mentioned below:

1. Goto $FIC HOME/ficweb/webroot/WEB-INF/classes.

2. Open ofsaaws.properties, replace <infodom name> and <userid>(with admin access) and save it.

3. Open ofsaawsClient.properties, give OFSAA URL.

4. Rebuild the war and deploy.

URL patterns for ad hoc web-services are:
http://<ip>:<port>/<context>/services/DailyQueriesService?wsdI

http://<ip>:<port>/<context>/services/ PricingService?wsdI

Note: See the Oracle Financial Services Funds Transfer Pricing User Guide for usage of the FTP Ad hoc
Pricing Web Services.
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APPENDIX A - ADDITIONAL CONFIGURATION

The following topics provide detailed module specific post installation configurations.

This appendix includes the following topics:
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Configuring FTP/SFTP

Configuration for Dimension and Hierarchy Management
Configure Infrastructure Server Memory

Retrieving Patch Information

OLAP Data Server Configuration

Changing IP/ Host name, Ports, Deployed Paths of the OFSAA Instance
OFSAAI Setup Information Fetching Tool

Encryption Changer

Infrastructure LDAP Configuration

Configure OFSAAI Web Services

Deploy OFSAAI Web Services

Configuration to Enable Parallel Execution of DML Statements
Configure Message Details in Forms Designer

Clearing Application Cache

Configuring Password Changes

Configuring Java Virtual Machine

Configure Internal Service (Document Upload/ Download)
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Configuring FTP/SFTP

This section details about the configurations required for FTP/SFTP.

Adding FTP/SFTP Configuration for File Transfer

In OFSAA, certain modules require transfer of files from the web application server to the OFSAA server over
SSH.

Follow these steps to ensure the OFSAA server recognizes the web application server during file transfers.

1. Login to the web application server.
2. Type sftp <user>@<OFSAA Server>
3. Specify Yes when prompted for permission.

Are you sure you want to continue connecting (Yes/No)?

This will add an entry into the "known_hosts" file.
A confirmation message is displayed:
Permanently added <OFSAA Server> RSA) to the list of known hosts.

Setting Up SFTP Private Key

Log in to OFSAA Unix user using Putty tool, where you plan for installation and generate a pair of authentication
keys using the ssh-keygen command. If required, set passphrase. Otherwise 0OFSAAT SFTP PASSPHRASE tagin
the OFSAAT InstallConfig.xml file should be set to NA.

To generate private key, enter the commands as shown:

0fsaapp@OFSASERVER: ~> ssh-keygen -t rsa

Generating public/private rsa key pair.

Enter file in which to save the key (/home/ofsaapp/.ssh/id rsa):
Created directory '/home/ofsaapp/.ssh'.

Enter passphrase (empty for no passphrase):

Enter same passphrase again:

Your identification has been saved in /home/ofsaapp/.ssh/id rsa.
Your public key has been saved in /home/ofsaapp/.ssh/id rsa.pub.
The key fingerprint is:
3e:4f£:05:79:3a:9f£:96:7c:3b:ad:e9:58:37:bc:37:e4

ofsaapp@OFSASERVER:~> cat /home/ofsaapp/.ssh/id rsa.pub >> /home/ofsaapp/.ssh/
authorized keys

In case, you are generating SFTP Private key for Hive server, append the content of /home/ofsaapp/.ssh/
id rsa.pub to Hiveserver authorized_keys file located at sHoME DIR HIVE/.ssh folder.

Ensure the following permissions exist for the given folders:

*  Permission of .ssh should be 700

*  Permission of .ssh/authorized_keys should be 640
» Permission of .ssh/id_rsa should be 400

*  Permission of Unix user created should be 755
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Configuration for Dimension and Hierarchy Management

These configuration changes are applicable when Dimension Management features provided in OFSAAI are
used. You can open AMHMConfig.properties file present in the $FIC_WEB_HOME/webroot/conf directory to set
the properties for the following:

This section includes the following topics:

+  Configure Member Deletion

* Configure Attribute Default Date Format

+  Configure Members Reverse Population

»  Configure Hierarchy Reverse Population

»  Configure Maximum Levels allowed in Hierarchies
» Configure Node Limit for a Hierarchy Tree

Configuration for Dimension and Hierarchy Management has to be done only after the application/solution
installation is done. The properties specific to Information Domain are:

+  $INFODOMS$=<Name of the Information Domain>
+ $DIMENSION_ID$=<Dimension ID for which the property to be set>

Configure Member Deletion

This property should be set to allow the user to delete the Members for the Dimension.

Example

# Member Deletion Configuration - MEMBER_DEL-$INFODOM$- MEMBER_DEL-ORAFUSION-1=Y
VALUE- Y/N $DIMENSION_ID$=$VALUE$
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Configure Attribute Default Date Format

This property should be set to display the Default Date Format for Date type Attribute in Attributes window.

Example

# Attribute Default Date Format - ATTR_DEF_DATE_FORMAT- ATTR_DEF_DATE_FORMAT-
DB_DATE_FORMAT:DD-MON-YYYY |$INFODOM$=$DB_DATE_FORMAT$ |ORAFUSION=DD/MON/YYYY

Configure Members Reverse Population

This property should be set for reverse population of Members for the Dimensions in required Information

Domains.

Example
# Members Reverse population - MEMBER_REVERSE_POP- MEMBER_REVERSE_POP-
VALUE- Y/N $SINFODOMS$- ORAFUSION-1=Y

$DIMENSION_ID$=$VALUE$

Configure Hierarchy Reverse Population

This property should be set for reverse population of Hierarchies for the Dimensions in required Information

Domains.

Example
#Hierarchy Reverse population - HIERARCHY_REVERSE_POP- HIERARCHY_REVERSE_POP-
VALUE- Y/N $INFODOMS$- ORAFUSION-1=Y

$DIMENSION_ID$=$VALUE$

Configure Maximum Levels allowed in Hierarchies

This property is required to set the maximum levels allowed to build the Hierarchies tree structure.

Example

#Hierarchy Maximum level allowed for |MAX_DEPTH-$INFODOM$=$VALUE$ |[MAX_DEPTH-FUSION=15

the hierarchy in particular Information
Domain - VALUE - Integer number

Hierarchies greater than 15 levels are not supported within OFSAA EPM applications (ALM, FTP, PFT, and HM).
If the hierarchy data contains more than 15 levels, OFSA_IDT_ROLLUP will not be populated. The number of
hierarchy levels allowed for OFSAA EPM key dimensions must be less than or equal to 15.

If the Hierarchy Reverse Population setting is set to "Y" and more than 15 levels exist in the data, then the
following alert is displayed "The number of levels exceeds the limit".

If the maximum level allowed setting is set greater than 15 and Hierarchy Reverse Population is set to "Y",
then following error is displayed "Error occurred in Reverse Populating the hierarchy".
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Configure Node Limit for a Hierarchy Tree

This property is required to display the Hierarchy as a small or a large hierarchy. If the tree node limit exceeds
the set limit, the Hierarchies are treated as large Hierarchy.

Example

#Tree node limit for the hierarchy - TREE_NODE_LIMIT=$VALUE$ TREE_NODE_LIMIT=30
Values is Integer number

Configure Infrastructure Server Memory

The memory settings for Infrastructure Application Server, Tomcat, WebSphere, and WebLogic can be edited
for customizing memory settings and garbage collector settings depending on the available hardware
configuration as explained below. These settings are base minimum and has to be incremented considering the
deployment metrics into account. The increments are usually handled in multiples of 128mb for heap and 64mb
for stack.

Infrastructure Application Server Memory Settings

You can configure the Infrastructure Application Memory settings as follows:

1. Locate .profile file.

2. Edit X_ARGS field in this file for customizing memory settings and garbage collector settings depends on
the hardware configuration.

This has a default value x_ARGS="-Xms200m"

X ARGS=" "$X ARGS" $SDELIM -Xmx2048m"

Note: Modify X_ARGS_APP variable in the .profile file to customize Java Memory Settings for Model
Upload based on the Data Model size.

For Run and Rule executions, the following value is recommended:
X_ARGS_RNEXE="-Xms1g -Xmx1g
XX:+UseAdaptiveSizePolicy -XX:MaxPermSize=512M -XX:+UseParallelOIdGC -XX:+DisableExplicitGC"

X_ARGS_RLEXE="-Xms1g -Xmx1g -XX:+UseAdaptiveSizePolicy -XX:MaxPermSize=512M
XX:+UseParallelOIdGC -XX:+DisableExplicitGC"

Retrieving Patch Information

To identify the list of patches installed on your OFSAA setup, follow these steps:

1. Login to the OFSAA application as a user with Object AdminAdvanced Role.
2. Navigate to Object Administration tab, expand Utilities and click Patch Information.
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3. The window displays the list of patches installed on the OFSAA setup across Applications/ Platform.
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OLAP Data Server Configuration

This section is applicable if you are using the OLAP feature of OFSAAI.

The following parameters must be set to ensure that the system limitations are not exceeded at any stage. The
values for these OS parameters should be specified based on the expected load at each implementation site.

Example:

Process Memory Limit

Max Thread Stack Size

Max Number of Threads per Process

»  Sort Buffer settings: This must be set at the Essbase application level appropriate to the anticipated load.

»  Shutdown and Restart: During shutdown of OFSAAI Server that has an instance of Data Services that is
communicating with an OLAP Data Server, it is imperative to ensure that the cleanup of the old instance is
completed on the OLAP Data Server before restarting the OFSAAI Server. Pause for a period of time based
on the load the system was subjected to, before restarting the Data Services subsystem.

Changing IP/ Host name, Ports, Deployed Paths of the OFSAA
Instance

For information on this section, see the OFS Analytical Applications Infrastructure Administration User Guide.

OFSAAI Setup Information Fetching Tool

Executing the Setuplnfo.jar file available in the FIC_HOME path will help you retrieve the related information
about the OFSAAI Set up such as Operating System Name and version, Database Type and Version, OFSAAI
architecture, Log file locations and so on.

To execute setupInfo.jar in console:

1. Navigate to the path srrc HOME.
2. Enter the command:
java -jar SetupInfo.jar

After execution, the output file location is displayed in the console.

Encryption Changer

This utility helps you to regenerate the new AESCryptKey.ext file and encrypt all the encrypted values of the
OFSAAI setup according to the new key.

To execute EncryptC.jar in console:

1. Navigate to the path $FIC_HOME.
2. Enter the command:

java -jar EncryptC.jar
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3. Aconfirmation message is displayed after execution.

Once executed, you need to create and deploy the EAR / WAR file depending on the configured Web Application
Server. For more information, see Creating EAR/WAR File and Deploying EAR/WAR File sections.

Infrastructure LDAP Configuration

For more information on LDAP configuration, see the OFS Analytical Applications Infrastructure Administration
User Guide.

Configure OFSAAI Web Services

Web Services in OFSAAI is meant for exposing a web service to "asynchronously” or "synchronously" execute
requested tasks offered by OFSAAI. The configuration steps given below are to be done only if you are using
the Web Services feature of OFSAAI.

Configure DynamicWSConfig.xml File

For each third party web service that needs to be accessed using the OFSAAI Web services framework and the
operations to be invoked, corresponding entries are to be made in the Dynamicusconfig.xml template file.

The variable <webserver> denotes any one of the application server, i.e. WebSphere, WebLogic, or Tomcat.

The DynamicWsConfig.xml file will be available in the <OFsSAAT Installation Directory>/EXEWebService/
<webServer>/RO0T/conf directory. This file can be placed in any directory that is accessible by the application
and this location must be specified in the web.xml file, as wsconFIGFILE parameter.

The DynamicwsConfig.xml template file will be in <webServer Deployment Path>/ EXEWebService.ear/
EXEWebService.war/conf directory.

This template is given below:
<XML>

<WEBSERVICES>
<WEBSERVICE CODE="S$CODE"
ENDPOINT="S$ENDPOINT" TARGETNAMESPACE="$TARGETNAMESPACE"
XMLNS XSD="$XMLNS XSD" ENCODINGSTYLE="S$ENCODINGSTYLE"
SERVICENAME="$SERVICENAME" PORTTYPENAME="S$PORTTYPENAME"
SESSION MAINTAIN PROPERTY="$SESSION MAINTAIN PROPERTY"
USERNAME="SUSERNAME"
PASSWORD="$PASSWORD" STYLE="SWEBSERVICESTYLE"
STUBIMPLEMENTATION="$STUBIMPLEMENTATION">
<OPERATION CODE="$CODE"
NAME="$NAME"
SOAPACTION="$SOAPACTION"

STYLE="S$STYLE"
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PACKAGENAME="$PACKAGENAME ">
<INPUT ORDER="S$ORDER"
PARAMNAME="SPARAMNAME"
ARGTYPE="SARGTYPE"
CLASSNAME="S$CLASSNAME" />
<OUTPUT PARAMNAME="$PARAMNAME"
RETURNTYPE="$RETURNTYPE"
CLASSNAME="$CLASSNAME" />
</OPERATION>
</WEBSERVICE>
</WEBSERVICES>

</XML>

The pynamicwsconfig.xml has the placeholders as tabulated below. These have to be updated depending on
the web service chosen and the mode of accessing it. For each Web service to be accessed, the entire web
service tag in the bynamicwsconfig.xml file must be repeated. The placeholders tabulated below should be set
in accordance to the parameters published in the third party wsdl files (web-services) to be accessed. The stub
class specified must implement the "com.iflex.Oracle Reveleus.execution.webservice.EXEWebIF"
interface.

Attributes for WEBSERVICE tag

Placeholder Description

$CODE Unique number within the xml file and cannot be 999 or 0.

$SENDPOINT soap: address location in the wsdl: service name tag of the wsdl file.
$TARGETNAMESPACE The attribute value for the targetNamespace of the wsdl: definitions tag.
$XMLNS_XSD The attribute value for the xmins:s of the wsdl:definitions tag.
$ENCODINGSTYLE The attribute value for the xmins:soapenc of the wsdl:definitions tag.
$SERVICENAME Name of the service found under the wsdl:service name tag of the wsdl file.
$PORTTYPENAME wsdl port type name as mentioned in the wsdl file.

$SESSION_MAINTAIN_PROPERTY | This could be given as "" also.

$USERNAME User name to access the web services. Enter " if no user name is required.
$PASSWORD Password to access the web services. Enter " if no password is required.
$WEBSERVICESTYLE This can take either "rpc” in case of DIl mode of invoking web services or "stub"

in case of static mode. This is a mandatory parameter.

$STUBIMPLEMENTATION Fully qualified class name (package name.classname).
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Attributes for OPERATION tag

Ensure that the "operation tag attributes" are repeated for each of the operation tags.

Placeholder Description

$CODE Should be unique within the Web service tag.

$NAME The name of the Function that is to be called by the wsdl file.

$SOAPACTION The URL for the Operation to access. This is associated with the Operation tag of
the wsdl file.

$STYLE This can take "rpc" if the web services invoking is in DIl mode or "stub” if it is in
static mode. This is a mandatory parameter.

$PACKAGENAME Represents the JAXB package of input object.

Attributes for INPUT tag

Placeholder Description

$ORDER The sequential number of the INPUT tag. Should start from 0. This is in line with
the input order of the arguments that the API accepts which is called by this
operation.

$PARAMNAME Input parameter name to be called by the wsdl file.

$SARGTYPE Input Parameter Data Type. If the input argument type is complex object, specify
$ARGTYPE as "xmlstring".

$CLASSNAME Represents class name of input object parameter.

Attributes for OUTPUT tag

Placeholder

Description

$PARAMNAME Output parameter name to be returned by the web service.

$SRETURNTYPE Output parameter Data Type. If the web service response is a complex object,
then specify SRETURNTYPE as "object".

$CLASSNAME Represents class name of output object parameter.

Oracle Financial Services Customer Analytics Application Pack Installation and Configuration Guide - 8.0.6.0.0 233



Additional Configuration

web.xml Entries

This step is optional and required only if the web application server used is Tomcat. In case of any other
application server, skip and proceed with next step.

1.

Navigate to sF1C HOME/webroot/WEB-INF/ and edit the web . xm1 file. Set parameter value DocsERVICEAPP
to EXEWebServiceAXIS.

Navigate to <OFSAAT Installation Directory>/EXEWebService/<WebServer>/ROOT/WEB-INF/ and
edit the web . xm1 file as explained below.

Note: Incase of Java 7 when WebLogic is used as web application server replace following line of <orFsaar
Installation Directory>/EXEWebService/Weblogic/ROOT/WEB-INF/web.xml file thatis

<?xml version='1.0' encoding='UTF-8'?>

<web-app id="WebApp ID" version="3.0"
xmlns="http://java.sun.com/xml/ns/javaee"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalocation="http://java.sun.com/xml/ns/javaee

http://java.sun.com/xml/ns/javaee/web-app 3 0.xsd" metadata-complete="true">
with
<?xml version='1l.0' encoding='UTF-8'?>

<web-app xmlns="http://java.sun.com/xml/ns/j2ee"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

Entry for WSConfig File

The WSCONFIG file (DynamicWSConfig.Xml) is available in the <webServer Deployment Path>/
EXEWebService.ear/EXEWebService.war/conf directory. This file can be placed in any directory that is
accessible by the application.

The path where the WSCONFIG file is placed must be specified in place of swsCONFIGFILELOCATIONS in the
below block of text in web . xm1.

<context-param>
<description>WebServices Configuration File</description>
<param-name>WSCONFIGFILE</param-name>
<param-value>$WSCONFIGFILELOCATIONS</param-value>
<!--Specify the Location of DynamicWSConFig.xml-->

</context-param>
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Proxy Settings

Replace the following <param-value> given in bold in the following block of text in web . xm1 file, with appropriate
values.

If no values are required, leave the <param-value> blank.
<context-param>
<description>http Proxy Host</description>
<param-name>http.proxyHost</param-name>
<param-value>$PROXYHOSTS</param-value>
<!-- Specify the IP address or hostname of the http proxy server-->
</context-param>
<context-param>
<description>http Proxy Port</description>
<param-name>http.proxyPort</param-name>
<param-value>$PROXYPORTS$</param-value>
<!--Port Number for the Proxy Server-->
</context-param>
<context-param>
<description>http proxy UserName</description>
<param-name>http.proxyUserName</param-name>
<param-value>$PROXYUSERNAMES</param-value>
<!-- User ID To get authenticated by proxy server-->
</context-param>
<context-param>
<description>http proxy Password</description>
<param-name>http.proxyPassword</param-name>
<param-value>$PROXYPASSWORDS</param-value>
<!-- User Password To get authenticated by proxy server-->
</context-param>
<context-param>
<description>http non-ProxyHosts</description>
<param-name>http.nonProxyHosts</param-name>
<param-value>$NONPROXYHOSTS$</param-value>

<!--Hosts for which the proxy settings should get by-passed (Note: Separate them by
"|" symbol) -->

</context-param>
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OFSAAI Home Entry

This entry should point to the Application layer / Web layer of the OFSAAI installation and should be accessible.

Replace sr1c_HOMES in the following block of text in web.xm1 with <webServer Deployment Path>/
EXEWebService.ear/EXEWebService.war.

<context-param>
<description>OFSAAI Web Home</description>
<param-name>FIC HOME</param-name>
<param-value>$FIC HOMES</param-value>
<!--OFSAAI Installation Folder-->

</context-param>

<context-param>
<description>OFSAAI Web Home</description>
<param-name>FIC PHYSICAL HOME</param-name>
<param-value>$FIC HOMES</param-value>
<!--OFSAAI Installation Folder-->

</context-param>

DynamicWSConfig.xml

For each third party web service that needs to be accessed using the OFSAAI Web services framework, and
the operation to be invoked, make corresponding entries into this file. This file is to be placed in the location that
is specified in the web.xml, as WSCONFIGFILE parameter.

Deploy OFSAAI Web Services

You can deploy OFSAAI Web Services separately if you had not configured OFSAAI Web Services as part of
the installation.

1. Complete the manual configuration of OFSAAI Web Services.

2. Navigate to <OFSAAT Installation Directory>/EXEWebService/<WebServer>and execute the
command:

./ant.sh
3. This will trigger the EAR/WAR file creation, which is required for the deployment.
4. Deploy the generated EXEWebService. EAR/EXEWebService. WAR file into the Web Server.

If you have already configured OFSAAI Web Services as part of the installation, deploy the generated
EXEWebService.EAR/ EXEWebService.WAR file into the OFSAAI Deployment area in Web Server profile.
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Configuration to Enable Parallel Execution of DML Statements

A configuration file, oracleDbB. conf has been introduced to accommodate any configurable parameter related
to operations on oracle database. If you do not want to set a parameter to a specific value, then the respective
parameter entry can be removed/commented off form the OracleDB.conf file which resides in the path

SFIC DB HOME/conf.

As of now, the oracleDB. cont file has only one parameter namely CNF DEGREE OF PARALLELISM. This
parameter indicates the degree of parallelism to be used for a DML operation if parallel DML is explicitly enabled
in the session with the ENABLE PARALLEL DML clause of the ALTER SESSTON statement. The default mode of a
session is DISABLE PARALLEL DML.If CNF DEGREE OF PARALLELISM is not set, then the default degree, as
decided by Oracle will be used.

Configure Message Details in Forms Designer

You can configure the Message Details in Forms Designer under Data Entry Forms and Queries module by
updating the details of mail server in the "NotificationConfig.cfg" file which resides in the path
$FIC APP HOME/common/FICServer/conf.

Ensure that the "authorized User details" for whom you need to configure the Message details are included in
Administration > Security Management > User Administrator > User Maintenance window.

Update the following parameters in the "NotificationConfig.cfg" file:

Parameter Description

SMTP_SERVER_IP Specify the host name or IP address of SMTP Server.

SMTP_DEBUG_MODE To run SMTP service in Debug mode, set value to 'true’, otherwise set value to
'false’.

SMTP_AUTHORIZATION Set to 'true' if SMTP server requires the client to be authenticated, otherwise set
to 'false’.

SMTP_USERNAME Username required for logging into SMTP server, if authentication is not required
use a dummy value.

SMTP_PASSWORD Password required for logging into SMTP server, if authentication is not required
use a dummy value.

SMTP_MAILID If the Messages has to go from a Particular ID that ID need to be added. Exchange
server forces you set a valid ID that is there in the exchange server (Based on
Security settings).

Ensure that the authorized User details are included in Administration > Security Management > User
Administrator > User Maintenance window.
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Clearing Application Cache

This is applicable to all Web Servers (i.e. WebSphere, WebLogic, and Tomcat).

Prior to the deployment of Infrastructure or Application Service Packs / One-off patches, navigate to the
following path depending on the Web Server configured and clear the cache:

Tomcat: <Tomcat installation folder>/work/Catalina/localhost/<Application name>/org/
apache/jsp

WeblLogic: <iWeblogic installation location>/domains/<Domain name>/servers/<Server name>/
tmp/ WL user/<Application name>/qaelce/jsp servlet

WebSphere: <websphere installation directory>/AppServer/profiles/<Profile name>/temp/

<Node name>/serverl/<Application name>/<.war file name>

Configuring Password Changes

This section explains about how to modify the OFSAA Infrastructure Config Schema and Atomic Schema
passwords.

OFSAA Infrastructure Config Schema Password Modification

To change the Config Schema password, perform the following steps:

1.
2,
3.

Change the Config schema User Password in the database.
Delete the $FIC_HOME/conf/Reveleus.SEC file.

Shutdown the OFSAAI App service:

cd $FIC APP HOME/common/FICServer/bin
./stopofsaai.sh

Start the Infrastructure Server in foreground directly on the server or through X-Windows software using the
command:

./startofsaai.sh
At the prompt, enter System Password. Enter the "new Config schema" password. The service will start and
initialize itself if it is able to successfully connect to the DB.

Post successful startup of the service, if required, the Infrastructure server may be shut down and restarted
in the background using nohup mode.

OFSAA Infrastructure Atomic Schema Password Modification

To change the Atomic Schema password, perform the following steps:

1.
2,

Change the Atomic schema User Password in the database.

Login to the application from the browser using SYSADMN account or any user id, which has System
Administrator role mapped.

Navigate to System Configuration > Database Details window. Modify the password as explained in the
following steps:
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o From the Database Master window, select the connection whose password you want to modify and click
button from the tool bar.

o Click button corresponding to the Alias Name. The Alias Details window is displayed.
o Modify the password in the Auth String field.

4. |If you are using Apache Tomcat as Web server, update the <Context> -> Resource tag details in Server.xml
file from the $CATALINA_HOME/conf folder. (In case of Tomcat only Atomic <Resource> will exist).

5. If you are using WebSphere as Web server:
a. Login to the WebSphere Administration Console, from the left side menu.
b. Navigate to Resources >JDBC >Data Sources. A list of data sources will be populated on the right side.

c. Select the appropriate Data Source and edit the connection details. (In this case, both Config and
Atomic data sources will need to be modified).

6. If you are using WebLogic as Web server:
a. Login to the WebLogic Administration Console, from the left side menu.

b. Under Domain Structure list box, expand the appropriate Domain and navigate to Services > JDBC
>Data Sources. A list of data sources will be populated on the right side.

c. Select the appropriate Data Source and edit the connection details. (In this case, both Config and
Atomic data sources need to be modified).

7. Restart the OFSAAI services.

Configuring Java Virtual Machine

While running several database intensive tasks in parallel, fetching the database connection from connection
pool may face an error. To ensure no such error is encountered, add the line securerandom. source=file:/
dev/./urandom in the java.security configuration file available in $Java HOME/jre/1ib/security/ path.

This needs to be configured on all the machines or virtual machines where the OFSAAI database components
(ficdb layer) are installed.

Configure Internal Service (Document Upload/ Download)

This step can be ignored if it has already been configured as part of any previous IR/ML installation.

The Document Upload/Download feature has undergone a change and can now be configured to use Internal
service for document upload/ download instead of the earlier ExeWebService.

To facilitate Internal service for document upload/ download, perform the following configurations:

1. Create the folders download, upload, TempDocument and Temp in the local path of Web application server
and provide Read/Write permission.

o Tofind the exact location, execute the following query in CONFIG schema:
select localpath from web server info

o To create folders with Read/Write permission, execute the command:
mkdir -m 777 download upload TempDocument Temp

2. Create DocStorage folder in the FTPSHARE location of APP tier and provide Read/Write permission.
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o To find the exact location, execute the query in CONFIG schema:
select ftpdrive from app server info
o To create folder with Read/Write permission, execute the command:

mkdir -m 775 DocStorage

By default, the parameter DOCUMENT SERVICE TYPE EXTERNAL value is set to FALSE in the Configuration table
in CONFIG schema and hence the application "ExeWebService" will not be used. It is recommended that the
value to be set to FaLsE and use the Internal service for document upload/ downloads. If you intend to continue
using the External ExeWebService, set the value to TRUE.

Navigate to $FIC HOME/EXEWebService/<WEBSERVER TypE> directory of WEB tier and type . /ant.sh. This
triggers the creation of EAR/WAR file ExEwebservice.ear/.war. The EAR/WAR file ExEwebservice.ear/
.war Will be created in $F1C HOME/EXEWebService/<WEBSERVER TYPE> directory of WEB tier. Redeploy the
generated EAR/WAR file onto your configured web application server.
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APPENDIX A - CLONING OF AN OFSAA INSTANCE

There is a consistent need for a faster and effective approach of replicating an existing OFSAA instance for
further project developments, that is, setting up OFSAA instances that are exact copies of the current OFSAA
instance. For more information on cloning, see OFSAA Cloning Reference Guide.
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APPENDIX A - MIGRATION FOR EXCEL UPLOAD

This appendix provides detailed instructions to migrate for excel upload.

Prerequisites

The following are the prerequisites for migration:

Data model in ATOMIC schemas should be same on the source and target setups.
OFS AAI (platform) patch level version should be same on the source and target setups.
PL/SQL Developer to connect and query the database.

WinSCP to connect and access server file system.

Migration for Excel Upload

To migrate, follow these steps:

1.

Open PL/SQL Developer and log in to the source setup's configuration (CONFIG) schema by entering the
appropriate username and password.

In a new SQL window query the data of table EXCEL_MAPPING_MASTER.

Open a new session in PL/SQL developer and log in to the target setup's configuration (CONFIG) schema
by entering the appropriate username and password.

Insert the records from Step 1 above in to this table.

In V_INFODOM column of EXCEL_MAPPING_MASTER table update the infodom name with the target
infodom name.

Note: If all the mappings can work out of the single target Infodom, update same Infodom value across all
rows. If only few mappings will work out of the target infodom, update the infodom value for selective
records. Excel upload mappings will work only if the target infodom has same data model entities as used
in the mappings defined on source setup.

Update V_CREATED_BY column with the name of any user present in the target setup that has appropriate
roles to perform Excel Upload tasks.

Note: It is mandatory to update values for V_INFODOM and V_CREATED_BY columns.

Open WinSCP and login a new session by entering the host name, port number, user name and password
to access the source setup.

Navigate to the folder referred as FTPSHARE.
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9. Copy the excel-entity mapping xml file(s) which are located in this folder according to their folder structure
on to your desktop. For example: /ftpshare /STAGE/ExcelUpload/$SOURCE INFODOM NAME/
SEXCEL FILE NAME.xml

Note: Actual file name of Excel Sheet is mentioned in the v_ExcEL NaME column of
EXCEL MAPPING MASTER table.

10. Copy the excel templates (.xls/ .xIsx) file(s) which are located in this folder according to their folder structure
on to your desktop. For example: /ftpshare/STAGE/ExcelUpload/ TEMPLATE/*.xls or *.xIsx

Note: Ignore this step if files are not present at the location.

11. Login a new session in WinSCP by entering the host name, port number, user name and password to
access the target setup.

12. Copy the xml file(s) from Step3 to the below location in the target setup. For example: /ftpshare/STAGE/
ExcelUpload/$TARGET INFODOM NAME/S$SEXCEL FILE NAME.xml

Note: $TAaRGET INFODOM NAME should be target setup infodom in which you have uploaded the
appropriate data model and the name should be same as the v_1xroDoM column value updated in
EXCEL MAPPING MASTER table.

13. Copy the xlIs/ xlsx file(s) from Step 3 to the below location in target setup. For example: /ftpshare/STAGE/
ExcelUpload/TEMPLATE/*.xIs or *.xlsx

Note: Ignore this step if files are not present at the location.
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APPENDIXA - VISIBILITY

Data Visibility

Data visibility refers to the data control established on the results fetched by reports depending on the user
logged in.

For each user, only those accounts which are directly handled or are handled by a subordinate are visible.

If the logged in user is a Relationship Management (RM), then only those accounts which are associated to that
user's organizational hierarchy will be fetched. This is achieved through FST M USER MANAGER MAP table.

If a user is an RM, then the particular log in ID and the manager code from DIM MANAGEMENT table have to be
populated into FST_M USER MANAGER MAP table. Also, the table rcT_accounT MGR REL should have the
necessary details for the relationship manager to account mapping.

A user logging in without any associated Manager code should have access to the entire data available.

The entries to FSI_M USER_MANAGER_ MAP table have to be manually inserted. It has two columns, v_USERNAME
and v_MANAGER CODE. The v_USERNAME has to be inserted with the login username created in OBIEE and
V_MANGER_CODE has to be inserted with the manager code of the corresponding user from DIM MANAGEMENT
table.

Example:

The following diagram depicts a hierarchy of Relationship Managers:

RM6

RM3 RM4

The data visibility for each of the Relationship Managers, starting from the top of the hierarchy is as follows:

* RM1 user has control over the data associated to that user along with the data associated to the immediate
subordinates, that is, RM2, RM5, and their subordinates till the end of the hierarchy.

* RM2 user has control over the data associated to that user along with the data associated to the immediate
subordinates, that is, RM3, RM4, and their subordinates till the end of the hierarchy.

* RMS5 user has control over the data associated to that user along with the data associated to the immediate
subordinate, that is, RM6 and his subordinates till the end of the hierarchy.

If the logged in user is a Sales Representative (SR), the data associated with the opportunities managed by the
respective Sales Representatives are visible. Each Sales Representative will have unique skey values and
accounts related to those skeys are displayed in reports.
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Report Visibility

This section describes the following sub-sections:

* Report Visibility for IPA
* Report Visibility for RPA

Report Visibility for IPA

The Report’s visibility for IPA application is restricted as per the below table:

Application Role = Dashboard Tab PIl Availability
Business Analyst Business Summary Performance Summary No
Cross Sell No
Product Performance No
Line of Business Performance No
Customer Summary Yes
What-If Analysis No
Customer Central Customer 360 Yes
Customer Group Yes
Opportunities & Activities Top 10 Opportunities Yes
Opportunities No
Activities Yes
Relationship Relationship Manager Insights Relationship Manager Insights Yes
Manager Top 10 Opportunities Yes
Opportunities No
Activities Yes
Sales Opportunities & Activities Opportunities No
Representative Activities Yes

Administrator

All Dashboards

All Tabs and Reports

The Reports visibility for the different roles has to be handled by setting proper catalog Permissions. The steps
to setup these permissions are described in Setting Up Dashboard Visibility under Configure Roles and Groups

of this document.

Note: Those users who have access to any of the above dashboards with PIl columns should also be mapped
to the ‘Data Security Group’ in OFSAA using SMS.

If PIl entitlements change for a given user; then you need to either clear the cache through OBIEE admin
or refresh the report.
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Report Visibility for RPA

The Report’s visibility for IPA application is restricted as per the below table:

Application Role = Dashboard Pll Availability
Business Analyst Business Analysis Performance Summary No
New Business Analysis No
Revenue Analysis No
Expense Analysis No
Credit Loss Summary No
Margin Report No
Customer Summary No
What-If Analysis No
Customer Central Customer 360 Yes
Customer Performance Yes
Product Summary All Products No
Cards No
Retail Bank No
Mortgage No
Relationship Relationship Manager Insights Relationship Manager Insights Yes
Manager
Administrator/ All Dashboards All Tabs and Reports
Super User

The Reports visibility for the different roles has to be handled by setting proper catalog Permissions. The steps
to setup these permissions are described in Setting Up Dashboard Visibility under Configure Roles and Groups

of this document.

Note: Those users who have access to any of the above dashboards with Pll columns should also be mapped
to the ‘Data Security Group’ in OFSAA using SMS.

If Pll entitlements change for a given user; then you need to either clear the cache through OBIEE admin

or refresh the report.
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Metadata Visibility

Accessibility to presentation layer objects for creating ad-hoc reports varies from user-to-user depending on the
application role the user is allocated.

The following are the requirements for viewing the metadata in RPD:

Application Role Tables for Ad-hoc Reporting

Business Analyst role Fact-Account Summary
Fact Account Profitability
Fact Opportunity

Fact Opportunity Activity
Fact Management Forecast
Fact Customers

Relationship Manager role Fact Relationship Manager Contribution
Fact Relationship Manager Profitability
Fact Opportunity

Fact Opportunity Activity

Sales Representative role Fact Opportunity
Fact Opportunity Activity
Fact Sales Representative Compensation

Administrative role (WebLogic) All tables
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APPENDIX A - REMOVING OFSAA

This chapter includes the following sections:
* Uninstalling OFSAA Infrastructure

* Uninstalling EAR Files in WebSphere

* Uninstalling EAR Files in WebLogic

* Uninstalling WAR Files in Tomcat

Uninstalling OFSAA Infrastructure

This section will guide you through the necessary steps to uninstall the OFSAA Infrastructure product.

Before you start the uninstallation process, ensure that no open connections exist to the OFSAA Infrastructure
Config and Atomic Schemas and Infrastructure services are brought down.

To uninstall OFSAA Infrastructure:

1. Log in to the system as non-root user.

2. Navigate to the $FIC_HOME directory and execute the command:

./Uninstall.sh

3. Enter the password for OFSAAI Configuration Schema when prompted as shown in the following figure.

/seratch/of saadb/OFSART: . /Uninstall.sh

Uninstallation Started [time : Tue Jun 10 14:20:27 IST 2014 ]

Fleaze enter Configuration schema Pazsword 3
Connected to Config Schema

Cleaning config schema ...,

config schema cleaned ...

Cleaning up Infrastructure Home Dir |

Please wait ..

Uninstallation Completed | Thank You [time 3

%% Driver loaded with Driver oracle,jdbc.driver.Oraclelriver

Tue Jun 10 14:21:53 [ST 2014 1

/scratch/of saadb/OFSEAT> |

Note: Uninstallation does not remove the Infrastructure application from the Web Application Server. This has

to be done manually.

The entries in the .profile file will have to be removed manually.

The files/ folders under the file system staging area (ftpshare) have to be deleted manually.

All the Database objects from Atomic Schemas have to be dropped manually.
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Uninstalling EAR Files in WebSphere

Following are the steps to uninstall any previously deployed application:

1. Open the URL in the browser window: http://<ipaddress>:<Administrative Console Port>/ibm/console (https

if SSL is enabled). The Login window is displayed.

2. Login with the user id that has admin rights.

3. Expand Applications > Application Types > WebSphere enterprise applications from the LHS. The
Enterprise Applications window is displayed with all the deployed applications.

Enterprise Applications

Enterprise Applications

Sraferences

Uze this page to manage installed spplications. A gingle apzlication can be decloyed onto multicle servers.

Remova File || Export || ExpereDDL || Exporefile |

s | o
i w s

Salezt Hama O
You can administer the following resources:
El Cafayltasclication

|:| Sy
0 |uesazz
Total 4

Seart | Seep Intnlll Uninseall | Upcate Rellout Updaee

Application Status ).

¥+ ¥+ ¥ &

Te

4. Select the check box adjacent to the application to be uninstalled and click Stop.

5. Click Uninstall to display the Uninstall Application window.

to the previous page

Narme

AINGAST

Cancel |

Chck OK to reenave the folldwng appbcaton(s). If you do Aot want 1O remove the sppicativnd, Chck Cancel 1o return

6. Click OK to confirm.

7. Click Save to save the master file configuration.
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Uninstalling EAR Files in WebLogic

On the machine that hosts WebLogic, perform the following steps to uninstall any previously deployed

application:

1. Open the URL in the browser window: http://<ipaddress>:<admin server port>/console (https if SSL is
enabled). The Login window of the WebLogic Server Administration Console is displayed.

2. Login with the WebLogic user credentials having administrator privileges.

3. From the Domain Structure LHS menu, click Deployments to display the Summary of Deployments screen.

Susnumary of Deploynients

¥ Customize this table

D phoymments

Stake

Health
13

4. Select the check box adjacent to the application to be uninstalled and click Stop > Force Stop Now.

5. Click Yes in the confirmation dialog to stop the selected deployment.

-
Summary of Deployments

Control  Movioong

18 & new oD

W Customsins this table

Deployments

d o this domain. irstalled

apphcations and modules can be started,

of 1 Previous | Mext

sinppes, Lpcates

State

Health

Enaerpnse Applcation

Type Deployment Order

6. Select the check box adjacent to the application and click Delete to delete the selected deployment.

7. Click Yes in the confirmation dialog to remove the selected deployment from the domain configuration.
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Uninstalling WAR Files in Tomcat

On the machine that hosts Tomcat, perform the following steps to uninstall any previously deployed application:
1. Comment out Context path section from server.xml file in SCATALINA_HOME/conf directory to avoid conflict
during undeploy and re-deploy of the WAR file.
Place comment <!-- --> in between the context path section. For example:
<!--

<Context path ="/pr2test" docBase="/home/perfuser/tomcat-7.0.19/webapps/pr2test"
debug="0" reloadable="true" crossContext="true">

<Resource auth="Container"

name="jdbc/PR2ATM"

type="javax.sqgl.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username="pr2atm"

password="pr2atm"
url="jdbc:oracle:thin:@10.184.74.99:1521:PERFTEST"
maxActive="100"

maxIdle="30"

maxWait="10000"/>

</Context>

-—>

Restart the Tomcat service by doing the following:

Login to the "Unix server" through a terminal emulator.
Navigate to $catalina home/bin directory.

c. Stop the tomcat services using the following command:
./shutdown.sh

d. Start the tomcat services using the following command:
./startup.sh

2. Open the URL in a browser window: http://<IP address>:<Tomcat server port>. (https if SSL is enabled).
The Tomcat home window is displayed.

3. Click the Manager App. The Connect to window is displayed.
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4. Login with the user credentials having admin rights. The Tomcat Web Application Manager window is

displayed with the list of all applications deployed in Tomcat.
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5. Click the Undeploy link against the deployed Infrastructure application. A confirmation message is

displayed on the application /Infrastructure being uninstalled.
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APPENDIX A - UPGRADING AN EXISTING OFSAA 8.0.X JAVA 7
INSTANCE TO JAVA 8

This appendix explains the configurations required to upgrade an existing OFSAA 8.0.x Java 7 instance to Java
8. It consists of the following topics:

*  Prerequisites

»  Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8

*  Web Application Server Configurations

* OFSAA Generic Configurations

+  OFSAA Configurations for New Web Application Server Installation

Prerequisites

The following are the prerequisites for upgrading OFSAA 8.0.x Java 7 instance to Java 8:

+ Java 8 should be installed on the OFSAA server and Web Application Server.

+ Oracle WebLogic Server should be 12.1.3.0 or above. Download and install patch 18729264 from http://
support.oracle.com/.

Note: IBM WebSphere 8.5.x (Full Profile) on Java 8 is not available.

Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8

To upgrade OFSAA 8.0.x Java 7 instance to Java 8, follow these steps:

1. Configure Web Application Server to Java 8. For more information, see Configuring Web Application Server.

2. Configure the OFSAA instance to Java 8. For more information, see OFSAA Generic Configurations. For a
newly installed Web Application Server, see OFSAA Configurations for New Web Application Server
Installation.

3. Restart the OFSAA services. For more information, see Start/Stop OFSAA Infrastructure Services section.

Generate the application EAR/WAR file and redeploy the application onto your configured web application
server. For more information on generating and deploying EAR / WAR file, see Creating EAR/WAR File and
Deploying EAR/WAR File sections.
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Web Application Server Configurations

This section describes the changes to be made in the Web Application Server. Following are the two options to
perform Web Application Server Configurations which are listed as follows:

* Upgrade the existing Web Application Server installation to Java 8
» Install a new instance of the Web Application Server with Java 8

This section consists of the following topics:

»  Oracle WebLogic Server Updates

*  Apache Tomcat Server Updates

Oracle WebLogic Server Updates

Perform the following configurations to upgrade the existing WebLogic server instance to Java 8:

1. Navigate to <WLS_HOME>/Middleware/Oracle_Home/wlserver.

2. Editthe product.properties file. Set Java HOME, WLS JAVA HOME, JAVAHOME properties to the new Java
path and java.vm.version to the new Java version. For example:

JAVA HOME=/usr/java/jrel.8.0_ 45
WLS_JAVA HOME=/usr/java/jrel.8.0_45
JAVAHOME=/usr/java/jrel.8.0 45
java.vm.version=1.8.0_ 45

3. Navigate to <wLs HOME>/Middleware/Oracle Home/user projects/domains/<domain>/bin. Update
SUN_JAVA HOME, DEFAULT JAVA HOME, JAVA HOME in the setDomainEnv. sh file to point to the new Java
path. For example:

SUN_JAVA HOME="/usr/java/jrel.8.0 45"
DEFAULT SUN_JAVA HOME="/usr/java/jrel.8.0_ 45"
JAVA HOME="/usr/java/jrel.8.0_45"
4. Clear the Application cache. Navigate to the following path and delete the files:
<Weblogic installation location>/domains/<Domain name>/servers/<Server name>/tmp/

WL user/<Application name>/qaelce/jsp servlet

If you want to install a new instance of the Oracle WebLogic Server, follow these steps:

1. Install Oracle WebLogic Server 12.1.3.x on Java 8.

2. Perform the configurations for the newly installed WebLogic server. For more information, see Configure
Resource Reference in WebLogic Application Server.

Note: While creating WebLogic Domain, the Listen Port should be set same as that of the existing Domain.
Note down the new Domain path to perform OFSAA Configurations.
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Apache Tomcat Server Updates

Perform the following configurations to upgrade the existing Apache Tomcat Server from Java 7 to Java 8:

1. Login to the Apache Tomcat Server as a non-root user.

2. Editthe user.profile. Update the value for Java noME from JRE 1.7 to JRE 1.8. For Example:
JAVA_HOME=/usr/java/jrel.8.0_45

3. Clear the Application cache. Navigate to the following path and delete the files:

<Tomcat installation folder>/work/Catalina/localhost/<Application name>/org/apache/jsp

If you wish to install a new instance of the Apache Tomcat Server, follow these steps:

1. Install Apache Tomcat Server 8 with Java 8.

2. Perform the configurations for the newly installed Tomcat server. For more information, see Configure
Resource Reference in Tomcat Application Server.

Note: Update the Connector Port in /apache-tomcat-8.0.21/conf/server.xml file to that of the existing
Tomcat instance. Note down the new deployment path to perform OFSAA Configurations.

OFSAA Generic Configurations
User .profile Settings

Perform the following configurations:

1. Login to the OFSAA Server as a non-root user.

2. Edit the user .profile. Update the value for PATH variable from JRE 1.7 to JRE 1.8. For Example,
PATH=/usr/java/jrel.8.0 45/jre
JAVA BIN=/usr/java/jrel.8.0 45/jre/bin

LD LIBRARY PATH=SLD LIBRARY PATH:/usr/java/jrel.8.0 45/jre/lib/amd64/server
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OFSAA Configurations for New Web Application Server Installation

This configuration is required only if you have freshly installed Oracle WebLogic 12.1.3 or Apache Tomcat
Server 8.0. Follow these steps:

1.

Modify the following parameters in the Configuration table present in the Config Schema with the new
Domain Path in case of WebLogic or with the new deployment path in case of Tomcat:

QO DeFiHome

O REV_IMG PATH

O EMBEDDED JSP JS PATH

Login to the OFSAA Server as a non-root user.

Navigate to $F1c HOME/ficweb/webroot/wEB_INFand update the following parameters in the web . xm1 file
with the new Domain path in case of WebLogic or with the new deployment path in case of Tomcat:

O FIC PHYSICAL HOME LOC

O FIC HOME

O ICC_SERVLET LOG FILE

Navigate to $FIC_HOME/ficweb/webroot/conf and update the Domain path in case of WebLogic or with the
new deployment path in case of Tomcat:

OFSAALogger.xml

MDBLogger.xml

RevLog4jConfig.xml

RFDLogger.xml

ExportLog4jConfig.xml

RFDLogger.xml

O 0O 0 0 0 0 o0

PR2Logger.xml
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APPENDIX A - JDBC JAR FILES

The ojdbc<version> jar file should be copied based on Database and Java version. Refer to the following table

for details:

Oracle Database version

12.1 or 12cR1

JDK/JRE Version supported

JDK 8, JDK 7 and JDK 8

JDBC Jar files specific to the release

ojdbc?7.jar for JDK 7/JDK 8

11.2 or 11gR2

JDK 7 supported in 11.2.0.3 and
11.2.04

ojdbc6.jar for JDK 7

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0

258



JDBC Jar Files

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0 259



Configuring Application Pack XML Files

APPENDIX A - CONFIGURING APPLICATION PACK XML FILES

OFS_PFT_PACK.xml

The ors prT pPaCK.xml file holds details on the various products that are packaged together in Profitability
Application Pack.

This section details the various tags/ parameters available in the file and the values that need to be updated.
Prior to installing the Profitability Application Pack in SILENT mode, it is mandatory to update this file.

Note: If you are installing in the GUI mode, then this file need not be updated.

<APP_PACK_CONFIG>

<APP_PACK_ID>0FS_PFT_PACK</APP_PACK_ID>

<APP_PACK_NAME>Financial services profitability Applications Pack</APP_PACK_NAME>

<APP_PACK_DESCRIPTION=-Applications for pProfitability in the Banking and Financial Services Domain</APP_PACK_DESCRIPTION=

<VERSION=8.0.0.0.0</VERSION=

<APP>
<APP_ID PREREQ="" DEF_SEL_FLG="YES" ENABLE="YES">OFS_AAI</APP_ID>
<APP_NAME>Financial services analytical Applications Infrastructure</APP_NAME>
<APP_DESCRIPTION=Base Infrastructure for analytical applications</APP_DESCRIPTION>
<VERSION>8.0.0. 0. 0</VERSION>

</APP>

<APP>
<APP_ID PREREQ="OFS_AAI" EMABLE="YES">0FS_PFT</APP_ID>
<APP_NAME>Financial Services Profitability Management</APP_NAME:>
<APP_DESCRIPTION=Application for Profitability Management</APP_DESCRIPTION>
<VERSION=8.0.0.0.0</VERSION>

</APP=

<APP>
<APP_ID PREREQ="OFS5_AAI" ENABLE="YES"=0FS_FTP</APP_ID>
<APP_NAME=Financial Services Funds Transfer Prw‘c‘ing</APP,NNv1E>
<APP_DESCRIPTION=Application for Funds Transfer Pricing</APP_DESCRIPTION>
<VERSION>8.0.0.0.0</VERSION>

</APP>

<APP>
<APP_ID PREREQ="OFS_AAIL" EMABLE="YES">0FS_IPA</APP_ID>
<APP_NAME>Financial Services Institutional Performance Analytics</APP_NAME>
<APP_DESCRIPTION=Application for Institutional Performance Analytics</APP_DESCRIFTION>
<VERSION>8.0.0.0.0</VERSION>

</APP>

<APP>
<APP_ID PREREQ="OFS_AAI" ENABLE="YES"=0FS_RPA</APP_ID>
<APP_NAME>Financial services Retail performance analytics</APP_NAME>
<APP_DESCRIPTION=Application for retail performance Analytics</APP_DESCRIPTION>
<VERSION=8.0.0.0.0</VERSION>

</APP>

<APP>
<APP_ID PREREQ="OFS_AAIL" ENABLE="YES'">0FS_EFPA</APP_ID>
<APP_NAME>Financial Services Enterprise Financial Performance analytics</APP_NAME>
<APP_DESCRIPTION=Application for Enterprise Financial Performance Analytics</APP_DESCRIPTION>
<VERSION>8.0.0.0.0</VERSION>

</APP>

</APP_PACK_CONFIG>

Tag Name/ Attribute Description Mandatory (Y/ Default Value/ Comments

Name Permissible Value

APP_PACK_ID Unique Application Y Unique Seeded Value |Do not modify this value.
Pack Identifier

APP_PACK_NAME Unique Application Y Unique Seeded Value |Do not modify this value.
Pack Name

APP_PACK_DESCRI |Unique Application Y Unique Seeded Value |Do not modify this value.

PTION Pack Description
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Tag Name/ Attribute

Name

Description

Mandatory (Y/
N)

Default Value/
Permissible Value

Comments

DEF_SEL_FLAG

VERSION Unique release Y Unique Seeded Value |Do not modify this value.
version
APP Unique Application Y Unique Seeded Value |Do not remove these tags.
Entries
APP_ID Unique Application Y Unique Seeded Value |Do not modify this value.
Identifier
APP_ID/ PREREQ Prerequisite Y Unique Seeded Value |For most applications
Application/ Product Infrastructure would be the
prerequisite set. For certain
other applications, an
appropriate Application ID
would be set.
Do not modify this value.
APP_ID/ Default Selected Flag |Y Default - YES In all Application Packs,

Infrastructure would have
this value set to "YES".

Do not modify this value.

APP_ID/ ENABLE

Enable Application/

YES if installing

Default - YES for

Set this attribute-value to

version

Product in SILENT Infrastructure YES against every APP_ID
mode. NO for Others which is licensed and should

Permissible - YES or be enabled for use.

NO Note: Application/ Product
once enabled cannot be
disabled. However,
Application/ Product not
enabled during installation
can be enabled later through
the Administration Ul.

APP_NAME Unique Application/ Y Unique Seeded Value |Do not modify this value.
Product Name

APP_DESCRIPTION |Unique Application/ Y Unique Seeded Value |Do not modify this value.
Product Name

VERSION Unique release Y Unique Seeded Value |Do not modify this value.
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Configuring OFS_PFT_SCHEMA_IN.xml

Creating database schemas, objects within schemas and assigning appropriate grants are the primary steps in
the installation process of OFSAA Applications. The ors prT scHeEMA IN.xml file contains details on the
various application schemas that should be created prior to the Application Pack installation.

Note: This file should be configured only if OFS Profitability Application Pack installation for RDBMS ONLY
target.
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The following table gives details about the various tags/ parameters available in the file and the values that need
to be updated. Prior to executing the schema creator utility, it is mandatory to update this file.

Tag Name/ Description Mandatory Default Value/ Permissible Value Comments

Attribute Name (Y/'N)

<APP_PACK_| |SeededuniquelD |Y Seeded Do not modify this value.

D> for the OFSSAA
Application Pack

<JDBC_URL> |Enter the JDBC Y Example: Ensure to add an entry (with
URL. jdbc:oracle:thin: @< SID/SERVICEINAME) in the
Note: You can enter DBSERVER IP/HOST/ tnsnames.ora file on the
RAC/ NON-RAC IP>:<PORT>:<SID> OFSAA server. The entry
enabled database or should match with the SID/
connectivity URL. SERVICE NAME

jdbc:oracle:thin:@//[HOS

used in the JDBC URL.
T] [:PORT] /SERVICE

or

jdbc:oracle:thin:@ (DESCRI
PTION= (ADDRESS
LIST=(ADDRESS= (PROT
OCOL=TCP) (HOST=[HO
ST]) (port=[PORT])) (ADD
RESS= (PROTOCOL=TCP)
(HOST=[HOST]) (PORT=[
PORT])) (LOAD
BALANCE=yes) (FAILOV
ER=yes) ) (CONNECT
DATA= (SERVICE
NAME=[SERVICE])))

For example:
jdbc:oracle:thin:@//dbhos

t.server.com:1521/service
1

or
jdbc:oracle:thin:@//dbsho
st.server.com:1521/scan-1
or

jdbc:oracle:thin:@ (DESCRI
PTION= (ADDRESS
LIST=(ADDRESS= (PROT
OCOL=TCP) (HOST=dbho
stl.server.com) (port=1521)
) (ADDRESS= (PROTOCO

L=TCP) (HOST=dbhost2.s
erver.com) (PORT=1521)) (
LOAD BALANCE=yes) (FAILOV

ER=yes) ) (CONNECT
DATA= (SERVICE

NAME=servicel)))
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Tag Name/

Attribute Name

Description

Mandatory
(Y/ N)

Default Value/ Permissible Value

Comments

<JDBC_DRIVE
R>

By default this
driver name is
seeded.

Note: Do not edit
this attribute value.

Example:

oracle.jdbc.driver.OracleDriver

Only JDBC Thin Driver is
supported.

Do not modify this value.

<HOST>

Enter the Host
name/ |IP Address
of the system on
which you are
installing the
OFSAA
components.

Host Name/ IP Address

<SETUPINFO>/
PREFIX_SCHE
MA_NAME

Identifies if the
value specified in
<SETUPINFO>/
NAME attribute
should be prefixed
to the schema
name.

YES or NO

Default value is YES.

<SETUPINFO>/
NAME

Enter the acronym
for the type of
implementation.
This information will
be displayed in the
OFSAA Home
Page.

Note: On executing
the schema creator
utility, this value will
be prefixed with
each schema
name. For
example:
dev_ofsaaconf,
uat_ofsaatm.

Accepts strings with a minimum
length of two and maximum of four.
Example: DEV, SIT, PROD

This name would appear in
the OFSAA Landing Page as
"Connected To: xxxx".

The schemas being created
would get this prefix. For
example, dev_ofsaaconf,
uat_ofsaaconf, etc.
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Tag Name/

Attribute Name

<PASSWORD>/
DEFAULT*

Description

Enter the password
if you want to set a
default password
for all schemas.

Note: You also
need to set
APPLYSAMEFOR
ALL attribute as Y
to apply the default
password for all the
schemas.

Mandatory
(Y/ N)

Default Value/ Permissible Value Comments

The maximum length allowed is 30
characters. Special characters are
not allowed.

<PASSWORD>/
APPLYSAMEF
ORALL

Enter as Y if you
want to apply the
password specified
in DEFAULT
attribute for all the
schemas.

If you enter as N,
you need to provide
individual
passwords for all
schemas.

Note: In case you
have entered Y in
APPLYSAMEFOR
ALL attribute and
also have specified
individual
passwords for all
the schemas, then
the specified
individual
passwords will take
precedence.

Default - N
Permissible - Y

Note: Setting this attribute
value is mandatory, if
DEFAULT attribute is set.
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Tag Name/

Description
Attribute Name

Mandatory
(Y/ N)

Default Value/ Permissible Value

Comments

seeded based on
the Application
Pack.

You can edit the

schema names if
required.

Note: The Schema
Name will have a
prefix of the
SETUPINFO/
NAME attribute.

SCHEMA NAME
must be same for all
the ATOMIC
Schemas of the
applications within
an Application
Pack.

characters are allowed. No special
characters allowed except
underscore '_".

<SCHEMA>/ The different types |Y ATOMIC/CONFIG/SANDBOX/ Only One CONFIG schema
TYPE of schemas that are ADDON can exist in the file.
f;zg::eai;n this Note: SANDBOX and ADDON This schema identifies as the
ATOMIC. CONFIG schemas are not applicable for tC;ONFIGURATION schema
’ ’ OFS PFT Application Pack. at holds the OFSAA setup
SANDBOX, and detains and other Metadata
ADDON. information.
By default, the Multiple ATOMIC/
schemas types are SANDBOX/ADDON
seeded pasgd on schemas can exist in the file.
the Application ATOMIC schema refers to
Pack. . .
the Information Domain
Note: Do not edit schema. SANDBOX schema
this attribute value. refers to the SANDBOX
schema. ADDON schema
refers to other miscellaneous
schema (not applicable for
this Application Pack).
Note: The Profitability Pack
supports only one Atomic
Schema.
<SCHEMA>/ By default, the Y The permissible length is 15 SETUPOINFO/NAME
NAME schema names are characters and only alphanumeric | attribute value would be

prefixed to the schema name
being created.

For example, if name is set
as 'ofsaatm' and setupinfo as
'uat’, then schema being
created would be
'uat_ofsaatm’'.

NAME should be same
where APP_GRP=1 for all
SCHEMA tags (Not
applicable for this Application
Pack).
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Tag Name/
Attribute Name

Description

Mandatory

(Y/N)

Default Value/ Permissible Value

Comments

<SCHEMA>/ Enter the password |N The maximum length allowed is 30 |Note: You need to
PASSWORD of the schema to be characters. Special characters are | mandatorily enter the
created. not allowed. password if you have set the
Note: If this <PASSWORD>/
attribute is left APPLYSAMEFORALL
blank, then the attribute as N.
password specified
in the
<PASSWORD>/
DEFAULT attribute
is applied as the
Schema Password.
<SCHEMA>/ By default, the Y Unique Seeded Value Identifies the Application/
APP_ID Application ID is Product for which the
seeded based on schema is being created.
the Application Do not modify this value.
Pack.
Note: Do not edit
this attribute value.
<SCHEMA>/ Enter the available |N Default - USERS Modify this value to associate
DEFAULTTABL |default tablespace Permissible - Any existing valid any valid tablespace with the
ESPACE for DB User. tablespace name. schema.
Note: If this
attribute is left
blank, then USERS
is set as the default
tablespace.
<SCHEMA>/ Enter the available |N Default - TEMP Modify this value to associate
TEMPTABLESP |temporary Permissible - Any existing valid any valid tablespace with the
ACE tablespace for DB schema.

User.

Note: If this attribute
is left bank, TEMPis
set as the default
tablespace.

temporary tablespace name.
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Tag Name/
Attribute Name

Description

Mandatory

(Y/N)

Default Value/ Permissible Value

Comments

DATA_REDACT

Redaction feature.

<SCHEMA>/ Enter the quotato [N Example: Modify this value to grant the
QUOTA be set on 600M/ m specified quota on the
DEFAULTTABLES 206/ g mentioned tablespace to the
PACE attribute for user.
the schema/ user. UNLIMITED/ unlimited
By default, the
quota size is set to
500M.
Minimum: 500M or
Unlimited on default
Tablespace.
<SCHEMA>/ Enter the name of [N Permissible length is 16 characters
INFODOM the Information and only alphanumeric characters
Domain to are allowed. No special characters
associate this are allowed.
schema.
The schema creator
utility automatically
derives an
Information Domain
Name based on the
Application Pack if
no value is specified
for this attribute.
<ADV_SEC_O |Parenttagtohold [N Uncomment the tag and edit
PTIONS>/ Advance Security if you want to add security
Options. options. For example, TDE
and Data Redact.
For details, see the example
following the table.
<ADV_SEC_O |Tag to enable/ N Default is FALSE. To enable TDE, |Ensure this tag is not
PTIONS>/TDE |disable TDE. set this to TRUE. commented if you have
uncommented
<ADV_SEC_OPTIONS>
<ADV_SEC_O |Tag to enable/ N Default is FALSE. To enable Ensure this tag is not
PTIONS>/ disable Data DATA_REDACT, set this to TRUE |commented if you have

uncommented
<ADV_SEC_OPTIONS>
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Tag Name/
Attribute Name

Description

Mandatory Default Value/ Permissible Value

(Y/N)

Comments

should be
encrypted using
TDE.

<TABLESPACE |Parenttagtohold [N NA Uncomment the tag and edit.
S> <TABLESPACE> ONLY if tablespaces are to
elements be created as part of the
installation.
For details, see the example
following the table.
Note: When TDE is TRUE in
ADV_SEC_OPTIONS, then
it is mandatory for the
<TABLESPACES> tag to be
present in the xml file.
<TABLESPACE |Logical Name of Y Name if specified should be
>/ NAME tablespace to be referred in the <SCHEMA
created. DEFAULTTABLESPACE=
"HENAME##"> attribute.
Note the ## syntax.
<TABLESPACE |Physical Name of |Y NA Value if specified will be the
>/ VALUE the tablespace to be actual name of the
created. TABLESPACE.
<TABLESPACE |Specifies the Y NA Enter the absolute path of the
>/ DATAFILE location of the data file to be created.
file on the server
<TABLESPACE |Specifies if the Y ON or OFF Set to ON to ensure that the
>/ tablespace should tablespace does not run out
AUTOEXTEND |be extensible or of space when full.
have a hard limit
<TABLESPACE |Specifies if the Y ON or OFF Set to ON to ensure that the
>/ ENCRYPT tablespace(s) tablespaces when created

are encrypted using TDE.
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Note: Encryption of tablespaces requires to enabling Transparent Data Encryption (TDE) on the Database
Server.

Example: (The following snippet shows that TDE is enabled and hence the tablespace has been shown with
encryption ON.)

<ADV_SEC_OPTIONS>

<OPTION NAME="TDE" VALUE="FALSE"/>

<OPTION NAME="DATA REDACT" VALUE="FALSE" />
</ADV_SEC_OPTIONS>
<TABLESPACES>

<TABLESPACE NAME="OFS AAI TBSP 1" VALUE="TS USERS1" DATAFILE="/scratch/oral2c/app/

oracle/oradata/OFSPQA12CDB/ts usersl.dbf" SIZE="500M" AUTOEXTEND="ON" ENCRYPT="ON" /
>

<TABLESPACE NAME="OFS AAI TBSP 2" VALUE="TS USERS2" DATAFILE="/scratch/oral2c/app/

oracle/oradata/OFSPQAl2CDB/ts_usersZ.dbf“ SIZE="500M" AUTOEXTEND="ON" ENCRYPT="ON" /
>

</TABLESPACES>

<SCHEMAS>

<SCHEMA TYPE="CONFIG" NAME="ofsaaconf" PASSWORD="" APP ID="OFS AAI"
DEFAULTTABLESPACE="##OFS AAI TBSP_ 1##" TEMPTABLESPACE="TEMP" QUOTA="unlimited"/>

<SCHEMA TYPE="ATOMIC" NAME="ofsaaatm" PASSWORD="" APP ID="OFS AAAI"
DEFAULTTABLESPACE="##0FS AAI TBSP 2##" TEMPTABLESPACE="TEMP" QUOTA="unlimited"
INFODOM="OFSAAAIINFO" />

</SCHEMAS>
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APPENDIX A - CONFIGURING OFSAAI_INSTALLCONFIG.XML
FILE

To configure the 0Fs InstallConfig.xml file:

1. Navigate to ors pFT PACK/OFS AAI/conf/ folder.

2. Openthefile OFsaaT InstallConfig.xml in text editor.

3. Configure the OFSAAI_InstallConfig.xml as mentioned in the below table:

You need to manually set the Interactionvariable parameter values as mentioned in the table. If a value is

not applicable, enter NA and ensure that the value is not entered as NULL.

InteractionVariable Significance and Expected Value Mandatory
Name

<Layer name="GENERAL">

InteractionGroup name="WebServerType”

WEBAPPSERVERTYPE |ldentifies the web application server on which the OFSAA Yes
Infrastructure web components would be deployed.

The below numeric value should be set depending on the type:
Apache Tomcat = 1

IBM WebSphere Application Server = 2

Oracle WebLogic Server = 3

For example, <InteractionVariable
name="WEBAPPSERVERTYPE">3</InteractionVari able>

InteractionGroup name="0OFSAA Infrastructure Server Detaills”

DBSERVER_IP Identifies the host name or IP address of the system on which the |Yes
Database Engine is hosted.

Note: For RAC Database, the value should be NA.

For example, <InteractionVariable name="DBSERVER_
IP">14.15.16.17</InteractionVariable> or

<InteractionVariable name="DBSERVER _
IP">dbhost.server.com</InteractionVariable>

InteractionGroup name="Database Details”

ORACLE_SID/ Identifies the Oracle DB Instance SID or SERVICE_NAME Yes

SERVICE_NAME Note: The Oracle_SID value should be exactly the same as it is
mentioned in JDBC_URL.

For example, <InteractionVariable name="ORACLE_SID/
SERVICE_

NAME">ofsaser</InteractionVariable>
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InteractionVariable Significance and Expected Value Mandatory
Name
ABS_DRIVER_PATH Identifies the directory where the JDBC driver (ojdbc<version>.jar) |Yes
exists. This would typically be the $ORACLE_HOME/jdbc/lib
For example, <InteractionVariable name="ABS_DRIVER _
PATH">">/oradata6/revwb7/oracle </InteractionVariable>
Note: See JDBC Jar Files for identifying the correct
"ojdbc<version>.jar" version to be copied.
InteractionGroup name="0OLAP Detail'
OLAP_SERVER _ Identifies if the OFSAA Infrastructure OLAP component needs to |No

IMPLEMENTATION

be configured depending on whether you intend to use the OLAP
feature. The below numeric value should be set depending on the
choice:

YES - 1
NO-0

Note: If value for OLAP_SERVER_IMPLEMENTATION is set to 1, it checks for following environment variables are set in
.profile: ARBORPATH, HYPERION_HOME and ESSBASEPATH.

InteractionGroup name="SFTP Details”

SFTP_ENABLE

Identifies if the SFTP (Secure File Transfer Protocol) feature is to
be enabled. The below numeric value should be set depending on
the choice:

SFTP-1
FTP-0

Yes

interface.

Note: The default value for SFTP_ENABLE is 1, which signifies that SFTP will be used. Oracle recommends using SFTP
instead of FTP because SFTP is considered more secure. However, a client may choose to ignore this recommendation
and to use FTP by setting SFTP_ENABLE to 0. You can change this selection later by using the OFSAAI administration

Set SFTP_ENABLE to -1 to configure ftpshare and weblocal path as local path mounted for OFSAAI server.

This release of the OFSAA Infrastructure supports only US English.

For example, <InteractionVariable name="LOCALE">en_US</
InteractionVariable>

FILE_TRANSFER_POR |Identifies the port used for the file transfer service. The default Yes
T value specified is 22 (SFTP). Specify value as 21 or any other
PORT value if value for SFTP_ENABLE is 0.
For example, <InteractionVariable name="FILE_TRANSFER _
PORT">21</InteractionVariable>.
InteractionGroup name="Locale Detail
LOCALE Identifies the locale information to be used during the installation. |Yes
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InteractionVariable
Name

Significance and Expected Value

InteractionGroup name="0OFSAA Infrastructure Communicating ports"

Mandatory

Note: The below ports are used internally by the various OFSAA Infrastructure services. The default values mentioned
below are set in the installation. If you intend to specify a different value, update the parameter value accordingly and
ensure this port value is in the range of 1025 to 65535 and the respective port is enabled.

JAVAPORT 9999 Yes
NATIVEPORT 6666 Yes
AGENTPORT 6510 Yes
ICCPORT 6507 Yes
ICCNATIVEPORT 6509 Yes
OLAPPORT 10101 Yes
MSGPORT 6501 Yes
ROUTERPORT 6500 Yes
AMPORT 6505 Yes

InteractionGroup name="Web Details"

Note: If value for HTTPS_ENABLE is set to 1, ensure you have a valid certificate available from a trusted CA and the same
is configured on your web application server. For more details on configuring your setup for HTTPS.

HTTPS_ENABLE Identifies if the Ul should be accessed using HTTP or HTTPS Yes
scheme. The default value set is 0. The below numeric value
should be set depending on the choice:
YES -1
NO-0
For example, <InteractionVariable name="HTTPS_ENABLE">0</
InteractionVariable>

WEB_SERVER_IP Identifies the HTTP Server IP/ Host name or Web Application No

Server IP/ Host name, to be used for accessing the Ul. This IP
would typically be the HTTP Server IP.

If no separate HTTP Server is available, the value should be Web
Application Server IP/Host name.

For example, <InteractionVariable name="WEB_SERVER _
IP">10.11.12.13</InteractionVariable>
or

<InteractionVariable name="WEB_SERVER _
IP">myweb.server.com</InteractionVariable>
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InteractionVariable
Name

WEB_SERVER_PORT

Significance and Expected Value

Identifies the Web Server Port. This would typically be 80 for non
SSL and 443 for SSL. If no separate HTTP Server exists, the value
should be the port configured for Web Server.

Note: The port value will not be accepted as 80 if HTTPS_ENABLE
is 1 and as 443, if HTTPS_ENABLE is 0.

For example, <InteractionVariable name="WEB_
SERVER_PORT">80</InteractionVariable>

Mandatory

No

CONTEXT_NAME

Identifies the web application context name which will be used to
build the URL to access the OFSAA applications. The context
name can be identified from a URL as below:

<scheme>://<host>:<port>/<context-name>/lo gin.jsp
Sample URL:
https://myweb:443/ofsaadev/login.jsp

For example, <InteractionVariable name="CONTEXT_
NAME">ofsaadev</InteractionVariable>

Yes

WEBAPP_CONTEXT_P
ATH

Identifies the absolute path of the exploded .ear file on the web
application server.

For Tomcat, specify the Tomcat directory path till
/webapps, such as
/oradata6/revwb7/tomcat/webapps/.

For WebSphere, enter the WebSphere path as
<WebSphere profile directory>/installedApps/
<NodeCellName>. For example,
/data2/test//WebSphere/AppServer/profiles/
<Profile_

Name>/installedApps/aix-imfNode01Cell. Where aix-imf is Host
name.

For WebLogic, provide the WebLogic home directory path as /
<WebLogic home directory path>/bea/wlserver_10.3

Note: For WebLogic, value specified for this attribute is ignored and
value provided against attribute WEBLOGIC_DOMAIN_HOME is
considered.

Yes

WEB_LOCAL_PATH

Identifies the absolute path to any directory on the web application
server that can hold temporary files being uploaded as part of the
applications usage. User can set this in FTPSHARE location to
avoid the confusion.

Note: In case of a clustered deployment, ensure this path and
directory is same on all the nodes.

Yes
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InteractionVariable
Name

Significance and Expected Value

InteractionGroup name="Weblogic Setup Details"

Mandatory

WEBLOGIC_DOMAIN_H
OME

Identifies the WebLogic Domain Home. Specify the value only if
WEBSERVERTYPE is set as 3 (WebLogic).

For example, <InteractionVariable name="WEBLOGIC_DOMAIN _
HOME">/home/weblogic/bea/user_ projects/domains/mydomain
</InteractionVariable>

Yes. Specify the value
only if
WEBSERVERTYPE is
set as 3 (WebLogic)

InteractionGroup name="OFSAAI FTP Details"

OFSAAI_FTPSHARE_P
ATH

Identifies the absolute path to the directory identified as file system
stage area.
Note: The directory should exist on the same system on which the

OFSAA Infrastructure is being installed (can be on a separate
mount).

The user mentioned in APP_SFTP_USER _ID parameter below
should have RWX permission on the directory.

For example, <InteractionVariable
name="APP_FTPSHARE_PATH">">/oradata6/revwb7/ftpshare</
InteractionVariable>

Yes

OFSAAI_SFTP_USER_
D

Identifies the user who has RWX permissions on the directory
identified under parameter APP_FTPSHARE_PATH above.

Yes

OFSAAI_SFTP_PRIVAT
E_KEY

Identifies the SFTP private key for OFSAAL.

For example,

<InteractionVariable name="OFSAAI_SFTP_PRIVATE_KEY">/
home/ofsaapp/.ssh/id_rsa</InteractionVariable>

By default, the value is NA, which indicates password will be
prompted for the user <OFSAAI_SFTP_USER_ ID> for
authentication.

For more information on generating SFTP Private key, see the
Setting Up SFTP Private Key section.

No

OFSAAI_SFTP_PASSP
HRASE

Identifies the passphrase for the SFTP private key for OFSAAI.
For example,

InteractionVariable name="OFSAAI_SFTP_PASSPHRASE">enter
a pass phrase here</InteractionVariable>

By default, the value is NA.

If OFSAAI_SFTP_PRIVATE_KEY value is given and this is kept as
NA, then it is assumed as empty passphrase.

No
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InteractionVariable
Name

Significance and Expected Value

InteractionGroup name="Hive Details"

Mandatory

The default value set for the interaction variables under this group is set as NA. These are required only for Hive

Configuration.

HIVE_SERVER_PORT

Identifies the port used for the file transfer service. The default
value set is 22 (SFTP). Set this value as 21 for FTP.
For example,

InteractionVariable name="HIVE_SERVER_PORT">22</
InteractionVariable>

Yes, only for HIVE
Configuration

HIVE_SERVER_FTPDRI
VE

Identifies the absolute path to the directory identified as file system
stage area of HIVE server.
For example,

InteractionVariable name="HIVE_SERVER_FTPDRIVE">/scratch/
ofsaalftpshare</InteractionVariable>

Yes, only for HIVE
Configuration

HIVE_SERVER_FTP_U
SERID

Identifies the user who has RWX permissions on the directory
identified under the preceding parameter
HIVE_SERVER_FTPDRIVE.

For example,

InteractionVariable
name="HIVE_SERVER_FTP_USERID">ofsaa</
InteractionVariable>

Yes, only for HIVE
Configuration

HIVE_SERVER_FTP_P
ROTOCOL

If the HIVE_SERVER_PORT is 21, then set value as FTP, else set
it as SFTP.
For example,

InteractionVariable
name="HIVE_SERVER_FTP_PROTOCOL">SFTP</
InteractionVariable>

Yes, only for HIVE
Configuration
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APPENDIX A - CONFIGURING RESOURCE REFERENCE IN WEB
APPLICATION SERVERS

This appendix includes the following topics:

Configure Resource Reference in WebSphere Application Server
Configure Resource Reference in WebLogic Application Server

Configure Resource Reference in Tomcat Application Server

Configure Resource Reference in WebSphere Application Server

This section is applicable only when the Web Application Server is WebSphere.

This section includes the following topics:

Create JDBC Provider
Create Data Source

J2C Authentication Details
JDBC Connection Pooling

Create JDBC Provider

Open the WebSphere admin console in the browser window:

http://<ipaddress>:<administrative console port>/ibm/console. (https if SSL is enabled). The
Login window is displayed.

Login with the user ID that has admin rights.
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3. Expand the Resources option in the LHS menu and click JDBC > JDBC Providers to display the JDBC

Providers window.
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4. Select the Scope from the drop-down list. Scope specifies the level at which the resource definition is
visible.

5. Click New to add new JDBC Provider under the Preferences section. The Create new JDBC provider

window is displayed.
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6. Enter the following details:

o 0 0 0 ©

Database Type - Oracle

Provider Type- Oracle JDBC Driver

Implementation Type- Connection pool data source
Name- The required display name for the resource
Description - The optional description for the resource
7. Click Next.

[Create s raw 0BG PROIr ]

Craste & naw JOBC Frovider

pathe whan you tyoe the JOBC drval w o axamplel
Windera{R} or fmomeldbinst s/ salin/Jave on Linum(TM}

¥ & valus s spacified for you, you may cick et to scest the valus

Cirechory locatien for “axdbof.par” which is saved a5 WebEphere vasiable
${ORACLE JOBC DRIVER SaTH)
eradlelerajdbe aop/ erajd ba praduat/ 11,2 0/ client_1/pdba/hy

Previous || Next] | Cancel |

8. Specify the directory location for "ojdbc<version>.jar" file. Ensure that you do not use the trailing slash file

separators.

The Oracle JDBC driver can be downloaded from the following Oracle Download site:

o Oracle Database 11g Release 2 (11.2.0.4) JDBC Drivers
o Oracle Database 12c Release 1 (12.1.0.1) JDBC Drivers
Once downloaded, you need to copy the file in the required folder on the server.

Note: See JDBC Jar Files for identifying the correct ojdbc<version>.jar version to be copied.

After dowloading, you need to place the file in the required folder in your system. While creating the JDBC
Provider, ensure that the path to the jar file in the folder is specified in the Classpath field in the previous

window.

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0

279



Configuring Resource Reference in Web Application Servers

9. Click Next to display the Summary window.

Stap 11 Crasts rew
IDBC provider

Step 21 B Summary of ackiens

datsbese class path ostichs
infoarmation
Scane
=3 Step 1 Sememany
JOBC provider name Cracle JOBC D
Cascngtion Cowcla JOBC Drivar
Class pats ${ORACLE_JOBC_DRIVER_PATH)/ sjabes. jur

S{CRACLE_JOBC_DRIVER_FPATH} Jorscle/ernidit/ son ornidit/oretuct/ 112, O cheni_L/de b

Implamantstion class nams aenclu prze soel DradaleanamionPoollatsloven

Brevicus !urusl‘l Cancel ]

10. Verify the details and click Finish to create the JDBC Provider.
11. The options to Save and Review are displayed. Click Save.

Create Data Source

The steps given below are applicable for both CONFIG and ATOMIC data source creation.

1. Open the WebSphere admin console in the browser window:

http://<ipaddress>:<administrative console port>/ibm/console. (https if SSL is enabled). The

Login window is displayed.

Login with the user id that has admin rights.

Expand the Resources option in the LHS menu and click JDBC > Data sources option to display the Data

sources page.

Drarta sources A

Dats sources
USE BhiS SEgE 15 Sc the SARAGE &F & datascurce tha

GO SUEDIHE 0L ARDliCAton wEh tonnectioas fo
Bivity. A gusded sctivity provides & list of tesk steps

EEDOZIBLEE il pour SAled JDBEC prevides. The datascurts
O ENE CAtADERE, LS MOt B 00U HhiE tREK in & guided
miore genersl information sbout the topis

B Scope: Cell=GRSISOREV-Zone INodelSCell Hode =EXS1SOREV -Zone THodeds, Serverssarver]

Seosw specifies tve lavel a2 whith the resgurte Sefinition i visisle. Fer cetailes
Enfarmation en shat Scope & 800 how it works. fee The §oce petiings help.

MedemdiS 1 SOREV-Zonaliodeds. Serveraganarl W

wnoes
N || Duluts TEIL CORRELEIER MERRE SEET.
5 ko
Salect Mame & MOT nama 5 Scops O Brovider 2 Cascrigtion & Categery 5
You taA the fallowing
M| Eatul EafsulbDstasscns | Nede=0ini1 S0REv: Barby JB0E | Datsasurs
- TTTTT N Zenaihodel s Sarvermnanarl | Srovider for tha
WebSohare
Dadault
dpghenbon
M | ELCMASTES ML/ FICMASTER NodesQxSiSCREY- FICHASTER haw J0BC
o Zonsihodels Servermnenaert Datarourte
M | Agesry B RORITN fiode=dNE1 SO0 LE=L L taw JOBC
— ZeralNodels Serveraiavast Catasauree
M | agasns Mbc/aCRENT ModewFISL SREY RQEENC Haw JOBC
o e i ——— - ——
r EGSEFT b URGERFT odemEesl S0RE- WRGERFT aw JOBC
— Zenslnodatd Servermgear] Dataasurss
M | weGsSsos B2 URPGSROR NedanGXSiSOREY- UWIGSROR N ICBC
o ZoNaINOCHD T SaT ETREET L Catasourte
Total 5

4. Selectthe Scope from the drop down list. Scope specifies the level at which the resource definition is visible.
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5. Click New to display the Create a Data Source window.

Create a cats source

-» ::oplll'nl--haﬂ-r Enter basic data scurce information |
ta source

Sab tha Badez soafigurabion valual of B dRtEISUSEE F57 BEROSMESA WlR your DOBC
Bravidar. A SETBESLTE BuBslies e BRyRICE] LOAREIISAE Datraan the Baolizetien
BaTAT a0 the datatene.

Raguirement: Ute the Dotssowrses [WadSohare! R] Agslicaticn Seroer v} conacle
pages i your applications are based on the Enterprize JavaBaana(THM) (EJB) 1.0
spacfication or the Java(TH) Sendet 2.2 specification

Seapm
f

seturity akases I

Step 5: Sumemary * Dath SOURTE MBI
atomT

* W01 nams
pebe DRYMOCK

Cancel I

6. Specify the Data Source name and JNDI name for the new "Data Source".

The JNDI and Data Source name are case sensitive. Ensure that JNDI name is same as the "Information
Domain" name.

7. Click Next to display the Select JDBC provider window.

Crasts & dalE douite

Sten 11 Enter bans Select JOBC provider |

Szandy & JOBC provider to sugsent the detsssuwrss. If you choces to create & naw
= - JDEC provider. @ will ba ceated 8t the same scope a8 the datascurce. IF you are
My Ty Swtart UM relasting 81 existing JDBS provider. only thore providers ot the cureat Biope are
proviaer avadakle from the ligt.

Stwp 31 Enber

e ) Craste naw JDBE provider

@ Zalect un axisting IDBE provider

Cracle JOBC Drivar  [W

8. Select the option Select an Existing JDBC Provider and select the required JDBC provider from the drop-
down list. Click Next.

Enter database specific properties for the dala source |

- St these databare-E0edific propertes, which are reguired by the databare vender
Step 21 Select IO
;"'E'I;."" i SRS driver to svesert the connections that sre managed through the datascurce.

Step 3: Enter Hame | Valus

database specific
properimes for ihe

* U 10. 184, 10892 :192 iorclt 15

* Dot 1tere nelper dlass ARTe
Cracleilg dats stors halses (%

Step 31 Summary Use this deta 1ource in containe managed Sersintence (CMB)

Previous | | next|| Cancel |

9. Specify the database connection URL.

For Example: jdbc:oracle:thin:@<DB_SEREVER IP>:<DB SERVER PORT>:<SID>
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10. Select Data Store Helper Class Name from the drop-down list and ensure that the checkbox Use this data

source in container managed persistence (CMP) is selected.

Note: For RAC configuration, provide the RAC URL specified during installation.

For Example:

jdbc:oracle:thin:@ (DESCRIPTION= (ADDRESS LIST=(ADDRESS=(PROTOCOL=TCP) (HOST=10.11.12.13)
(port=1521)) (ADDRESS=(PROTOCOL=TCP) (HOST=10.11.12.14) (PORT=1521)) (LOAD BALANCE=no) (FAI

LOVER=yes) ) (CONNECT DATA=(SERVICE NAME=pgadb)))

11. Click Next.

Crasts 8 Cats BOLTE

Setup security aliases
dates source |
informmation
Stap 21 Select IDBC Saluct the authentication values for this reseurce
et Campanant-mEanges suthantization alag
Step 3t Enter (none) o
database specific =
propartes for the Mapping -coafiguration slisg
dats source [noae) -
Step 4: Setup Coatainesmansged avthasbication alies
security aliases naae] b

Step 31 Surmemany
Hgbes You can create a new 130 suthentication alas by awessing one of the follgming
links. Clicking on 8 kak will sancel the wzand and your curment wigard pelestions will be
lest

Slobal 12C authestication alisg
Smcurity domaing

[ Previsus | Hext| | Cancel |

12. Map the J2C authentication alias, if already created. If not, you can create a new J2C authentication alias
by accessing the link given (Global J2C authentication alias) or you can continue with the data source

creation by clicking Next and then Finish.

Craste & Juts BOUSTE

Stap 11 Enter basic Summary
dats sounce
imformation

Summany of actigais

Step 2: Select JOBC Cietians Valuas
Erravicer T
cally GX51S0REV-Zone2Nedel 30el nodes GXE1S0REV-

Stap 31 Entar Scops ZenallhiodelSiserversisarverl

database specfic T

ot for i Dats SoLTtE AETE | AbemT

data source O nama HEORYMOCK

Step 41 Setup Seluct an existing —_

IH:-l‘h' el JOBC provider Cracle JDBC Driver

Step 51 Summary l::::'mn“ho" T orwcle e ool SradeConnectionPoolCataSourne

URL sbsnoradlathiniQi0.184.108. 91 1 52 Lroreliigr2

Dats sters halzar clags

=iy eemLEsm v bashare raadater. Sracle L OgDataSter e elzar

Usae this dats ssunce in
contuiner mansged Erus
peargigtence (CMB)

Comaanant-maniged

Suthaaticabon aliss none)
Mapging-canfiguration | =
aliss pecmz
Container managed [nena)

auihentication alias

Frevicus | Flwﬂ*l Caroell

You can also create and map J2C authentication alias after creating the data source.
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13. You must create another Data source by following the above procedure with jdbc/FICMASTER as JNDI
name pointing to the "configuration schema" of Infrastructure.

J2C Authentication Details

The steps given below are applicable for creating both config and atomic J2C Authentication.
To create J2C Authentication details:

1. Select the newly created Data Source and click JAAS - J2C authentication data link under Related Items.

Bata isurces > Dafaslt Datiddurcs > JAAS - 12C suthentication data

ifiag m list of uaer identtinn and passmerds for Java(TH) 2 conmestar setunity i use

"
® 32

Brafin muw Blins Aamves wih the noce name of the ool (Tor compatindiay with sarier relesser)
Azaly

B Eraferances

1
=
BB

Select Alias = User 10 3 Cescription 2

M= || Calers

Yois can sdministar the following rescucen:
FICMASTER

Tetsl 8

2. Click New under the Preferences section.

Cata spwrces > Defaylt Datasourcs > JAAS - J3C puthentication dats > New
Specifies o list of urer identities and passwords for Java(TM) 2 conmettor setusity te une

General Properiies

* akgy
2t

3. Enter the Alias, User ID, Password, and Description. Ensure the following:

o User ID is the Oracle user ID created for the respective CONFIG and ATOMIC Schema for the
"Information Domain".

o Specify the CONFIG database user ID and password information for the jdbc/FICMASTER data source,
and specify the ATOMIC database user ID and password information for the ATOMIC schema data
source that you created earlier.

4. Click Apply and save the details.
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JDBC Connection Pooling

To define the JDBC connection pooling ensure that you have created JDBC Provider and Data source to access
the data from the database.

1. Expand the Resources option in the LHS menu and click JDBC > Data sources option to display the Data

sources page.

2. Click the newly created Data Source $paTa SOURCES$ and navigate to the path Data sources >

$DATA_SOURCES$ > Connection pools.

Data sources > GAFUSION DATA SOURLE > Conmection pools

Use this page to set properties that impact the timing of connedion manasgement tarks, which can sffect
tha padornance of your spplication. Condidar the dalault valued carefully: pour spPNCAtan figuirementi

roight warant changeng thess valses,

Configuration

Loneral Properties

Scops
* Connaction timeout
saconds

* Maximurn connactions
100 connecions

# Mandmam connedions

[10 connatiang

* Raap time
L 1] saconds

* Unured timaout
1800 seatonds

# Aged timeout
a facondi

Purge policy
Entira ool w

ok | Reset | | Cancel

3. Set the values for the following:

o Connection timeout to 0 seconds

o Maximum connections to 100 connections

o Minimum connections to 10 connections

You can also define Reap Time, Unused Timeout, and Aged Timeout as required.
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Configure Resource Reference in WebLogic Application Server

This section is applicable only when the Web Application Server is WebLogic.
This section includes the following topics:

+ Create Data Source

* Create GridLink Data Source

»  Configure Multi Data Sources

» Advanced Settings for Data Source

+ JDBC Connection Pooling

In WebLogic, you can create "Data Source" in the following ways:

For a Non RAC Database instance, Generic Data Source has to be created. For more information, see Create
Data Source.

For a RAC Database instance, Gridlink Data Source has to be created. For more information, see Create
GridLink Data Source.

When Load Balancing/Fail over is required, Multi Data Source has to be created. For more information, see
Configure Multi Data Sources.

Create Data Source

The steps given below are applicable for both config and atomic data source creation.

1. Open the WebLogic admin console in the browser window:

http://<ipaddress>:<administrative console port>/console. (https if SSL is enabled). The Login
window is displayed.

2. Login with the Administrator Username and Password.

ORACLE
WeblLogic Server® 11g

Administration Console
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3. From the LHS menu (Domain Structure), click Services > Data Sources to display the Summary of JDBC

Data Sources window.

CIRACLIE Weblogh Sarvw® o

4. Click New and select Generic Data Source option to display the Create a New JDBC Data Source

window.

You can also select GridLink Data Source or Multi Data Source while creating a Data Source. For more

information, see Create GridLink Data Source or Configure Multi Data Sources.

Create a Hew JDBC Data Sowrce
ol Cancal

DB Dsts Source Progerties

15 * Maane:

Datsbaie Type:

L Cansed

The fiolowang properiies vl be used i idenify your P DBC data souroe.

Wit wed ons Bk B2 e i P JOBC tata seurie?

ATOMSTSOL

Wil JNOH narme would you e o sssgn o vour reesr JOBC Duta Source?

Wit databane o woukd you e o select?

Oracle

5. Enter JDBC data source Name, JNDI Name, and select the Database Type from the drop-down list. Click

Next.
Ensure the following:

The JNDI Name field should be in the format "jdbc/informationdomain”

o Same steps needs to be followed to create a mandatory data source pointing to the "configuration
schema" of infrastructure with jdbc/FICMASTER as JNDI name.

o JNDI Name is the same as mentioned in web.xml file of OFSAAI Application.
Required "Database Type" and "Database Driver" should be selected.
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Create & New JOBC Dats Sowrce
Bact Mt Cancel

J0OL Data Sowrce Properties

The foliosng properties will be wsed to dentrfy your new JDBC Sata source.

Database Type: Cwae

What database drrver would you b

Database Driver: “Oracie’s Drrver (Thin JA) for instance conmections. Versio

Back  Mexd Cancel

s 90 1 and kater

1 use 1o creste databate correctons) fate: ® ndcaten Tl the drer s ealioty supoarted by Orade

Wetnoge Server

6. Select the Database Driver from the drop-down list. You need to select the Database Driver depending on

database setup, that is, with or without RAC. Click Next.

Create & New JOBE Dats Sourte

Tranasction Optias

A Sean e S000N

7. Select the Supports Global Transactions checkbox and the One-Phase Commit option.

8. Click Next to display the Connection Properties window.

Create s lew M08 Dala Sowie

Databaas Same

Mol N
WR——— - !

Pact:

e St s i el 5 B okt il o
Databade User Hame Sttom

+ s - . s Core
Paviword: T
Contiem Fangmoed sennns

2 Canc

9. Enter the required details such as the Database Name, Host Name, Port, Oracle User Name, and

Password.
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10. Click Next to display the Test Database Connection window.

Eneate & lew SDBC Data Source

Test Database Conmection

Database Uner Heme.

Lot Pasasenid EESRERSREE R e R

11. Verify the details and click Test Configuration and test the configuration settings.

A confirmation message is displayed stating "Connection test succeeded."

12. Click Finish. The created "Data Source" is displayed in the list of Data Sources.

Note: “User ID" is the Oracle user ID that is created for the respective "Information Domain".

"User ID" to be specified for data source with "FICMASTER" as "JNDI" name should be the Oracle user ID
created for the CONFIG schema.
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13. Select the new Data Source and click the Targets tab.

Create s lew J06C Duta Source

Sebect Taegets

<] AdmanServer

14. Select the AdminServer option and click Finish.

Create GridLink Data Source

If you have selected the option, New > GridLink Data Source while creating the "Data Source", you can directly
specify the JDBC URL as indicated.

Errate s lew DB Gridlink Cuts Source

et Craink Durta Sssrce Propesters

Tz] * Rt

7] IO s

Datsbue Type:

BA Dewver

1. Enter Data Source Name, and JNDI Name.
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Ensure that the "JNDI Name" field is specified in the format "jdbc/infodomname" and the XA Driver
checkbox is not selected. Click Next.

Crnake » Raw JOBC Gridlink Dats Sowre

Lot Proprrties

Complete JOBC URL

Cuaksdave uer Hame

Favnmerd

€ ot 3 saierd

2. Specify Complete JDBC URL, Database User Name, and Password. Click Finish. The created "Data
Source" is displayed in the list of Data Sources.

Configure Multi Data Sources

A JDBC multi data source is an abstraction around a group of data sources that provides load balancing and
failover between data sources. As with data sources, multi data sources are also bound to the JNDI tree.
Applications can look up a multi data source on the JNDI tree and then reserve a database connection from a
data source. The multi data source determines from which data source to provide the connection.

When the database used is Oracle RAC (Real Application Clusters) which allows Oracle Database to run across
a set of clustered servers, then group of data sources can be created for instances running on a set of clustered
servers and a JDBC multi data source can be created so that applications can look up a multi data source on
the JNDI tree to reserve database connection. If a clustered server fails, Oracle continues running on the
remaining servers.

1. Open the WebLogic admin console in the browser window:

http://<ipaddress>:<administrative console port>/console. (https if SSL is enabled). The Login
window is displayed.

2. Login with the "User ID" that has admin rights.

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0 290



Configuring Resource Reference in Web Application Servers

3. Inthe LHS menu (Domain Structure), select Services > JDBC > Multi Data Sources to display the
Summary of JDBC Multi Data Sources window.

Sumamary of JDBL Mualti Duts Saarcors

¥ Cunbomicr Bhin Lable

Flats Dots SoweceelTilbered - Hlove Cobsmaa [xmi |

00 | w5 |J-0u.-n- | Angerntien Type | Tarpers |
| |

4. Click New to display the New JDBC Multi Data Source screen.

Note: Ensure that the Data Sources which needs to be added to new JDBC Multi Data Source has been
created.

Create & New JDBC Mk Dats Source
—

Combugrare thor iully Data Source

1] W] v

1£) Aot Trpe: i Balpeming =

5. Enterthe JDBC Source Name, JNDI name, and select the Algorithm Type from the drop-down list. Click
Next.

Note: The JNDI Name has to be specified in the format jdbc/infodomname.

JNDI Name of the Data Sources that will be added to new JDBC Multi data source should be different from
the JNDI name specified during Multi Data Source.

Same steps needs to be followed to create a mandatory data source pointing to the "configuration schema"
of infrastructure with jdbc/FICMASTER as JNDI name for Data Source.

Same steps needs to be followed to create a mandatory data source pointing to the "configuration schema"
of infrastructure with jdbc/FICMASTER as JNDI name for Data Source.
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JNDI Name provided in multi data source should be the same name that will be mentioned in the web.xml

file of OFSAAI Application.

You can select the Algorithm Type as Load-Balancing.

Create o Sew BB Mol Data Sowe

Seebect Targuts

. Adimmbenees

6. Select the AdminServer check box and click Next.

Crtate & e JOBC Holls Dol Source

Select Data Sowrce Typs

A Befrer

o M- A e

7. Select the type of data source which will be added to new JDBC Multi Data Source. Click Next.

Crrate s New J0BC Hult Dats Source
Bl Data Sewres

Blata Shurie

8. Map the required Data Source from the Available Data Sources. Click Finish.

The New JDBC Multi Data Source is created with added data sources.
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Advanced Settings for Data Source

1. Click the new Data Source from the Summary of JDBC Data Sources window. The Settings for <Data
Source Name> window is displayed.

Select the Connection Pooling tab given under Configuration.

Go to the Advanced option at the bottom of the page, and check the Test Connection of Reserve
checkbox (Enables Weblogic Server to test a connection before giving it to a client).

4. To verify if the data source is valid, select "Data Source name". For example, FICMASTER.

Settngs for FICHASTER

W Cuitomire this table

Test Data Sowrce (Filtered - Hore Columns Exint)

SEFVER State

5. Select the server and click Test Data Source.

A message is displayed indicating that the test was successful.

6. Once the "Data Source" is created successfully, the following messages are displayed:
o All changes have been activated. No restart is necessary.
o Settings updated successfully.

If not, follow the steps given above to recreate the data source.

JDBC Connection Pooling

To define the JDBC connection pooling, ensure that you have created JDBC Provider and Data source to access
the data from the database.

1. Click the newly created Data Source $DATA_SOURCES$ and navigate to the path Home >Summary of
Services: JDBC >Summary of JDBC Data Sources >JDBC Data Source-<INFODDOM_NAME>

2. Set the values for Initial Capacity to 10, Maximum Capacity to 100, Capacity Increment by 1, Statement
Cache Type to LRU, and Statement Cache Size to 10.

3. Click Save.
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Configure Resource Reference in Tomcat Application Server

This section is applicable only when the Web Application Server is Tomcat.
This section includes the following topics:

»  Create Data Source
» JDBC Connection Pooling

» Class loader Configuration for Apache Tomcat

Copy the Oracle JDBC driver file, ojdbc<version>.jar from <Oracle Home>/jdbc/lib and place it in <Tomcat
Home>/lib.

Note: See JDBC Jar Files for identifying the correct ojdbc<version>.jar version to be copied.

Create Data Source

To create "data source" for OFSAA application, navigate to <Tomcat Home>/conf and edit the following block of
text by replacing the actual values in server.xml.

Note: The User-IDs for configuration/ atomic schemas have the prefix of setupinfo depending on the value set
for PREFIX SCHEMA NAME in <<APP Pack>> SCHEMA IN.xML file of Schema Creator Ultility.

For example: If the value set for PREFIX scHEMA NaAME is DEV and the schema name was mentioned as
ofsaaconf, then the actual schema created in the database would be DEV_ofsaaconf.

<Context path ="/<context name>" docBase="<Tomcat Installation Directory>/webapps/<context

name>" debug="0" reloadable="true" crossContext="true">
<Resource auth="Container"
name="jdbc/FICMASTER"

type="javax.sgl.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username="<user id for the configuration schema>"
password="<password for the above user id>"
url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"
maxActive="100"
maxIdle="30"
maxWait="10000"/>

<Resource auth="Container"

name="jdbc/< INFORMATION DOMAIN NAME >"

type="javax.sqgl.DataSource"
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driverClassName="oracle.jdbc.driver.OracleDriver"
username="<user id for the atomic schema>"

password="<password for the above user id>"

url="7jdbc:oracle:thin:@<DB engine IP address>:<DB Port>

maxActive="100"
maxIdle="30"

maxWait="10000"/>

</Context>

:<SID>"

The <Resource> tag must be repeated for each Information Domain created. After the above configuration, the
"WAR" file has to be created and deployed in Tomcat.

JDBC Connection Pooling

To define the JDBC connection pooling, do the following:

1.

Copy $ORACLE HOME/jdbc/lib/ojdbc<version>.jar to the path $TOMCAT DIRECTORY/1ib/.

Note: Refer to JDBC Jar Files for identifying the correct "ojdbc<version>.jar" version to be copied.

<Resource auth="Container"

name="jdbc/ SINFODOM NAMES"
type="javax.sqgl.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username=" SATOMICSCHEMA USERNAMES"
password="SATOMICSCHEMA PASSWORDS"

url="SJDBC CONNECTION URL"

maxActive="100"

maxIdle="30"

maxWait="10000"

removeAbandoned="true" removeAbandonedTimeout="60"

logAbandoned="true"/>

</Context>
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Note the following:

$aPP DEPLOYED PATHS should be replaced by OFSAAI application deployed path.
$INFODOM NAMES$ should be replaced by Infodom Name.

$ATOMICSCHEMA USERNAMES should be replaced by Atomic schema database user name.
$SATOMICSCHEMA PASSWORDS should be replaced by Atomic schema database password.

$JDBC_CONNECTION URL should be replaced by JDBC connection string
jdbc:0Oracle:thin:<IP>:<PORT>:<SID>. Forexample, jdbc:oracle:thin 10.80.50.53:1521:so0luint

The User-IDs for configuration/ atomic schemas have the prefix of setupinfo depending on the value set for
PREFIX SCHEMA NAME in <<APP Pack>> SCHEMA IN.xML file of Schema Creator Utility.

For example: if the value set for PREFIX SCHEMA NAME is DEV and the schema name was mentioned as
ofsaaconf, then the actual schema created in the database would be DEV _ofsaacont.

Class loader Configuration for Apache Tomcat

Edit the server.xml available in $ToMCAT HOME/conf/ folder.

Add tag <L.oader delegate="true" /> withinthe <Context>tag, above the <resource>tag. This is applicable
only when the web application server is Apache Tomcat 8.

This configuration is required if Apache Tomcat version is 8.
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APPENDIX A - POST DEPLOYMENT CONFIGURATION

This chapter covers the following topics:

* Deploying the Application

* Logging as System Administrator

»  Creating Application Users

*  Mapping Application User(s) to User Group

+ Change ICC Batch Ownership

* Mapping ICC Batch Execution Rights to User
» Saving Post- Load Change Transformations

Deploying the Application

This section covers the following topics:

* Deploying the FTP Application

+ Deploying the PFT Application

+ Deploying EFPA/ IPA/ RPA Applications

+ Post-deployment Activities of OFSEFPA v8.0.6.0.0

Deploying the FTP Application

The Oracle Financial Services Analytical Applications Infrastructure Application Server is started using
reveleusstartup.sh. This file can be edited for setting customized memory settings, garbage collector settings
depending on the available hardware configuration. Please raise an SR in http://support.oracle.com if you have
any queries related to EPM applications.

Once the installation of Oracle Financial Services Funds Transfer Pricing Management Product is completed,
you must perform the following steps:
1. Check the Log file.

2. Add the below mentioned entries in excludeURLList.cfq file located in the path $Frc wes HOME/
webroot/conf/. These entries are required for Asset and Liability Management, Funds Transfer pricing,
Profitability Management and Hedge Management/ IFRS:
[SQLIA]./fsapps/common/batchCreate.action

[SQLIA]./fsapps/common/batchEdit.action

Note: Copy the above information into notepad, and then copy it from notepad into cfg file. Take extra care
to avoid copying formatting characters into the cfg file.
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3. For Administrative Reports (Admin BI) configuration follow the steps mentioned in Oracle Financial Services
Administrative Reports on OBIEE 11g v8.0.2.0.0 - Configuration Note.docx under $FIC_HOME/adminbi/.

Note: You can also find the Oracle Financial Services Administrative Reports on OBIEE 11g v8.0.2.0.0 -
Configuration Note on OHC.

4. The web.xml under the path sF1c wB HOME \webroot\weB-INF\ should have Resource tag, if not present
add the tag and replace ORDEMO with the INFODOM name.

<resource-ref>

<description>DB ConnectionORDEMO</description>
<res-ref-name>jdbc/ORDEMO</res-ref-name>
<res-type>javax.sql.DataSource</res-type>
<res-auth>Container</res-auth>

</resource-ref>

Note: Copy the above information into notepad, and then copy it from notepad into cfg file. Take extra care
to avoid copying formatting characters into the cfg file.

5. Ifthere are ICC batch processes created having roll_portfolio and rebalance_portfolio DTs as the tasks, the
parameter list of the DTs are to be updated as:
o If the parameters for roll portfolio are '70001", 'TP', TP USER1',change the parameters as :
" 70001Y, TP, 'TP USER1T'.
o If the parameters for re-balance portfolio are '70001", '2', 'TP USERT', 'TP' change the parameters as:
",",ll,",|70001', l2|’ lTP USER»]I, lTPl.

Task Definition
Batch Maintenance = Task Defintion (Add

# Task Definition

Task ID askl Description
Components TRANSFORM DATA w

# Dynamic Parameters List

Value

EDWY

Property

EPMSZDEV

10.184.134.17
Roll Portfolio
0001, TP, TP USER1

L) <] 4

An example as of Merge Portfolio is given below:
o Run ID: when running via ICC batch and Simplified batch process, this parameter can be passed as ".

o Process ID: when running via ICC batch and Simplified batch process, this parameter can be passed
aS n
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o O O ©

Execution ID: when running via ICC batch and Simplified batch process, this parameter can be passed
as "

Run Surrogate Key: when running via ICC batch and Simplified batch process, this parameter can be
passed as "

Pattern Code, for example, '70001'
FTP User, for example, TP USER 1
Application ID, for example, 'TP' (this is a static value)

When to merge (roll versus rebalance): when running via ICC batch and Simplified batch process, this
parameter should always be 'N'. Maturity date identifying maturing strips to be merged on roll : when
running via ICC batch and Simplified batch process, this parameter should always be "

These parameters would appear as follows in the simplified batch parameter input block:
ll’ll’ll’ll’l70001l’ ITP USER 1I’ ITPI’ INI, n

The parameter pattern to be used when RP batches are scheduling from the Run Rule Framework.
When executing from the Run Rule Framework, the user does not have to pass the Run ID, Process

ID, Execution ID, and Run Surrogate Key, as the framework itself passes these values along with the
Batch ID and MISDATE. The parameters would appear as follows:

"70001 ""'TP USER 1II,|ITP|I,I|NI|,III|

6. Transfer the ownership of batches to the required User.

a. Login to config user.

b. Execute the Following anonymous pl/sql block to execute procedure

"AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP".
begin
AAI OBJECT ADMIN.TRANSFER BATCH OWNERSHIP ('fromUser', 'toUser', 'infodom');
end;
OR
begin
AAT OBJECT ADMIN.TRANSFER BATCH OWNERSHIP ('fromuser', 'touser');

end;
Parameter details:

m  fromUser: Indicates the user who currently owns the batch
m  to User: Indicates the user to which the ownership has to be transferred.

= infodom: Optional parameter, if specified the ownership of batches pertaining to that Infodom will
be changed.

7. |If the web application server is hosted on a machine other than where pack is installed, then perform the
following step.

o Generate RSA key for the machine where Web application server is hosted.

o Add the generated RSA key to the authorized keys list of the machine where Pack s installed.

Deploying the PFT Application
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The Oracle Financial Services Analytical Applications Infrastructure Application Server is started using
reveleusstartup.sh. This file can be edited for setting customized memory settings, garbage collector settings
depending on the available hardware configuration. Please raise an SR in http://support.oracle.com if you have
any queries related to EPM applications.

Once the installation of Oracle Financial Services Profitability Management Product is completed, you must
perform the following steps:
1. Check the Log file.

2. Add the below mentioned entries in excludeURLList.cfq file located in the path $Frc wes HOME/
webroot/conf/. These entries are required for Asset and Liability Management, Funds Transfer pricing,
Profitability Management and Hedge Management/ IFRS:

[SQLIA]./fsapps/common/batchCreate.action
[SQLIA]./fsapps/common/batchEdit.action

3. For Administrative Reports (Admin Bl) configuration follow the steps mentioned in Oracle Financial Services
Administrative Reports on OBIEE 11g - Configuration Note.docx under $F1C¢ HOME/adminbi.

4. The web.xml under the path sFrc wB HOME \webroot\weB-INF\ should have Resource tag, if not present
add the tag and replace ORDEMO with the INFODOM name.

<resource-ref>

<description>DB ConnectionORDEMO</description>
<res-ref-name>jdbc/ORDEMO</res-ref-name>
<res-type>javax.sql.DataSource</res-type>
<res-auth>Container</res-auth>

</resource-ref>

Note: Copy the above information into notepad, and then copy it from notepad into cfg file. Take extra care
to avoid copying formatting characters into the cfg file.

5. Transfer the ownership of batches to the required User.
a. Login to config user.

b. Execute the Following anonymous pl/sql block to execute procedure
"AAl_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP".

begin

AAI OBJECT ADMIN.TRANSFER BATCH OWNERSHIP ('fromUser', 'toUser', 'infodom');
end;

OR

begin

AAT OBJECT ADMIN.TRANSFER BATCH OWNERSHIP ('fromuser', 'touser');

end;
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Parameter details:

m  fromUser: Indicates the user who currently owns the batch.
m  to User: Indicates the user to which the ownership has to be transerred.

» infodom: Optional parameter, if specified the ownership of batches pertaining to that Infodom will
be changed.

6. If the web application server is hosted on a machine other than where pack is installed, then perform the
following step.

o Generate RSA key for the machine where Web application server is hosted.

o Add the generated RSA key to the authorized keys list of the machine where Pack s installed

Deploying EFPA/ IPA/ RPA Applications

Ensure that the Oracle Business Intelligence version 11.1.1.7.1 is available.

Note: AfterInstallation, patch 16556157 is recommended for all the customers who are using Oracle Business
Intelligence Enterprise Edition 11.1.1.7.0. This patch can be downloaded from Oracle support site.

1. Setthe <oracle BI Instance Home> directory> =>.
For example: /u01/0BIEE11G/instances/instancel
2. Start Weblogic AdminServer.
a. Set the < Bl Domain Home> directory> =>

For example: /u01/0BIEE11G/user projects/domains/bifoundation domain

b. Navigate to < BT Domain Home >/bin andrun 'nohup ./startWebLogic.sh &'

c. Bringing up this service may take a few minutes depending on your environment.Check the logs using
the command 'tail -f nohup.out'

3. Start Node Manager.
a. Setthe < WebLogic Server Home > directory> =>
For example: /u01/0BIEE11G/wlserver 10.3
b. Navigate to <webLogic Server Home>/server/binandrun 'nohup ./startNodeManager.sh &'
4. Start Weblogic Managed Server(bi_server1).

a. Loginonto http://localhost:7001/console using your Administrator credentials created during
platform install (Replace the hostname based on your setup).
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b. Under Environment block (mid of page, towards left side), click on Servers link.

c. The bi_server1 line should show as shutdown state at this point.

[ | server s Hachine State Status of Last Action
[ | Adninserves{admin) ok 4ap RUNNING Neee
[ |biservert lalvap E_nzm_m:) TASK COMPLETED
d. Click on control page tab.
Summary of Servers
Configuration | )
e. Select the bi_server1 line by clicking on the left tick box.
f. Click start button at the top of the list and confirm starting this service.
Servers (Filtered - More Columns Exist)
| Start | | Resume | | Suspend v | | Shutdown v || Restart SSL |
[ | server & Machine State
O |Adminserver(admin) laliv-ap RUNNING
[#] |bi_servert laliv-ap SHUTDOWN

|Rum||supmv'|snm-mv||mnssy'

g. State will update to "RUNNING" mode after a few minutes.
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5. Start BIEE services and login.
a. Starting services From EM screen.

i. Log in to the EM administration screen using the url http://localhost:7001/em (Replace the
hostname and port number based on your setup). Use the login you created in BIEE installation to
log in.

i. Expand 'Business Intelligence’ node on the left and choose Coreapplication.

=1 52 Farm_bifoundation_domain |
& [ Application Deployments
® [3 weblogic Domain
B 3

@ coreapplication
@ [ Metadata Repositories

iii. Click on the Overview Tab.

Change Center: | & Lock and Edit Configuration

Overview = Capacity Management = Diagnostics = Security | Deployment

System Shutdown & Startup

T @ .

System Components

System Status Manage System

4 All components are available @ start ) stop [ Restart

iv. Click on blue button 'Restart' (or green button 'Start') under the Manage System category, middle of
screen.

v. Click yes on dialog box to confirm the move. Wait for message that confirms successful restart.

b. If starting using EM is not successful and complaining about OPMNCTL not up, Follow starting process
with OPMNCTL.

i. Open acommand prompt, navigate to <Oracle Bl Instance Home>/bin.
ii. Run".Jopmnctl status, this will show you status of all the OBIEE core services.
iii. Run ".Jopmnctl startall" or "./opmnctl stopall" depending on your need.

6. Deploy RPD and webcat file(s).

a. Copy ors PFT PACK.rpd from $r1c HOME/OFSPFTPACKBI/OBIEE11G of Web layer to windows
machine where the OBIEE windows administration client is installed.

b. Copy these catalog files to the local folder, where ors pFT PACK.rpd has been copied.
c. Login to OBIEE - Enterprise Manager URL (http://<ip address>:<port>/em).
i. Click on hyperlink 'coreapplication' from 'Business Intelligence' tab on left hand side.

ii. Under 'coreapplication’, select the tab 'Deployment' and in that select sub-tab 'Repository'.
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ii. Click 'Lock and Edit Configuration' button located below title 'coreapplication’. Following screen is
displayed.

Loggedin m wtdoy

i coreapplication s

e e e S b ey . 205 B

Artivate Changes i e hanges Sy s Condigurnion ) st 13 iy seoens anges B

Oumves  ChsotyMmsmesd  Dagmts  Searty  Depheymest
Premnisten | eposiery | e Hariing el
|
Bl Server Repositony Sopiy Apply Button|
LSS (LSRRI S — |
DAL b Etoeéorm Achareen _B11L0
e Bt

Wpaad BI Senver Raposony

I T L s T T LT rep S ————

1 Presentation Catsiog

Thm wectior shomn P carresd incaben of e caising used by Prosentsbon Servor. Lse P secion s hangs B locsien o catiiag. o i shane e catog by porng b o shares

: foasdion :
Catalog bocation
s RS LIRSy ot cn gt WOMPO ST AL e

iv. RPD Deployment: Select 'Browse' button available under 'Upload Bl Server Repository' section and
select OFS_PFT_PACK.rpd file from the local folder. Enter Repository password Admin123.
v. Web catalog Deployment:
m  Open the analytics OBIEE URL-(http://<ipaddress>:<port>/analytics) and login with the
credentials.
m  Click "Catalog" link available on the top right corner.

ﬁ' Advanced Administration

Favorites ~ | Dashboards ~ | [ New ~ | B Open «
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m  Click "Shared Folders" and then "Un-Archive".

ORACLE

Business In

= Tasks

[5] shared Folders

¢ Delete

;f' Create Shortcut

[ Expand [£] Archive

s

) copy 5@ Properties

(i@ Rename LA permissions

Browse the path where "OFS_PFT_PACK.catalog" is copied in the local folder. Select the file

u
and click "Open". Then click "OK".
Unarchive (]
Archive fle |Financial Reporting.ca|| Browse...
Replace None -
ACL  Inherit -
eb [0k ] conce
m  Click on "Shared Folders" and then on Un-Archive. Browse the path where
"OFS PFT PACK.catalog"is copied in the local folder. Select the file and click "Open". Then
click "OK" as shown in below diagram.
Unarchive (]
Archive file |Management Reportini| Browse...
Replace None -
ACL  Inherit -
teb
= Two new catalogs are available on the left hand side.
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= Click "Dashboard" and click on any of the reports to ensure that all the reports are available.

Search | Al

Home Catalog

=

Favorites

\#| Advanced Administration Help ~ Signout O

E nNew ~ | B Open ~ | Signed In As weblogic ~

| L]E Most Recent({Income Statement - Income Statement)

[ My Dashboard

| El Financial Reporting

([ Financial Reporting
= Management Reporting
(@ Balance Sheet
[ Income Statement
([ Key Trends
([ Performance Measures

vi. Steps to restart all services in OBIEE "Enterprise Manager".

Open the EM OBIEE URL- (http://<ipaddress>:<port>/em) and login with the credentials.

m  Click "coreapplication" link.

LSS N e Ty T T T ——

CT | S———,
- Farmn Ifoumition domose
| P lemmtatmn e

[ ——

U rpm

trwm g

B b vt

e
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m  Click the "Restart" button.

ORACLE Enterprise Manager 11g Fusion Middleware Contrel
Hirerm~ | 4, Topology
=
= BH Farm_bifoundaton_domain
+ [ Application Deployment:
& [ WebLogic Domain
[ Business Inteligence
l:]' glmmhnj - Availabiity = Capadty Management = Diagnosbcs
# [] Metadata Repostonies

{¢ coreapplication @
Business Inteligence Instance +

Change Center: | J® Lock and Edit Configuration

Security | Deployment

Q Hup (5)

Sysiem Companents

E system Shutdown & Startup

System Status Manage System

'Lf‘ All companents are available @ start | | Stop I G Restart 3'

= Diagnostics

m  Click "Yes" to restart all Bl components.

1, Confirmation

Are you sure you want to restart all BI components?

Yes Mo

A message is displayed as follows:

(9 Processing

Restart All - In Progress.

(¥ This operation cannot be cancelled. It will continue even if the browser window is dosed.

m  Once restart is done, a confirmation message is displayed as follows:

- @ Confirmation

Restart All - Completed Successfully

Done

7. Configure tnsnames.ora file.

a. Open "tnsnames.ora" file under the folder - <Oracle Home>/network/admin/ folder.

b. Make sure an entry is made in the tnsnames.ora to connect to atomic schema of OFSAA application.
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C.

Save the tnsnames.ora file.

8. Configure ODBC data source to connect to Oracle Bl Server.

a.

© o 0 T

f.

Go To Control Panel>Administrative Tools>Data Sources (ODBC).
Select the 'System DSN' tab and click 'Add' Button.
Select a driver specific to (Oracle Bl Server 11g) and click 'Finish' Button.

Enter 'Name' and 'Server' details (Specify the Host Name or IP Address of the Bl Server and click 'Next').

Enter Oracle Bl Server login id and password (Enter User Name and Password created at the time
OBIEE installation). Click 'Next'.

Click 'Finish'.

9. Modify RDBMS connection pool and set the properties.

= 9o 20 T

h.

i

Open the OBI Administration tool.

Select Start > Programs > Oracle Business Intelligence > Bl Administration.

Select File > Open > Online and select 'OFS_PFT_PACK.rpd' file from the Open dialog box.
Enter Repository password as 'Admin123'.

In the "Physical" layer, double-click the "OFSEFPA Connection Pool" to open its properties.
In the 'General’ tab, edit/ check the following entries:

i. Call Interface: (OCI 10g/119).

ii. Data source name: <tnsnames.ora entry created in the step 7.b connecting to OFSAA atomic
schema>.

iii. User name: <enter atomic db user name>.

iv. Password: <enter atomic db user password>.

Confirm password and Click 'OK' to close the window and click 'Save' to save the RPD file.
Click 'No' for the Global Consistency Message.

Repeat the steps from 9.f to 9.1 to set the connection properties for "OFSEFPA Init Block".
Close the RPD file (File / Exit).

10. In case RPD deployment is done on Essbase then modify ESSBASE connection pool and set the
properties.

of

Note: This is applicable only for EFPA.

a. Open the OBI Administration tool.

b. Select Start > Programs > Oracle Business Intelligence > Bl Administration.

Select File > Open > Online and select the cube rpd file created as mentioned in the 3rd step (RPD
Deployment On Essbase Cubes) of section Post-Deployment Activities of OFSEFPA 8.0.6.0.0, from t
Open dialog box.

Enter Repository password as 'Admin123'.

In the "Physical" layer, double-click the "Connection Pool" under Essbase, to open its properties.
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f. Inthe 'General' tab, edit / check the following entries:
i. Call Interface: (Essbase).
i. Essbase Server: IP Address of Essbase server.
iii. User name: <enter Essbase console user name>.

iv. Password: <enter Essbase console user password>. g. Confirm password and Click 'OK' to close
the window and click 'Save' to save the RPD file.

g. Click 'No' for the Global Consistency Message.
h. Close the RPD file (File > Exit).

11. Login into OFSEFPA Application using the URL: http://localhost:9704/analytics. (Replace the port number
based on your setup).

12. Once the OBIEE Environment is up and running, the OBIEE url needs to be updated in the table
'AAl_MENU_B' for an end user to access the respective Business Intelligence Analytics Application.

Following update statement needs to be executed in the config schema:

UPDATE AAI MENU B
SET V_MENU URL = '<URL>'

WHERE V_MENU ID IN ('<List of enabled BI Analytical Links for a particular Media Pack
>1)

/
COMMIT
/

For PFT Media Pack as an example:
UPDATE AAI MENU B
SET V_MENU URL = 'http://0fss222798:7001/analytics/"’
WHERE V_MENU ID IN ('OFS EFPABI LINK')
/
UPDATE AAI MENU B
SET V_MENU _URL = 'http://0fss222799:7001/analytics/"
WHERE V_MENU ID IN ('OFS RPABI LINK', 'OFS IPABI LINK')
/
COMMIT
/
(Replace the IP address and port number based on your setup.)

13. Execute the following in atomic schema to view the T2T mappings in Metadata browser(object view):
declare
result number;
begin
result:=fn mdb t2t view;
dbms output.put line(result);

exception
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when others then
dbms output.put line (SQLERRM) ;

end;

Post-deployment Activities of OFSEFPA v8.0.6.0.0

The following activities have to be done after installing and deploying OFSEFPA v8.0.6.0.0:
OBIEE Configuration:
1. Evaluate Support Level:

Evaluate function is used in filters of many reports. To support the evaluate function in reports, the value of
EVALUATE SUPPORT LEVEL in NOSConfig.INI file of the OBIEE server needs to be set as 2.

Path for 11G
SOBIEEHOME\instances\instancel\config\OracleBIServerComponent\coreapplication obisl
For 12C
SOBIEEHOME/user projects/domains/bi/config/fmwconfig/biconfig/OBIS
Changes: Set EVALUATE SUPPORT LEVEL = 2 from EVALUATE SUPPORT LEVEL = 0;

2. Session Variable Setting:

'ENTITY' by default picks the lowest of Legal Entities in the alphabetical order.
select min(v_entity_name) from dim_org_structure

This query fetches the default legal entity that will be displayed in the obiee reports (Legal Entity drop-down)
at on load of the report.

Users can also set the default value for Entity, by following these steps:

Open the RPD online.
b. Under Manage Menu go to Variables and select session variable 'ENTITY".

c. Set the default value in default initialize section with any one of the available entity name from
DIM_ORG_STRUCTURE table in single quotes. For example: '<Entity Name>'

d. Save and check the global consistency of the RPD.
3. Repository Variable Setting:
a. Open the RPD online.

b. Under Manage Menu go to Variables. Set Static Repository variables 'RV_Reporting_Currency' and
'RV_Base_Currency".

c. Save and check the global consistency of the RPD.
4. RPD Deployment On Essbase Cubes(Optional):
a. During deployment use "Admin123" as OFS_PFT_PACK.rpd repository password.

b. Deployment of RPD on ESSBASE cubes will be done through an xml patch (EFPA_Cube_Patch.xml).
The xml has been provided as a part of installation and will be present at $FIC_HOME/ EFPA/repository
folder.

c. Provide connection details of RDBMS in 'OFSEFPA Connection Pool' and 'OFSEFPA Init Block'. This
is required to show LCY Label in the reports, for the legal entity selected in the prompt.
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d. The steps to be followed for creating cube related RPD is mentioned in the following procedure:

i. Create a folder “xmlpatch” in your system and copy the EFPA.rpd (Its RDBMS RPD) &
EFPA_Cube_Patch.xml files.

ii. Open the EFPA Repository (EFPA.rpd) in offline mode.

j=/ Oracle BI Administration Tool
File Tools Help

Do eBA|XEE|E AL TERKHBEG|H

Look in: | | xmipatch

Computer 4 I

File name: [EFPADd
. Files of type: [Repostory Fies rpd)

iii. Give the repository password as “Admin123”.

E Oracle BI Administration Tool
File Tools Help

nelew 288 KEB |3 |Ma> 0@aaHRG|%

Open Offline EFPALrpd

Bepository Password:
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iv. Choose “Merge” option from File Menu.

Oracle BI Administration Tool - EFPA.rpd
Edit View Manage Tools Diagram Window Help

MNew Repository... Ctrl+N
Open

Multiuser

Source Control

Close

Save Ctrl+5
Save As

Copy As

Change Password...

BRALOTERE G

Print Preview.,.,
Print

Import Metadata...
Compare...

Turn off Compare Mode
Check Global Consistency Ctri+K
Check Models

Check Cut All
Check In Changes
Undo &ll Changes

1 EFPA.rpd

2 EFPA_Dashboard_analysis.rpd
3 EFPA.rpd

4 EFPA_Cube_Final.rpd

Exit

v. On the Merge Repository Wizard screen, choose option as “Patch Repository Merge”.

E Oracle Bl Administration Tool - EFPA.rpd

File Edit Wiew Manage Tools Diagram. Windou
PR

Help

m [1 & @& | Merge Repository Wizard - Select Input Files

GEIQ

Presentatiu‘ N
n Select Input Files
E Balaa

Difine Merge Strateqy

Help

Merge Type:

" Ful Repository Merge (& Patch Repository Merge

Original Master Repository: I

Repository Password:

Modified Repository:

I D:\1_PFTBI Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmlpatch\EFPA.rpd

Repository Password: ssesnses

Patch File: I

Patch Password:

—

Save Merged Repository as:

I D:\1_PFTBI Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA(1).rpd

Repository Password: srasases

¥ Equalize during merge

Back

Mext

Finish

Cancel

Select  »
Selert ¢
Select...

Select *

For Help, press F1
\

==
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vi. Select the Original Master Repository as “EFPA.rpd” from xmlpatch folder by clicking select option.

Oracle BI Administration Tool - EFPArpd

File Edit Wiew Manage Tools Diagram ‘Window Help

” [ & @ | Merge Repository Wizard - Select Input Files ‘ﬁl
Presentation| Merge Type: ( Ful Repository Merge @ Patch Repository Merge ical
n Select Input Files B =n
Original Master Repository: ID:\l_PFTBI_Project_Work\Bl_MemdaE_Sheets_oBIEE_TZT\xm\pat(h\EFPA.rpd Select » E, EFPA_Esd
Define Merge Strateay &
I s

@ rreom E Select Original Repository u

Modified Repository: Hodicin: I | xmipatch ﬂ G T @ Seleit r

Date maodified

Patch File:

T Select..

Save Merged Repository as:

Select  »

¥ Equalize during merge Libraries
A
‘Computer 1 I I LI
Fie name [EFPARd ~] Open
Files of typs |Repostory Fies ("md) | Cancel
Help Back | Mext Finish Cancel

For Help, press F1

vii. Give “Admin123” as password for Original repository.

Oracle BI Administration Tool - EFPA.rpd
File Edit View Manage Tools Diagram Window Hel

” [ & @ Merge Repository Wizard - Select Input Files —

i SO Merge Type: ¢ Full Reposttory Merge @ Patch Repositary Merge cal
@ Balang n |
{@ Finan . Original Master Repository: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA.rpd == D ;
@ Fran Define Merge Suategy

@ Incomf Repository Password: -

eedl

Modified Repository: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2 T\xmipatch\EFPA.rpd St >

Repository Password: srsnseee

Patch File: I Select...
Patch Password:
Save Merged Repository as: | D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA(1).rpd Select  *

Repository Password: sssssnse

¥ Equaliee during merge

Help Back Mext Finish Cancel

For Help, press F1
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viii. Select the xml patch file from the saved path (xmlpatch folder).

Oracle BI Administration Tool - EFPA.rpd
File Edit View Manage Tools Diagram Window Help
” [ & @ | Merge Repository Wizard - Select Input Files ‘ 1] Pl
Presentation| ] Merge Type: ¢~ Full Reposttory Merge @ Patch Repository Merge Isiral
n Select Input Files e
Original Master Repository: ID:\ljFTBU’m]a¢7Work\817MemdamfshaatgDBIEEﬁTZT\xm\patch\EFPA.rpd Select * E, EFPA_H]
Define Merge Strategy = -
Repository Password:
Modified Repository: ID:\l_PFTBI_PmJect_Wurk\Ell_Memdam_Sheets_DBIEE_TZT\xm\pat(h\EFPA.rud Selert
Repository Password: sssssses
Patch File: I Select... I
Patch Password:
s
[=] select The Patch File [
Save Merged Repository as: 1 e = Selact
Loskcin: [ ] xripatch >l e @
¥ Equalize during merge
Desktop
Libraries
Help ish Cancel
For Help, press F1 l‘!
-
‘Computer 4 I LI
File name: |EFPA_Cube_Patchxml ~ Open
Files of type: [XML Fies (*ml) ~| Cancsl
H H “ H » .
ix. Give “Admin123” as Patch file password.
E Oracle BI Administration Tool - EFPA.rpd
File Edit View Manage Tools Diagram Window el
” [ & & | Merge Repository Wizard - Select Input Files o=l g
Presentation N Merge Type: ¢ Ful Repository Merge @ Patch Repository Merge cal
n Select Input Files
({1 Balane EFP.
I3 Finan . Original Master Repasitory: ID:\l_PFTBI_PruJEct_Work\Bl_MEGdat:i_ShEEts_UBIEE_TZT\xm\patch\EFPA.rpd Select  » EFP.
) Frn Define Merge Shateny —I*
) Inconl Repository Password: PP
Modified Repository: ID:\lJFTBLPrn]e¢7Work\817MemdamjheefsﬁDBIEEﬁTZT\xm\patch\EFPA.rpd St >
Repository Password: sreesere
Patch File: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA_Cube_Patch.xml Select...
Patch Password: W
save Merged Repository as: |D:\1JFTBLPrmect,Wurk\m,Memdam,sheem,oalEE,TzT\xm\patch\EFPA(1).rpd Select  *
Repository Password:
¥ Equalize: during merge
Help Bark | Next Finish Cancel |
For Help, press F1 A
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H “ ”
x. Change the name of the merged repository to “EFPA_C1.rpd”.
Oracle BI Administration Tool - EFPA.rpd
File Edit View Manage Tools Diagram Window Help
” [ & @ | Merge Repository Wizard - Select Input Files [ BN
Presentation) N Merge Type: ¢ Ful Repository Merge @ Patch Repository Merge Isaal
n Select Input Files el
) Balan I
@ Finand . Original Master Repository: |D:\l_PFTBI_ProJe:t_ka\Bl_MemdaG_Sheets_OBIEE_TZT\xm\patch\EFPA.rpd Select  » E, EF
@ Finand Define Merge Shateqy 4|—
@ Incom Repository Password: [ esssssss
Modified Repository: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA.rpd Select >
Repostory Password: -
Patch File: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets OBIFE_T2T\xmipatch\EFPA_Cube_Patch.xml Select...
Patch Password: IT
Save Merged Repository as: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets OBIEE_T2T\xmipatch\EFPA(1).rpd Select  *
Repository Password: sssssess
~
E Select repository file to save the merged result E
¥ Equaliee during merge Save in: I | amlpatch j (< Wz S )
Name = |‘| Date modified
=) eFPArpd 9/27/2014 3:38 P
Help J Cancel
For Help, press F1 A
Libraries
A
Computer b I I LI
File name = save |
Save as type | Cancel
xi. Click on Next.
Oracle BI Administration Tool - EFPA.rpd
File Edit ‘View Manage Tools  Diagram Mindow Hel
” [ & @ | Merge Repository Wizard - Select Input Files E‘Eﬂ
Presentation N Merge Type: " Ful Repository Merge @ Patch Repository Merge ca
n Select Input Files
) Balang
@ Finane . Original Master Repository: ID:\l_PFTBI_ProJe:t_ka\Bl_MemdaG_Sheets_OBIEE_TZT\xm\patch\EFPA.rpd Select  »
) Fnan Define Merge Shateqy 4|—
@ Incon Repostory Password: - .
Modified Repository: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA.rpd Select ¥
Repository Password: ssssssss
Patch File: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA_Cube_Patch.xml Select...
Patch Password: IT
Save Merged Repository as: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets OBIEE_T2T\xmipatch\EFPA_Cl.rpd
Repository Password: sssssese
¥ Equaliee during merge
Help Back | Next Firiish Cancel
For Help, press F1 2
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Note: If “Merge Repository Wizard — Define Merge Strategy” window opens up then skip the below steps and

proceed from “Step: xxiii” onwards. In this case the final Cube Rpd name will be “EFPA_C1.rpd”.
Otherwise proceed ahead with the below steps.

xii. Check for global consistency by clicking on “Check Global Consistency Ctrl+K” under “File” menu.

Oracle BI Administration Tool - EFPA_Cl.rpd
Edit View Manage Tools Diagram Window Help

MNew Repository... Ctrl+N
Open 4
Multiuser 4
Source Control 4
Close

Save As 4
Copy As 4

Change Password...

Import Metadata...
Compare...

Merge...

Check Global Consistency Ctri+K

1 EFPA_Cl.rpd

2 EFPA_patched.rpd

3 EFPA.rpd

4 EFPA_Dashboard_analysis.rpd

Exit

xiii. It should result in no errors. Click on “OK” button.

Oracle Bl Administration Tool [&J

0' Consistency check fixed certain object(s); there are no errors,
L¥" warnings or best practice violations left to report.
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xiv. In “xmlpatch” folder copy “EFPA_C1.rpd” and paste so that a new duplicate rpd gets created

“‘EFPA_C1 - Copy.rpd”.

@Ov| » Computer » Data (D:) » 1_PFTBLProject Work » 81 _Metadata_Sheets_OBIEE_T2T » xmlpatch »

File Edit View Tools Help

| 58_EFPA_11.1.1.7.0_Qualification

| 59_Disaster_Recovery_and Issues

| 60_EFPA_RPD_And_Catalog_Cleanup
61_EFPA_MergeStatementGenerate

Organize « Include in library ~ Share with + Burn Mew folder
| 51 InstallationOf 61 _And ML . Mame Date madified Type Size
52_GSH_Issues : )
. - B EFPA.rpd 9/27/2014 3:38 PM RPD File 181 KB
| 53_Translation_Config_Schema_Dump i ) .
. E EFPAZID 9/27/2014 3:38 PM zip Archive 74 KB
| 54 _Performance_Tuning
. =] EFPA_CL - Copy.rpd 10/8/2014 7:00 PM RPD File 179 KE
| 55_RepLine DT
. e e | = EFPA_Clrpd 10/8/2014 7.00 PM RPD File 179 KB
| 56_All_documentation_Verification -
z 5 EFPA_Cube_Patch.xml 9/27/2014 3:38 PM XML File 313 KB
57_2_Adjustments_Project 5 . )
“a] EFPA_patched.merge_log.csv 10/8/2014 7:00 PM Microsoft Office Ex... 7 KB
| 57_GLRecon_HandOver % . )
'] Steps_to_create_Cube_RPD.doc 10/8/2014 7:00 PM Microsoft Office W... 2,737 KB

xv. In the currently opened “EFPA_C1.rpd” click on “Merge...” under “File” menu.

Oracle BI Administration Tool - EFPA_Cl.rpd
Edit View Manage Tools Diagram Window Help

MNew Repository... Ctrl+N
Open L -
Multiuser 4
Source Control 4
Close

Save Ctri+5s

Save As 4
Copy As 4

Change Password...

Import Metadata...

Compare...
Check Global Consistency Ctri+K

1 EFPA_Cl.rpd

2 EFPA_patched.rpd

3 EFPA.rpd

4 EFPA_Dashboard_analysis.rpd

Exit
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xvi. On the Merge Repository Wizard screen, choose option as “Patch Repository Merge”.

Oracle BI Administration Tool - EFPA_Cl.rpd

File Edit view MIManage Tools Disgram Jafindow Help

” [ & @ | Merge Repository Wizard - Select Input Files = |E g
Presentation ) Merge Type: ¢ Ful Repository Merge @& Patch Repository Merge ical
“ Select Input Files
s Balan EFPA]
i E 3
g 2::: l_iL‘ Define Merge Stuateny Original Master Repository: I Select EFPA]
@ Incom§

Help

Modified Repository:

Patch File:

Save Merged Repository as:

I¥ Equalize during merge

Repository Password:

I D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmlpatch\EFPA_C1.rpd

Repository Password: eresesee

Patch Password:

—

Repository Password: ssssssse

I D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA_C1(1).rpd

Back et

Firish

Cancel

For Help, press F1

N —

xvii.Select the Original Master Repository as “EFPA_C1 - Copy.rpd” from xmlpatch folder by clicking

select option.

Oracle BI Administration Tool - EFPA_C1.rpd

File Edit wiew Manage Tools

Diagrarm Window Help

” [ & @ | Merge Repository Wizard - Select Input Files

@ Incom

Help

Repository Password:

-
Modified Repository: E Select Original Repository S — -
Lookein: [ . smipatch x| @ e m-
Patch File: Name = | +| pate modified
= EFPArpd 9/27/2014 3:38 PN
CJEFPA C1 - Copy.rpd 10/8/2014 Pl

Save Merged Repositol

¥ Equalize during mer|

= EFPA_CLrpd

Desktop

Libraries

A

Computer 4 I

10/8/2014 7:00 Ph

Fie name |EFPA_CT -Copyma

Files of type | Repository Files ("md)

] —

Finish

Selet »

Select...

Select  »

Cancel

=] = ]
Presentation| Merge Type: ¢ Full Repository Merge @ Patch Repository Merge Isiﬂal
Select Input Files
T Balan 8 ErP
Original Master Repository: 3 EFP
[2] Dstine Mo Sttes e v | et =

For Help, press F1
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xviii.Give “Admin123” as password for Original repository.

Oracle BI Administration Tool - EFPA_Cl.rpd

File Edit view MIManage Tools Disgram Jafindow Help
” [ & @ | Merge Repository Wizard - Select Input Files

= | B [

@ Incom§

Repository Password: e

J

Presentation ) Merge Type: ¢ Ful Repository Merge @& Patch Repository Merge ical
“ Select Input Files
(=G Balan EF
@ Finany Original Master Repository: ID:\I,PFTBLPmJe(t,WDrk\Ell?MemdaﬁLSheetgOBIEEfTZT\xm\pat(h\EFPAfCl - Copy.rpd Select  * EF
@ Finen Define Merge Stategy

Repository Password: eresesee

Modified Repository: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2 T\xmipatch\EFPA_C1.rpd

[

Patch File: I

Patch Password:

Select...

Save Merged Repository as:
Repository Password: sssssses

I¥ Equalize during merge

I D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA_C1(1).rpd

Select  »

Help Back et Finish Cancel
For Help, press F1 Y
xix. Select the xml patch file from the saved path (xmlpatch folder).
Oracle BI Administration Tool - EFPA_C1.rpd
File Edit wiew Manage Tools Diagram Wincow Help
” [ & @ | Merge Repository Wizard - Select Input Files ‘ I
Presentation| Merge Type: ¢ Full Repository Merge @ Patch Repository Merge Isiﬂal
n Select Input Files Skl
T Balan: ==
{3 Finand Original Master Repository: ID:\I_PFTBI_PrDJect_Work\Bl_MeGdaG_SheEts_DBIEE_TZT\xm\uatch\EFPA_Cl - Copy.rpd select  +| | |Ea EF
@ Finand Define Merge Strateay
@ Incom Repository Password: li, .
Modified Repository: ID:\I_PFTBI_Pmje:t_Work\&l_MeGdaG_SheEts_DBIEE_TZT\xm\patch\EFPA_Cl.rpd Selt
Repository Password: ssessse
Patch File: I Select... I
Patch Password:
Save Merged Repository as: (7 -
¢ ? v E Select The Patch File - g Seled
Losicin: [ . smmipatch -] @2 oy
¥ Equalize during merge 9/27/2014
Help - . Finish Cancel
Libraries

For Help, press F1

N

Computer L] I I

File name: |EFPA_Cube_Patchmi -

Files of type: [ XML Fies (*soml) = Cancel
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xx. Give “Admin123” as Patch file password.

Oracle BI Administration Tool - EFPA_Cl.rpd

File Edit view MIManage Tools Disgram Jafindow Help

” [ & @ | Merge Repository Wizard - Select Input Files = |E g
Presentation ) Merge Type: ¢ Ful Repository Merge @& Patch Repository Merge ical
“ Select Input Files
s Balan EFF
@ Finan Original Master Repository: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA_C1 - Copy.rpd Select  » EFF
@ Finen Define Merge Strateqy —I*
@ Incom§ Repository Password:  [sessssss
Modified Repository: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2 T\xmipatch\EFPA_C1.rpd Selt
Repository Password: EETTTETT
Patch File: I D:\1_PFTBI Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA_Cube_Patch.xml Select...
Patch Password: sssensed
Save Merged Repository as: ID:\I_PFTBI_Pmje:t_Work\&l_MeGdaG_SheEts_DBIEE_TZT\xm\patch\EFPA_Cl(1).rpd Select  »
Repository Password: sssssses
I¥ Equalize during merge
Help Back Next Finish Cancel |
For Help, press F1 Y
H H “ ”
xxi. Change the name of the merged repository to “EFPA_Cube.rpd”.
Oracle BI Administration Tool - EFPA_C1.rpd
File Edit View Manage Tools Diagram Window Help
” [ & @& | Merge Repository Wizard - Select Input Files ‘ @ = ]
Presentation| N Merge Type: ¢ Full Repository Merge @ Patch Repository Merge Isioal
n Select Input Files [
(i) Balan . BE
@ Finang E Original = - a oo s - Copy.rpd Select | ||Ea E
Finang Define Merge Siategy E Select repository file to save the merged result u
@ Incom
Savein: [ smipatch ~| @ @# = m-
Modified .rpd Seleit >
Name = |‘| Date modified p =
= EFPArpd 9/27/2014 3:38 PN
= EFPA_C1 - Copy.rpd 10/8/2014 7:00 Pl
Patch A S EFPA_Clrpd 10/8/2014 700 PN ibe_patchaxmi Select...
Desktop
Save M, (1).rpd Select »
Libraries
I¥ Equ !!,3
-
Computer 4 I I LI
File name: |EFPA_Cube pd -] Save |
Save as type: |Hepagnary Flles ("pd) -] Cancel
Help Back | Next Finish Cancel
For Help, press F1 A
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xxii. Click on Next.

Oracle BI Administration Tool - EFPA_Cl.rpd

File Edit View [IManage Tools  Diagram \iindow Hel

” [ & @& | Merge Repository Wizard - Select Input Files l — | B g
Presentat\b‘ ~ Merge Type: ( Full Repository Merge @ Patch Repository Merge
= 3 ok n Select Input Files
1@ Finan Original Master Repository: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets OBIEE_T2T\xmipatch\EFPA_C1 - Copy.rpd Select  *
) Fran Define Merge Strategy —I
@ Incom Repository Password: [ sesesses
Modified Repository: I D:\1_PFTBIL Project_Work\81_Metadata_Sheets_OBIEE_T2T\xmipatch\EFPA_C1.rpd Selit >
Repositary Password: sessssss
Patch File: I D:\1_PFTBI_Project_Work\81_Metadata_Sheets_OBIEE_T2Ti\xmipatch\EFPA_Cube_Patch.xml Select...

Patch Password: sssssnss

[¥ Egualize during merge

Help

Save Merged Repository as: ID:\ljFTBLPrn)]ect?ka\BliMemdamisheemﬁDBIEEﬁTZT\xm\pat(h\EFPAﬁCube.rpd

Repository Password: sesssess

Back

| Next Finiish Cancel |

A

For Help, press F1
\

ical
EFP
EFP|

xxiii. The wizard asks for the confirmation for deletion. Please select option “Current” under Decision

drop down.
Oracle Bl Administration Tool - EFPA_C1 - Copy_patched.rpd
File Edit wiew Manage Tools  Diadgrarn, Wwindow  Help
e ol
“ [ & @ | Merge Repository Wizard - Define Merge Strategy g
Presentat\'o‘ . ical
i Show qualified names
= m Select Input Files . @ = ‘ ‘ B 2 ‘l_ q =
@ Finan u Define Merge Strateqy T Type Name Description Decision | « | EFF
@ Finan : Column ; Year-to-Date Deleted from Current ; Current
G Incom & Logical Table Saurce | FCT_LEDGER_STAT Deleted from Current | Current
ﬁ Logical Table Source : FCT_MGMT_REPORTING Deleted fram Current burrem A
=
Original repository Modified repository Current repository
&) FCT_MGMT_REPORTING [E3 Dim-Run ﬂ
i .G ADPAMNRE [F@ Fact - Management Reporting
] = ' - ra [E2) Fact - Management Reporting RDBMS
J 1 PR ot Mammmmrmned Dt 1€ Vmmmnn |
EFPA_C1 - Copy.rpd EFPA_C1_equalized_again.rpd EFPA_C1 - Copy_patched.rpd
Differences:
Following objects were deleted from the Current repository: (=]
4 ;I_I
[™ Check consistency of the merged RPD
Help Back Mext Finish | Cancel |
Logical Table Source : "Management Reporting”."Fact - Management Reporting”."FCT_MGMT_REPORTING" : Active Source Y
\
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xxiv.Click on Finish.

E Oracle BI Administration Tool - EFPA_C1 - Copy_patched.rpd

iew Manage Tools  Diagram, indow Help
[ & @ | Merge Repository Wizard - Define Merge Strategy l By X
Presentatiof 3
1| Select Input Filss 6 = & B | show qualfied names
=[5 Balan Conflicts:
] @ Finan Define Merge Stiategy \ \ Type Name Description Decision j
- Finan |3 Presentation Column ; Year-to-Date Deleted from Current ; Current
=@ Incom &l Logical Table Source  FCT | EDGER_STAT Deleted from Current : Current
@ Logical Table Source : FCT_MGMT_REPORTING Deleted from Current _[Current |
=]
Original repository Modified repository Current repository
FCT_MGMT_REPORTING Py @ FCT_MGMT_REPORTING - & Dim - Run -
@ ADPAMNRE = @ ADPAMNRE = G % Fact - Management Reporting wl
. - - . - B Fact - Management Repotting RDBMS ~ —
l vl W[T e LTINS -
EFPA_C1 - Copy.rpd EFPA_C1_equalzed_again.rpd EFPA_C1 - Copy_patched.rpd
Differences:
Elowmg objects were deleted from the Current repository: =
I”" Check consistency of the merged RPD
Help Finish ‘ Cancel ‘
Logical Table Source : "Management Reporting”."Fact - Management Reporting”."FCT_MGMT_REPORTING" : Active Source

This creates a merged repository (EFPA_Cube.rpd) under xmipatch folder.

Take the “EFPA_Cube.rpd” file and deploy it using EM console on the environment where Data is to be
fetched from ESSBASE Cubes.

Note: Provide connection details of RDBMS in ‘OFSEFPA Connection Pool’ and ‘OFSEFPA Init
Block’. This is required for LCY Label in the OBIEE reports.

5. OFSAAI Startup:

OFSAAI servers need to be restarted, in order to see the transformations in the Post Load Transformation
screen.

6. Security Roles:
Security roles are created in OBIEE to allow or disallow certain users to see selective dashboards and data.

To accomplish these user roles can be created in OBIEE. This step is optional and the procedure to create
user roles is mentioned below (in this procedure LoB stands for Line of Business):

a. Open Admin Console of OBIEE.

b. Click on Security Realms under Domain Structure.
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c. Click on myrealm under Realms.

Change Center
View changes and restarts

Click the Lock & Edit button to modify, add or
delete items in this domain.

Lock & Edit

Release Corfiguration

ORACLE weblogic Server® Administration Console

Domain Structure

bifoundation_domain

EBH-Environment
~Deployments

L

[B1-Diagnostics

How do ..

* Configure new security realms
« Delete security realms
o Change the default security ream

System Status

Health of Running Servers

[ Faied@
[ cital @
[ Overloaded (0)
[ wamng@
I oK (1)

Welcome, weblogic ‘ Connected to: bifoundation_dom{

&) Home LogOut Preferences Help Q

Home >Summary of Securty Resims >myraslm >

<t >Summary of Security Reslm

ryrezim >Summary of Sacurity Realms

Summary of Security Realms
A security realm is a container for the mechanisms—indluding users, groups, security roles, security polides, and security providers—that are used to protect Weblogic resources. You can have multple
security realms in a WebLogic Server domain, but anly one can be set as the default (acive) reaim.

This Security Realms page lists each security reaim that has been configured in this WebLogic Server domain. Click the name of the realm to explore and configure that reaim.

[ Customize this table

Realms (Filtered - More Columns Exist)

Click the Lock & Fditbutton in the Change Center to activate al the buttons on this page.

New | | Delete Showing 1to 1of 1 Previous | Next
Hame & Default Realm
i) e

New Delete

Showing 1to 10f 1 Previous | Next

d. Click on ‘User and Groups’ and then on ‘Groups’.

Change Center
View changes and restarts

Click the Lock & Edit button to modify, add or
delete items in this domain.

Lock & Edit

Release Corfigurtion

ORACLE Weblogic Server® Administration Console

Domain Structure
bifoundation_domain

How do L..

® Manage users and groups
« Create groups
« Modify groups
* Delete groups

System Status

Health of Running Servers

[ Falkd@
[ criical (0)
[ Overloaded (0)
[ waming(0)
I o (1)

&) Home LogOut Preferences Help Q Welcome, weblogic | Connected to: bifoundation_domd|
Home »Summary of Security Realms >myreaim > User: ps > BusinessAnalyst > Summary of Securtty Realms »myreaim >Summary of Security Reslms >myrealm
Settings for myrealm
Configuration | Users and Groups | Roles and Polides | Credential Mappings | Providers | Migration
Users | Groups
This page displays information about each group that has been configured in this security reaim.
[ Customize this table
G
New Iste Showing 1to 10 of 14 Previous | Next
[[]| Name &% Description Provider
[ | AdminChannelUsers AdminChannellsers can access the admin charnel. DefauitAuthenticator
[ | Administrators Administrators can view and modify all resource atiributes and start and stop servers, DefauitAuthenticator
[ | AppTesters AppTesters group. DefaultAuthenticator
[£] | BankGlobalCFO DefaultAuthenticator
[ | Bradministrators BI Administrators Group DefauitAuthenticator
[F] | BrAuthors BI Authors Group DefaultAuthenticator
[ | B1consumers EI Consumers Group DefaultAuthenticator
[ | crossDomainConnectars CrossDomainConnectors can make inter-domain calls from foreign domains. DefauitAuthenticator
[T | Deployers Deployers can view all resource attributes and deploy applications. DefaultAuthenticator
[ |LoBManiager DefaultAuthenticator
| Mew | [ Delete Showing 1to 10 of 14 Previous | Next
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e. Click on ‘New’ and create two new groups with the names ‘Business Analyst’ and ‘LoBManager'.

Change Center
View changes and restarts

Click the Lock & Edit button to modify, add or
delete items in this domain,

Lock & Edit

Refease Corfigurtion

ORACLE Weblogic Server® Administration Console

&) Home LogOut Preferences

Q

ot »Summary of Securty Res

Home =Summary

Create a New Group
oK ‘ Cancel

Group Properties

Domain Structure
bifoundation_domain
Environment
Deployments
Services

Security Realms
Interoperabilty
Disgnostics

o]

How do L..

+ Create groups
« Modify groups
® Delete groups
* Create users

» Manage users and groups

System Status
Health of Running Servers
" Failed ()
| Critical ()
[ Overloaded (0)

| Warning (0)

oK (1)

The following properties wil be used to identify your new Group.
= Indicates required fislds

What would you like to name your new Group?

* Name: Business Analyst
How would you like to describe the new Group?
Description:

Please choose a provider for the group.

Provider: DefaultAuthenticator E

0K Cancel

4
Welcome, weblogic ‘ Connected to; bifoundation_dom

=>Summary of Security

myrealm

f.

Click on newly created ‘Business Analyst’ group for assigning parent group.

Change Center
View changes and restarts

Click the Lock & Edit button to modify, add or
delete items in this domain,

Lock & Edit

Release Corfiguration

Domain Structure

bifoundation_domain

How do .. =
* Create groups
* Modify groups
+ Delete groups
System Status =1

Health of Running Servers

| Failed (0)

J& " Critical {0)
Overloaded (0)

I Warning (0)

I (1

ORACLE Weblogic Server® Administration Console

@) Home Log Out Preferences

Home >Summary of Security Rs st »Summary of Security Resims >

Settings for Business Analyst

General | Membership

Save
Use this page to add groups to other groups.

Parent Groups:
Available:

[F] AdminChannelusers
[] Administrators

[] AppTesters

[F] BiAdministrators
[] BIConsumers

[7 BankGlobalcFo

[F] CrossDomainConnectors ~

Chosen:
[F] e1Authors

8 v

i

<

&

Save

Welcome, weblogic | Cennected to: bifoundation_dom|

myrezim >Bank

~Business Analyst ]

This group can be a member of any of these parent groups.  More Info. .
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g- Create two new users under ‘Users’ tab of ‘Users and Groups’. One user for Business Analyst and

another for LoB Manager.

ORACLE WeblLogic Server® Administration Console

Change Center &) Home LogQut Preferences

View changes and restarts

Click the Lack & Edit button to madify, add or Settings for myrealm
delete items in this domain.

T Configuration | Users and Groups | Roles and Polices | Credential Mappings | Providers | Migration

Release Corfiguration | S

Domain Structure
bifoundation_domain
Bt-Environment
Deployments [ Customize this table
Services
Security Realms
Interoperability

This page displays information about each user that has been configured in this security realm,

Welcome, weblogic ‘ Connected to: bifoundation_dom]

ICFO »Business Analyst =myreslm > Users and Groups

System Status ]

New 2lete:
e Showing 1to 7of 7 Previous | Next
]| name & Description Provider
[C] | BankGlobalcFo1 Defaulthuthenticator
[ | BrSystembser BI System User DefaLitAuthenticator
[ | LoBManager 1 Defaultauthenticator
[ | LoBManager2 DefaultAuthenticator
How do L.. =]
[] | OraclesystemUser Oradle application software system user, Defaulthuthenticator
» Manage users and groups [ | RegionalHead 1 DefaultAuthenticator
® Create users
[ | weblogic Defaultauthenticator
» Modify users
* Delete users ity [[Deidtn

Showing 1to 70f 7 Previous | Next

Health of Running Servers

[ Faied@
[ it @
[ Overloaded (0)
[ waming(@
I ok (1)

ORACLE Weblogic Server® Administration Consale

Change Center {8 Home Log Out Preferences ¢ Help Q

curty Resims >my

View changes and restarts

Click the Lock & Edit button to modify, add or Settings for businessanalyst1
delete items in this domain.
ey General | Passwords | Attributes | Groups

Relesse Corfiguration Save

Domain Structure Use this page to configure group membership for this user,
bifoundation_domain

B-Environment

B Parent Groups:
Depl s
B Available: Chosen:
E-Services ] DA S LTS =
~Security Realms [ BAuthors - [T Business Analyst

B-Interoperability
[-Diagnostics

[C] BiConsumers
[] BankGlobalCFO L
&l Cmssl)amain(onnzctmsf
[F] Deployers =
] LoBManager

[l Manitars

Save
How do L.

Welcome, weblogic | Connected to; bifoundation_domain

ps >businessanalyst1

This user can be @ member of any of these parent groups.  More Info...

* Create users

System Status =
Health of Runring Servers

[ Faled(®
[ critical (@)
[ Overloaded (3)
[ Waming(@)
I o (1)
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h. Map the newly created users to respective groups.

Change Center

View changes and restarts

delete items in this domain.

Click the Lock & Edit button to modify, add or

ORACLE Weblogic Server® Administration Consale

{&) Home Log Out Preferences ccord Help

Settings for businessanalyst1

bifoundation_domain
EH-Environment
~Deployments
[EH-Services
~Security Realms
EH-Interoperability

[-Diagnostics

——— General | Passwords | Aftributes | Groups
eiease Configuration Save
Domain Structure

Parent Groups:
Available:
L v

[7] B1Authors

[F] BiConsumers

[] BankGlobalCFO

|} CrossDomainConnectors|

How do L.

s Create users

Use this page to configure group membership for this user.

This user can be @ member of any of these parent groups.  More Info...
Chosen:

[7] Business Analyst

Welcome, weblogic | Comnected to: bifoundation_domair

Groups >businessanalyst1

System Status

Health of Running Servers
Failed (0

= Critical (0)

i " Warning (0)
I ok ()

[ Overloaded (0)

[F] peployers
] LoBManager
[Fl Manitors =
Save
a —
=2

i. Close the Admin Console of OBIEE.

j- Open Enterprise Manager of OBIEE.

k. Navigate to CoreApplication > Security > Singe Sign On > Configure and Manage Application Roles.

gﬁ Farm + &Topc\ngy

-

=1 5% Farm_bifoundstion_domain

[ Application Deployments

[ WebLogic Domain

I [ Business Inteligence
[ lcoreapplication |

[: Metadata Repositories

ORACLE Enterprise Manager 11g Fusion Middleware Control

1} coreapplication @
[&] Business Inteligence Instance

Change Center: | 2 Lock and Edit Configuration

Overview | Avallabiity = Capacity Management | Diagnos

Secure SocketsLayer | Single Sign On

Single Sign On (SS0)

S50 enables a user to log in once and gain access to all systems withaut being prompted to log in again at ach of them, IF S50 is enabled then Oracle Business Inteligence will not challenge the user for
authentication and wil assume the user has already been authenticated by 550.

Custom

Security Realm

Application Policies and Roles

T Configure and Manage Application Policies

T T aure and Manage Application Roles. =g

o to the Oracle WebLogic Server Administrator Console to configure and manage the Weblogic security realm,

Setpy Helpw Log(]

Loggedin a5 weblog
Page Refreshed Mar 11, 2013 8:55:58 PM IST

@

Apply
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I. Create a new application roles with the name ‘Business Analyst Role’ with display name as ‘Business
Analyst Role’ and ‘LoBManager’ with display name as ‘LoB Manager Role’.

ORACLE Enterprise Manager 11g Fusion Middleware Control

EFam~ | 4 Topology

B~

= 52 Farm_bifoundation_domain

[ Application Deployments

[ WebLogic Domain

£ B3 Business Inteligence
[] coreapplication|

& 3 Metadata Repositories

Setup. Hep+ LogOf

I
¢} coreapplication® Logged in as weblog
Business Inteligence Instance +

Page Refreshed Mar 11, 2013 9:02:41 PM IST |
Application Roles

Application roles are the roles used by security aware applications that are spedific to the application. These roles are seeded by applications in single global policy store when the applications are registered. These are

also appiication roles that are created in the context of end users accessing the application.

To manage users and groups in the WebLogic Domain, use the Oracle Webl ogic Server Security Provider.
®Policy Store Provider

[EHSearch

obi

Enter search keyword for rale name to query roles defined by this application. Use application stripe to search if application uses a stripe that s differerent from appiication name.
Application Stripe
Role Name [ Starts with [=]

®
Create... J [ Crestelike.. ZEdit.. 3§ Delete...
le Name: A7 Display Name Description
ElAdministrator EL Administrator Role
BlAUthor BI Author Role
EIConsumer BL Consumer Role
BlSystem BT System Role
BankGlobalCFO Bank Global CFO Role
LoBManager LoB Manager Role
RegionalHead Regional Head Role
4

ElMembership for BISystem

Principal Display Name: Type Desaription

BlSystemlser

User

E - 4} coreapplication ® Logged in as weblog

=1 5 Farm_bifoundation_domain [&] Business Inteligence Instance »
B [ Application Deployments

[23 WebLogic Domain

Page Refreshed Mar 11, 2013 5:05:11 PM IST
Application Rales > Create Application Role
= [ Business Inteligence Create Application Role
[]|coreapplication General
[ [ Metadata Repositoriss

oK | | cancel
Application Stripe obi

*Role Mame | Business Analyst Role
Display Name

Description

Members

An role may need to be mapped to users or groups defined in enterprise LDAP server, or the role can be mapped to other application roles.
o Add elete. .

Name Display Mame
No groups or application roles added.

Type
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m. Assign Business Analyst Group to its role and similarly ‘LoB Manager’ group to its respective role.

§§Farmv
s

Q%Topﬁ\ngy

Farm_bifoundation_domain

(3 Application Deployments

i [ weblogic Domain

E [ Business Inteligence
%] lcoreapplication

] [7] Metadata Repositories

ORACLE Enterprise Manager 119 Fusion Middleware Control

1} coreapplication@
[] Business Inteligence Tnstance =

Application Roles > Create Application Role
Create Application Role
General
B obi
Business Analyst Role

| add Principal

Page Refreshed Mar 11, 2013 9:05:

Setup» Helpy Log

Logged inas weblof

|
Spedify ariteria to search and select the application roles that you want to grant permissions to.
Members Elsearch
An appiication role may nesd to be = fation roles.
o TYPE | Group [=]
dpadd 3 Deiet= Princinsl Name | tarts With [ ® I
Name Searched Principals I
M licatian ro
SEdio i L b princpal Display Name Description
) canmakeinter- -
CrossDomainConnectors dorzin s from
fareign domains.
BlAuthors BI Authors Group
AppTesters AppTesters group.
Business Analyst
LoBManager

AdminChannelUsers

AdminChannelUsers can access the =

Type

admin channel.
BlAdministrators Gﬂrijgm‘"'smm's
Orade application
OradeSystemGroup software system
i Cancel
n. Unarchive the catalogs by selecting ACL as ‘Preserve’.
Unarchive (%]
archive file Browse... |
Replace | None [=]
aa
| Help | | OK || Cancel

o. After un-archiving the catalogs (Financial Reporting.catalog & Management Reporting.catalog)
configure the physical tables in database PFTBI_USER_LOB_MAP to create LoB Manager and LoB

mapping.
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p- Login with corresponding LoB Manager User Id to verify if the respective LoBs are being selected. To
verify all the reports, login with Business Analyst user id.

Metadata Browser Batches:

UMM Metadata (Hierarchies, Datasets, Measures, Dimensions) can be seen in Metadata Browser by executing
the Metadata Browser Batches (MDB batches) from the Batch Execution screen of OFSAAI. The batch names
are mentioned below:

1. <INFODOM>_MDB
2. <INFODOM> MDB_OBJECT_APPLN_MAP

Additional Configuration:

1. After deploying the latest Web catalog and RPD from the server, the default reporting periods have to be
set based on users requirements. The default value has to be set at the Reporting Period prompts by editing
the dashboard and choosing a specific value for the reporting period prompt. Following are the dashboard
pages where the default time period is to be selected:

Financial Reporting>Income Statement>Time_Hierarchy Prompt

Management Reporting>Balance Sheet> Time Hierarchy Prompt

Management Reporting>FTP Reports> Time Hierarchy FTP Prompt

Management Reporting>Income Statement> Time Hierarchy Prompt

Management Reporting>Key Trends>Time Hierarchy Prompt

Management Reporting>KeyTrends>Balance Trends> Time_Hierarchy_Month Prompt

@ m® a0 T

Management Reporting > Performance Measures> Time Hierarchy Prompt

2. Create an entry in Setup_Master table to configure the identity codes that are required for Financial
Reporting dashboard reports.

V_COMPONENT DESC @S "IDENTITY CODE PFTBI FR _UNALLOCATED DATA" having ldentity Code value in
V_COMPONENT CODE and V_COMPONENT VALUE columns.

3. If OFSEFPA6.1.1.0.0 is deployed on Oracle ESSBASE Cubes, then the hierarchies would need to be
resaved in the Business Hierarchy link of OFSAAI. Subsequently, rebuild the Oracle ESSBASE Cubes.
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Logging as System Administrator

Post installation, the first login into Infrastructure is possible only for a System Administrator through user id
"sysadmn". This ID is created at the time of installation with the password provided during installation. Enter
login id "sysadmn" and password that was provided during installation. Click Login.

System Administrator

System Administration refers to a process of managing, configuring, and maintaining confidential data in a multi-
user computing environment. System Administration in Security Management involves creating functions, roles,
and mapping functions to specific roles. System Administration also involves maintaining segment information,
holiday list, and restricted passwords to ensure security within the Infrastructure system.

You can access System Administrator in LHS menu of Security Management. The options available under
System Administrator are:

*  Function Maintenance
* Role Maintenance

* Segment Maintenance
* Holiday Maintenance
* Restricted Passwords

Function Maintenance

A function in the Infrastructure system defines the privileges to access modules or components and to define or
modify Metadata information associated. Function Maintenance allows you to create functions for users to
ensure only those functions are executed which are specific to the user's role.

You can access Function Maintenance by expanding System Administrator section within the tree structure
of LHS menu. The Function Maintenance window displays the function details such as Function Code, Function
Name, Description, and the number of Roles Mapped to the function. The Function Maintenance window also
facilitates you to view, create, modify, and delete functions within the system.

You can also make use of Search and Pagination options to search for a specific function or view the list of
existing functions within the system.

Role Maintenance

Arole in the Infrastructure system is a collection of functions defined for a set of users to execute a specific task.
You can create roles based on the group of functions to which users are mapped.

You can access Role Maintenance by expanding System Administrator section within the tree structure of LHS
menu. The Role Maintenance window displays the role details such as Role Code, Role Name, Role
Description, and the number of Users Mapped to the role. The Role Maintenance window also facilitates you to
view, create, modify, and delete roles within the system.

You can also make use of Search and Pagination options to search for a specific role or view the list of existing
roles within the system.
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Segment Maintenance

Segment is used to control access rights on a defined list of objects. It is mapped to an information domain.

Segment Maintenance in the Infrastructure system facilitates you to create segments and assign access rights.
You can have different segments for different Information Domains or same segments for different Information
Domains.

User scope is controlled by segment/ folder types with which the object is associated.

» Objects contained in a public folder will be displayed irrespective of any user.

+ Objects contained in a shared folder will be displayed if user belongs to a user group which is mapped to
an access type role with the corresponding folder.

* Objects contained in a private folder will be displayed only to the associated owner.

You can access Segment Maintenance by expanding System Administrator section within the tree structure of
LHS menu. The Segment Maintenance window displays a list of available segments with details such Domain,
Segment Code, Segment Name, Segment Description, Segment/Folder Type, Owner Code, and the number of
Users Mapped to the segment. You can view, create, modify, and delete segments within the Segment
Maintenance window.

You can also make use of Search and Pagination options to search for a specific role or view the list of existing
roles within the system.

Holiday Maintenance

Note: As part of OFSAAI 7.3.3.0.0 release, this feature will not be available if Authentication is configured to
SSO Authentication and SMS Authorization.

Holiday Maintenance facilitates you to create and maintain a schedule of holidays or non-working days within
the Infrastructure system. On a holiday, you can provide access to the required users and restrict all others from
accessing the system from the User Maintenance window.

You can access Holiday Maintenance by expanding System Administrator section within the tree structure of
LHS menu. The Holiday Maintenance window displays a list of holidays in ascending order. In the Holiday
Maintenance window you can create and delete holidays.

Restricted Passwords

Note: As part of OFSAAI 7.3.3.0.0 release, this feature will not be available if Authentication Type is selected
as SSO Authentication and SMS Authorization from System Configuration> Configuration.

Restricted Passwords facilitates you to add and store a list of passwords using which users are not permitted to
access the Infrastructure system.

You can access Restricted Passwords by expanding System Administrator section within the tree structure of
LHS menu. The Restricted Passwords window displays a list of restricted passwords and allows you to add and
delete passwords from the list.

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0 331



Post Deployment Configuration

You can also make use of Search and Pagination options to search for a specific password or view the list of
existing passwords within the system. For more information, refer Pagination and Search & Filter.

Note: While searching for any pre-defined restricted password, you have to key in the entire password.

Creating Application Users

Create the application users in the OFSAA setup prior to use.

Note: This step may not be required if you have already setup users in the OFSAA setup.

For more information refer user creation section from the Oracle Financial Services Analytical Applications
Infrastructure User Guide.

Mapping Application User(s) to User Group

Starting the OFSAA 8.0 release, with installation of Profitability Application Pack, pre-configured application user
groups are seeded. These user groups are unique to every OFSAA Application Pack and have application roles
pre-configured.

Map the application user(s) to the respective Application User Group(s) and subsequently authorize the
entitlements by logging in as SYSAUTH (System Authorizer) user.

For more information on seeded User Groups, refer to User Group Mapping.

Change ICC Batch Ownership

All the seeded Batches in PFT Applications Pack will be automatically assigned to SYSADMN user during
Installation. If one user who wants to see the Batches in Batch Maintenance Menu, He needs to execute the
following Queries in Config Schema of the Database.

Syntax:
begin
AATI OBJECT ADMIN.TRANSFER BATCH OWNERSHIP ('fromUser', 'toUser', 'infodom') ;
end;
OR
begin
AAT OBJECT ADMIN.TRANSFER BATCH OWNERSHIP ('fromuser', 'touser');
end;

Where from User indicates the user who currently owns the batch, to User indicated the user to which the
ownership has to be transferred. Infodom is optional parameter, if specified the ownership of batches pertaining
to that Infodom will be changed.
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Example:
begin
AAT OBJECT ADMIN.TRANSFER BATCH OWNERSHIP ('SYSADMN','PFTOP','OFSPFTINFO');

end;

Mapping ICC Batch Execution Rights to User

Login as SYSADMN and navigate to Identity Management > System Administrator > Function-Role Map.
Map the User-Batch Execution Mapping Screen function to RLPFTADMIN role.

Now any user who is mapped under PFT Admin User Group will have the access to the Batch execution rights
Menu under Operations list.

FS-Engish ¥ | DFSADN ¥

OHRACLE" Financial Services Analytical Applications
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Saving Post- Load Change Transformations

After creating users, Login to Infrastructure as any user who is mapped to PFT Admin or PFT Analyst group.

Navigate to Data Management Framework >> Post Load Changes.

B &ov| v | T

COHRAC L E Frascia Sereiirk ATaybosl Appioassn

- . i:. - ....-..__..- :g .-.. - -
3 : .-ﬂ o E
'i;rn-.....;-l-.....
i 5 [ -

A New window will be displayed. Click on Each Transformation from Transformations List & Click on Stored
Procedure in the Right Panel, Click on Edit in the Top Right Menu and Click on Finish Button in Bottom.

o A

All the Transformation Stored Procedures are required to be edited and saved (Finish Button) once for getti
it is available.

Instrument Table Validation

ng

Run the Instrument Table Validation. For more information, see the Doc ID 1457511.1 and Data Model Utility

Guide.

Check the Fs1_MESSAGE LOG file after running Instrument Table Validation to verify that tables are classified
correctly.
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8.0.6.0.0 — PROFITABILITY MANAGEMENT APPLICATION PACK INSTALLATION AND CONFIGURATION GUIDE

APPENDIX A - TDE, DATA REDACTION AND THE
CORRESPONDING SETTINGS IN OFSAA

This section provides information to help enable TDE (Transparent Data Encryption), Data Redaction and its
corresponding settings in OFSAA. For more details on TDE and Data Redaction, see the Database Advanced
Security Guide.

The following sections provide details to enable TDE in the database and run the schema utility.
*  Prerequisites

* Creating a Wallet

*  Running the Schema Utility with Encryption

« Testing the Encryption

Prerequisites

1. Ensure the required Oracle Database Server versions are installed:
o Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.4.0 +) - 64 bit
RAC/Non-RAC with/ without partitioning option, Advanced Security Option
o Oracle Database Server Enterprise Edition 12c Release 1 (12.1.0.1.0 +) - 64 bit RAC/
Non-RAC with/ without partitioning option, Advanced Security Option
2. Ensure the required patches are applied for your respective Oracle DB versions:
o For Oracle DB Serve 11.2.0.4, the patch 22205607 should have been applied.

o For Oracle DB Server 12.1.0.1 and 12.1.0.2, the patches 27010930 and 22205607 should have been
applied.

Creating a Wallet

The environment setup for tablespace encryption is the same as that for transparent data encryption. Before
creating an encrypted tablespace, create a wallet to hold the encryption key. The search order to find the wallet
is described in the following list:

1. The location specified by the ENCRYPTION WALLET LOCATION parameter in the sqlnet.ora file.

2. The location specified by the wALLET LoCATION parameter in the sglnet.ora file.

Encrypted tablespaces can share the default database wallet. However, Oracle recommends that you use a
separate wallet for transparent data encryption functionality by specifying the ENCRYPTION WALLET LOCATION
parameter in the sqlnet.ora file.

1. Add the following entry into the sqlnet.ora file on the server and check if the specified directory is created:

ENCRYPTION WALLET LOCATION=
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(SOURCE= (METHOD=FILE) (METHOD DATA=
(DIRECTORY=/u01/app/oracle/admin/DB11G/WALLET/)))
For RAC-DB or ASM enabled databases, use the following entry:

ENCRYPTION WALLET LOCATION=
(SOURCE=
(METHOD=FILE)
(METHOD DATA=
(DIRECTORY=+DATA/PRODCDB/WALLET)

)

2. For ASM Diskgroup, create a relevant directory as defined by ENCRYPTION WALLET LOCATION using the
following instruction:

[oracle@server ~]$ echo SORACLE SID

+ASM

[oracle@server ~]$ asmcmd
ASMCMD>
ASMCMD> cd +DATA/PRODCDB
ASMCMD> mkdir WALLET
ASMCMD> cd WALLET/
ASMCMD> pwd
+DATA/PRODCDB/WALLET
3. Use the following command to create and open the wallet:
CONN sys/password@serviceid AS SYSDBA
ALTER SYSTEM SET ENCRYPTION KEY IDENTIFIED BY "my Password";

4. Reopen Wallets after the instance restart and then close it to prevent access to encrypted data using the
following command.

ALTER SYSTEM SET ENCRYPTION WALLET OPEN IDENTIFIED BY "my Password";

Note: In a CDB, open the Keystore in the ROOT (CDB$ROOQT) container and in all the associated PDBs,
where TDE is enabled.

Alternatively, you can create an Auto-Login or Local-Login Keystore to avoid opening the Keystore manually
every time. To enable the Keystore to open automatically, use the following command:

ADMINISTER KEY MANAGEMENT CREATE [LOCAL] AUTO LOGIN KEYSTORE FROM KEYSTORE
'keystore location' IDENTIFIED BY keystore password;
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Running the Schema Ultility with Encryption

Run the schema creator utility by including the encrypt=on option in the Tablespace tag in the Schema in the
XML file. You have to perform this procedure manually as it's not a part of the schema template originally.
<APPPACKSCHEMA>

<APP_PACK_ID>OFS AAAI PACK</APP PACK ID>

<JDBC_URL>jdbc:oracle:thin:@whf00ajn:1521:0FSPQA12CDB</JDBC_URL>

<JDBC_DRIVER>oracle.jdbc.driver.OracleDriver</JDBC DRIVER>

<HOST><HOST NAME></HOST>

<SETUPINFO NAME="t608" PREFIX SCHEMA NAME="Y"/>

<PASSWORD APPLYSAMEFORALL="Y" DEFAULT="<password>"/>

<TABLESPACES>

<TABLESPACE NAME="OFS AAI TBSP" VALUE:"TS_USERSl" DATAFILE:"<HOME_DIR>/Ora12c/app/
oracle/oradata/OFSPQAl2CDB/ts_users1.dbf" SIZE="500M" AUTOEXTEND="OFF" ENCRYPT="ON"
/>

</TABLESPACES>
<SCHEMAS>

<SCHEMA TYPE="CONFIG" NAME="ofsaaconf" PASSWORD="" APP ID="OFS AAI"
DEFAULTTABLESPACE="TS USERS1" TEMPTABLESPACE="TEMP" QUOTA="unlimited"/>

<SCHEMA TYPE="ATOMIC" NAME="ofsaaatm" PASSWORD="" APP ID="OFS AAAI"
DEFAULTTABLESPACE="TS USERS1" TEMPTABLESPACE="TEMP" QUOTA="unlimited"
INFODOM="OFSAAAIINFO" />

<SCHEMA TYPE="ATOMIC" NAME="ofsaaatm" PASSWORD="" APP ID="OFS IPE"
DEFAULTTABLESPACE="TS USERS1" TEMPTABLESPACE="TEMP" QUOTA="unlimited"
INFODOM="OFSAAAIINFO"/>

</SCHEMAS>

</APPPACKSCHEMA>
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Testing the Encryption

Test the encryption by checking if a tablespace is encrypted or not. Execute the following query to check:

SELECT tablespace name, encrypted FROM dba tablespaces;

The following result is displayed, which indicates whether the TABLESPACE is encrypted (ENCRYPTED TS -
YES) or not (ENCRYPTED TS - NO) in the ENC column:

TABLESPACE_NAME ENC
SYSTEM NO
SYSAUX NO
UNDOTBS1 NO
TEMP NO
USERS NO
ENCRYPTED_TS YES

6 rows selected.

Profitability Management Application Pack Installation and Configuration Guide - 8.0.6.0.0 338



Data Protection Implementation in OFSAA

APPENDIX A - DATA PROTECTION IMPLEMENTATION IN OFSAA

This chapter includes sections about Data Protection implemented in OFSAA applications and covers the
following sections:

* Right to be Forgotten
« Data Portability

* Pseudonymization

* Notice and Consent
» Data Archival

+ Data Redaction

Right to be Forgotten

This section covers the following sub-sections:

* Introduction to Right to be Forgotten
* Implementation of Right to be Forgotten by OFSAA
»  Sample Queries using the AAl_DRF_QUERY_METADATA Metadata table

Introduction to Right to be Forgotten

Right to be Forgotten is the task of removing Pl (Personally Identifiable Information) of a Data Subject for the
given Party. The financial institution can delete PIl for those Data Subjects who have requested this Right to be
Forgotten functionality.

The Data Subjects may have made significant financial transactions, and/or financial information may be
required for regulatory or compliance reporting. Deleting the complete record that consists of Pll may lead to
issues in data reconciliation. In OFSAA, the PII data will be replaced with randomized values and therefore, the
complete Data Subject record is retained. As a result, financial information is retained; however, the associated
Party PIl is removed permanently.

Implementation of Right to be Forgotten by OFSAA

To implement Right to be Forgotten:

1. Use the FSI_PARTY_RIGHT_TO_FORGET table to collect the input list of Party IDs for which PIl must be
removed from the system. The financial institution must source this Party ID list into the
FSI_PARTY_RIGHT_TO_FORGET table, and then invoke the batch (<<INFODOM>>_RightToForget) or
schedule it.

Note: For sample query, see Sample Query for the FSI_PARTY_RIGHT_TO_FORGET table.

2. Use the AAl table AAI_DRF_FUNCTION_COLUMN_MAP to store the PII attribute list. During the Right to
Forget batch execution, AAl_DRF_FUNCTION_COLUMN_MAP table is referred to randomize the PII
values. See the Data Redaction section in OFSAAI Administration Guide.
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3. Use the AAl table AAI_DRF_QUERY_METADATA to store the query metadata, which is used during the
<<INFODOM>>_RightToForget batch execution. This is the query metadata table that can lead to two types

of queries:

a. When the table consists of Party Identifier as an attribute, a simple record is required in the metadata

query table.

For example:

Select v_party_id from Dim_Party where v_party _id="10'

b. When the table does not consist of Party Identifier as an attribute, an interrelated set of records are
required in the metadata query table AAI_DRF_QUERY_METADATA. Compose these set of records in
a systematic way such that, for the selected Party Identifier, the table join procedure can be performed

and traversed to reach the required PII attribute.

fo_cu ¥ n_cust_skey
4Dim Fuail n_email skey Fer_Party Email Hap n_email skey

5 For_Party_Email _Map n_party_skey Dim_Pacty n_pacty_skey
6 Dim_Exployee {eall) [mull) (mall)
7Dhia_Eaployes_Nls (mall) (null) (mall)
8 Dim_Phone n_phone_skey Fer_Party_Phone_Hap n_phone_skey

30 @ N AW R e

# Fer_Pacty_Fhone_Nap n_pazty_skey
H PR

Dia_Pacty n_pacty_skey

(mall)
{mall)
T
N

warchar
(oull)
warchat
warchar
varchat

(mull)

v_party_id
(mull)
v_employee_id
v_employes_id

v_parcy_id
(mull)

Update_dim _email
Update_dim_email
Update_dim_eaployee
Update_dim_eaployee_ml
Update_dim_phote
Update_dim_phone

Table definition for AAI_DRF_QUERY_METADATA

Column Name Column Type Description

ID Number This is the Primary Key field. You must enter a numerical
value.

V_TABLE_NAME Varchar This is the source table name.

V_COLUMN_NAME Varchar This is the source column name.

V_CHILD_TABLE_NAME Varchar This is the table name, which must be linked to the
V_TABLE_NAME. If the same table name is repeated with the
same column name V_COLUMN_NAME, then the AND
condition is formed with V_CHILD_TABLE_NAME.
V_CHILD_TABLE_NAME

V_CHILD_COLUMN_NAME Varchar This the column name, which must be linked to the
V_COLUMN_NAME.

F_QUERY_FLAG Varchar Enter Y or N, which is case sensitive. If the value is Y, then you
must form a query from V_TABLE_NAME
.V_COLUMN_NAME

V_COLUMN_DATA_TYPE Varchar Mention the Data Type of the V_COLUMN_NAME. This is
required only if F_QUERY_FLAG =Y.
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Column Name Column Type Description

V_TARGET_COLUMN_NAME Varchar Mention the PARTY_ID column name, which is required only if
F_QUERY_FLAG =Y.

V_QUERY_NAME Varchar Mention the same query for a set of joining tables and
columns. The set of tables and columns under join query are
grouped together using the same query name.

For example:

Dim_Cards_Master table does not consist of n_cust_skey (n_cust_skey is the required Primary Key for the PlI
Attribute n_card_number_skey). Therefore, perform the table join procedure similar to the following query:

Select Dim Cards Master.n card number skey from Dim Cards Master Dim Cards Master,
Fct Card Acct Mapping Fct Card Acct Mapping,

Fct Cards Summary Fct Cards Summary, Dim Customer Dim Customer where

Dim Cards Master.n card number skey=Fct Card Acct Mapping.n card number skey and
Fct Card Acct Mapping.n acct skey=Fct Cards Summary.n acct skey and

Fct Cards Summary.n cust skey=Dim Customer.n cust skey and v_d cust ref code='GDPR'

)

y > >

b i @ (]

2 | FetCard Acet| & | et cards s ﬁr

Dim_Cards_Master 5 | apeiis 3 o AATOe_ O 3 Dim_Customer

I | (] mary o

fo 2 !

m

UI

=

Where Dim_Customer.n_cust_skey is a Number Datatype.

Note: For more sample queries generated using the query metadata table, see Sample Queries using the
AAI_DRF_QUERY_METADATA Metadata Table.

To arrive at the above-mentioned query, follow these steps:

In first figure, the required table Dim_Cards_Master does not consist of Party Identifier. Therefore, perform
the table join procedure using the AND condition at the table level.

i. Search for a table, which consists of the Party Identifier field. In this query, we have searched for
the table Dim_Customer with unique identifier n_cust_skey field. This table must be joined with the
required table Dim_Cards_Master.

i. However, the tables Dim_Cards_Master and Dim_Customer do not consist of any common column
name to perform the table join operation. Therefore, search for one more table
Fct_Card_Acct_Mapping. This table (Fct_Card_Acct_Mapping) consists of common column name
(n_card_number_skey) between Dim_Cards_Master table and itself.

iii. Join the Fct_Card_Acct_Mapping table, which consists of common column name (n_acct_skey)
with another table Fct_Cards_Summary.
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iv. Join the Fct_Cards_Summary table, which consists of common column name (n_cust_skey) with
the final table Dim_Customer.

v. Now, the Dim_Cards_Master table is joined with the Dim_Customer table.

c. You must arrive at the skey or equivalent column in the table, which consists of the required PlII
attributes. Then the <<INFODOM>>_RightToForget batch uses this key to filter records (For example:
Dim_Cards_Master) and randomize all the PlIs listed in the AAl_DRF_FUNCTION_COLUMN_MAP for
that table.

4. Now, PIl attributes can be queried and the values are randomized.

Sample Queries using the AAl_DRF_QUERY_METADATA Metadata table

These are the sample queries generated using the AAl_ DRF_QUERY_METADATA table:

Example 1:

select DIM MANAGEMENT.n manager skey from DIM MANAGEMENT DIM MANAGEMENT, FCT CUSTOMER
FCT CUSTOMER, DIM CUSTOMER DIM CUSTOMER where

DIM MANAGEMENT.n manager skey=FCT CUSTOMER.n manager skey and

FCT CUSTOMER.n cust skey=DIM CUSTOMER.n cust skey and DIM CUSTOMER.v d cust ref code
in(?2,?)

Example 2:

select DIM EMAIL.n email skey from DIM EMAIL DIM EMAIL, FCT PARTY EMAIL MAP

FCT PARTY EMAIL MAP, DIM PARTY DIM PARTY where

DIM EMAIL.n email skey=FCT PARTY EMAIL MAP.n email skey and

FCT PARTY EMAIL MAP.n party skey=DIM PARTY.n party skey and DIM PARTY.v party id
in(?,?)

Example 3:

select STG_CLAIM DETAILS.v_claim id from STG_CLAIM DETAILS STG_CLAIM DETAILS,
STG_CLAIM CLAIMANT STG CLAIM CLAIMANT where

STG_CLAIM DETAILS.v claim id=STG_CLAIM CLAIMANT.v claim_id and

STG_CLAIM CLAIMANT.v_cust ref code in(?,?)

Example 4:
select STG CONTACT MASTER.v contact id from STG CONTACT MASTER STG CONTACT MASTER,

DIM CONTACT DIM CONTACT where STG_CONTACT MASTER.v contact id=DIM CONTACT.v contact id
and DIM CONTACT.v customer id in(?,?)

Example 5:

select DIM CARDS MASTER.n card number skey from DIM CARDS MASTER DIM CARDS MASTER,
FCT CARD ACCT MAPPING FCT CARD ACCT MAPPING, FCT CARDS SUMMARY FCT CARDS SUMMARY where
DIM CARDS MASTER.n card number skey=FCT CARD ACCT MAPPING.n card number skey and

FCT CARD ACCT MAPPING. n_acct skey=FCT CARDS SUMMARY.n acct skey and

FCT CARDS SUMMARY.v d cust ref code in(?,?)

Sample Query for the FSI_PARTY_RIGHT_TO_FORGET table

This is the sample entry for the FSI_PARTY_RIGHT _TO_FORGET table:

Insert into FSI PARTY RIGHT TO FORGET values (SYSDATE, <<PARTY ID FROM Ur ENV>>,
'Testing Right2Forget');
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Data Portability

According to the Data Protection guidelines, a scenario may occur with a customer in which a Data Subject
requests the financial institution to share the PII of that Data Subject stored in the application. To cater to such
a scenario, the customer may use T2F (Table to File) functionality provided by AAI. This T2F functionality
enables the customer to query the data warehouse and save the attributes to a file.

Data Portability Scenario

A sample scenario to apply Data Portability:

1. The DIM_PARTY table consists of a set of Plls for multiple Data Subjects.

{} V_PARTY_NAME |{} V_PAN_CARD_ID |{} D_DATE_OF_BIRTH [{} D_DATE_OF_BIRTH_1 |{} V_ADDRESS_TELE_PH_NO |{} V_ADDRESS_STATE |{} V_ADDRESS_STATE_1

1 Aditya Sharma HSWENJEBZ91T

2 Maria Victor PCLOST413H
3 Abdul Mchammed AHJNSE3R4F
4 Vibhe Rac ROSAARTLI0L

5 Sharanya Gupra EMHPLS1E7H

09=-JhH=-53
15-SEP-24
04-DEC-73
13-MAY-TE
29-JAN-30

09-JAH-33
15-5EP-84
04~-DEC-73
13-MAY-78
29-JAH-30

8801283098
024372784
Je52198762
E962T3I5610
9901838919

Himachal

Fradesh

Harnataka

Orissa

Mahazashtra

Funjab

Himachal Fradesh
Harnataka

Orisaa
Maharashtra
Punjab

A Data Subject requests the bank to share a copy of the PIl data of that Data Subject stored by the bank.
For illustration, the Data Subject with V_PAN_CARD ID EMHPL5167K is used.

2. To make a file copy of the Pll requested by the Data Subject, the User (bank) must perform T2F data
mapping. Follow the Data Mapping procedure. See the Defining Data Mapping to File (T2F, H2F) section in
the Data Mapping part in the OFS AAAI Application Pack Minor Release 8.0.6.0.0 User Guide to:

a. Create a T2F definition for the scenario mentioned in step 1. V_PAN_CARD ID is the V_PARTY_ID in

the DIM_PARTY table.

Entity Selection

Prescripnt
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b. Create a Batch to run the T2F.

Batch Maintenance 9 -
Save Cancel
Batch Maintenance
12F DIM_PARTY|
Batc ame T2F_DIM_PARTY Batch Description
Duplicate Batch Batch ID v
c. Create a Task for the Batch.
Task Definition (7]
S st e
dim_par
a5k

[ alue

Datasicre Type EDW ¥

Dataitone Name ESCREINGD -

Frimary I# For Runtime Processes 10.184.157.123 v

Source Name L]

Extract Mame T2F_DIM_PARTY ¥

Default value SRLINSK
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d. Execute the Batch. Verify the progress of batch execution in Batch Monitor.

OHRALCLE prarcyl Lervices Dits Foundat a o @O bk = O+ B A

gy Dmabreiaon Tabde

Al LIAQabt Suppee Divardion;

BRI P8 v | sion Hirarchen ol Do Loacer
#  FSDRIO 129 Do FAT THl D |

Fage 1 of 1 (16 od g demyy K . Rncoic Pur Puge 13

FRDRENFO_TIF Dol Bl 0 S04, 1 Stitiiled

Tk 11F e pity

1. The output file path is:

/scratch/ofsaaappl/ftpshare/FSDFINFO/dmt/def/<T2F name>/<Batch name>/<batch run id>/
<information date>/<T2Fname>.dat

For example:

/scratch/ofsaaappl/ftpshare/FSDFINFO/dmt/def/T2F DIM PARTY/
FSDFINFO T2F DIM PARTY 20180504 1 Task1/20180504/ T2F DIM PARTY.dat

Note: This extracted file consists of PIl of a Data Subject that must be encrypted. See the Data Mapping
section in Data Management Tools chapter in the OFS AAAI Application Pack Minor Release 8.0.6.0.0 User
Guide.

2. T2F output file with the PIl details requested by the Data Subject.

| File Edit Format View Help
101-29-1990,Punjab,9901838919,160017 Sharanya Gupta -

Price Creation and Discovery Application Pack Installation and Configuration Guide - 8.0.6.0.0 345


https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm

Data Protection Implementation in OFSAA

Pseudonymization

Overview of Pseudonymization

Pseudonymization is a process by which Pl fields of a record are replaced by one or more artificial identifiers,
or pseudonyms. There can be a single pseudonym for a collection of replaced fields or one pseudonym for each
replaced field. Therefore, Pseudonymization is a method to substitute PII data with a reversible and consistent
value. This decreases the linking ability of a data set with the original identity of a data subject and acts as a
Data Security mechanism.

The mapping of pseudonyms to those PlIs that are required for lookups, to retrieve the data subject information,
must be stored away from the data warehouse in a secure location. This involves highly restricted access
controls and security mechanisms that are defined at the customer environment to suit customer data security
needs.

Implementation of Pseudonymization

OFSDF data model enables its customers to implement Pseudonymization process such that the Pll data is
separated from transaction data, and this Pll data is referenced only by pseudonym. For a wide range of
analytical processes, the access to Pll data is not necessary.

1. Customers can employ Pseudonymization and load the Pseudonymized data into OFSDF.

2. When analytical or modeling condition requires the availability of PIl data, then care must be taken by the
customer to load PII data into those columns that consist of additional data security controls such as
Redaction. When the requisite attributes are not part of the seeded Pl list, then the customer must:

o Extend the PII list
o Verify the completeness of the extensions

o Verify that Redaction is enabled on the extended PII fields prior to loading sensitive data attributes

To know more about Data Redaction, see OFS Analytical Applications Infrastructure Administration Guide.

Note: Itis recommended that the PIl values must not be added in the account dimension, party dimension,
and customer dimension columns where redaction is not applied. For example, PIl values must not be
added in the v_account_number, v_party_id, and v_cust_id columns. Instead, they must be loaded in
the v_original_account_number, v_orig_party_id and v_orig_cust_ref_code columns respectively,
where redaction is applied.
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Notice and Consent

Introduction to Notice and Consent

According to the Data Protection guidelines, a clear, legal based and accessible Notice must be provided to the
Party regarding the Personally Identifiable Information (PIl), which is collected from the Party during the on-
boarding process or during any stage of the workflow where PII of the Data Subject is captured.

After providing a Notice, a clear Consent must be obtained from the Party regarding the usage and handling of
PII by the financial institutions. This Consent must be given by the Party, and must be presented to them as their
choice with the option of withdrawal from providing Consent at any time. After the Party gives their Consent,
their PIl can be used in the workflow.

Populating Consent Purpose Dimension Party Consent and Fact Party
Consent

OFSAA is a back office product, and does not have direct interaction with the end user of the bank. Therefore,
Notice, and Consent User Interfaces are not applicable. However, Data Model of Data Foundation is enhanced
to hold Notice and Consent information as a download from source systems. The bank may further use this
feature for the task of processing or reporting.

Procedure to Populate Consent Purpose Dimension and Fact Party Consent

This section provides information about Consent Purpose Dimension Population and Party Consent Population
processes in the Oracle Financial Services Data Foundation application.

Overview of Consent Purpose Dimension Population and Fact Party Consent
Population

* Overview of Consent Purpose Dimension Population

In the Consent Purpose Dimension table (DIM_CONSENT_PURPOSE), Consent content is stored. This
table can be populated from Stage Consent Purpose Master Entity
(STG_CONSENT_PURPOSE_MASTER) using the SCD-468 packaged in FSDF.

¢ Overview of Fact Party Consent Population

Fact Party Consent is the table where Consent of the Party is stored. Table to Table seeded definitions are
provided for loading data into the target table Fact Party Consent (FCT_PARTY_CONSENT):

Source Table Name Target Table Name T2T Definition Name

STG_PARTY_CONSENT FCT_PARTY_CONSENT T2T_FCT_PARTY_CONSENT
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Executing Consent Purpose Dimension Population and Fact Party Consent Population
T2T

* Executing through Batch

o From Consent Party Master, Consent Purpose Dimension SCD can be executed by executing task
present in the SCD batch FSDFINFO_DATA_FOUNDATION_SCD.

o Fact Party Consent T2T can be executed by executing task present in the T2T batch
FSDF_SOURCED_RUN.

Follow these steps to execute the batch:

i. Navigate to the Batch Execution screen.

ii. Selectthe seeded batch:
FSDFINFO_DATA_FOUNDATION_SCD for Consent Purpose Dimension
FSDF_SOURCED_RUN for Fact Party Consent

where Infodom is the information domain where application is installed.

iii. Selectthe AS_OF_DATE for which source customer information is required to be loaded into the
table.

iv. Click Execute Batch.
Monitor the status of the batch in the screen of OFSAAI.

¢ Execution of T2T Batch through Run Management

T2T_FCT_PARTY_CONSENT is part of Financial Services Data Foundation Sourced Run. The process
can be executed through the Seeded Run Financial Services Data Foundation Execution Run.

Note: When executing through Run, the RUNSkey is auto-generated and stamped against each record.

Error Messages

In the log file present in the:

+ ftpshare/logs/<Run_Date>/FSDFINFO/RUN EXECUTABLE folder for DIM_CONSENT_PURPOSE
+ ftpshare/logs/<Run_Date>/FSDFINFO/LOAD DATA folder for T2T_FCT_PARTY_CONSENT

This is the most common error message:

* Unique Constraint Violation: This occurs when attempting re-load or loading existing records for the
already executed AS_OF_DATE.
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Checking the Execution Status for Fact Party Consent T2T

The status of execution can be monitored using the Batch Monitor screen.

Note: For a more comprehensive coverage of configuration and execution of a batch, see Oracle Financial
Services Analytical Applications Infrastructure Release 8.0.6.0.0 User Guide.

The status messages in Batch Monitor are:

* N - Not Started
+ 0O-0nGoing

* F - Failure

* S -Success

The execution log can be accessed on the application server in the directory ftpshare/logs/<Run_Date>/
FSDFINFO/LOAD DATA. The file name consists of the Batch Execution ID.

This is the error log table in atomic schema:

+  FCT_PARTY_CONSENTS for T2T_FCT_PARTY_CONSENT
Fact Party Consent T2T

T2T definition can be retrieved as an excel document for reference from the metadata browser of the Unified
Metadata Manager (UMM) component of OFSAAI.

Data Archival

Synopsis for Data Archival

The OFSAA data model, along with the active data stores Personally Identifiable Information (PIl) of Data
Subjects who are no longer actively using the financial services, which is a liability.

Implementation of Data Archival by OFSAA

To implement this invisibility of data at row level, Oracle Database 12c¢ has introduced a new feature called Row
Archival.

» The Row Archival feature is simple and effective to use as opposed to the traditional approach, which
requires storage and maintenance of historical tables.

+ This feature enables to archive records based on a given criteria within the account table. The criteria can
be, for example, the Account Close Date of the Data Subject.

« This archived data can be viewed or made hidden by setting a session parameter.
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A Criteria for Data Archival

To archive Party records, which are closed for more than seven years:

1.

To enable Row Archival on the DIM_PARTY table, run this command:
ALTER TABLE DIM PARTY ROW ARCHIVAL

Run the Row Archival Update statement periodically, to search for the account Party records which are
closed for more than seven years. Run this command:

UPDATE DIM PARTY SET ora archive state='l' where

trunc (months between (SYSDATE, d closed date)/12)>7

In the above query:

ora archive state is a hidden column which is created after the ROW ARCHIVAL is set on the table.

o SETora archive state='1"' archives the records which meets the criteria of seven years of account
closure.

o Hidden rows are available for Select/Update queries only after ora_archive state is disabled.

Viewing Archived Rows

To make hidden rows visible for a session, run this command:

ALTER SESSION SET ROW ARCHIVAL VISIBILITY=ALL;

To make the rows invisible, run this command:

ALTER SESSION SET ROW ARCHIVAL VISIBILITY=ACTIVE;

Data Redaction

Overview of Data Redaction in OFSAA

Data Redaction is one of the Data Security features that provides protection of data against unauthorized access
and data theft.

In OFSAA, these tables are seeded as part of Data Redaction:

AAI_DRF_FUNCTION_MASTER

This table holds the Redaction function definitions. Generic logical functions can be address, email, card
number, phone number etc.

AAI_DRF_FUNCTION_COLUMN_MAP
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This table holds the Redaction Function- Column mappings. The PII columns will be redacted according to
the Function mapping.

it V_FUNCTION_CD | ¢ V_TABLE_MNAME 4 V_COLUMN_NAME it V_COLUMNM_DATATYPE { W_COLUMMN_DESC
53 ADDRESS Dim Parcy v_ADDRESS city VRRCHARZ (255) Corrent / Residence RADDRESS. .
M RDDRESS Dim_Parcty v_ADDEESS country VARCHRRZ(Z53] Current / Residence ADDRESS...
55 ADDBEESS Dim Parccy v_ADDEESS district VRRCHARZ {2533) Current / Residence BDDRESS. ..
56 ADDBESES Dim Parcty v_ADDEESS line 1 VRRCHRRZ (255 Current / Residence ADDRESS...
57 ADDRESS Dim Parcy v_ADDEESS lire 2 VARCHAR2 (255 Current / Reasidence ADDRESS...
58 ADDBESS Dim Parcty v_JDDEESS line 3 VRRCHAR2 (255] Current / Residence ADDRESS...
39 RDDEESS Dim_Farccy V_ARDDEESS off_city VRRCHRRZ (255) Office RADDRESS City
60 RDDRESS Dim_Parcy V_ADDEESS Off COUnTIy VRRCHRRZ(Z33] QIfice ADORESS COUNCEY
6l ADDBE33 Dim Packty v_ADDBESS off district I {235] Office ADDRESS District
62 ADDRESS Dim Party v_IDDEESE off line 1 VARCHAR2 (255] Qffice ALCRESS Line 1
63 IDDREESS Dim Party w_IDDEESS off line 2 VLRCHLRZ (255) Office ADDBESS Line 2
64 ADDEESS Dim_Party v_IDDRESS off line 3 VRRCHRRZ (255 Office ADORESS Line 3
65 LONEFSS mMm Parcy T ANORFSS AfT Srare VLRCHRR? (755] Ortire GITRFSS Snarts

- AAI_DRF_TABLE_ACCESS CD_MAP

This table holds the mapping of tables having columns marked for redaction to the Access codes. These
access codes are SMS function codes and are expected to be mapped to the role DATASECURITY. The
policy expression will be created based on this role and evaluated to access non-redacted data.

Note: The list of Plls, on which Data Redaction is applied, is available at My Oracle Support.

Accessing PIl Table and PIl Datasheet

. AAI_DRF_FUNCTION_COLUMN_MAP is the PII table.

* PIll Datasheet list can be accessed from My Oracle Support.

Data Redaction Batch

Execute the Data Redaction seeded Batch ##INFODOM## DATA REDACTION to execute the Data Redaction
Utility if it is available as part of application common metadata. If the Batch is not available, you must create a
new Batch as mentioned in the Creating Batch for Executing Data Redaction Utility section in the OFS Analytical
Applications Infrastructure Administration Guide.

The task in the Batch ##INFODOM## DATA REDACTION consists of three parameters:

. dataredaction.sh

« trueffalse
« OFSAA User ID

For more information, see Data Redaction section in the OFS Analytical Applications Infrastructure
Administration Guide.
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Data Protection Implementation in OFSAA

Mapping Roles to User Groups for Data Redaction

Data Controller Group is mapped to DATASECURITYADMIN role:
Group Code: DATACONTROLLER

Group Name: Data Controller Group

Mapping from individual applications to DATASECURITY role:

Group Description: Data Controller Group
Role code: DATASECURITYADMIN
Role Name: Data Security Admin

Role Description: Data security admin role for executing redaction policies

Role code: DATASECURITY
Role Name: Data Security Viewer

Role Description: Data Security Viewer role for viewing original (non-redacted) data.

a. DATASECURITY role must be mapped to those application User Groups which have the privilege to
view the data in its originality (un-redacted). Therefore, applications must identify the functions which

must be mapped to the DATASECURITY role. These mappings must come as seeded data.
b. And then, map DATASECURITY role to the respective User groups. This mapping must be done

manually from individual applications to the DATASECURITY role.

Data Redaction Batch Execution Sample

Data before executing Data Redaction Batch:

|V_ACCOUNT_DESC |
"'u" ACCOUNT_MANAGER_CODE | drmc :
V ORIGIMAL ACCOUNT _MUMBER data redachon orgmal account numl:u

| Row 1 __| Fields
B MN_ACCT SKEY E
W_ACCOUNT_MUMBER ECI007

| data redaction desc

Data after executing Data Redaction Batch:

>

Row 1
M_ACCT_SKEY

g

W_ACCOUNT_MNUMEER
YW ACCOUNT_DESC
W_ACCOUNT_MANAGER_CODE

Y _ORIGINAL_ACCOUNT_NUMEER

Fields

BC1007
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